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Notice

Every effort was made to ensure that the information in this manual was accurate at the 
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reserves the right to provide an addendum to this manual with information not available at 
the time that this manual was created.

Copyright/Trademarks 
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reproduced or transmitted, electronically or otherwise, without written permission of the 
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All other trademarks and registered trademarks are the property of their respective 
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Copyright release 

Reproduction and distribution of this guide is authorized for US Government purposes 
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Terms and conditions
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Federal Communications Commission (FCC) Notice 

This product was tested and found to comply with the limits for a Class A digital device, 
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likely to cause harmful interference, in which case you will be required to correct the inter-
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About this Guide
This guide discusses the following Xgig Maestro products:

• Xgig Jammer

• Xgig Delay Emulator
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Who Should Read this Guide

This guide is intended for networking professionals in research and development who need to 
monitor and test network performance. It is assumed that users of this guide have an engineering 
background.

What this Guide Contains

This guide is organized into three parts:

• PART ONE: Using Xgig Jammer which includes chapters 1 through 9.

• PART TWO: Using Delay Emulator which includes chapters 10 through 13.

• PART THREE: Appendices which includes appendices Athrough E.

The chapters contain the following information:

Chapter 1, “Introducing Xgig Jammer"” describes the Jammer features and capabilities.

Chapter 2, “Using the Jammer Tab"” describes the Jammer tab interface and provides procedures 
to use it.

Chapter 3, “Creating Jammer Test Configurations for Fibre Channel"” describes the elements on 
the Xgig Jammer Configuration FC window and how to use them.

Chapter 4, “Creating Jammer Test Configurations for Gigabit Ethernet"” describes the elements on 
the Xgig Jammer Configuration GE window and how to use them.

Chapter 5, “Creating Jammer Test Configurations for SAS and SATA/STP"” describes the 
elements on the Xgig Jammer SAS/SATA/STP Configuration window and how to use them.

Chapter 6, “Creating Jammer Test Configurations for 10GigE"” describes the elements in the Xgig 
Jammer Configuration 10GigE window and how to use them.

Chapter 7, “Creating Jammer Test Configurations for 16G FC"” describes the elements in the Xgig 
Jammer Configuration 16G Fibre Channel window and how to use them.

Chapter 8, “Creating Jammer Test Configurations for PCIe"” describes the elements in the Xgig 
Jammer Configuration PCIe window and how to use them.

Chapter 9, “Xgig Jammer Application Notes"” provides examples of how to use the Jammer in 
practical situations.

Chapter 10, “Introducing Xgig Delay Emulator"” describes the Jammer features and capabilities.

Chapter 11, “Using the Delay Emulator Tab"” describes the Jammer tab interface and provides 
procedures to use it.

Chapter 12, “Creating Delay Emulator Test Configurations for Delay Mode"” describes the 
elements on the Xgig Delay Emulator Configuration Delay window and how to use them.

Chapter 13, “Creating Delay Emulator Test Configurations for Reorder Mode"” describes the 
elements on the Xgig Delay Emulator Configuration Reorder window and how to use them.
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Appendix A, “Fibre Channel Ordered Sets - Partial List” contains some of the Ordered Set values 
that are used in this application.

Appendix B, “8-Bit/10-Bit Mapping” contains three tables: one is legal 8-bit/10-bit characters 
sorted by 10-bit value; the second is 10-bit values with no 8-bit mapping sorted by 10-bit value; 
the third is legal 10-bit values sorted by K/D code.

Appendix C, “Fibre Channel Legal Arbitrated Loop Physical Addresses” contains translation 
tables. 

Appendix D, “Gigabit Ethernet Ordered Sets - Partial List” contains a table of these values.

Appendix E, “Primitive Encoding” contains a table of K28.5-based Primitive encoding whose 
40-bit values have a Hamming distance of at least 8.
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Conventions

The following conventions are used in this guide.

Message Formats

This guide uses the following format to highlight special messages:

Typographical Conventions

This guide uses the following typographical conventions:

Technical Assistance

If you require technical assistance, call 1-844-GO-VIAVI (1-844-468-4284) or 
e-mail Techsupport-snt@viavisolutions.com.

For the latest TAC information, go to
http://www.viavisolutions.com/en/services-and-support/support/technical-assistance.

Note: This format is used to highlight information of importance or special interest.

Caution: This format is used to highlight information that will help you prevent equipment 
failure or loss of data.

bold sans serif Commands

italics Directory names, book titles, named key, for example the Enter key

courier font Screen text, user-typed command-line entries

mailto:techsupport-snt@viavisolutions.com
http://www.viavisolutions.com/en/services-and-support/support/technical-assistance
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Chapter 1
Introducing Xgig Jammer

In this chapter:

• Xgig Jammer Overview

• Features

• New Features
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Xgig Jammer Overview

The Xgig Jammer includes hardware (Xgig Multi-function Blade) and software that performs 
real-time data modification for PCIe, Fibre Channel, Gigabit Ethernet, 10GigE, Serial Attached 
SCSI (SAS), and Serial ATA (SATA) protocols. You can use the Jammer with Xgig Analyzers or 
Bus Doctor to capture and display the network traffic associated with the data modification.

The Xgig Jammer should be used as a digital retiming device. The Xgig Jammer blade re-times the 
data and re-transmits it with a new clock transparent to the data link (it passes every bit of data.) 
The Xgig Jammer blade functions in any PCIe, Fibre Channel, Gigabit Ethernet, 10GigE, SAS, or 
SATA architecture. It does not log onto a loop, switch, or fabric; it only passes data between two 
devices. The Xgig Jammer blade can pass PCIe, Fibre Channel, Gigabit Ethernet, 10GigE, SAS, or 
SATA traffic, or it can recognize an event or event sequence and modify the traffic. The events can 
be Ordered Sets, frames, Primitives, Control Characters, SOF, or EOF depending on the selected 
protocol. A specific Ordered Set, series of Ordered Sets, Primitive Sequence, or Control Character 
can be modified or replaced. A specific frame or series of frames can be modified in many ways: 
replacing a frame with idles, truncating a frame, inserting a frame, or changing any bits within a 
frame.

The data modifications are performed on the 8-bit representations of the Ordered Sets, frames, 
Primitives, Control Characters SOF, and EOF. This ensures that the Xgig Jammer module always 
produces consistent PCIe, Fibre Channel, Gigabit Ethernet, 10GigE, SAS, and SATA traffic 
without disparity errors or clock discontinuities. The exception to this is when the Xgig Jammer is 
used to insert disparity errors or code violations into a frame, Ordered Set, or Primitive. 

Note: The events and traffic modification options vary with each protocol.
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Figure 1 shows an example of a configuration where the Xgig Jammer and Xgig Analyzer are 
inserted into a network with two data paths, designated A and B.

The Xgig Jammer module can detect a Trigger Event and modify data in Path A. The response 
from Device 2 is detected on Path B.

Figure 1:  Duplex Xgig Jammer in Crossover Configuration with Xgig Analyzers

Note: When the Jammer is used in a SATA (or Serial ATA Tunneling Protocol—STP) 
environment, the Jammer is required to modify the traffic automatically in order to support the 
flow control mechanism. This happens even if the Jammer is not started, and is only passing 
through traffic. Therefore, SATA_HOLD and SATA_HOLDA Primitive Sequences are usually 
not passed through the Jammer, but instead, the Jammer generates its own SATA_HOLD and 
SATA_HOLDA Primitive Sequences on the fly to maintain flow control with Device 1 and 
Device 2. Consequently, the Jammer does not allow Jamming of SATA_HOLD or 
SATA_HOLDA Primitive Sequences because it would not be Jamming actual received traffic.

S
F

P

Xgig Jammer Xgig Analyzer B
Fibre Channel
or
Gigabit Ethernet S

F
P

S
F

P

S
F

P

S
F

P

S
F

P
Xgig Analyzer A

or
SAS or SATA

Device 1

Fibre Channel
or

or
SAS or SATA

Device 2

Gigabit Ethernet

Xgig Jammer Xgig Analyzer B

SAS or SATA

w
ide

 S
A

S

Xgig Analyzer A

Device 1 Device 2

SAS or SATA

w
ide

 S
A

S

w
ide

 S
A

S

w
ide S

A
S

w
ide

 S
A

S

w
ide

 S
A

S



Introducing Xgig Jammer Features

10 Xgig Jammer and Delay Emulator User Guide

  

Features

Xgig Jammer has the following features:

Operation

The Xgig Jammer system (hardware and software), allows you to perform the following 
operations:

• Change predefined network serial traffic patterns to new patterns.

The Xgig Jammer modifies Trigger Events in the manner you specify. It does not insert or 
remove network traffic, except for the re-timing circuit that adds or drops appropriate Ordered 
Sets or Primitives. An exception is in the SAS protocol, where the Jammer might need to 
rearrange the ordering of Primitives inside a frame so that the first thirty-two, 32-bit words of 
a frame are not too spread apart for accurate triggering. Another exception is the automatic 
SATA flow control that is performed.

• Pass traffic, unchanged, that does not match the Trigger Condition pattern.

• Reproduce a pattern change at will.

You can define multiple, sequential, arbitrary Jam cases by entering each of them into a test 
suite list. Each case can be unique or you can repeat a case within the suite.

Capabilities

The Xgig Jammer has the following capabilities:

• Operates with Fibre Channel, Gigabit Ethernet, 10GigE, SAS, and SATA protocols

Depending on the license you purchase, you can select the protocol that your network uses and 
display the graphical user interface for that protocol.

• Supports the following line rates:

— Fibre Channel: 

• 1.0625 Gbps

• 2.1250 Gbps

• 4.2500 Gbps

• 8.5000 Gbps

• 14.0250 Gbps

— Gigabit Ethernet: 

• 1.2500 Gbps (GigE blades run only at this rate.)

• 10.3125 Gbps (10GigE blades run only at this rate.)

— SAS/SATA:

• 1.5 Gbps 

• 3.0 Gbps 

• 6.0 Gbps 

• 12.0 Gbps (SAS only)
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• Operates in digital re-timing mode at all times. 

• In SAS and SATA, the Jammer auto negotiates out of band (OOB) with other hardware on 
your network.

You can also force the link to perform OOB at any time. You can force the Jammer to 
speed-negotiate to a particular speed.

• Allows you to generate a test suite with up to 1024 separate Test Cases per run.

Contains standard editing features such as copy, cut, paste, add, insert, and delete to edit the 
test suite. An option lets you run the test suite forever in a repeating loop.

• Provides the appropriate MAC (media access control) layer for Fibre Channel, Gigabit 
Ethernet, 10GigE, or SAS/SATA when you load the application.

Triggering Capabilities

The Xgig Jammer module provides the following Triggering capabilities:

• You have two levels of triggering:

— Arm (first level)

— Trigger (second level)

• You can set an Arm condition as a specific Ordered Set, frame, or Primitive Sequence, or as an 
external Trigger Condition. An external Trigger Condition comes from outside the port (from 
another port in the same domain or from a TTL-in connector in the same domain).

• You can set the Jammer to repeatedly Arm and/or Trigger on an Ordered Set, frame, Primitive 
Sequence, Control Character, SOF, or EOF.

• You can set the Jammer to create an external trigger output when the Trigger condition is met. 
This triggers everything in the same domain as the Jammer port.

Jamming Capabilities

The Xgig Jammer can perform the following types of Jams on the contents of frames:

• Pass a 32-bit word unchanged

• Replace a 32-bit word with a new value, masked nibble by nibble

• Corrupt a 32-bit word with a code violation (Fibre Channel, Gigabit Ethernet, and 10GigE)

• Corrupt a byte with a disparity error or code violation (SAS and SATA only)

• Invert a 32-bit word’s specified bit(s)

• Replace a 32-bit word with a new value, masked bit by bit, according to a preset global 
definition

• Invert a 32-bit word’s specified bit(s) according to a preset global definition. 

• Replace a 32-bit word with a calculated CRC value (Fibre Channel, SAS and SATA only) 

• Set a 32-bit word’s specified bit(s) to 1

• Set a 32-bit word’s specified bit(s) to 0

• Replace triggered frame with a 10 bit frame (SAS/SATA only)
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• Insert a frame after the triggered frame (10GigE and 16G FC only)

• Insert D.C. Idle into a frame (SAS/SATA only)

• Truncate the target frame to a shorter length

• Duplicate a frame (10GigE and 16G FC only)

• 66-bit Block Jam (16G FC only)

• Insert Dword within frame (10GigE ad 16G FC only)

The Xgig Jammer can perform the following types of Jams on Ordered Sets Primitive Sequences, 
Control Characters, EOF and SOF:

• Pass the Ordered Set or Primitive Sequence unchanged

• Replace the Ordered Set or Primitive Sequence with another standard or user-defined Ordered 
Set or Primitive Sequence

• Corrupt the Ordered Set with a code violation (Fibre Channel and Gigabit Ethernet)

• Corrupt any byte(s) in the Primitive Sequence with a disparity error or code violation (SAS 
and SATA only)

• Replace the 32-bit word containing an /S/ character with idles [/I] (10GigE and 16G FC only).

• Replace the 32-bit word containing an /S/ character with idles [/I] (10GigE and 16G FC only).

• Insert a frame after a standard or user defined Ordered Set (10GigE and 16G FC only)

• Perform FEC error injection (16G FC only)

New Features

The following new features have been released in this version of Xgig Jammer.

• Xgig Jammer32-bit client software is supported on both 32-bit and 64-bit versions of the 
Windows operating systems. Refer to the Xgig Maestro Software Installation Guide for the 
complete list of supported operating systems.
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Chapter 2
Using the Jammer Tab

In this chapter:

• Using the Configuration Manager in Jammer

• Using the Parameters Status Table in Jammer

• Using the Parameters Status Context Menu in Jammer

• Using the Ports Manager in Jammer

• Using the Log Manager in Jammer

• Customizing the Appearance of the Maestro/Jammer Main Window

• Performing Configuration Tasks in Jammer

• Running the Test Suite on a Jammer Device
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After you have discovered and locked the Jammer ports that you want to use and have set up your 
capturing and monitoring applications, such as Xgig Analyzer or Bus Doctor, you are ready to run 
the Xgig Jammer application. This chapter provides an overview of the Jammer tab, on the Xgig 
Maestro main window, and its functions; it also includes steps to run predefined tests supplied 
with the Xgig Jammer application or tests you have defined and saved.

You should have launched Xgig Maestro and locked at least one device as described in the Xgig 
Maestro Introduction Guide. The Xgig Maestro window is displayed with the Jammer tab on the 
right. This tab is where you operate the Jammers you have locked.

Figure 2:  Xgig Jammer Tab on Xgig Maestro Window
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Using the Configuration Manager in Jammer

The Configuration manager (Figure 3) is associated with the device function tab, BERT and 
Jammer. This window allows you to select the protocol you want to use. This window also 
displays the configuration files specific to the function tab displayed. The Sample 
Configurations folder includes configurations that are provided with the application. The User 
Configurations folder is where the configurations you create are saved. The Most Recently Used 
folder allows you easy access to those configuration files most recently used. The Configuration 
Manager also includes a list of all the drives on your system allowing you to locate any 
configuration files on your system quickly.

The Configuration manager has the following features:

• The Configuration manager provides a list of test configurations organized into folders and 
lists all the drives on your system allowing you to easily browse to locate all of your 
configuration files on your system

Figure 3:  File Location in Jammer Configuration Manager
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• The configurations files in the Configurations, Sample, and User Configurations folders 
are organized according to protocol. When you open one of these folders, the Configuration 
Manager provides you with a list of protocols to select.

Figure 4:   Protocol Selection in Jammer Configuration Manager

• List of configuration files in a folder

Figure 5:  Configuration Files and Description Pane
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• Description pane

— When you select a configuration file in the list, a description of the file is displayed in the 
description pane below. It also displays the name of the file, the path where the file is 
located, the size of the file, the date and time when the file was created, the date and time 
the file was modified, whether the file is read-only and the Map path where the file is 
located on your system. 

— When you click the Show/Hide button below the Description pane, you display or hide 
this pane.

• Drag and drop files

You can drag any configuration from the Configuration manager list onto a device column to 
load it.

• Tool bar that lets you create, load, copy, cut, and paste configuration files. See “Configuration 
Manager Tool Bar in Jammer” on page 17 for more information on this tool bar.

• Context menu

Select a configuration file name, and right-click to display a menu where you can choose to 
create and edit configuration files, and additional operations. See “Configuration Manager 
Context Menu in Jammer” on page 18 for more information about these menus.

• Browse to map folders of files stored in locations other than the default Sample and User 
Configuration folders.

Configuration Manager Tool Bar in Jammer

The Configuration manager tool bar (Figure 6) allows you to perform the following functions:

New Configuration  allows you to open the Configuration window and create a new Jammer 
configuration from scratch. 

New Folder  allows you to create a new folder.

Load  allows you to load a configuration file into a port or ports. This icon is only active when 
a port has been locked and is selected in the Port Manager. See “Loading Jammer Configuration 
Files” for details.

Map  allows you to select a folder that you want to be listed in the Configuration Manager for 
the selected function tab.

Unmap  allows you to unmap a folder that has been mapped.

Cut  allows you to cut a file from its current location. This is not the same as deleting a file.

Copy  allows you to copy a file.

Paste  allows you to paste a file you have cut or copied.

Delete  allows you to delete a file or folder.

Path  allows you to go up one level in the folder tree. This field next to this icon displays the 
current folder name.
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Refresh  allows you to refresh the Configuration Files and Description pane.

Show/Hide  allows you to show or hide the details for the selected file. These details appear in 
the lower section of the Configuration Manager pane.

View  allows you to view the files in the Configuration Manager as a list including only the 
file name or to view the details of the files in the list.

Figure 6:  Configuration Manager Tool Bar in Jammer 

Configuration Manager Context Menu in Jammer

Figure 7:  Configuration Manager Context Menu in Jammer 

Right-click in the list to choose the following actions from the context-sensitive menu:

• Up

Displays the contents one folder level up from the current display.

• New Jammer Configuration

Opens a new Jammer configuration window for editing.

• New Folder

Opens the Configuration manager dialog where you can enter the name of a new folder you 
want to add.

• Edit Jammer Configuration

Opens the file highlighted in the list, the same as double-clicking on the file name.
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• Load Jammer Configuration into Selected Port(s)

Loads the file highlighted in the list into the port(s) selected in the Ports Manager. See “Using 
the Ports Manager in Jammer.”

• Cut

Removes a selected file or folder from the list. 

• Copy

Copies a selected file or folder to a clipboard making it available to paste in another location.

• Paste

Pastes a file or folder you cut or copied to the location you choose.

• Rename

Opens a dialog with the current file or folder name displayed in an entry field that you can 
modify. It also shows the protocol, path, and current file or folder name.

• Delete

Opens a dialog where you can confirm whether you want to delete the highlighted file 
(configuration) or folder from the list.

• Must Confirm Delete

Sets this choice as a preference that opens a dialog to confirm that you want to delete a file or 
folder from the list. When you select it, a check mark is displayed next to it. It is selected by 
default.

• Map Folder

Opens the Map Folder dialog box that lets you map a folder to a name of your choice. 

Figure 8:  Map Folder dialog box 

Enter a name of your choice in the Mapped Folder Name field, and use the Browse button to 
select the folder on your system or network you want to map to this name.

• Edit Mapping Path

Allows you to edit the mapping path.

• Unmap Folder

Removes a highlighted mapped folder from the Configuration manager.

• Explore

Opens a Windows Explorer window showing the directory where the current configuration 
files are located.
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• Open Command Prompt

Opens a Windows Command Prompt window showing the directory where the current 
configuration files are located.

• Refresh

Refreshes the Configuration Manager window.

• View

Has two choices:

— List

Displays the list of files or folders in the path you choose.

— Details

Displays the list of files or folders with the size and modification date.
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Using the Parameters Status Table in Jammer

Each Jammer device (a simplex Jammer or a duplex Jammer is considered as one device) is 
displayed by a column on the Jammer tab (Figure 9). At the top of each column is the protocol, the 
chassis name, and in parenthesis the chassis number, the slot number and port number(s) in 
parenthesis. 

To configure how to display the ports in the Parameters Status Table, click on the Views button 
and do the following:

Select or unselect Configuration to display or hide the Configurations tab and Parameters tab 
where you manage Jammer configuration files and select the Parameters to display, respectively.

Click Ports to display or hide the Port Status table.
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Figure 9:  Jammer Parameters Status Table 

The first column on the tab is the legend for each row in the device columns and contains the 
following categories:

• State

• Jam Status

• Configuration

• Status

• Settings

• Current test
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Parameters Category Descriptions

State

This row shows the state of the Jammer: Disconnected, Connecting, Paused, Pausing, Running, 
Skipped, Skipping, Starting, Stopped, or Stopping.

Jam Status

Displays the state of the Jam defined in the currently loaded configuration file: Idle, Waiting for 
Trigger, Done, Skipped, Timed Out.

Configuration...

Displays the name of the configuration file, if any, loaded into the port.

Start/Stop

Click this button to Start or Stop a test. The green arrow icon indicates you can click the button to 
Start the test. The red box indicates you can click the button to stop the test.

Pause/Resume

Click this button to pause or resume a test suite that is running.

Skip

Click this button to skip a test that is running and move to the next test in the suite.

Operation

Opens the Operation dialog box.

Status Category

This category gives the status of the test suite that you have loaded into the Jammer.

Protocol

Indicates the protocol of the Jammer: Fibre Channel, Gigabit Ethernet, SAS, or SATA. You choose 
a protocol in the Port Selection and Domain Setup window when you lock ports. The small lock 
icon indicates that the protocol cannot be changed at this stage. For SAS and SATA Jammer, you 
may choose the protocol between SAS and SATA using the Edit protocol and speed settings 
option.

Clock rate

Indicates the Jammer clock rate. The closed lock icon indicates you cannot currently change the 
clock rate; the open lock icon indicates you can change the clock rate. 

In Gigabit Ethernet, the clock rate is always 1.2500 Gbps, therefore, the icon is always locked. 
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In 10 Gigabit Ethernet, the clock rate can be either 1.0625 or 10.3125 Gbps. 

In Fibre Channel, the clock rate can be 1.0625 Gbps, 2.1250 Gbps, 4.2500 Gbps, 8.5000, or 
14.0250 Gbps. 

In SAS and SATA, you can choose to auto-negotiate to any speed. You can also set the Jammer to 
force the link to only negotiate to either 1.5 Gbps, 3.0 Gbps, or 6.0 Gbps.

Both ports in a port pair must always be set to the same clock rate. Therefore, if you have two 
single Jammers, and one of them is running, the clock rate is locked on both.

Signal LED A and Signal LED B

These two indicators change color, green, red, yellow, black, depending on the link status. They 
also match the Link status LEDs on the front panel of the blade in the Xgig chassis. Refer to the 
table below for the description of each LED color.

16G FC FEC

This setting is only for 16G FC with the speed set at 14.0250 Gbps. Unlocked indicates that the 
setting is Auto. This is the default setting. To set this setting, select FEC Mode from the context 
menu, then select Auto, On, or Off. When this is set to On, the table will read “Locked”, and there 
will be a green dot next to the table entry.

PCIe Link Speed

Indicates the link speed of the PCIe generation, Gen1 or Gen2.

PCIe Link Width

Indicates the link width of the PCIe link in lanes.

Progress

Indicates where the Jammer is in the test suite while it is running or where it is stopped or paused.

Table 1:  Xgig Jammer Blade LEDs

Label on Blade Blade Parameters Status table-Signal A, Signal B

In Use
• Green when port locked by client application
• Black otherwise 

Link (3G)
Signal (6G)

• Green -FC, GE: when traffic is good
• Green-SAS/SATA: Speed set
• Yellow -FC, GE: Loss Of Synchronization
• Yellow-SAS/SATA: No speed set (Before 

OOB/In OOB)
• Blinking Yellow -SAS/SATA: In OOB
• Off-FC, GE:Loss Of Signal
• Off-SAS/SATA: No signal (nothing connected)

• Green -FC, GE: when traffic is good
• Green-SAS/SATA: Speed set
• Yellow -FC, GE: Loss Of Synchronization
• Yellow-SAS/SATA: No speed set (Before 

OOB/In OOB)
• Blinking Yellow -SAS/SATA: In OOB
• Black-SAS/SATA: No signal (nothing 

connected

Signal (12G) • Green (solid) - Link present
• Green (flashing) Traffic is coming
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Log

Indicates if a log from the last operation is available for viewing. 

Settings Category

This category indicates the current physical setup of the Jammer device. You can change most of 
the settings in this category by using the Parameters Status context menu for each device you have 
locked.

Protocol

Indicates the current protocol setting for the Jammer: Fibre Channel, 16G FC, Gigabit Ethernet, 
10GigE, SAS, or SATA. To change the Protocol, you must select a device (port) from the port 
context menu in the Port Selection and Domain Setup window. 

For SAS and SATA you can edit the protocol and the speed from the Parameters Status context 
menu. 

Clock Rate 

Indicates the Jammer clock rate. The clock rate options and behavior is different for the protocols 
and speeds. The clock rate options may include 1.0625 Gbps, 1.2500 Gbps, 2.1250 Gbps, 2.5000 
Gbps, 4.2500 Gbps, 8.5000, 10.3125, or 14.0250 Gbps, depending on the blade. Both ports in a 
port pair must always be set to the same clock rate. Therefore, if you have two Jammers, and one 
of them is running, the clock rate is locked on both of them. See “Changing the Clock Rate of a 
Jammer” on page 31 for instructions on changing the clock rate.

Number of tests

Displays the number of Test Cases in the currently loaded test suite. You can change the number of 
Test Cases to run in the Jammer Configuration window.

Run suite…

Indicates if the test suite is set to run only once or to loop forever (until you click Stop).

GigE Jumbo Frames

This indicates if Gigabit Ethernet jumbo frame support is enabled. (This is only available in the 
Gigabit Ethernet Jammer.) When enabled, the Jammer supports jumbo frames up to 16 KB in size, 
however, the latency through the port is about 136 microseconds. Otherwise, only normal 1500 
byte frames are supported, with a latency of about 17 microseconds.
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Current Test Category

This group of parameters gives information and status about the current test in the test suite that 
the Jammer is running or about to run.

Name

Displays the name of the current test.

Mode

Displays the current test mode setting that you set in the Jammer Configuration window.

Arm name, Trigger name, and Jam name

Displays the names given to each of the components of the current test.

Arm status

For a Test Case with an Arm condition, this indicates if that condition has been met.

Arm-Trigger timeout

Displays the number of 32-bit words the Jammer waits for the Trigger condition to be met after the 
Arm condition has been met. After this expires, the Jammer rolls back to wait again for the Arm 
condition.

Trigger occurred

Indicates if a trigger and Jam have occurred for this test case.

Trigger timed out

Indicates if the Arm-Trigger timeout has ever occurred for this Test Case.

Repeat Mode

Indicates the Test Case mode and whether or not it is repeated. You set this in the Jammer 
Configuration window, Test Case Repeat settings dialog.

Repeat Count

Indicates the number of times the Test Case is repeated.

Test Timeout

Indicates the total amount of time you have set the Jammer to wait for a Test Case to fully 
complete (including all repeats) before aborting and going to the next Test Case, preceded by the 
amount of time currently left. For example, when the Jammer is in the running state, the timer 
would show 59 sec/1:30 for a test configured to timeout after one minute, thirty seconds, while 59 
seconds remain before the timeout.



Using the Parameters Status Context Menu in Jammer Using the Jammer Tab

Xgig Jammer and Delay Emulator User Guide 27

  

Using the Parameters Status Context Menu in Jammer

Right-click on the Parameters Status table to display the context menus shown in Figure 10. Each 
protocol has a unique context menu. The available operations are displayed for the column in 
which you click. This menu provides controls for configuration files, for setting clock rates, 
allowing jumbo frames, logging test activity, removing a Jammer from the Parameters Status table, 
and the appearance of the status table. 

Refer to the following pages for more information about the how to use the context menu choices:

• “Using the Parameters Status Table in Jammer” on page 21 for information about the 
parameter settings you make from these menus. 

• “Running the Test Suite on a Jammer Device” on page 62 for information about running the 
Jammer. 

• “Using the Log Manager in Jammer” on page 50 for choosing log preferences. 

• “Performing Configuration Tasks in Jammer” on page 60 for information about using the 
Load configuration file, Save configuration file, Reset configuration, and Edit configuration 
selections from these menus.
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Figure 10:  Jammer Parameters Status Table Context Menus 
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Changing the SAS/SATA Protocol Setting of a Jammer

The procedure for changing the SAS/SATA protocol setting depend on the blade’s speed.

Changing the Protocol Setting for 3G Blades

To edit the SAS and SATA protocol setting on a 3G blade:

1 Select Edit protocol and speed settings from the Parameters Status context menu.

A dialog is displayed that lets you choose Auto-Negotiate between SAS and SATA (the 
default), SAS only, SATA only (Figure 11).

Figure 11:  SAS/SATA Protocol Setting Dialog for 3G Blades 

2 Click a radio button to choose the protocol.

3 Click OK to close the dialog and apply the settings.

You will receive a warning message. Click OK to apply the setting and reset the link, or click 
Cancel to discard the changes.
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Changing the Protocol Setting for 6G Blades

To edit the SAS and SATA protocol setting on a 6G blade:

1 Select Edit protocol and speed settings from the Parameters Status context menu.

A dialog is displayed that lets you choose Auto-Negotiate between SAS and SATA (the 
default), SAS only, SATA only (Figure 12).

Figure 12:  SAS/SATA Protocol Setting Dialog for 6G Blades 

2 Click a radio button to choose the protocol on the Protocol tab.

3 If you made a change from the previous setting, the option below will appear at the bottom of 
the dialog.

Check this check box if you want the link to reset when the change is applied upon clicking 
OK. Otherwise, clicking OK will apply the change, but the protocol will not change until the 
next time OOB initialization occurs.

4 Click OK to close the dialog and apply the setting.
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Changing the Clock Rate of a Jammer

The procedure for changing the clock rate for a port depend of the blade’s speed and selected 
protocol.

Changing the Fibre Channel Clock Rate for All But 6G Blades

To change the clock rate or speed on all but 6G blades for the Fibre Channel protocol:

1 Right-click anywhere on the specific device column to open the Parameters context menu. 

2 Select Clock rate.

The speed choices are displayed (Figure 13).

Figure 13:  Fibre Channel Clock Rate Menu (except 6G blades) 

3 Click to choose one. 

A bullet is displayed to the left of the currently operating selection. 

4 Click OK to close the dialog. 

You will receive a warning message. Click OK to apply the setting and reset the link, or click 
Cancel to discard the changes.

Changing the Gigabit Ethernet Clock Rate for All But 6G Blades

To change the clock rate or speed on all but 6G blades for the gigabit ethernet protocol:

1 Right-click anywhere on the specific device column to open the Parameters context menu. 

2 Select Clock rate.

The speed choices are displayed (Figure 13).
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3 Click to choose one. 

A bullet is displayed to the left of the currently operating selection. 

4 Click OK to close the dialog. 

You will receive a warning message. Click OK to apply the setting and reset the link, or click 
Cancel to discard the changes.

Changing the SAS/SATA Clock Rate for 3G Blades

To change the clock rate or speed 3G blades for the SAS/SATA protocol:

1 Right-click anywhere on the specific device column to open the Parameters context menu.

2 Select Edit Protocol and speed settings for SAS or SATA Jammer.

The speed choices are displayed (Figure 14).

Figure 14:  SAS/SATA 3Gbps Speed Settings Dialog

3 Click to choose one.

You can also specify one or both protocols. Refer to “Protocol” on page 25.

4 Click to choose one.

5 Click a radio button in the in the Speed section of the Protocol and speed setting dialog.

6 Click OK to close the dialog.

You will receive a warning message. Click OK to apply the setting and reset the link, or click 
Cancel to discard the changes.

Changing the SAS/SATA Clock Rate for 6Gbps Blades

To change the clock rate or speed 6Gbps blades for the SAS/SATA protocol:

1 Select Edit protocol and speed settings from the context menu.

2 The Protocol and speed settings dialog appears. 
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Figure 15:  Speed Settings Menu for SAS and SATA on a 6Gbps blade 

If you made a change from the previous setting, the option below will appear at the bottom of 
the dialog.

3 Check this check box if you want the link to reset when the change is applied upon clicking 
OK. Otherwise, clicking OK will apply the change, but the protocol will not change until the 
next time OOB initialization occurs.

4 Select either the SAS Speed Settings or the SATA Speed Settings tab. See Figure 15.

5 Select the speed setting you want for SAS or SATA. 

6 Click OK to close the dialog and apply the setting.

Note: Both ports of the port pair share one protocol and one clock rate; therefore, two 
adjacent simplex Jammers always have the same protocol and clock rate.
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The 6Gbps blade also has a Without OOB (Advanced) tab at the top of the window see Figure 16. 
This allows you to set the speed the Jammer if no OOB is detected after a broken link. This can be 
useful if, for some reason, you want to attach equipment without going through OOB.

Figure 16:  Without OOB (Advanced) Tab 6G 

Figure 17:  Changing Clock Rate and Protocol/Speed Warning Dialogs 

Changing the SAS Clock Rate for 12G Blades

To change the clock rate or speed 12Gbps blades for the SAS protocol:

1 Select Edit protocol and speed settings from the context menu.

2 The Protocol and speed settings dialog appears. 

Note: For Fibre Channel and SAS/SATA only The clock rate is not saved in the 
configuration file. This allows Jammer scripts to run independently of the clock rate setting 
and avoids breaking the link to which the Jammer is connected.

Caution: Changing the clock rate disrupts the traffic passed through the FC and 3 Gbps SAS/
SATA Jammer. A warning message appears when you change the setting (Figure 17).

Fibre Channel and Gigabit Ethernet SAS and SATA on a 3Gbps Blade
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Figure 18:  Speed Settings Menu for SAS on a 12Gbps blade 

You can either use the Auto-negotiation settings or the advanced SAS speed negotiation 
settings. The options available from the Auto-negotiate to the highest speed drop-down 
menu are:

• 12Gbps, 6Gbps, 3Gbps

• 6Gbps, 3Gbps

• 3Gbps

Important: It is recommended that if you have a 6Gbps device, you select the 6Gbps, 3Gbps 
option, and if you have a 3Gbps device, you select the 3Gbps option.
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3 Set advanced speed negotiation settings.

For Train-SNW 12.0 Gbps Parameters, you can set the Transmitter Mode, which determines 
how the Tx training transmitter state machine behaves. When you select a transmitter mode, 
the mode’s description appears below the drop-down menu. 

You can also set the Programming Coefficients. The coefficient values are initially set to the 
default when you initiate the SAS link reset. The coefficient values will be changed based on 
requests from devices under test and will be within the range of the Min and Max values. For 
example, if the device requests that the Jammer to go to Reference 1, the coefficient values 
will be moved to current Reference 1 values. All coefficient values must be between 0 and 
255. 

Changing the pointer value for each coefficient does not affect the signal. It is only for logical 
testing of devices under test.

If you set the coefficients and do not want to keep the new values, click the Restore all 
parameters to default button.

If you made a change from the previous setting, the option below will appear at the bottom of 
the dialog.

4 Check this check box if you want the link to reset when the change is applied upon clicking 
OK. Otherwise, clicking OK will apply the change, but the protocol will not change until the 
next time OOB initialization occurs..

5 Select the speed setting you want for SAS. 

6 Click OK to close the dialog and apply the setting.

The 12Gbps blade also has a Without OOB (Advanced) tab at the top of the window see Figure 19. 
This allows you to set the speed the Jammer if no OOB is detected after a broken link. This can be 
useful if, for some reason, you want to attach equipment without going through OOB.

Note: Both ports of the port pair share one protocol and one clock rate; therefore, two 
adjacent simplex Jammers always have the same protocol and clock rate.

Note: For Fibre Channel and SAS only The clock rate is not saved in the configuration file. 
This allows Jammer scripts to run independently of the clock rate setting and avoids breaking 
the link to which the Jammer is connected.
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Figure 19:  Without OOB (Advanced) Tab 12G 

16G FC FEC

16G FC blades running at 14.0250 Gbps have a FEC (Forward Error Correction) setting that 
allows you to specify if FEC is enabled on the link. To set, select FEC Mode from the context 
menu. Then, select On, Off, or Auto. Auto is the default. This setting allows Jammer to 
automatically detect if FEC is enabled for a link.

Scrambling

Some blades give the option of enabling Fibre Channel Frame Scrambling, which is part of the 
Fibre Channel Specification for 8.5000 Gbps. You may enable or disable scrambling at any speed. 
Select Scrambling from the Parameters context menu, and then select Enabled or Disabled. A 
check mark appears next to the current selection. When Scrambling is enabled, Fibre Channel 
Frame Scrambling is performed in the Configuration pattern starting after any SOF indicator 
template and continuing until the next word with a K character (usually EOF).

Changing the GigE Jumbo Frames Setting

To change the jumbo frame setting:

1 Open the Parameters context menu (Figure 20). 

2 Select Jumbo frames.

Another menu appears with the two choices. 

3 Click to choose one.

Note: When changing the clock rate from 8.5000 Gbps to any other speed, Scrambling is 
automatically set to Disabled. When changing to 8.5000 Gbps, it is automatically set to 
Enabled. You may then override this setting using the Parameters context menu.
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A bullet is displayed to the left of the currently operating selection.

Figure 20:  GigE Jumbo Frames Menu

Figure 21:  GigE Jumbo Frame Warning 

Replace Received Invalid Data with Idles

This option is for 10GigE only. It allows you to replace invalid data with Idles before it passes 
through the Jammer.

Caution: Changing the supported frame size disrupts the traffic passed through the Jammer. 
A warning message appears when you change the setting (Figure 21).

Note: The frame size (Gigabit Ethernet only) is not saved in the configuration file. This 
allows Jammer scripts to run independently of this setting and not disrupt the link when a new 
configuration is loaded.



Using the Parameters Status Context Menu in Jammer Using the Jammer Tab

Xgig Jammer and Delay Emulator User Guide 39

  

Tuning and Equalization

Tuning and Equalization are procedures to optimize ports on the 6G SAS/SATA 4x/Wide-Port 
Blade for your environment. When you connect the Xgig SAS Analyzer, Jammer, or Generator in 
a new environment (for example, after changing devices or cable length) we recommend that you 
run the Tuning procedure detailed in the Xgig Tuning and Equalization document. Click Tuning 
and Equalization to open the Tuning and Equalization window.

Tuning for 12G SAS

This option is for 12G SAS only. Click Tuning to open the SAS Link Tuning dialog. If two blades 
are being used, you must tune each blade independently by launching the SAS Link Tuning dialog 
twice. 

The new 12G SAS Link Tuning dialog introduces a new concept of port groups. It still focuses on 
the tuning of a single 12G blade, but the ports on the blade are aggregated into port groups. The 
port groups are named "Input #n" or "Output #n", referring to ports on the mini-SAS connectors. 
The dialog shows the port group for the selected configuration and allows you to load a preset 
tuning, auto-select the best preset, or auto-tune.

The top portion of the 12G SAS Link Tuning dialog displays the lane steering diagram for the 
current link configuration. It is the same dialog as visible inside the Discovery dialog's Link 
Configuration, except that the wire colors uniquely identify port groups.

Figure 22:  12G SAS Link Tuning Dialog
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Use the drop-down menu to select a tuning method. You can choose from the following options:

• Auto-select the best preset

• Auto-tune

• Change to [preset name]

Auto-select the best preset 

To automatically select the best preset, select Auto-select the best preset from the Tunings 
drop-down menu. Then, click the Apply Changes button. The software selects the best preset 
from the list of saved presets and applies that tuning preset to the hardware. This selection is based 
on the preset with the lowest bit error rate (BER). When the preset selection is complete, the 
following dialog is displayed showing the selected preset. 

Figure 23:  Auto-Select Complete Dialog 

The Save area is reserved for future use.

Click the Back button to close the dialog and returns to the SAS Link Tuning dialog where the 
name of the preset selected is shown as the current tuning.

Click the Exit button to close the dialog and return to the Jammer tab of the Xgig Maestro 
window. 
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Auto-tune

Auto-tuning in Jammer is supported by the following configurations: 

Before starting the auto-tuning process, try applying the best preset. If you are not sure which one 
is best, perform the Auto-Select the best preset process. This may shorten the time it takes to 
auto-tune. To auto-tune all the ports in the configuration loaded on the hardware for the ports you 
have selected, select Auto-tune from the Tunings drop-down menu. Then, click the Apply 
Changes button to begin the auto-tuning process. Note that when a configuration is selected in the 
Discovery dialog, auto-tuning will tune all the ports in that configuration regardless of whether 
the other ports in the configuration are locked or not.

A dialog appears showing the tuning progress. It includes the duration of the tuning and the bit 
error rate (BER). 

Figure 24:  Auto-tuning In Progress Dialog

The auto-tuning process concludes only when the ports are error free for the longest of a series of 
intervals. This may take six hours or more. You can stop the auto-tuning process at any time and 
keep the best settings found thus far by clicking the Stop, Keep Best button. 
In this case, the dialog shown in Figure 25 appears.

#32 – A-J-A,A #34 – J-A #41 – G-J-A,A
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Figure 25:  Auto-tuning Stopped Dialog 

When the auto-tuning process has completed, the following dialog appears showing the duration 
of the process.

Figure 26:  Auto-tuning Completed
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In the Save area, the group and the name of the tuning is displayed. The group is provided by 
default and is not editable. The default name of the auto-tuning is MyLastTuning. You can change 
the name by typing another name into the text field. When you enter a new name, a Save button is 
displayed. Click the Save button to save the auto-tuning with the new name.

Click the Back button to close the dialog and returns to the SAS Link Tuning dialog. 

Click the Exit button to close the dialog and return to the Jammer tab of the Xgig Maestro 
window. 

Change to [preset name] 

To load a preset on the ports in a configuration, click Change to [preset name] from the Tunings 
drop-down list. Then, click the Apply Changes button. The software applies the tuned settings of 
the preset configuration hardware and returns to the Jammer tab on Xgig Maestro window. 

In addition to the default settings, the tuned settings that you have saved after auto-tuning are also 
available.

The Manage Presets... button opens a dialog allowing you to delete or rename presets.

All the presets are listed in the right column. The left column shows the port groups affected by 
each preset. You cannot rename or delete the factory provided presets, nor any preset currently in 
use.
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Tx Equalization 

Tx Equalization allows you to configure transmitter settings for the Jammer and Generator. Click 
the Tx Equalization button to open the dialog box. For each port, you can specify pre-emphasis 
and output levels. Tx Equalization is an advanced feature. These settings should normally be left at 
their defaults, unless changes are recommended by Viavi “Technical Support”.

Figure 27:  Tx Equalization

The pre-emphasis module in each transmitter boosts high frequencies in the transmit data signal to 
compensate for attenuation in the transmission media. Three pre-emphasis taps are provided: Tap 
0 is the pre-tap, Tap 1 is the first post tap, and Tap 2 is the second post tap.

Tap 0 sets the pre-emphasis on the data bit before each transition. Tap 1 and Tap 2 set the 
pre-emphasis on the transition bit and the following bit, respectively. Tap 0 and Tap 2 also provide 
inversion, which is set by using a negative value for the tap setting.

Allowable ranges are -15 to 15 for Tap 0 and Tap 2 and 0 to 31 for Tap 1.

The output level sets the transmitter amplitude. The allowable range is 0 to 7, which corresponds 
to an amplitude range of approximately 200 – 1200mV.

Note that these settings are applied on internal signal paths in the hardware, and the full effect will 
not normally be seen at the cable outputs.
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Using the Ports Manager in Jammer

The Ports manager displays details about the ports you have locked. It shows the protocol, chassis 
name (with chassis number, slot number, and port numbers), and other port specific information. 
You can sort the rows from first to last or last to first by clicking the column heading. For more 
information about Xgig slot positions and numbering, refer to the Xgig Family Hardware Guide 
included with the product CD.

Figure 28:  Jammer Ports Manager

The following icons are displayed on the menu bar:

Note: If you are disconnected due to a network problem, you can reconnect to the ports by 
using the Port Selection and Domain Setup window.

Select All Ports
Selects all ports in the Ports Manager.

Unselect All Ports
Unselect all ports in the Ports Manager.

Load Configuration to Selected Ports
Load the selected configuration file to all selected ports in the Ports Manager.

Start Selected Ports
Start BERT operation on the selected ports in the Ports Manager.

Stop Selected Ports
Stop BERT operation on the selected ports in the Ports Manager.

Show Properties of Selected Ports
Display the Port Properties dialog box, with information on the selected function, 
protocol, and clock rate (speed). It also shows the chassis name, IP address, slot and 
port(s).

Disconnect Selected Ports
Disconnect the selected ports in the Ports Manager.

Disconnect All Ports
Disconnect all ports in the Ports Manager.
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Actions Button

The Actions button contains menus for Multiple speed Change and Toggle Display. See 
Figure 29.

Figure 29:  Actions Button Options

Multiple Speed Change

This option allows you to change the speed of multiple Jammer ports simultaneously. If you have 
the All Devices tab selected, the menu will display BERT, Jammer, and Generator. For Jammer, 
you can choose to change the speed of 6.0 Gbps and 3.0 Gbps blades.

Select the ports you want to change the speed for, holding the Ctrl key down to select multiple 
ports, then click the speed you want to change to, and click OK to apply the change.

Figure 30:  Multiple Speed Change Menu

For Jammer Fibre channel

Select the ports you want to change the speed for, then click the speed you want to change to, and 
click OK to apply the change.

For Jammer SAS/SATA 3.0 Gbps

1 Select the ports you want to change the speed for.

2 Select the protocol you want, Auto-negotiate, SAS only, or SATA only. 

3 Select the speed you want to change to.

4 Check the Reset link after and changes are applied check box if you want the link to reset 
when the change is applied upon clicking OK. Otherwise, clicking OK will apply the change, 
but the protocol will not change until the next time OOB initialization occurs.

For Jammer SAS/SATA 6.0 Gbps

1 Select the protocol you want, Auto-negotiate, SAS only, or SATA only.

2 Select either the SAS Speed Settings or the SATA Speed Settings tab.

If you made a change from the previous setting, a check box will appear at the bottom of the dialog 
highlighted in yellow with a message that reads, Reset link after and changes are applied to 
above settings.
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3 Check the Reset link after and changes are applied check box if you want the link to reset 
when the change is applied upon clicking OK. Otherwise, clicking OK will apply the change, 
but the protocol will not change until the next time OOB initialization occurs.

4 Select the speed settings you want for SAS or SATA. 

5 Click OK to close the dialog and apply the setting.

The 6Gbps blade also has a Without OOB (Advanced) tab at the top of the window see. This 
allows you to set the speed the Jammer if no OOB is detected after a broken link. This can be 
useful if, for some reason, you want to attach equipment without going through OOB.

Toggle Display

This option toggles between a horizontal and vertical view of the ports.

Ports Manager Columns

The Ports Manager includes the following columns:

Operation

Operation is a button you press to display the Operation bar for the device you are using. Refer to 
“Running the Test Suite on a Jammer Device” on page 62 for additional information.

Status

Information in this column displays the state of the device under test.

Domain of Port A and Domain of Port B 

Each of these fields indicates to which domain the respective port belongs. In a simplex Jammer, 
only port A is relevant. In a duplex Jammer, the lower port number is always port A. You set up 
domains in the Port Selection and Domain Setup window. Refer to the Xgig Maestro Introduction 
Guide for more information.

Output Voltages

The Output Voltage settings are for the SAS and SATA protocols and display each port number 
and the corresponding output voltage setting. 

Click on the Output Voltages field in the Port Manager to open the dialog box. This allows you to 
select the amplitude control for the output voltage buffers. There are two output voltage settings, 
High and Low.

Note: For Fibre Channel and SAS/SATA only The clock rate is not saved in the 
configuration file. This allows Jammer scripts to run independently of the clock rate setting 
and avoids breaking the link to which the Jammer is connected.



Using the Jammer Tab Using the Ports Manager in Jammer

48 Xgig Jammer and Delay Emulator User Guide

  

Figure 31:  Output Signal Voltage Dialog 

High: The default setting is High. If the output voltage for a port is set to high, then the Output 
Voltages field in the Port Manager reads “Norm” . 

The High setting, is useful for driving extended length cables. This setting also provides a 
pre-emphasis circuit that boosts higher frequency signals to compensate for signal amplitude loss 
that affects the data eye in long trace length runs.

Low: If the output voltage for a port is set to Low, then the Output Voltages field in the Port 
Manager reads “Low” . You can set the signal to Low when you are using short 
cables with SATA devices.

Caution: For ports on 6G blades using a SATA cable connected to a SATA device, it is 
possible for the SATA receiver voltage to exceed the maximum specifications. To keep the 
SATA receiver voltage within the specifications, it is advisable that you set the output voltage 
for these ports to “Low”.
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Using the Ports Manager Context Menu

You can right-click in the Ports Manager to open the context menu (Figure 32).

Figure 32:  Ports Manager Context Menu 

The menu contains the following choices:

Text Size

Refer to “Changing Text Size” on page 58 for information.

Columns

This choice opens a Customize table dialog (Figure 33) where you can choose to display Domain 
of Port A. 

Click the check box next to this item to display this item in the Ports Manager.

The grayed out items are defaults; you cannot clear these items.

Figure 33:  Jammer Ports Manager Context Menu Parameters Selection 
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Using the Log Manager in Jammer

To access the Log Manager, click the Log tab at the bottom of the Jammer main window.

The purpose of logging is to automatically create a log that reports which Jam tests have occurred 
and which ones might have reached the timeout limit while not finding a trigger to Jam. You can 
view a log with any text editor.

The Filter icons next to the Type and Address column labels allow you to choose how you want 
to display device types, by protocol or All, and device addresses, by single address or All devices.

If the All Devices tab at the top of the Xgig Maestro main window is selected, then the Log 
Source menu shows all log sources as active by default. You can choose 
to disable BERT logging, Jammer logging, Generator logging, Target Emulator logging, or all four 
by clicking the Log Sources menu and un-checking the selections. If the BERT-Bit error rate 
testing, Jammer, or Generator tabs in the main window are selected, then the Log Manager 
displays only the log entries for that tab, respectively.

The following icons are displayed on the Log Manager menu bar:

Display Entry Contents
Lets you save the selected log to a file in the device Logs folder (for example: 
C:\Program Files\Viavi\Xgig Maestro\Jammer\Logs) or anywhere you 
want to save it on the network. Refer to the note on page 54 for information about 
installation on 64-bit operating systems.

Save All Entries As
Lets you save all the logs in the Log Manager to a file.

Save selected entries as
Lets you save the selected logs to a file.

Select All
Selects all the logs in the Log Manager.

Options
Opens the Log Manager Options dialog where you can enter your preferences for the 
information you want displayed in the Log Manager (Figure 34).

Clear Filtering
Removes filtering by Type and Address and displays all the devices you have locked.

Clear Selected Entries
Deletes the log entry you have highlighted.

Clear All Entries
Deletes all the log entries in the Log Manager.
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Setting Log Options

To have log files automatically named and saved to a specific location:

1 Click the Log Manager Options icon to open the drop-down menu (Figure 34), and select 
Jammer logging options. 

Figure 34:  Log Manager Options Menu 

Or: 

Open the Parameters context menu and select Options.

Either of these commands opens the Jammer Log Options dialog (Figure 35). This dialog 
allows you to set up how you want the log files to be automatically named and the default 
location where you want them saved. You can also change the filename and folder when you 
save the log.

Figure 35:  Log Options Dialog 

2 Select a log filename template from the following choices:

• JammerLog_[port]

• JammerLog_[port]_[date]_[time]

• JammerLog_[date]_[time]

• JammerLog_[date]_[time]_[port]

Or, you can type in your own template. Any [port], [date], and [time] in the template is 
replaced by the corresponding value. Port is displayed as:

protocol (FC, GE, or SAS), chassis name (chassis number in the 
cascade, blade number in the chassis, port number on the blade)

3 Enter the path to the folder where you want to save the log file.

You can browse to where you want to save the log file by clicking .

4 Click OK.

You have set up the log filename template and default folder to save the log.

Note: These settings apply to all Jammer logs. Log options are the same for all Jammer ports.



Using the Jammer Tab Using the Log Manager in Jammer

52 Xgig Jammer and Delay Emulator User Guide

  

Viewing a Log

The Jammer log shows the status of each Test Case during the entire length of the test run 

To display a log:

>> Click the Log Manager tab at the bottom of the Xgig Maestro main window to view the log in 
a tabulated format (Figure 36).

Or:

>> Double-click on the log you want to view in the Log Manager to display the Log Entry 
Display (Figure 37).

Or:

>> Click the Log button on the Operation bar (with the appropriate Jammer device selected in the 
Parameters Status table; a green check mark indicates the device is selected).

Or you can:

>> Open the Parameters context menu and select Log > View.

These two latter commands open a window that allows you to quickly view the Xgig Jammer log. 
(Figure 38). In the case of these two methods, each time you run a Jammer, a new Jammer log is 
created for the device, and the previous log is discarded. Click Print at the bottom of the Jammer 
log to print a hard copy of the log. 

On the other hand, the Log Manager continues to list the logs and display them depending on the 
Log Manager options you have selected. See “Setting Log Options” on page 51.

You can save a log to a .txt file or an HTML file. Refer to “Saving a Log” on page 54.

Figure 36:  Log Manager
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Figure 37:  Viewing a Log in the Log Entry Display

Figure 38:  Example of a Jammer Log Display 



Using the Jammer Tab Using the Log Manager in Jammer

54 Xgig Jammer and Delay Emulator User Guide

  

Saving a Log

You can save a log from the Log Manager tab or the Parameters context menu.

To save a log from the Log Manager tab as an HTML file or text file:

1 Highlight the log you want to save.

2 Click the Save Selected Entries As... button.

The Save Log Manager Contents As window is displayed that lets you name and save the log 
as an HTML file to the Saved Logs folder or to a location you prefer.

Or:

>> Double-click on the log you want to save to display it in the Log Entry Display window 
(Figure 37), then click Save As...

The Save As window is displayed that lets you name and save the log to the Logs folder as a 
.txt file, or to a location you prefer.

To save a log to a .txt file using the Parameters context menu:

>> Open the Parameters context menu (Figure 39) and select Log > Save As.

This command opens a File dialog where you can save the log with a file name you assign to 
it. The default location is C:\Program Files\Viavi\Xgig Maestro\Jammer\Logs.  

Figure 39:  Log Menu

Note: This software application can be loaded on 32-bit or 64-bit Windows operating 
systems. The path used above is for a 32-bit operating system. 
If you are using a 64-bit operating system, the path would be: 
C:\Program Files(x86)\Viavi\Xgig Maestro\Jammer\Logs
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Customizing the Appearance of the Maestro/Jammer Main Window

You can move and rearrange the individual device tabs on your monitor screen as you prefer. You 
can also select the information you want to display in the Parameters Status table. In addition, you 
can select the size of displayed text.

Using the Window Menu

The Window menu allows you to arrange the window display:

Layout

Layout offers choices for rearranging the Maestro device tab windows. The Ports manager and 
Log Manager windows are not affected by this menu selection.

Internal Tabs

Allows you to restore the Maestro main window to its default format.

Internal MDI

Internal multiple document interface (MDI) lets you isolate each device tab as a separate window 
that you can activate by clicking anywhere on the window.

Show Hidden Windows

Restores any windows you have closed while using the Internal Tabs or Internal MDI display 
arrangement.

Arrange Icons

Arranges the icons for minimized windows at the bottom of the screen. If an open document 
window is at the bottom of the screen, some or all of the icons will be underneath this document 
window and will not be visible.

Cascade

Arranges all open windows in a cascade style from the top, left corner of the window.

1 All Devices

Brings the All Devices tab to the front as the active window. This window displays ports from all 
active devices (BERT, Jammer, Generator, and Target Emulator).

2 BERT - Bit error rate testing

Brings the BERT device tab to the front as the active window

3 BERT - Latency measurement

Brings the BERT Latency measurement device tab to the front as the active window
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4 Jammer

Brings the Jammer device tab to the front as the active window 

5 Generator

Brings the Generator device tab to the front as the active window

6 Target Emulator

Brings the Target Emulator device tab to the front as the active window

Tile Horizontally

After selecting Layout > Internal MDI, this command opens and aligns the BERT, BERT Latency 
measurement, Jammer, Generator, and Target Emulator device windows horizontally one over the 
other.

Tile Vertically 

After selecting Layout > Internal MDI, this command opens and aligns the BERT, BERT Latency 
measurement, Jammer, and Generator, and Target Emulator device windows vertically one next to 
the other. You can view the individual device windows by dragging the sides out to resize them.

Minimize All Windows

After selecting Layout > Internal MDI, this command minimizes all the open windows. You can 
restore each window, individually, by using the standard window controls on the header or select 
Internal Tabs to restore the Maestro main window to its default format.
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Customizing the Parameters Status table in Jammer

You can change the appearance of the Parameters Status table by:

• Removing columns

• Resizing columns

• Changing the text size

• Displaying and hiding status table parameters

Removing columns

If you have a number of devices locked, you can remove a column that you do not need to view 
without unlocking the port or affecting the operation. 

To remove a column:

1 Right-click on the specific column you want and open the Parameters context menu. 

2 Select Do not show Jammer (Figure 40).

Or:

In the Ports Manager, clear the Show check box next to the device you want to remove.

The column is removed, but the device is still locked (“in use”) and displayed in the Ports 
Manager. 

Figure 40:  Removing a Device Column 

To replace the device column on the Parameters Status table:

>> Click the Show check box for the device in the Ports Manager. 
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Resizing columns

You can resize any of the columns by placing the mouse at the right edge at the top of a column, 
next to the chassis name. A resizing cursor appears. Hold down the mouse button, and drag the 
mouse to resize the column.

Changing Text Size

You can choose the text size you want the Parameters Status table or the Ports Manager to display.

To change text size:

1 Open the context menu by clicking the right mouse button while the cursor is on the 
Parameters Status table or the Ports Manager.

2 Select Text size (Figure 41).

You have five choices from which to select.

Smallest is the default size.

3 Select the text size you want.

A bullet is displayed next to the current selection.

Figure 41:  Text Size Menu

Note: You cannot change the text size in the Log Manager.

Context menu over device parameters 
status tableContext menu over Ports manager
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Displaying and Hiding Parameters in Jammer

You can hide specific parameters on the Parameters Status table to simplify the status tables and 
show only the information in which you are interested.

To display or hide parameters on the Parameters Status table:

1 Click the Parameters tab at the top of the Configuration manager pane to switch to the 
Parameters manager (Figure 42).

You can expand the categories by clicking the plus signs on the left.

The default displays most of the parameters.

Figure 42:  Jammer Parameters Manager

2 Click check box to set or clear the check mark next to the parameters. 

Checked parameters are displayed.
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Performing Configuration Tasks in Jammer

This section describes how to handle configuration files from the Jammer main window.

Loading Jammer Configuration Files

You can load a configuration file on a Jammer using one of the following methods:

From the Configuration Manger:

>> Drag the configuration file from the list in the Configuration Manager onto the Parameters 
Status table (column for the device) and release the mouse button. 

You can drag configuration files from anywhere, including the list of configuration files in the 
Configuration Manager on the Xgig Maestro window, the system desktop, or Windows 
Explorer.

From the Parameters Context Menu 

1 Right-click on the device column to open the Parameters context menu and select Load 
configuration file. 

An Open File dialog is displayed. 

2 Navigate to the Jammer .tsk file that you want to use and click Open.

The file is loaded and its name and parameters are displayed in the device column of the 
Parameters Status table.

From the Ports Manager:

1 Check the Select check box(es) in the Ports Manager for the port(s) you want to use.

2 Click the configuration file you want to load from the Configuration Manager.

3 Click the Load Configuration to Selected Ports button . This button is located in the 
Ports Manager and in the Configuration Manager. Both have the same function.

You can use the above methods to navigate to a mapped folder and load a configuration file.

Saving a Jammer Configuration File

To save a Jammer configuration file you created or edited:

1 Right-click on the device column in the Parameters Status table to open the Parameters context 
menu, and select Save configuration file.

A Windows Save dialog is displayed.

2 Navigate to where you want to save the configuration file and assign a name to it.

Xgig Jammer configuration files are saved with a .tsk extension.

Resetting a Jammer Configuration

To clear the configuration from a device:
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1 Right-click on the device column in the Parameters Status table to open the Parameters context 
menu, and select Reset configuration.

A warning dialog may be displayed asking you to confirm the configuration reset.

Figure 43:  Reset Configuration Warning Dialog

2 Click Yes to clear the configuration from the device.

Editing a Jammer Configuration

To create a configuration file for a device, you can start from a blank default configuration or edit 
the configuration after you have loaded a configuration file to the device. 

You can open the Configuration window using one of the following methods: 

1 Right-click on the device column in the Parameters Status table to open the Parameters context 
menu. 

2 Select Edit configuration.

Or:

>> Click the Configuration button on the Parameters Status table

This opens the Configuration window for the device that is currently selected. Refer to or 
“Using the Jammer Configuration Window” on page 116 for more information.
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Running the Test Suite on a Jammer Device

After you have configured a Jammer device, you can start the operation. Three methods are 
available:

>> Click the Start button on the Parameters Status table.

Figure 44:  Parameters Status table Start Button

Or you can:

>> Right-click on the device column to open the Parameters context menu where the Start, 
Pause, Skip, and Stop commands are available. 

Or:

1 On the Ports manager, select the device.

2 Click the Start button .

Or:

1 On the Ports manager, in the Operation column, click the Operation button for the device.

The Operation dialog is displayed (Figure 45, Figure 46, and Figure 47).

2 Click Start.

Figure 45:  Jammer Tab Operation Bar for Fibre Channel and Gigabit Ethernet
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Figure 46:  Jammer Operation Dialog for SAS and SATA

Figure 47:  Jammer Operation Dialog for 16G FC

Clicking any of the Operation buttons (including Config) takes effect on the Jammer device that is 
currently selected in the Parameters Status table.

Start runs the Test Suite from the beginning if you click it while the Jammer is stopped. The Start 
button label becomes a Stop label while the Test Suite is running.

Pause causes the Jammer to pause and not run the next Test Case in the Test Suite when the 
current Test Case is completed. When you click Pause, the State of the Jammer is “Pausing” while 
the current Test Case is still running. When the current Test Case completes (or is skipped), the 
Jammer is in the “Paused” state waiting for user intervention.
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Skip Current causes the Jammer to abort the current Test Case and move on to the next test in the 
test case. If the Jammer is “Paused,” you can click Skip to jump through your Test Suite without 
running any Test Cases until you get to the Test Case you want to run and resume testing. If you 
skip past the last Test Case in the Test Suite and the Test Suite is not set to loop forever, then the 
Jammer goes to the Stopped state as if the Test Suite completed.

To let a test run to the end and then skip to another test:

1 Click Pause. 

Wait for the current test to finish.

2 Click Skip To to step through the tests. 

3 Observe the progress field on the Parameters Status table to track tests in the queue.

4 Click Start.

Skip To allows you to skip to a specific test in the test case. 

To skip to a specific test:

1 Select a test number from the drop-down menu next to the Skip To button. 

2 Click Skip To to skip to the selected test. 

Stop causes the Jammer to abort running the entire Test Suite and go to the Stopped state.

Reset Link (SAS and SATA only) causes the Jammer, at any time, to reset the link and enter OOB 
initialization. This does not affect any of the other buttons nor does it change the running state of 
the Jammer.

Figure 48:  Reset Warning

Log indicates a log is available for viewing. Click Log to view the latest test log.

Instant FEC Jam for 16G FC

When you open the Operation window for 16G FC, the window contains options to perform an 
instant FEC Jam on port A or port B. See Figure 47. You can select to invert a number (1-16) 
consecutive bits or use a bit mask to define which bits to invert at the beginning of the FEC block. 
Note that you cannot perform an instant FEC Jam when you are running a test suite.

Note: Resetting the link disrupts the traffic passed through the Jammer. A warning message 
appears when you choose this action (Figure 48).
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Chapter 3
Creating Jammer Test Configurations for 
Fibre Channel

In this chapter:

• Defining Your Own Test Configurations

• Using the Jammer Configuration Window

• Configuring Arm and Trigger Conditions

• Configuring the Jam Definition
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Defining Your Own Test Configurations

Xgig Jammer lets you define your own test configurations and save them with or without hardware 
available.

You can create a configuration from scratch, or you can open and edit an existing configuration. 
Also, you can edit a configuration in edit only mode, which is independent of any hardware, or 
you can edit a configuration that is currently loaded to a Jammer device.

To edit a configuration in edit only mode:

>> Double-click on a configuration file in the Configuration manager. 

Or:

>> Right-click on the configuration in the Configuration manager and choose Edit Jammer 
Configuration from the context menu.

The edit only mode Jammer Configuration window opens (Figure 49).

This window allows you to set up your own Test Cases, name them, organize them, and save 
them to files so that you can use them again.

Figure 49:  Edit Only Jammer Configuration Window
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To start a configuration from scratch in edit only mode:

>> Select New Jammer Configuration from the Configuration manager context menu or the File 
menu (Figure 50) on the Xgig Maestro menu bar.

Figure 50:  Maestro File Menu

Or:

>> Click the New Configuration icon at the top of the Configuration manager.

Or:

>> Right-click the configuration in the Configuration manager and choose New Fibre Channel 
Jammer Configuration from the context menu.

To save your configuration in edit only mode:

>> Click Save at the bottom of the Jammer Configuration window or open the File menu at the 
top of the Jammer Configuration window and select Save Configuration As... or Save 
Configuration.

Any changes you make have no effect on actual Jammer devices you control.

To edit a configuration that is loaded to a Jammer port:

>> Click Configuration... in the device column.

Or:

>> Right-click in the Parameters Status table in the device column to open the context menu and 
select Edit configuration.

Or: 

>> Click Operation in the device column to open the Operation dialog, then click Config.

The Xgig Jammer Configuration window in hardware edit mode is displayed (Figure 51). This 
window allows you to set up your own Test Cases, name them, and save them to a file so that 
you can use them again.

Click Apply or OK and Jammer accepts the changes. They are immediately reflected in the 
Parameters Status table and affect the Jammer device the next time you run it.

To save your configuration edits:

>> Open the File menu at the top of the Jammer Configuration window and select 
Save Configuration As... or Save Configuration.
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Or:

>> Right-click in the Parameters Status table in the device column to open the context menu and 
select Save configuration file ...

Figure 51:  Xgig Jammer Configuration Window

Using the Jammer Configuration Window

The Jammer Configuration window title bar indicates how many ports it is configuring, the 
protocol, and the configuration file name, if any. If you are using hardware edit mode, the chassis 
name, chassis number, slot number, and port number are also listed. The elements of the Jammer 
Configuration window are described in the following sections.

Using the Jammer Test Suite Tools

The Test Suite lists the series of Xgig Jammer tests in the order in which you want them to 
execute. The suite includes one or more tests. The highlighted test appears as the Current Jammer 
Test on the upper right side of the window. Each test in the suite executes in sequence with a test 
reset time of approximately 130 (200 max) milliseconds. 
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Repeat Test Suite

If you select Repeat Test Suite , the Jammer tests continuously run from the top 
of the Test Suite to the bottom and then loop back to the top until you click Stop on the Xgig 
Jammer Tab in Xgig Maestro.

Creating a Test Suite

When you create a Test Suite you use the edit buttons at the top of the Test Suite window.

The edit button definitions for the Jammer Test Suite are:

To duplicate a test at another point in the Test Suite:

1 Highlight the test you want to duplicate.

2 Click Copy.

3 Highlight the test in the suite that is just after the point where you want the duplicate test 
inserted.

4 Click Paste.

The duplicate test is inserted.

Refer to “Configuring Arm and Trigger Conditions” on page 73 and “Configuring the Jam 
Definition” on page 77 for information about configuring each test.

Using the Context Menu

The same operations (Cut, Copy, Paste, etc.) can be performed with the options available in the 
Context menu. In addition, the direction of an individual test can be reversed by selecting the 
‘Reverse Current’ option. To reverse the direction of all tests, select the ‘Reverse All’ option.

Using the Configuration File Menu

The File menu is the only menu on the menu bar (Figure 52). 

Cut Removes the highlighted test and holds its contents in the memory 
buffer.

Copy Copies the highlighted test to the memory buffer.

Paste Inserts the current memory buffer contents before the currently 
highlighted test.

Add Adds a new blank test to the bottom of the suite.

Insert Inserts a new blank test above the currently highlighted test.

Delete Removes the highlighted test from the suite. If only one test is present, 
then the contents of this test are cleared.
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Figure 52:  Configuration File Menu

The choices are:

The recently used FC Jammer configuration files appear in the file menu and are loaded when 
selected.

Using the Current Jammer Test Window

The graphics in this section of the window represent the hardware configuration for the selected 
test in the Jammer Test Suite.

Mode

Use Mode drop-down (Figure 53) near the top of the window to display a list of the possible 
configuration choices. In a duplex Jammer all path A and path B options are available. In a 
simplex Jammer, only path A is available. If you are editing a configuration without any 
associated Jammer ports, both paths are available.

The input to path A (on top) is always port A and the input to path B (on the bottom) is always port 
B. The external trigger input and output that are available on path A always are linked to the 
domain shown on the Xgig Maestro window as “Domain of port A.” The trigger input and output 
on the bottom on path B are in the “Domain of port B.” 

Open Configuration Open a selected configuration file.

Import to Selected Test Import a Test Case from a .tst file ot an entire test suite, .tsk file, to the 
currently highlighted position.

Export Selected Test Export and save the currently highlighted test to a .tst file.

Save Configuration Save the entire Test Suite to the .tsk file you currently have loaded.

Save Configuration As Save the entire Test Suite to a .tsk file with a name you assign to it.

Close Close the Jammer Configuration Window.

Note: The .tst files are only for storing individual Test Cases and swapping them between 
configuration files. You cannot load .tst files directly into a Jammer device on the Xgig 
Maestro window.
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Figure 53:  Mode Drop-down Menu

The functions represented by the graphic are:

Reverse

You can reverse the direction of the jam by selecting the Reverse button .

Arm

Use the Arm condition  to define the frame or Ordered Set to find prior to the frame or 
Ordered Set to be modified. You can also use an external trigger input to the Jammer.

Trigger

The Trigger event  is the frame or Ordered Set to be modified. The Trigger event can be 
in the next word after the Arm event.

Jam

The Jam definition  contains modifications to be made to the Trigger event. It is the 
same type (frame or Ordered Set) as the Trigger event.

Rollback

The Rollback option  parameter defines the time or word count parameter between the 
Arm and Trigger events. If the Trigger does not follow the Arm event in the allotted time or word 
count, the Xgig Jammer begins looking for the Arm event again. Click Rollback to display the 
dialog box shown in Figure 54. 

Note: If you use an external trigger input to define the Arm condition, then you cannot select 
the external trigger output for that path in that Test Case, and vice versa. For information 
regarding using the external trigger input and output during a Test Case, refer to “Using 
Domains and External Triggering” on page 291.” However, you can use an external trigger in 
on port A with an external trigger out on port B, and vice versa.

Note: This value is saved in terms of words, not time, so keep this in mind if you save a Test 
Case using a device running at 2.125 Gbps and later open the configuration on a Jammer 
running at 1.0625 Gbps.
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Figure 54:  Rollback Condition Dialog

Timeout

This  option defines the period of time to wait for a specified test to complete before 
aborting and proceeding to the next test in the suite. 

To set the timeout:

1 Click Timeout to display the dialog box in Figure 55. 

2 Enter the hours, minutes, and seconds you want to wait.

Use the check box to enable or disable this feature. 

Figure 55:  Timeout Dialog

3 Click OK.

Repeat

Click this option to repeat the Arm > Trigger > Jam sequence once, n times, or forever 
(Figure 56).

Figure 56:  Test Case Repeat Settings
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Pause

Click Pause to open the dialog shown in Figure 57. The Pause setting allows you to insert a pause 
before the beginning of a test case. 

Figure 57:  Pause Test Dialog

Trigger From Domain A (or B)

Click this option to arm when the domain associated with the port is triggered.

Trigger Domain A (or B) upon Jam

Click this option to trigger a domain whenever the Trigger condition is met.

Configuring Arm and Trigger Conditions

Arm and Trigger conditions recognize specific Ordered Sets or frames, depending on the protocol. 

In Fibre Channel, you can specify any standard Ordered Set, or a user-defined Ordered Set (K28.5 
followed by three data bytes). You can also use a frame as a condition, by specifying the SOF, the 
6 word header, and up to the first 25 payload words.

You can save an arm or trigger condition as a .jmt file by clicking the Save button in the Arm or 
Trigger window. You can load a .jmt file by clicking the Load button in the Arm or Trigger 
window.

Depending on the Mode you select, the appropriate graphic diagram shows the Trigger and 
optional Arm conditions, along with the Jam event. If the Mode you select does not include an 
Arm condition, the Arm button remains disabled. 

To set Arm and Trigger conditions: 

1 For the Arm and/or Trigger, open the Type drop-down on the Current Jammer Test window 
and select Frame or Ordered Set.

2 Click on the Arm or Trigger button in the Xgig Jammer Configuration window. 

The window for the condition is displayed (Figure 58). If you are in hardware edit mode, the 
protocol, chassis name, chassis number, slot number, and port numbers are displayed in the 
title bar.

3 Set the values as required to specify a unique Arm and Trigger sequence for the specific test.

The following sections describe the available values.
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Figure 58:  Fibre Channel Arm and Trigger Windows for Frames

Setting Frame Conditions

You can specify frame conditions in two ways. One way is to load a template from the Template 
Library tree, and the other way is to manually specify bits in the frame.

To use a template:

1 Select a template from the Template Library tree on the left.

2 Click the double right arrow button to set the Trigger Condition. 

The condition is indicated on the right side of the window.

To manually specify a frame: 

>> Type hexadecimal values directly into the center column of the window.

An X represents a nibble that can be any value (a “don’t care”). 

To set individual bits in any field, double-click on the hex entry to open the Binary Editor 
(Figure 59). In the hex view, partially defined hex characters appear as question marks: 
X001=?
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Figure 59:  Binary Editor Dialog

Another way to manually edit the frame condition is to make selections from the tree view in 
the right window pane.

Saving a Frame Condition

If you create a frame condition that you want to save and make easily available for future use, you 
can save it into the “User Library” folder in the Template Library tree. To do this:

>> Highlight the folder and click the double left arrow button.

When you check the “Use inverse of condition specified (i.e. NOT)” option, it means that the first 
frame encountered that does not match what you have specified creates a “condition met” event.

For each frame condition, you can specify an optional name at the top of the window. This name is 
also shown on the Jammer Configuration window under the Type selection, and on the main Xgig 
Maestro window.

Setting Ordered Set Conditions

To set an Ordered Set condition, choose a value from the drop-down list. All legal Fibre Channel 
Ordered Sets are available as well as a User Defined selection at the bottom of the drop-down list 
as shown in Figure 60.

To edit the user-defined value:

>> Type a hex value into the byte field, or double-click on a byte field to open the Binary Editor. 

As in frame conditions, an X indicates “don’t care” and a ? indicates a partially specified hex 
character. You can also check the “Use inverse of condition specified (i.e. NOT)” option; this 
means the first word encountered that does not match what you have specified creates a 
“condition met” event.
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Figure 60:  Fibre Channel Arm and Trigger Windows-Ordered Sets

To edit the values: 

>> Enter a hex value, or double-click the byte field to open the Binary Editor. 

As in frame conditions, an X indicates “don’t care” and a ? indicates a partially specified hex 
character. 

As with frame conditions, you can specify an optional name at the top of the window. This name is 
also shown in the Jammer Configuration window under the Type selection and on the main Xgig 
Maestro window.
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Configuring the Jam Definition

The Jam Definition window defines how to modify the event specified on the Trigger Condition 
window.

The Jam is always the same type (frame or Ordered Set) as the Trigger.

For any Jam Definition, you can specify an optional name at the top of the window. This name is 
also displayed on the Jammer Configuration window under the Type selection and on the main 
Xgig Maestro window.

You can save a Jam definition as a .jmj file by clicking the Save button in the Jam window. You 
can load a .jmj file by clicking the Load button in the Jam window.

Jamming an Ordered Set

If the Trigger Event is an Ordered Set, click the Jam button on the Xgig Jammer Configuration 
window, to open the Ordered Set Jam Definition window (Figure 61).

The Ordered Set Jam Definition window allows you to modify any Ordered Set by replacing it 
with a different Ordered Set, or by replacing it with a code violation. The code violation is a 
predefined 10-bit value that replaces the last 10 bits of the target Ordered Set in its 40-bit form. 
The control to edit the Ordered Set is similar to that in the Trigger Condition window.

Figure 61:  Fibre Channel Ordered Set Jam Definition Window

For example, assume that the Trigger Event was a CLS, the Jam was set to replace it with an Idle 
and the repeat count was set to forever. This replaces every CLS in the link traffic with an Idle 
until you click Stop or the specified timeout occurs. Note that the number that you specify in the 
Repeat setting is the number of repetitions that occur including the first Jam. In addition, 
remember that if an Arm condition is specified, each repeat Jam requires the Arm and Trigger 
condition be met each time.
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Jamming a Frame

To define a Jam for a frame:

1 On the Configuration window, select one of the following from the Type drop-down menu for 
Jam:

— Replace Frame with Modified Frame

— Replace Frame with Truncated Frame

— Replace Frame with Idles

— Replace Frame with ARB(ff)

2 Click the Jam button to open the Frame Jam Definition Window.

Jam Behavior

This controls the number of user-defined header/payload Jams performed relative to the target 
trigger frame. The Jam Behavior section is present on all tabs of the Frame Jam Definition 
window.

Figure 62:  Jam Behavior Selection

• Jam until end of trigger frame

Jams defined in the Header and Payload tabs are performed until the end of the target trigger 
frame (or until an abnormal termination of the frame). All Jams defined that would take place 
on the original CRC or later are ignored. However, if the frame that is triggered on has more 
words than the Jams you specify, the remaining words are passed through. This is the standard 
way to Jam a frame, and is the way the GTX Jammer always Jams frames.

• Execute full Jam pattern

All Header and Payload Jams take place, even if they overwrite beyond the end of the target 
trigger frame. Use the control at the top of the Payload tab to define how many payload Jams 
should take place. 

The last defined Jam is the last Payload Jam, unless there are no payload Jams defined then the 
sixth Header word is the last defined Jam. In any case, when you select this option, the options 
for modifying the CRC and EOF on the SOF/CRC/EOF tab are unavailable. 

If the target trigger frame is longer than the number of Jams defined, then the portion of the 
target trigger frame that extends after the last defined Jam is overwritten with Idles. If the 
target trigger frame is shorter, then the Jammer switches back to pass-through immediately 
after the last defined Jam.

Note: Be careful when using this option because you may overwrite a portion of important 
traffic (a frame or Flow Control Ordered Sets).
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Replace Frame with Modified Frame

Each tab contains options relevant to different frame modifications.

Using the Global Tab

Use this tab (Figure 63) to define Jam parameters that apply globally to the frame.

Figure 63:  Fibre Channel Global Tab 

Global Replace Jam Option

Use the Global Replace Jam Option to set specific bits in a word to 1 or 0 while passing through 
the remaining bits. You can apply this change globally to any word in the frame. Define one 
Global Replace Jam word for each Test Case.

To edit these bits: 

>> Enter hex values, or double-click on a byte field to open the Binary Editor. 

Any bits left as Xs are passed through.
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Global Bit Errors

The Jammer software can introduce bit errors repeatedly in sequential or random fashion to 
predefined fields. These bit errors are introduced to the 32-bit form of the target words (not the 
40-bit form) so code violations are not created. The Global Bit Errors control allows you four 
options.

• Select one bit for all fields and randomly. This causes the Jammer to inject a single bit error 
in the group of all fields selected in the header or payload for a single Test Case. If the Jammer 
Test Suite is set to loop, then single bit errors are randomly injected into these fields, with one 
bit for each cycle of the Test Suite.

• Select one bit for all fields and sequentially. This also injects a single bit error in the group 
of all fields selected in the header or payload. If the Test Suite is set to loop forever, the bit 
error walks through all the selected fields.

• Select one bit in each field and randomly does the same thing as the first option; however, 
there will be one error for each word selected in the header or payload.

• Select one bit in each field and sequentially does the same thing as the second option; 
however, there will be one error for each word selected in the header or payload.

LRC Options

This option is only available for Fibre Channel. The FICON protocol uses an LRC which is a 
special checksum located in the eighth payload word. This option controls what happens to that 
payload word during the Jam, as well as, for any other words that qualify as being an LRC (that is, 
if you select Replace Jams with SOFs, then the fourteenth word after each SOF is an LRC word).

• Pass through LRC unchanged

Whatever word is present in an LRC word is passed through regardless of what you have 
defined on the Payload tab for that word.

• Recalculate correct LRC

An LRC is calculated and placed wherever an LRC word occurs. The LRC only functions 
correctly in valid frames (SOF followed by at least 14 data words).

• Replace LRC with this

LRC words are all replaced with this new word, regardless of what you have defined on the 
Payload tab for that word.

• Disable LRC

The Jams defined on the Payload tab take place with no special cases for LRC words.

Using the SOF/CRC/EOF Tab for Fibre Channel

Use the choices on this tab to modify the Start of Frame (SOF), Cyclic Redundancy Check (CRC), 
and End of Frame (EOF) words of the original target frame (Figure 64).
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Figure 64:  Fibre Channel SOF/CRC/EOF Tab

Modifying SOF/EOF 

You can replace the start and end of frame characters with another SOF, EOF, or other Ordered 
Set. For example, you can change SOFn3 to an SOFi3, which changes a frame from a sequence 
member to the start of a new sequence.

CRC Options

CRC options include:

• Pass through CRC unchanged - Not changing the CRC in the original target frame

• Recalculate correct CRC - Recalculating the CRC to make it correct for the modified data 

• Replace CRC with this - Replacing with a user-specified data word or Ordered Set

Depending on the changes made to a frame, the old CRC might be invalid. If the CRC is passed 
through, an invalid Fibre Channel frame might be created. The lowest layer of Fibre Channel error 
checking should recognize this type of error. The normal system response is to terminate the 
exchange and start over. If the frame is modified and the CRC is recalculated, a valid frame with 
modified data is created. If, for example, the modifications are made to SCSI commands 
embedded in the payload, the SCSI error checking routines should trap and handle the error.
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Using the Header/Payload Tab for Fibre Channel

Any parameter in the Fibre Channel header can be modified (Figure 65). Select either the Replace 
Jam or All Jam Modes radio button to define the Jam frame. 

Figure 65:  Fibre Channel Header/Payload Tab

Similar to defining an Arm or Trigger Condition, there are two ways to specify your frame Jam 
Definition. One way is to load a template from the Template Library tree, and the other way is to 
manually specify bits in the frame.

To use a template:

1 Highlight a template in the Template Library tree on the left side of the window. 

2 Click the double right arrow to display the Jam definition on the right side of the window. 

When you use a template, the Jam definition is populated with Replace Jams of the specified data, 
while all other bits are passed through.

Notice the special choice at the bottom left, “Current Trigger.” This is a copy of the frame 
condition you have specified for the Trigger. Click the double right arrow to use this.

When you use a template, the Jam definition is populated with Replace Jams of the specified data, 
while all other bits are passed through.
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To manually edit the values, enter a value into the byte field. An X in a nibble passes the original 
value through. 

Select the Replace 8b Jam Mode radio button to open a dialog that allows you to replace an entire 
frame either by using a template or manually entering values. The Replace 8b Jam Mode dialog 
also contains a view of the frame contents, similar to those seen the Arm and Trigger Condition 
windows. These values correspond to the hex values defined in the center column. 

Figure 66:  Replace 8b Jam Mode

Select the All Jam Modes radio button opens a dialog that provides the following choices for each 
word in a frame on the Header/Payload tab:

• Replace 8b Jam - This function allows you to replace each nibble with a new value. Choose 
between a standard Ordered Set or a user-defined Ordered Set or data word. For user-defined 
values, you can specify a value for each nibble.

• Apply Global Replace Jam - This function allows individual bits to be set to 1, set to 0 or 
passed through unchanged according to the Global Replace Jam defined on the Global Tab.

• Insert Code Violation Jam - Introduce a pre-defined, fixed code violation to the current 
word.

• Invert Jam - Invert defined bits and pass through the rest. Enter 1s at the appropriate bit 
locations.

• Pass Through Jam - Pass through the current word unchanged.

• Replace Jam with CRC - This word contains the current CRC value. CRC calculation is reset 
and started at the word after any SOF. Note that there should be only valid data words between 
an SOF and its partner automatic CRC insertion or else the CRC value will be incorrect. 
Violations of this rule include using Ordered Sets or inserting code violations.
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• Set Bits To 0s Jam- Set defined bits to 0s and pass through the rest. Enter 0s at the 
appropriate bit locations.

• Set Bits To 1s Jam - Set defined bits to 1s and pass through the rest. Enter 1s at the 
appropriate bit locations.

• Apply Global Bit Error Jam - Apply the Global Bit Error function set on the Global tab. Enter 
1s at the appropriate bit locations.

You can modify any and all words in the payload. Decide what portion of the payload you want to 
modify. The larger the portion of the payload that is selected, the longer the time between Test 
Cases in the suite. Switching from one Test Case to the next is a software operation, so the time 
between cases will be on the order of hundreds of milliseconds.

Use the Number of payload words counter to define the number of payload Jams (Figure 67). 
Use the scroll bar to position the display to the desired word.

Figure 67:  Selecting Frame Jam Size

The drop-down menus are the same as those found on the Header words. See page 83.

You can also use the List View controls at the top to cut, copy, paste, add, insert, or delete words.

Similar to defining an Arm or Trigger Condition, there are two ways to specify your frame Jam 
Definition. One way is to load a template from the Template Library tree, and the other way is to 
manually specify bits in the frame.

To use a template:

1 Highlight a template in the Template Library tree on the left side of the window. 

2 Click the double right arrow to display the Jam definition on the right side of the window. 

Notice the special choice at the bottom left, Current Trigger (Figure 68). This is a copy of the 
frame condition you have specified for the Trigger. The name of the Trigger Condition (if any) is 
shown in parenthesis. Click the double right arrow to use this.

Figure 68:  Current Trigger Option

Note: If you place an SOF in header word 2, and an automatic CRC in payload word 10, the 
CRC is calculated over header words 3 to 6 and continues with payload words 1 to 9.
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When you use a template, the Jam definition is populated with Replace Jams of the specified data, 
while all other bits are passed through.

To manually specify a frame word Jam, select a Jam Type from the drop-down menu (under the 
Type column), then specify any additional definition (if necessary) by clicking on the data field 
(under the Description column).
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Replace Frame with Truncated Frame

This option truncates the target frame to a shorter length and sends Idles on top of the remainder of 
the target frame.

To replace a frame with a truncated frame:

>> Use the up and down arrow buttons or type the number of words you want to truncate the 
frame to (including header and payload, not including SOF, CRC, and EOF). 

The CRC is automatically recalculated. If the target frame is already shorter than the specified 
truncation length, no truncation occurs. In any case, the EOF is always replaced with the new 
EOF you select from the drop-down menu.

Figure 69:  Fibre Channel - Replace Frame with Truncated Frame

Replace Frame with Idles

This option replaces the target frame with Idles.

Replace Frame with ARB(ff)

This option replaces the target frame with ARB(ff).
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Chapter 4
Creating Jammer Test Configurations for Gigabit 
Ethernet

In this chapter:

• Defining Your Own Test Configurations

• Using the Jammer Configuration Window

• Configuring Arm and Trigger Conditions for Gigabit Ethernet

• Configuring the Jam Definition for Gigabit Ethernet
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Defining Your Own Test Configurations

Xgig Jammer lets you define your own test configurations and save them with or without hardware 
available.

You can create a configuration from scratch, or you can open and edit an existing configuration. 
Also, you can edit a configuration in edit only mode, which is independent of any hardware, or 
you can edit a configuration that is currently loaded to a Jammer device.

To edit a configuration in edit only mode:

>> Double-click on a configuration file in the Configuration manager. 

Or:

>> Right-click on the configuration in the Configuration manager and choose Edit Jammer 
Configuration from the context menu.

>> Or:

>> Right-click the configuration file in the Configuration manager to open the context menu, and 
select Edit Configuration.

The edit only mode Jammer Configuration window opens (Figure 70).

This window allows you to set up your own Test Cases, name them, organize them, and save 
them to files so that you can use them again.
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Figure 70:  Edit Only Jammer Configuration window

To start a configuration from scratch in edit only mode:

>> Select New Jammer Configuration from the context menu or the File menu (Figure 71) on 
the Xgig Maestro menu bar.

Or:

>> Click the New Configuration icon at the top of the Configuration manager.

Figure 71:  Maestro File Menu

To save your configuration in edit only mode:
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>> Click Save at the bottom of the Jammer Configuration window or open the File menu on the 
Jammer Configuration window and select Save Configuration or Save Configuration As.

Any changes you make have no effect on actual Jammer devices you control.

To edit a configuration that is loaded to a Jammer port:

>> Click Configuration... in the device column.

Or:

>> Right-click in the Parameters Status table in the device column to open the context menu and 
select Edit configuration.

Or: 

>> Click Operation in the device column to open the Operation dialog, then click Config.

The Xgig Jammer Configuration window in hardware edit mode is displayed (Figure 72). This 
window allows you to set up your own Test Cases, name them, and save them to a file so that 
you can use them again.

Click Apply or OK and Jammer accepts the changes. They are immediately reflected in the 
Parameters Status table and affect the Jammer device the next time you run it.

To save your configuration edits:

>> Open the File menu at the top of the Jammer Configuration window and select 
Save Configuration As... or Save Configuration.



Using the Jammer Configuration Window Creating Jammer Test Configurations for Gigabit Ethernet

Xgig Jammer and Delay Emulator User Guide 91

  

Figure 72:  Xgig Jammer Configuration Window

Using the Jammer Configuration Window

The Jammer Configuration window title bar indicates how many ports it is configuring, the 
protocol, and the configuration file name, if any. If you are using hardware edit mode, the chassis 
name, chassis number, slot number, and port number are also listed. The elements of the Jammer 
Configuration window are described in the following sections.

Using the Jammer Test Suite Tools

The Test Suite lists the series of Xgig Jammer tests in the order in which you want them to 
execute. The suite includes one or more tests. The highlighted test appears as the Current Jammer 
Test on the upper right side of the window. Each test in the suite executes in sequence with a test 
reset time of approximately 130 (200 max) milliseconds. 
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Creating a Test Suite

When you create a Gigabit Ethernet Jammer Test Suite, you use the toolbar in the Jammer Test 
Suite section of the Configuration window (Figure 73).

Figure 73:  10GigE Jammer Test Suite Toolbar

The following list describes the icons on the toolbar:

To duplicate a test at another point in the Test Suite:

1 Highlight the test you want to duplicate.

2 Click Copy.

3 Highlight the test in the suite that is just after the point where you want the duplicate test 
inserted.

4 Click Paste.

The duplicate test is inserted.

Refer to “Configuring Arm and Trigger Conditions for Gigabit Ethernet” and “Configuring 
the Jam Definition for Gigabit Ethernet” for information about configuring each test.

Cut current test Removes the highlighted test and holds its contents in the 
memory buffer.

Copy current text Copies the highlighted test to the memory buffer.

Paste last test cut or copied Inserts the current memory buffer contents before the currently 
highlighted test.

Add new test to bottom of stack Adds a new blank test to the bottom of the suite.

Insert new test before current test Inserts a new blank test above the currently highlighted test.

Delete current test Removes the highlighted test from the suite. If only one test is 
present, then the contents of this test are cleared.

Move current test down the stack Moves the highlighted test down one in the test order.

Move current test up the stack Moves the highlighted test up one in the test order.

Toggle view Toggles Test Suite between Card View and List View.

Run test suite once or Repeat test 
suite

When you choose Repeat test suite, the tests run according 
the settings you define in the Jammer Current Test window.
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Using the Configuration File Menu

The File menu is the only menu on the menu bar (Figure 74). 

Figure 74:  Configuration File Menu

The choices are:

The recently used Gigabit Ethernet Jammer configuration files appear in the file menu and are loaded when 
selected.

Using the Current Jammer Test Window

The graphics in this section of the window represent the hardware configuration for the selected 
test in the Jammer Test Suite.

Mode

For 10GigE, Mode menus are available near the top of the Current Jammer Test window 
(Figure 75) and also near the top of each Test Case in the Jammer Test Suite window (Figure 76). 

The input to path A (on top) is always port A and the input to path B (on the bottom) is always port 
B. The external trigger input and output that is available on path A always are linked to the domain 
shown on the Xgig Maestro window as “Domain of port A.” The trigger input and output on the 
bottom on path B are in the “Domain of port B.” 

Open Configuration Open an existing .tsk configuration file.

Import to Selected Test Import a Test Case from a .tst file or an entire test suite, .tsk file, to 
the currently highlighted position. A Test Case is one line in the Jammer 
Test Suite.

Export Selected Test Export and save the currently highlighted test to a .tst file.

Save Configuration Save the entire Test Suite to the .tsk file you currently have loaded.

Save Configuration As Save the entire Test Suite to a .tsk file with a name you assign to it.

Close Close the Jammer Configuration Window.

Note: The .tst files are only for storing individual Test Cases and swapping them between 
configuration files. You cannot load .tst files directly into a Jammer device on the Xgig 
Maestro window.
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Figure 75:  Mode Drop-down Menu in Current Jammer Test - Right Pane

Figure 76:  Mode Drop-down Menu in Test Suite - Left Pane

Reverse

You can reverse the direction of the jam by selecting the Reverse button.

Arm and Trigger

To define Arm and Trigger conditions, select a respective Type from each drop-down menu. Then 
click the Arm or Trigger button to open the corresponding definition window. 

You can use an external input as an Arm condition. Check Trigger from Domain A (or B) to enable 
this feature. You must put the corresponding Jammer port into a domain for this to work properly. 

The Trigger event can be in the next Dword after the Arm event in the traffic stream.

Jam

To define a Jam: 

1 Select a Type from the drop-down menu, if available.

2 Click the Jam button to open the Jam Definition window.

The Jam Definition specifies the modifications to be made to the traffic matching the Trigger 
Condition.
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In addition, the Jammer port can trigger out to the Domain it is in when a Jam takes place. 
Check Trigger Domain A (or B) upon Jam to enable this feature.

Figure 77:  Trigger In and Trigger Out

Note: If you use an external trigger input to define the Arm condition, then you cannot select 
the external trigger output for that path in that Test Case, and vice versa. For information 
regarding using the trigger input and output during a Test Case, refer to “Using Domains and 
External Triggering” on page 291. However, you can use an external trigger in on port A with 
an external trigger out on port B, and vice versa. Figure 77 shows an example.
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Rollback

The Rollback option defines the time or Dword count parameter between the Arm and Trigger 
events. If the Trigger does not follow the Arm event in the allotted time or Dword count, the 
Jammer begins looking for the Arm event again. Click Rollback to display the dialog shown in 
Figure 78. 

Figure 78:  Rollback Condition Dialog

Timeout

The timeout option defines the period of time to wait for a specified test to complete before 
aborting and proceeding to the next test in the suite.

To set the timeout:

1 Click Timeout to display the dialog box in Figure 79. 

2 Check Enable Timeout.

3 Enter the hours, minutes, and seconds you want to wait.

Figure 79:  Timeout Dialog

4 Click OK.

Repeat

Click Repeat to open the dialog shown in Figure 80. The Repeat Mode setting allows you to 
configure what is repeated when using an Arm condition. The first option means the Jammer will 
match the Arm condition once, then will repeat matching the Trigger condition as specified by the 
Repeat Count setting below. The second Repeat Mode option means that the Jammer must match 
the Arm condition each time before looking for a Trigger.

Note: This value is saved in terms of Dwords, not time, so keep this in mind if you save a 
Test Case using a device running at 3.0 Gbps and later open the configuration on a Jammer 
running at 1.5 Gbps.
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Figure 80:  Repeat Test Dialog

Pause

Click Pause to open the dialog shown in Figure 81. The Pause setting allows you to insert a pause 
before the beginning of a test case. 

Figure 81:  Pause Test Dialog

You can also configure options for each Test Case directly in the Test Suite, instead of clicking in 
the Current Jammer Test pane. Click on the area of the Test Case you want to modify to open the 
corresponding dialog (Figure 82).
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Figure 82:  Configuring Options Directly in the Test Suite
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Configuring Arm and Trigger Conditions for Gigabit Ethernet

Arm and Trigger conditions recognize specific Ordered Sets or frames, depending on the protocol. 

In Gigabit Ethernet, you can specify any standard Ordered Set or any user-defined one or two 
bytes of K/D characters (of which standard Ordered Sets are a subset). You can also use a frame, 
for which you can specify the Gigabit Ethernet header and up to 114 bytes of payload.

You can save an arm or trigger condition as a .jmt file by clicking the Save button in the Arm or 
Trigger window. You can load a .jmt file by clicking the Load button in the Arm or Trigger 
window.

Depending on the Mode you select, the appropriate graphic diagram shows the Trigger and 
optional Arm conditions, along with the Jam event. If the Mode you select does not include an 
Arm condition, the Arm button remains disabled. 

To set Arm and Trigger conditions: 

1 Click on the Arm or Trigger button in the Xgig Jammer Configuration window. 

The window for the condition is displayed (Figure 83). If you are in hardware edit mode, the 
protocol, chassis name, chassis number, slot number, and port numbers are displayed in the 
title bar.

2 Open the Type drop-down in the Arm or Trigger Condition window and select Frame or 
Ordered Set.

3 Set the values as required to specify a unique Arm and Trigger sequence for the specific test.

The following sections describe the available values.
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Figure 83:  Gigabit Ethernet Arm and Trigger Windows for Frames

Setting Frame Conditions

You can specify frame conditions in two ways. One way is to load a template from the Template 
Library tree, and the other way is to manually specify bits in the frame.

To use a template:

1 Select a template from the Template Library tree on the left.

2 Click the double right arrow button to set the Trigger Condition. 

The condition is indicated on the right side of the window.

To manually specify a frame: 

>> Type hexadecimal values directly into the center column of the window.

An X represents a nibble that can be any value (a “don’t care”). 

To set individual bits in any field, double-click on the hex entry to open the Binary Editor 
(Figure 84). In the hex view, partially defined hex characters appear as question marks: 
X001=?
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Figure 84:  Binary Editor Dialog

Another way to manually edit the frame condition is to make selections from the tree view in 
the right window pane.

Saving a Frame Condition

If you create a frame condition that you want to save and make easily available for future use, you 
can save it into the “User Library” folder in the Template Library tree. To do this:

>> Highlight the folder and click the double left arrow button.

Frame conditions have the option of “Use inverse of condition specified (i.e., NOT).” When you 
check this option, it means that the first frame encountered that does not match what you have 
specified creates a “condition met” event.

For each frame condition, you can specify an optional name at the top of the window. This name is 
also shown on the Jammer Configuration window under the Mode selection, and on the main Xgig 
Maestro window.
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Setting Ordered Set Conditions

To arm or trigger on an Ordered Set: 

1 Click on the Arm or Trigger button in the Jammer Configuration window. 

2 Open the Type drop-down in the Arm or Trigger Condition window and select Ordered Set.

3 Set the values as required to specify a unique Arm and Trigger sequence for the specific test.

You can choose from any standard Ordered Set or choose user-defined (Figure 85). All choices are 
either one byte or two bytes. A user-defined condition can use any K/D character(s).

To edit the values: 

>> Enter a hex value, or double-click the byte field to open the Binary Editor. 

As in frame conditions, an X indicates “don’t care” and a ? indicates a partially specified hex 
character. 

You can also click on the K/D character display (for example, 16.2) to open drop down menus 
of possible values from which you can select. A period separates the two values. Click the K 
or D to toggle the Control Characters setting.

Figure 85:  Gigabit Ethernet Arm and Trigger Windows-Ordered Sets

As with frame conditions, you can specify an optional name at the top of the window. This name is 
also shown in the Jammer Configuration window under the Mode selection and on the main Xgig 
Maestro window.

Note: In Gigabit Ethernet, if you choose a one byte Ordered Set Trigger condition, then the 
Jam definition must be one byte. If you choose a two byte Ordered Set, then the Jam must be 
two bytes.

Note: Two byte Ordered Set conditions are only met when aligned to the normal 16-bit 
boundary (in alignment with the I2 Ordered Sets). For example, if you specify a condition of 
50-K28.5, hoping that the condition would be met by two I2 (K28.5-50-K28.5-50), this 
condition would not be met. 
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Configuring the Jam Definition for Gigabit Ethernet

The Jam Definition window defines how to modify the event specified on the Trigger Condition 
window.

The Jam is always the same type (frame or Ordered Set) as the Trigger.

For any Jam Definition, you can specify an optional name at the top of the window. This name is 
also displayed on the Jammer Configuration window under Mode selection and on the main Xgig 
Maestro window.

You can save a Jam definition as a .jmj file by clicking the Save button in the Jam window. You 
can load a .jmj file by clicking the Load button in the Jam window.

Jamming an Ordered Set

If the Trigger Event is an Ordered Set, click the Jam button on the Xgig Jammer Configuration 
window, to open the Ordered Set Jam Definition window (Figure 86).

The Ordered Set Jam Definition window allows you to modify any Ordered Set by replacing it 
with a different Ordered Set, or by replacing it with a code violation. The code violation is a 
predefined 10-bit value that replaces the last 10 bits of the target Ordered Set in its 40-bit form. 
The control to edit the Ordered Set is similar to that in the Trigger Condition window.

Figure 86:  Gigabit Ethernet Ordered Set Jam Definition Window

For example, assume that the Trigger Event was an I1, the Jam was set to replace it with an I2 and 
the repeat count was set to forever. This replaces every I1 in the link traffic with an I2 until you 
click Stop or the specified timeout occurs. Note that the number that you specify in the Repeat 
setting is the number of repetitions that occur including the first Jam. In addition, remember that if 
an Arm condition is specified, each repeat Jam requires the Arm and Trigger condition be met 
each time. An exception is in Gigabit Ethernet: if the Trigger condition is met more than once in a 
32-bit word, then the Jam occurs multiple times in that same word, and then begins looking for the 
Arm condition, again, on the next word.
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Jamming a Frame

To define a Jam for a frame:

1 Click the Jam button on the Xgig Jammer Configuration window to open the Frame Jam 
Definition window (Figure 87).

2 Under the Jam Type drop-down, choose to:

— Modify traffic

— Truncate a frame

— Replace the frame with Idles (I2)

The following paragraphs describe these choices.

Replace Frame with Modified Frame

Each tab contains options relevant to different frame modifications.

Using the Global Tab

Use this tab (Figure 87) to define Jam parameters that apply globally to the frame.

Global Match/Mask Option

Use the Global Match/Mask word to set specific bits in a word to 1 or 0 while passing through the 
remaining bits. You can apply this global mask to any word in the frame. Define one Global 
Match/Mask for each Test Case.

To edit these bits: 

>> Enter hex values, or double-click on a byte field to open the Binary Editor. 

Any bits left as Xs are passed through.

Figure 87:  Gigabit Ethernet Global Tab
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Global Bit Errors

The Jammer software can introduce bit errors repeatedly in sequential or random fashion to 
predefined fields. These bit errors are introduced to the 32-bit form of the target words (not the 
40-bit form) so code violations are not created. The Global Bit Errors control allows you four 
options.

• Select one bit for all fields and randomly. This causes the Jammer to inject a single bit error 
in the group of all fields selected in the header or payload for a single Test Case. If the Jammer 
Test Suite is set to loop, then single bit errors are randomly injected into these fields, with one 
bit for each cycle of the Test Suite.

• Select one bit for all fields and sequentially. This also injects a single bit error in the group 
of all fields selected in the header or payload. If the Test Suite is set to loop forever, the bit 
error walks through all the selected fields.

• Select one bit in each field and randomly does the same thing as the first option; however, 
there will be one error for each word selected in the payload or header.

• Select one bit in each field and sequentially does the same thing as the second option; 
however, there will be one error for each word selected in the payload or header.

Using the Delimiters/CRC Tab for Gigabit Ethernet

Use the choices on this tab to modify the Start of Packet (SOP), Start Frame Delimiter (SFD), 
CRC, End of Packet (EOP), and Carrier Extend(s) of the original frame (Figure 88).

Figure 88:  Gigabit Ethernet Delimiters/CRC Tab
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Modifying SOP/SFD/EOP/ Carrier Extend(s)

To modify any of these special characters in the target trigger frame:

1 Check the appropriate box to select replacement. 

2 Open the drop-down menu and choose a standard Gigabit Ethernet Ordered Set, or select 
User-defined.

If you choose User-defined, you can specify any value. 

To edit the value enter a hex value into the byte field or double-click to display the Binary 
Editor. 

You can also click on the K/D character display (for example, 16.2) to open drop-down menus 
of possible values from which you can select (Figure 89). A separator (a period) distinguishes 
the two values. Click the K or D to toggle the Control Character setting. 

Figure 89:  K/D Character Value Drop-down Menus

CRC Options

The CRC options include:

• Not changing the CRC in the original target frame

• Recalculating the CRC to make it correct for the modified data

• Replacing with a user-specified data word
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Using the Header/Payload Tab for Gigabit Ethernet

You can modify any parameter or word on the Gigabit Ethernet Header/Payload Tab (Figure 90).

Figure 90:  Gigabit Ethernet Header/Payload Tab

The Gigabit Ethernet window always shows Jam definitions for the header and 4096 payload 
words (for the maximum supported 16 Kilobyte jumbo frames). If the frame that is Jammed has 
less than 4096 payload words, the extra Jam definitions do not take effect. The Jammer does not 
support Gigabit Ethernet frames larger than 4096 payload words.

Notice the first line of the Jam Definition (Ether 0001) has only the first two bytes of the 
Destination Address header field. This is to visually orient the frame in the same manner as the 
Arm and Trigger Condition windows.

Similar to defining an Arm or Trigger Condition, there are two ways to specify your frame Jam 
Definition. One way is to load a template from the Template Library tree, and the other way is to 
manually specify bits in the frame.

To use a template:

1 Highlight a template in the Template Library tree on the left side of the window. 

2 Click the double right arrow to display the Jam definition on the right side of the window. 
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Notice the special choice at the bottom left, “Current Trigger.” This is a copy of the frame 
condition you have specified for the Trigger. Click the double right arrow to use this.

When you use a template, the Jam definition is populated with Replace Jams of the specified data, 
while all other bits are passed through.

To manually edit the values, enter a value into the byte field. An X in a nibble passes the original 
value through. 

Select the Replace 8b Jam Mode radio button to open a dialog that allows you to replace an entire 
frame either by using a template or manually entering values. The Replace 8b Jam Mode dialog 
also contains a view of the frame contents, similar to those seen the Arm and Trigger Condition 
windows. These values correspond to the hex values defined in the center column. 

Figure 91:  Replace 8b Jam Mode

Selecting the All Jam Modes radio button opens a dialog that provides the following choices for 
each word in a frame on the Header/Payload tab:

• Apply Global Match Mask Jam - This function allows individual bits to be set to 1, set to 0 or 
passed through unchanged according to the Global Match/Mask defined on the Global tab.

• Invert Jam - Invert defined bits and pass through the rest. Enter 1s at the appropriate bit 
locations.

• Pass Through Jam - Pass through the current word unchanged.
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• Replace 8b Jam - Replace nibbles with new values. Each drop-down represents a byte so you 
can replace a byte with a standard Ordered Set. If you choose User-defined, you can specify 
any K/D character. To edit these values, enter a value into the byte field or double-click to 
display the Binary Editor. If you specify a bit as a 0 or 1, you must specify the values of the 
other three bits in that nibble also. Any nibbles with an X are passed through.

• Set Bits To 0s Jam - Set defined bits to 0s and pass through the rest. Enter 0s at the 
appropriate bit locations.

• Set Bits To 1s Jam - Set defined bits to 1s and pass through the rest. Enter 1s at the 
appropriate bit locations.

• Apply Global Bit Error Jam - Apply the Global Bit Error function set on the Global tab.

• Insert Code Violation Jam - Introduce a predefined, fixed code violation to a byte in that 
word. Which byte is corrupted depends on the alignment orientation of the frame. The Jam 
Definition of the word before a Code Violation Jam must always be a Pass Through Jam. A 
Code Violation Jam cannot be placed in the first word of a frame (Ether 0001).

Using the Embedded Protocol(s) Tab for Gigabit Ethernet

Figure 92 shows the Embedded Protocol(s) tab for Gigabit Ethernet. The available functions are 
described in this section.

Figure 92:  Gigabit Ethernet Embedded Protocol(s) Tab

Recalculate Checksum

Select the check boxes to choose recalculation of IP and TCP checksums.

Recalculate IP checksum for valid IP embedded frames

Checking this option replaces the IP checksum in the Jammed frame with a recalculated value. For 
the checksum to be inserted properly, the frame, after Jamming takes place, must have a Gigabit 
Ethernet header EtherType field value of 0x0800 and a valid IP header IHL field.
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Recalculate TCP checksum for valid TCP embedded frames

Checking this option replaces the TCP checksum in the Jammed frame with a recalculated value. 
For the checksum to be inserted properly, the frame, after Jamming takes place, must meet the 
same requirements as those listed for the IP checksum, and, in addition, have an accurate IP header 
Total Length field, an IP header IP Protocol field value of 0x06, and a valid TCP header Data 
Offset field.

Also, the Jumbo Frames setting (see “GigE Jumbo Frames” on page 25) must be correct for the 
TCP checksum insertion to work. If the Jammed frame is “normal size” (1500 Gigabit Ethernet 
payload bytes or less) then either setting is correct. If the Jammed frame is a jumbo frame (16 KB 
Gigabit Ethernet payload bytes or less), then you must select the jumbo setting. The Jammer does 
not support recalculating the TCP checksum for larger frames.

The TCP checksum recalculation is not available when using the Repeat Jam feature.

Replace Frame with Truncated Frame

This option truncates the target frame to a shorter length and sends Idles (I2) on top of the 
remainder of the target frame.

In the Truncate Frame Options window:

1 Choose the type of payload you want to truncate from the drop-down menu: 

• Gigabit Ethernet

• IP

• TCP

2 Enter the number of bytes you want the payload to be truncated to (this does not include the 
CRC or other delimiters).
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Figure 93:  Replacing a Frame with a Truncated Frame

Gigabit Ethernet Payload

For a Gigabit Ethernet payload, the New Payload Size setting specifies how many bytes to leave 
after the Gigabit Ethernet header (the first 14 bytes of the frame). For normal sized frame support, 
you can specify from 0 to 1500 bytes, and for jumbo sized frame support, you can specify from 0 
to 16383 bytes. If the target frame is shorter than the specified number of bytes, then no Jamming 
occurs.

IP Payload

For an IP payload, the New Payload Size setting specifies how many bytes to leave after the IP 
header. For normal sized frame support you can specify from 0 to 1480 bytes, and for jumbo sized 
frame support, you can specify from 0 to 16364 bytes. You also have the option to replace the IP 
checksum with a recalculated value, which also automatically updates the IP header Total Length 
field.

For the truncation or the IP checksum option to work properly, there are some requirements of the 
incoming target frame. The frame must have a Gigabit Ethernet header EtherType field value of 
0x0800, a valid IP header IHL field, and a valid IP header Total Length field. If the Jammed frame 
is shorter than the specified number of bytes, then no truncation occurs, but the IP checksum can 
be recalculated if you select it.

TCP Payload

For a TCP payload, the New Payload Size setting specifies how many bytes to leave after the TCP 
header. For normal sized frame support you can specify from 0 to 1460 bytes, and for jumbo sized 
frame support you can specify from 0 to 16344 bytes. You also have the options to replace the IP 
and/or TCP checksums with recalculated values (either option also automatically updates the IP 
header Total Length field). 

For the truncation to occur and for the checksum options to work, the incoming target frame must 
meet the same requirements listed earlier for IP payload truncation, and, in addition, have an IP 
header IP Protocol field value of 0x06 and a valid TCP header Data Offset field. If the Jammed 
frame is shorter than the specified number of bytes, then no truncation occurs, but the checksums 
can be recalculated if you select them.
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In addition, TCP checksum recalculation is not available when using the Repeat Jam feature.

For any successful truncation, the Gigabit Ethernet CRC is automatically replaced with a 
recalculated value.

Replace Frame with Idles

This option replaces the target frame with I2 Ordered Sets in the Gigabit Ethernet Jammer.

Figure 94:  Gigabit Ethernet - Replace Frame with Idles
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Chapter 5
Creating Jammer Test Configurations for SAS and 
SATA/STP

In this chapter:

• Defining Your Own SAS and SATA/STP Test Configurations

• Using the Jammer Configuration Window

• Configuring SAS Arm and Trigger Conditions

• Configuring the SAS Jam Definition

• Configuring SATA/STP Arm and Trigger Conditions

• Configuring the SATA/STP Jam Definition
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Defining Your Own SAS and SATA/STP Test Configurations

Xgig Jammer lets you define your own test configurations and save them with or without hardware 
available.

You can create a configuration from scratch, or you can open and edit an existing configuration. 
Also, you can edit a configuration in edit only mode, which is independent of any hardware, or 
you can edit a configuration that is currently loaded to a Jammer device.

To edit a configuration in edit only mode:

>> Double-click on a configuration file in the Configuration manager. 

Or:

>> Right-click on the configuration in the Configuration manager and choose Edit Jammer 
Configuration from the context menu.

The edit only mode Jammer Configuration window opens.

This window allows you to set up your own Test Cases, name them, organize them, and save 
them to files so that you can use them again.

To start a configuration from scratch in edit only mode:

>> Select New Jammer Configuration from the context menu or the File menu (Figure 95) on 
the Xgig Maestro menu bar.

Or:

>> Click the New Configuration icon at the top of the Configuration manager with the 
appropriate protocol selected next to it.

Figure 95:  Maestro File Menu

To save your configuration in edit only mode:

>> Click Save at the bottom of the Jammer Configuration window or open the File menu on the 
Jammer Configuration window and select Save Configuration or Save Configuration As.

Any changes you make have no effect on actual Jammer devices you control.

To edit a configuration that is loaded to a Jammer port:

>> Click Configuration... in the device column on the Parameters Status table.

Or:
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>> Right-click in the Parameters Status table in the device column to open the context menu and 
select Edit configuration.

Or:

>> Highlight the configuration file in the Configuration manager, open the context menu, and 
select Edit Configuration.

Or: 

>> Click Operation in the device column to open the Operation dialog, then click Config.

The Xgig Jammer Configuration window in hardware edit mode is displayed (Figure 96). This 
window allows you to set up your own Test Cases, name them, and save them to a file so that 
you can use them again.

Click Apply or OK and Jammer accepts the changes. They are immediately reflected in the 
Parameters Status table and affect the Jammer device the next time you run it.

To save your configuration edits:

>> Open the File menu at the top of the Jammer Configuration window and select 
Save Configuration As... or Save Configuration.

Figure 96:  Xgig SAS and SATA/STP Jammer Configuration Window
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Using the Jammer Configuration Window

The Jammer Configuration window title bar indicates how many ports it is configuring, the 
protocol, and the configuration file name, if any. If you are using hardware edit mode, the chassis 
name, chassis number, slot number, and port numbers are also listed. The components of the 
Jammer Configuration window are described in the following sections.

Using the Jammer Test Suite Tools

The Test Suite, the pane on the left side of the configuration window, lists the series of Xgig 
Jammer tests in the order in which you want them to execute (Figure 97). The suite includes one or 
more tests. The highlighted test appears as the Current Jammer Test on the right side of the 
window. Each test in the suite executes in sequence with a set up time from the end of one test to 
the start of the next of approximately 130 (200 max) milliseconds. 

Figure 97:  SAS/SATA Jammer Test Suite Windows

Card View
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Using the SAS/SATA Jammer Test Suite Toolbar

When you create a SAS/SATA Jammer Test Suite, you use the toolbar in the Jammer Test Suite 
section of the Configuration window (Figure 98).

Figure 98:  SAS/SATA Jammer Test Suite Toolbar

The following list describes the icons on the toolbar:

Using the Context Menu

The same operations (Cut, Copy, Paste, etc.) can be performed with the options available in the 
Context menu. In addition, the direction of an individual test can be reversed by selecting the 
‘Reverse Current’ option. To reverse the direction of all tests, select the ‘Reverse All’ option.

Cut current test Removes the highlighted test and holds its contents in the 
memory buffer.

Copy current text Copies the highlighted test to the memory buffer.

Paste last test cut or copied Inserts the current memory buffer contents before the currently 
highlighted test.

Add new test to bottom of stack Adds a new blank test to the bottom of the suite.

Insert new test before current test Inserts a new blank test above the currently highlighted test.

Delete current test Removes the highlighted test from the suite. If only one test is 
present, then the contents of this test are cleared.

Move current test down the stack Moves the highlighted test down one in the test order.

Move current test up the stack Moves the highlighted test up one in the test order.

Toggle view Toggles Test Suite between Card View and List View.

Run test suite once or Repeat test 
suite

When you choose Repeat test suite, the tests run continuously 
from the top of the Test Suite to the bottom and loopback to the 
top until you click stop.

List View
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Using the Configuration Menus

Two menus are available in the Configuration window: File and Tools.

The choices on the File menu are:

The recently used FC Jammer configuration files appear in the file menu and are loaded when 
selected. 

The Tools menu in the SAS/SATA Configuration window lets you open the SAS Hashed Address 
Calculator. 

The SAS Hashed Address Calculator is also available by clicking the Hashed ID button at the 
bottom right corner of the SAS Frame Arm or Trigger Condition windows.

SSP frames use a hashed address that is derived from the SAS device address. The SAS Hashed 
Address Calculator allows you to calculate the hashed address from the SAS address. You must 
use the hashed address when setting an Arm Condition, Trigger Condition, or Jam Definition for 
an SSP frame.

To determine the hashed address:

>> Type the SAS address into the calculator.

The hashed address updates on the right.

Figure 99:  SAS Hashed Address Calculator

Import to Selected Test Import a Test Case from a .tst file or an entire test suite, .tsk file, to the 
currently highlighted position. A Test Case is one test in the Jammer Test 
Suite.

Export Selected Test Export and save the currently highlighted test to a .tst file.

Save Configuration Save the entire Test Suite to the .tsk file you currently have loaded.

Save Configuration As Save the entire Test Suite to a .tsk file with a name you assign to it.

Close Close the Jammer Configuration Window.

Note: The .tst files are only for storing individual Test Cases and swapping them between 
configuration files. You cannot load .tst files directly into a Jammer device on the Xgig 
Maestro window.
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Using the Current Jammer Test Window

The graphics in this section of the window represent the hardware configuration for the selected 
test in the Jammer Test Suite (Figure 100).

Figure 100:  Current Jammer Test Window

Mode

For SAS/SATA, Mode menus are available near the top of the Current Jammer Test window 
(Figure 101) and also near the top of each Test Case in the Jammer Test Suite window 
(Figure 102). 

The input to path A (on top) is always port A and the input to path B (on the bottom) is always port 
B. The external trigger input and output that are available on path A always are linked to the 
domain shown on the Xgig Maestro window as “Domain of port A.” The trigger input and output 
on the bottom on path B are in the “Domain of port B.” 
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Figure 101:  Mode Drop-down Menu in Current Jammer Test - Right Pane

Figure 102:  Mode Drop-down Menu in Test Suite - Left Pane

Reverse

You can reverse the direction of the jam by selecting the Reverse button.

Arm and Trigger

To define Arm and Trigger conditions, select a respective Type from each drop-down menu. Then 
click the Arm or Trigger button to open the corresponding definition window. 

You can use an external input as an Arm condition. Check Trigger from Domain A (or B) to enable 
this feature. You must put the corresponding Jammer port into a domain for this to work properly. 

The Trigger event can be in the next Dword after the Arm event in the traffic stream.

Jam

To define a Jam: 

1 Select a Type from the drop-down menu, if available.

2 Click the Jam button to open the Jam Definition window.

The Jam Definition specifies the modifications to be made to the traffic matching the Trigger 
Condition.
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In addition, the Jammer port can trigger out to the Domain it is in when a Jam takes place. 
Check Trigger Domain A (or B) upon Jam to enable this feature.

Figure 103:  Trigger In and Trigger Out

Note: If you use an external trigger input to define the Arm condition, then you cannot select 
the external trigger output for that path in that Test Case, and vice versa. For information 
regarding using the trigger input and output during a Test Case, refer to “Using Domains and 
External Triggering” on page 291. However, you can use an external trigger in on port A with 
an external trigger out on port B, and vice versa. Figure 103 shows an example.
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Rollback

The Rollback option defines the time or Dword count parameter between the Arm and Trigger 
events. If the Trigger does not follow the Arm event in the allotted time or Dword count, the 
Jammer begins looking for the Arm event again. Click Rollback to display the dialog shown in 
Figure 104. 

Figure 104:  Rollback Condition Dialog

Timeout

The timeout option defines the period of time to wait for a specified test to complete before 
aborting and proceeding to the next test in the suite.

To set the timeout:

1 Click Timeout to display the dialog box in Figure 105. 

2 Check Enable Timeout.

3 Enter the hours, minutes, and seconds you want to wait.

Figure 105:  Timeout Dialog

4 Click OK.

Note: This value is saved in terms of Dwords, not time, so keep this in mind if you save a 
Test Case using a device running at 3.0 Gbps and later open the configuration on a Jammer 
running at 1.5 Gbps.
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Repeat

Click Repeat to open the dialog shown in Figure 108. For Basic Jammer Configurations, the 
Repeat Mode setting allows you to configure what is repeated when using an Arm condition. The 
Repeat Mode option means that the Jammer must match the Arm condition each time before 
looking for a Trigger. The Repeat Count allows you set the number of times a test case is repeated. 
The limit for repeating a test for 6G SAS/SATA is 2,147,483,647, and for 12G SAS, the limit is 
32,767.

Figure 106:  Repeat Test Dialog - Basic Jammer Configuration

Pause

Click Pause to open the dialog shown in Figure 107. The Pause setting allows you to insert a 
pause before the beginning of a test case. 

Figure 107:  Pause Test Dialog

For Advanced Jammer Configurations, this setting allows you to configure what is repeated when 
using an Arm or Trigger condition. The Repeat dialog uses counters to provide an increased level 
of control over the Jam allowing you to skip over extraneous instances of the arm or trigger 
condition and target the precise data you want to Jam. 

You can force the Jammer to match the Arm condition a given number of times before triggering, 
and you can skip a given number of occurrences of the trigger before Jamming. Once you reach 
the Jam, you can Jam all occurrences of the trigger condition forever or jam a given number of 
sequential occurrences of the trigger condition.
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Unless you select to Jam forever, you can choose to repeat all or part of the arm-trigger-Jam 
process either returning to the pre-armed state waiting for another occurrence of the arm condition 
or returning to the armed state waiting for another occurrence of the trigger condition.

The Repeat Mode option means that the Jammer must match the Arm condition each time before 
looking for a Trigger. The Repeat Count allows you set the number of times a test case is repeated.

Figure 108:  Repeat Test Dialog- Advanced Jammer Configuration

You can also configure options for each Test Case directly in the Test Suite, instead of clicking in 
the Current Jammer Test pane. Click on the area of the Test Case you want to modify to open the 
corresponding dialog (Figure 109).

Note: For 12G SAS blades, there is a eight clock latency between the arm and trigger/jam 
state and between the jam and arm state.
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Figure 109:  Configuring Options Directly in the Test Suite

Configuring SAS Arm and Trigger Conditions

SAS Arm and Trigger conditions recognize specific frames or Primitives. 

For Frame conditions, you can specify SOF, SOAF, or either (use all Xs for “either”). You can 
specify up to 31 additional Dwords after the SOF or SOAF. 

You can also define a wildcard specifying bits to be masked out of an arm word and passed 
through in the corresponding trigger word.

For Primitive Conditions, you can choose from groups of Single, Extended, Triple, or Redundant 
Primitive Sequences.

For a Single Primitive Sequence, you can specify any standard Single Primitive Sequence or you 
can specify any user-defined 4 bytes of K/D characters (of which standard Primitives are a subset). 
You can also specify where you want the Jammer to look for the matching Dword: only inside 
frames, only outside frames, or anywhere. 

Note: The Jammer does not look for any matching conditions during OOB initialization or 
Speed Negotiation.
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For Triple, Extended, and Redundant Primitive Sequences, you can choose any standard Extended, 
Triple or Redundant Primitive Sequence. To match the condition, the Jammer only needs to match 
one valid Primitive.

You can save an arm or trigger condition as a .jmt file by clicking the Save button in the Arm or 
Trigger window. You can load a .jmt file by clicking the Load button in the Arm or Trigger 
window.

The Arm and Trigger windows are identical. In addition, you can select the domain triggered input 
as an Arm condition.

Depending on the Mode you select, the appropriate graphic diagram shows the Trigger and 
optional Arm conditions, along with the Jam event. If the Mode you select does not include an 
Arm condition, the Arm button remains disabled. 

To set Arm and Trigger conditions: 

1 Click on the Arm or Trigger button in the Jammer Configuration window. 

The window for the condition is displayed (Figure 110). If you are in hardware edit mode, the 
protocol, chassis name, chassis number, slot number, and port numbers are displayed in the 
title bar.

2 Set the values as required to specify a unique Arm and Trigger sequence for the specific test.

The following sections describe the available values.
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Figure 110:  SAS Frame Arm and Trigger Window Examples
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Figure 111:  SAS Primitives Arm and Trigger Window Examples

Setting Frame Conditions

You can specify frame conditions in three ways: 

• Load a template from the Template Library tree

• Manually specify bits in the frame

• Select fields from the tree view in the right pane

To use a template:

1 Select a template from the Template Library tree on the left.

2 Click the double right arrow button to set the Frame Condition. 

The condition is indicated on the right side of the window.

To manually specify a frame: 

>> Type hexadecimal values directly into the center column of the window.

An X represents a nibble that can by any value (a “don’t care”). 
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To set individual bits in any field, double-click on the hex entry to open the Binary Editor 
(Figure 112). In the hex view, partially defined hex characters appear as question marks: 
X001=?

When you use the tree view, values are automatically entered into the center column in the right 
window pane.

Figure 112:  Binary Editor Dialog

Saving a Frame Condition

If you create a frame condition that you want to save and make easily available for future use, you 
can save it into the “User Library” folder in the Template Library tree. To do this:

>> Click the double left arrow button.

Frame conditions have the option of “Use inverse of condition specified (i.e. NOT).” When you 
check this option, it means that the first frame encountered that does not match what you have 
specified creates a “condition met” event.

For each frame condition, you can specify an optional name at the top of the window. This name is 
also shown on the Jammer Configuration window under the Type selection, and on the main Xgig 
Maestro window.

Setting Primitive Sequence Conditions

You can choose a Primitive Sequence from any of the categories listed on the left side of the 
window: Single, Extended, Triple, or Redundant. For Single Primitives, you can also choose 
where to match: anywhere, only outside of frames, or only inside of frames.

Single Primitives include a User-defined option.

To edit the user-defined value:

>> Type a hex value into the byte field.

Or 

>> Double-click on a byte field to open the Binary Editor. 

As in frame conditions, an X indicates “don’t care” and a ? indicates a partially specified hex 
character.

Or
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>> Click to toggle between K and D, and choose data from the drop-down menu of legal 8-bit 
characters.

Figure 113:  Selecting K and D Legal 8-bit Characters

You can also check the “Use inverse of condition specified (i.e. NOT)” option; this means the first 
word encountered that does not match what you have specified creates a “condition met” event.

As with frame conditions, you can specify an optional name at the top of the window. This name is 
also shown in the Jammer Configuration window under the Type selection and on the main Xgig 
Maestro window.

Configuring the SAS Jam Definition

The SAS Jam Definition window defines how to modify the event specified on the Trigger 
Condition window.

The Jam is always the same type (frame or Primitive Sequence) as the Trigger.

For any Jam Definition, you can specify an optional name at the top of the window. This name is 
also displayed on the Jammer Configuration window under the Type selection and on the main 
Xgig Maestro window.

You can save a Jam definition as a .jmj file by clicking the Save button in the Jam window. You 
can load a .jmj file by clicking the Load button in the Jam window.
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Jamming a Frame

If the Trigger Event is a frame, click the Jam button on the Jammer Configuration window to open 
the Frame Jam Definition window.

The content of the Jam Definition window corresponds to the type of frame Jam you choose on the 
Jammer Configuration window (modify frame, truncate frame, or replace frame with Idles). The 
following paragraphs describe these choices.

Jam Behavior

This controls the number of user-defined header/payload Jams performed relative to the target 
trigger frame. The Jam Behavior section is present on all tabs of the Frame Jam Definition 
window.

Figure 114:  Jam Behavior Selection

• Jam until end of trigger frame

Jams defined in the Header/Payload tab are performed until the end of the target trigger frame 
(or until an abnormal termination of the frame). All Jams defined that would take place on the 
original CRC or later are ignored. However, if the frame that is triggered on has more Dwords 
than the Jams you specify, the remaining Dwords are passed through. The CRC and EOF of 
the original target trigger frame are always jammed according to the CRC and EOF settings on 
the SOF/CRC/EOF tab. This is the standard way to Jam a frame.

• Execute full Jam pattern

All header and payload Jams take place, even if they overwrite beyond the end of the target 
trigger frame. Use the control at the bottom of the Header/Payload tab to define how many 
Jams should take place. 

The last defined Jam is the last Header/Payload Jam. The options for modifying the CRC and 
EOF on the SOF/CRC/EOF tab are unavailable. 

If the target trigger frame is longer than the number of Jams defined, then the portion of the 
target trigger frame that extends after the last defined Jam is overwritten with Idles. If the 
target trigger frame is shorter, then the Jammer switches back to pass-through immediately 
after the last defined Jam.

Note: Be careful when using this option because you may overwrite a portion of important 
traffic (a frame or Flow Control Primitives).
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Replace Frame with Modified Frame

Each tab contains options relevant to different frame modifications.

Using the Global Tab

Use this tab (Figure 115) to define Jam parameters that apply globally to the frame.

Global Replace Jam Option

Use the Global Replacement Dword to set specific bits in a Dword to 1 or 0 while passing through 
the remaining bits. You can apply this global replacement to any Dword in the frame. Define one 
Global Replacement for each Test Case.

To edit these bits: 

>> Enter hex values, or double-click on a byte field to open the Binary Editor. 

Any bits left as Xs are passed through.

The difference between this Global Replacement option versus the Replace Dword option found 
on the Header/Payload tab is that the Global Replacement option allows masking down to the bit 
level, whereas the other option allows masking at the nibble level.

Figure 115:  SAS Global Tab

This option is only available in the SAS/SATA Advanced
Jammer configuration.
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Global Bit Errors

The Jammer software can introduce bit errors repeatedly in sequential or random fashion to 
predefined fields. These bit errors are introduced to the 32-bit form of the target Dwords (not the 
40-bit form) so code violations are not created. The Global Bit Errors control allows you four 
options.

• Select one bit for all fields and randomly. This causes the Jammer to inject a single bit error 
in the group of all fields selected in the header or payload for a single Test Case. If the Jammer 
Test Suite is set to loop, then single bit errors are randomly injected into these fields, with one 
bit for each cycle of the Test Suite.

• Select one bit for all fields and sequentially. This also injects a single bit error in the group 
of all fields selected in the header or payload. If the Test Suite is set to loop forever, the bit 
error walks through all the selected fields.

• Select one bit in each field and randomly does the same thing as the first option; however, 
there will be one error for each Dword selected in the header or payload.

• Select one bit in each field and sequentially does the same thing as the second option; 
however, there will be one error for each Dword selected in the header or payload.

Global Timer for Jam with D.C. Idle

In an Advanced SAS/SATA Jammer configuration, the Jammer software allows you to set a global 
timer for Jamming with D.C. Idles. When using this option, DCI will continue until the timer 
expires regardless of the triggering item.

Note: The location of the bit errors are moved each time you run this entire Test Case, not 
each time you repeat the Jam within the Test Case.
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Using the SOF/CRC/EOF Tab

Use the choices on this tab to modify the Start of Frame (SOF), Cyclic Redundancy Check (CRC), 
and End of Frame (EOF) Dwords of the original target frame (Figure 116).

Figure 116:  Serial Attached SCSI SOF/CRC/EOF Tab

SOF/EOF Options

You can pass through or replace the start and end of frame Dwords with another SOF, EOF, 
another standard Primitive, a Scrambled Idle Dword, or any four user-defined K/D characters. In 
addition to these options, you can send an error on any byte of the Dwords.

DCI options are available only in the Advanced SAS/SATA Jammer configurations. These allow 
you to replace a Dword with a DCI or to send DCI with the Global timer set in the Global tab.

Check Inject Error for any byte(s) on which you want to send errors. Then choose Disparity Error 
or Code Violation. If you choose Disparity Error, the Jammer inverts the running disparity at that 
byte. If that byte is a neutral 10b character, you might not see the disparity error until a later byte. 
The Code Violation option replaces the byte with a predefined 10-bit illegal character. 

DCI options are only available with the SAS/SATA
Jammer Advanced configuration.
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CRC Options

CRC options include:

• Not changing the CRC in the original target frame

• Recalculating the CRC to make it correct for the modified data 

• Replace Dword with DCI

• Send DCI (with Global timer)

• Replacing with a user-specified data Dword or Primitive

With the addition of recalculating the CRC, you configure the CRC option in the same way as the 
SOF/EOF options.

Depending on the changes made to a frame, the old CRC might be invalid. If the CRC is passed 
through, an invalid frame might be created. The lowest layer of protocol error checking should 
recognize this type of error. If the frame is modified and the CRC is recalculated, a valid frame 
with modified data is created. If, for example, the modifications are made to SCSI commands 
embedded in the payload, the SCSI error checking routines should trap and handle the error.

Recalculating a CRC might not work if you corrupt the frame with illegal Primitives, errors, or 
Scrambled Idle Dwords.

Using the Header/Payload Tab 

You can modify any and all words in the header and payload (Figure 117). Select either the 
Replace Jam or All Jam Modes radio button. 

Similar to defining an Arm or Trigger Condition, there are two ways to specify your frame Jam 
Definition. One way is to load a template from the Template Library tree, and the other way is to 
manually specify bits in the frame.

To use a template:

1 Highlight a template in the Template Library tree on the left side of the window. 

Tree View is structured similar to the display on the right side of the Arm and Trigger 
Condition windows. You can make selections from the tree; this creates the appropriate 
Replace Jams.

2 Click the double right arrow to display the Jam definition on the right side of the window. 

When you use a template, the Jam definition is populated with Replace Jams of the specified data, 
while all other bits are passed through.

To manually edit the values, enter a value into the byte field. An X in a nibble passes the original 
value through.  

Note: The more Dwords in a Jam Definition, the longer the time between Test Cases in the 
suite. Switching from one Test Case to the next is a software operation, so the time between 
cases will be on the order of hundreds of milliseconds.
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Figure 117:  SAS Header/Payload Tab

To manually define each nibble, enter a value into the byte field or double-click to display the 
Binary Editor. If you specify a bit as a 0 or 1, you must specify the values of the other three bits in 
that nibble as well. An X in a nibble passes the original value through. Choose any K/D character 
for an entire byte by using the drop-down controls. Click on the K or D to toggle this setting.

Use the Number of Header + Payload Dwords counter to define the number of Dwords to Jam. 
(Figure 118). Use the scroll bar to position the display to the desired Dword, if necessary.

Figure 118:  Setting Header + Payload Size

You can also use the List View controls at the top to cut, copy, paste, add, insert, or delete Dwords.

Notice the special choice at the bottom left, Current Trigger (Figure 119). This is a copy of the 
frame condition you have specified for the Trigger. The name of the Trigger Condition (if any) is 
shown in parenthesis. Click the double right arrow to use this.
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Figure 119:  Current Trigger Option

To manually specify a frame Dword Jam, select the All Jam Modes radio button. Select a Jam 
Type from the drop-down menu (under the Type column), then specify any additional definition (if 
necessary) by clicking on the data field (under the Description column).

Selecting the Replace Jam Mode radio button opens a dialog that allows you to replace an entire 
frame either by using a template or manually entering values. The Replace Jam Mode dialog also 
contains a view of the frame contents, similar to those seen the Arm and Trigger Condition 
windows. These values correspond to the hex values defined in the center column. 

Figure 120:  Replace Jam Mode

Selecting the All Jam Modes radio button opens a dialog that provides the following choices are 
available for each Dword in a frame on the Header/Payload tab:

• Replace 8b Jam Mode - This function allows you to replace the Dword with any standard 
Primitive, a Scrambled Idle Dword, or a user-defined Dword (Figure 121). 
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Figure 121:  Replace Jam Dialog

• Replace 10b Jam (Advanced Jammer Configurations only) - This function allows you to 
replace the Dword with any standard Primitive, a Scrambled Idle Dword, or a user-defined 
Dword.

• Apply Global Replace Jam - This function allows individual bits to be set to 1, set to 0 or 
passed through unchanged according to the Global Replacement Dword defined on the Global 
Tab.

• Create Error Jam - Check Inject Error for any byte(s) on which you want to send errors 
(Figure 122). Then choose Disparity Error or Code Violation. If you choose Disparity Error, 
the Jammer inverts the running disparity at that byte. If that byte is a neutral 10b character, you 
might not see the disparity error until a later byte. The Code Violation option replaces the byte 
with a predefined 10-bit illegal character.

Figure 122:  Create Error Dialog

• Invert Jam - Invert defined bits and pass through the rest. Enter 1s at the appropriate bit 
locations.

• Pass Through Jam - Pass through the current Dword unchanged.

• Replace Jam with CRC - This word contains the current CRC value. CRC calculation is reset 
and started at the Dword after any SOF. Note that there should be only valid data Dwords 
between an SOF and its partner automatic CRC insertion or else the CRC value will be 
incorrect. Violations of this rule include using Primitives, Scrambled Idle Dwords, or code 
violations.

Note: If you place an SOF in Dword 2, and an automatic CRC in Dword 10, the CRC is 
calculated over Dwords 3 to 9.
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• Set Bits To 0s Jam- Set defined bits to 0s and pass through the rest. Enter 0s at the 
appropriate bit locations.

• Set Bits To 1s Jam - Set defined bits to 1s and pass through the rest. Enter 1s at the 
appropriate bit locations.

• Apply Global Bit Error Jam - Apply the Global Bit Error function set on the Global tab. Enter 
1s at the appropriate bit locations (Figure 123). 

Figure 123:  Apply Global Bit Error Jam Bit Location Dialog

Replace Frame with Truncated Frame

This option truncates the target frame to a shorter length and sends Scrambled Idle Dwords on top 
of the remainder of the target frame (Figure 124).

>> Use the up and down arrow buttons or type the number of Dwords you want to truncate the 
frame to (including header and payload, not including SOF, CRC, and EOF). 

You can pass through or replace the SOF Dword with another SOF, another standard Primitive, a 
Scrambled Idle Dword, or any four user-defined K/D characters. In addition to these options, you 
can send an error on any byte of the Dword.

DCI options are available only in the Advanced SAS/SATA Jammer configurations. These allow 
you to replace a Dword with a DCI or to send DCI with the Global timer set in the Global tab.

The CRC must be replaced or recalculated in one of the following ways:

• Recalculating the CRC to make it correct for the modified data 

• Replacing with a user-specified data Dword or Primitive

• Replace Dword with DCI

• Send DCI (with Global timer)

Replacing the CRC is specified the same way as the SOF. You can also send an error on any byte.

You must select a replacement Dword for the EOF. This is specified in the same way as the SOF. 
You can also send an error on any byte.
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Check Inject Error for any byte(s) on which you want to send errors. Then choose Disparity Error 
or Code Violation. If you choose Disparity Error, the Jammer inverts the running disparity at that 
byte. If that byte is a neutral 10b character, you might not see the disparity error until a later byte. 
The Code Violation option replaces the byte with a predefined 10-bit illegal character.

Figure 124:  SAS - Replace Frame with Truncated Frame

Replace Frame with Scrambled Idle Dwords

This option replaces the target frame with Scrambled Idle Dwords. The following dialog is 
displayed (Figure 125).

Figure 125:  SAS - Replace Frame with Scrambled Idle Dwords.

Jamming a Primitive Sequence

If the Trigger Event is a Primitive Sequence, click the Jam button on the Jammer Configuration 
window to open the Primitive Sequence Jam Definition window (Figure 126, Figure 127, 
Figure 128).

DCI options are only available with the SAS/SATA
Jammer Advanced configuration.
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Figure 126:  Single Primitive Sequence Jam Definition Window 

Figure 127:  Triple Primitive Sequence Jam Definition Window

DCI options are only available with the SAS/SATA
Jammer Advanced configuration.

DCI options are only available with the SAS/SATA
Jammer Advanced configuration.
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Figure 128:  Redundant Primitive Sequence Jam Definition Window 

The number of Dwords shown in the Definition window corresponds to the type of Primitive 
Sequence you specified as the Trigger Condition (one Dword for a Single or Extended, four for a 
Triple, or seven for a Redundant Primitive Sequence). 

Ideally, any Triple or Redundant Sequences that the Jammer triggers on should be three or six 
Dwords long, respectively. If the Dwords are shorter, then the Jammer does not use all of the Jams 
specified in this widow. If the Dwords are longer, than any Dword over the ideal third or sixth 
Dword in the sequence is Jammed according to the fourth or seventh Dword Jam Definition, 
respectively.

For each Dword, you have three options:

• Pass through the Primitive

• Corrupt any byte(s) with an error

• Replace Dword with DCI

• Send DCI (with Global timer)

DCI options are only available with the SAS/SATA
Jammer Advanced configuration.
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• Replace the Primitive with a new Dword

To pass through a Primitive, select the top option for that Dword.

To create an error, select Create Error for that Dword. Then check Inject Error for any byte(s) on 
which you want to send errors. Then choose Disparity Error or Code Violation. If you choose 
Disparity Error, the Jammer inverts the running disparity at that byte. If that byte is a neutral 10b 
character, you might not see the disparity error until a later byte. The Code Violation option 
replaces the byte with a predefined 10-bit illegal character. 

DCI options are available only in the Advanced SAS/SATA Jammer configurations. These allow 
you to replace a Dword with a DCI or to send DCI with the Global timer set in the Global tab.

You can replace the Dword with any K/D characters, any standard Primitive, or a Scrambled Idle 
Dword, by selecting the bottom option and choosing from the drop-down list.

Configuring SATA/STP Arm and Trigger Conditions

Arm and Trigger conditions recognize specific frames or Primitives. 

For Frame conditions, SATA_SOF is automatically specified. You can specify up to 31 additional 
Dwords after the SOF.

You can also define a wildcard specifying bits to be masked out of an arm word and passed 
through in the corresponding trigger word.

For Primitive Conditions, you can choose from groups of Single, Repeated, or Continued 
Primitive Sequences.

For a Single Primitive Sequence, you can specify any standard Single Primitive Sequence. You 
can also specify where you want the Jammer to look for the matching Dword: only inside frames, 
only outside frames, or anywhere. 

For Repeated Primitive Sequences, you can choose either SATA_PMACK or SATA_PMNAK.

For Continued Primitive Sequences, you can choose any standard Continued Primitive Sequence.

The Arm and Trigger windows are identical (Figure 130 and Figure 131). In addition, you can 
select the domain triggered input as an Arm condition.

Depending on the Mode you select, the appropriate graphic diagram shows the Trigger and 
optional Arm conditions, along with the Jam event. If the Mode you select does not include an 
Arm condition, the Arm button remains disabled. 

To set Arm and Trigger conditions: 

1 Click the Arm or Trigger button in the Jammer Configuration window. 

The window for the condition is displayed (Figure 129). If you are in hardware edit mode, 
chassis name, chassis number, slot number, and port numbers are displayed in the title bar.

Note: The Jammer does not look for any matching conditions during OOB initialization or 
speed negotiation.
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2 Set the values as required to specify a unique Arm and Trigger sequence for the specific test.

The following sections describe the available values.

Figure 129:  SATA/STP Frame Arm and Trigger Window Examples
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Figure 130:  SATA/STP Continued Primitives Arm Window Example

Figure 131:  SATA/STP Single Primitive Trigger Window Example



Creating Jammer Test Configurations for SAS and SATA/STP Configuring SATA/STP Arm and Trigger Conditions

146 Xgig Jammer and Delay Emulator User Guide

  

Figure 132:  SATA/STP Repeated Primitives Trigger Window Example

Setting Frame Conditions

You can specify frame conditions in three ways: 

• Load a template from the Template Library tree

• Manually specify bits in the frame

• Select fields from the tree view in the right pane

To use a template:

1 Select a template from the Template Library tree on the left.

2 Click the double right arrow button to set the Trigger Condition. 

The condition is indicated on the right side of the window.

To manually specify a frame: 

>> Type hexadecimal values directly into the center column of the window.

An X represents a nibble that can be any value (a “don’t care”). 

To set individual bits in any field, double-click on the hex entry to open the Binary Editor 
(Figure 133 on page 147). In the hex view, partially defined hex characters appear as question 
marks: X001=?

When you use the tree view, values are automatically entered into the center column in the right 
window pane.
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Figure 133:  Binary Editor Dialog

Saving a Frame Condition

If you create a frame condition that you want to save and make easily available for future use, you 
can save it into the “User Library” folder in the Template Library tree. To do this:

>> Highlight the folder and click the double left arrow button.

Frame conditions have the option of “Use inverse of condition specified (i.e., NOT).” When you 
check this option, it means that the first frame encountered that does not match what you have 
specified creates a “condition met” event.

For each frame condition, you can specify an optional name at the top of the window. This name is 
also shown on the Jammer Configuration window under the Type selection, and on the main Xgig 
Maestro window.
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Setting Primitive Sequence Conditions

You can choose a Primitive Sequence from any of the categories on the left side of the window: 
Single, Repeated, or Continued. For Single Primitives, you can also choose where to match: 
anywhere, only outside of frames, or only inside of frames. 

Figure 134:  SATA/STP Single Primitive Sequence Conditions Example

You can check the “Use inverse of condition specified (i.e. NOT)” option; this means the first 
Dword encountered that does not match what you have specified creates a “condition met” event.

As with frame conditions, you can specify an optional name at the top of the window. This name is 
also shown in the Jammer Configuration window under the Type selection and on the main Xgig 
Maestro window.

Configuring the SATA/STP Jam Definition

The Jam Definition window defines how to modify the event specified on the Trigger Condition 
window.

The Jam is always the same type (frame or Primitive Sequence) as the Trigger.

For any Jam Definition, you can specify an optional name at the top of the window. This name is 
also displayed on the Jammer Configuration window under the Type selection and on the main 
Xgig Maestro window.

You can save a Jam definition as a .jmj file by clicking the Save button in the Jam window. You 
can load a .jmj file by clicking the Load button in the Jam window.

Select where to match

Select sequences
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Jamming a Frame

If the Trigger Event is a frame, click the Jam button on the Jammer Configuration window to open 
the Frame Jam Definition window.

The content of the Jam Definition window corresponds to the type of frame Jam you choose on the 
Jammer Configuration window (modify frame, truncate frame, or replace frame with 
SATA_SYNC Continued Primitive Sequence). The following paragraphs describe these choices.

Replace Frame with Modified Frame

Each tab contains options relevant to different frame modifications.

Using the Global Tab

Use this tab (Figure 135) to define Jam parameters that apply globally to the frame.

Global Replace Jam Option

Use the Global Replacement Dword to set specific bits in a Dword to 1 or 0 while passing through 
the remaining bits. You can apply this global replacement to any Dword in the frame. Define one 
Global Replacement for each Test Case.

To edit these bits: 

>> Enter hex values, or double-click on a byte field to open the Binary Editor. 

Any bits left as Xs are passed through.

The difference between this Global Replacement option versus the Replace Dword option found 
on the Header/Payload tab is that the Global Replacement option allows masking down to the bit 
level, whereas the other option allows masking at the nibble level.

Figure 135:  SATA/STP Global Tab

This option is only available for the Advanced
SAS/SATA Jammer configuration.
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Global Bit Errors

The Jammer software can introduce bit errors repeatedly in sequential or random fashion to 
predefined fields. These bit errors are introduced to the 32-bit form of the target Dwords (not the 
40-bit form) so code violations are not created. The Global Bit Errors control allows you four 
options.

• Select one bit for all fields and randomly. This causes the Jammer to inject a single bit error 
in the group of all fields selected in the header or payload for a single Test Case. If the Jammer 
Test Suite is set to loop, then single bit errors are randomly injected into these fields, with one 
bit for each cycle of the Test Suite.

• Select one bit for all fields and sequentially. This also injects a single bit error in the group 
of all fields selected in the header or payload. If the Test Suite is set to loop forever, the bit 
error walks through all the selected fields.

• Select one bit in each field and randomly does the same thing as the first option; however, 
there will be one error for each Dword selected in the header or payload.

• Select one bit in each field and sequentially does the same thing as the second option; 
however, there will be one error for each Dword selected in the header or payload.

Global Timer for Jam with D.C. Idle

In an Advanced SAS/SATA Jammer configuration, the Jammer software allows you to set a global 
timer for Jamming with D.C. Idles. When using this option, DCI will continue until the timer 
expires regardless of the triggering item.

Note: The location of the bit errors are moved each time you run this entire Test Case, not 
each time you repeat the Jam within the Test Case.
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Using the SOF/CRC/EOF Tab

Use the choices on this tab to modify the Start of Frame (SOF), Cyclic Redundancy Check (CRC), 
and End of Frame (EOF) Dwords of the original target frame (Figure 136).

Figure 136:  SATA/STP SOF/CRC/EOF Tab

SOF/EOF Options

You can pass through or replace the start and end of frame Dwords with another standard 
Primitive, Scrambled Primitive Data, or any four user-defined K/D characters. In addition to these 
options, you can send an error on any byte of the Dwords.

DCI options are available only in the Advanced SAS/SATA Jammer configurations. These allow 
you to replace a Dword with a DCI or to send DCI with the Global timer set in the Global tab.

Check Inject Error for any byte(s) on which you want to send errors. Then choose Disparity Error 
or Code Violation. If you choose Disparity Error, the Jammer inverts the running disparity at that 
byte. If that byte is a neutral 10b character, you might not see the disparity error until a later byte. 
The Code Violation option replaces the byte with a predefined 10-bit illegal character. 

DCI options are only available with the SAS/SATA
Jammer Advanced configuration.
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CRC Options

CRC options include:

• Not changing the CRC in the original target frame

• Replace Dword with DCI

• Send DCI (with Global timer)

• Recalculating the CRC to make it correct for the modified data 

• Replacing with a user-specified data Dword, Primitive, or Scrambled Primitive Data

With the addition of recalculating the CRC, you configure the CRC option in the same way as the 
SOF/EOF options.

Depending on the changes made to a frame, the old CRC might be invalid. If the CRC is passed 
through, an invalid frame might be created. The lowest layer of protocol error checking should 
recognize this type of error. If the frame is modified and the CRC is recalculated, a valid frame 
with modified data is created. 

Using the Header/Payload Tab 

Similar to defining an Arm or Trigger Condition, there are two ways to specify your frame Jam 
Definition. One way is to load a template from the Template Library tree, and the other way is to 
manually specify bits in the frame.

To use a template:

1 Highlight a template in the Template Library tree on the left side of the window. 

Tree View is structured similar to the display on the right side of the Arm and Trigger 
Condition windows. You can make selections from the tree; this creates the appropriate 
Replace Jams.

2 Click the double right arrow to display the Jam definition on the right side of the window. 

When you use a template, the Jam definition is populated with Replace Jams of the specified data, 
while all other bits are passed through.

To manually edit the values, enter a value into the byte field. An X in a nibble passes the original 
value through.  

Note: The more Dwords in a Jam Definition, the longer the time between Test Cases in the 
suite. Switching from one Test Case to the next is a software operation, so the time between 
cases will be on the order of hundreds of milliseconds.
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Figure 137:  SATA/STP Header/Payload Tab

To manually define each nibble, enter a value into the byte field or double-click to display the 
Binary Editor. If you specify a bit as a 0 or 1, you must specify the values of the other three bits in 
that nibble as well. An X in a nibble passes the original value through. Choose any K/D character 
for an entire byte by using the drop-down controls. Click on the K or D to toggle this setting.

Use the Number of Header + Payload Dwords counter to define the number of Dwords to Jam 
(Figure 138). Use the scroll bar to position the display to the desired Dword, if necessary.

Figure 138:  Setting Header + Payload Size

You can also use the List View controls at the top to cut, copy, paste, add, insert, or delete Dwords.

Notice the special choice at the bottom left, Current Trigger (Figure 139). This is a copy of the 
frame condition you have specified for the Trigger. The name of the Trigger Condition (if any) is 
shown in parenthesis. Click the double right arrow to use this.
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Figure 139:  Current Trigger Option

To manually specify a frame Dword Jam, select the All Jam Modes radio button. Select a Jam 
Type from the drop-down menu (under the Type column), then specify any additional definition (if 
necessary) by clicking on the data field (under the Description column).

Selecting the Replace Jam Mode radio button opens a dialog that allows you to replace an entire 
frame either by using a template or manually entering values. The Replace Jam Mode dialog also 
contains a view of the frame contents, similar to those seen the Arm and Trigger Condition 
windows. These values correspond to the hex values defined in the center column. 

Figure 140:  Replace 8b Jam Mode

Selecting the All Jam Modes radio button opens a dialog that provides the following choices are 
available for each Dword in a frame on the Header/Payload tab:

• Apply Global Replace Jam - This function allows individual bits to be set to 1, set to 0 or 
passed through unchanged according to the Global Replacement Dword defined on the Global 
Tab.

• Replace 8b Jam Mode - This function allows you to replace the Dword with any standard 
Primitive, a Scrambled Idle Dword, or a user-defined Dword (Figure 141). 
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Figure 141:  Replace 8b Jam Dialog

• Replace 10b Jam (Advanced Jammer Configurations only) - This function allows you to 
replace the Dword with any standard Primitive, a Scrambled Idle Dword, or a user-defined 
Dword (Figure 141). 

• Create Error Jam - Check Inject Error for any byte(s) on which you want to send errors 
(Figure 142). Then choose Disparity Error or Code Violation. If you choose Disparity Error, 
the Jammer inverts the running disparity at that byte. If that byte is a neutral 10b character, you 
might not see the disparity error until a later byte. The Code Violation option replaces the byte 
with a predefined 10-bit illegal character.

Figure 142:  Create Error Dialog

• Invert Jam - Invert defined bits and pass through the rest. Enter 1s at the appropriate bit 
locations.

• Pass Through Jam - Pass through the current Dword unchanged.

• Replace 8b Jam - You can replace the Dword with any standard Primitive, Scrambled 
Primitive Data, or a user-defined Dword (Figure 141). 

To define each nibble, enter a value into the byte field or double-click to display the Binary 
Editor. If you specify a bit as a 0 or 1, you must specify the values of the other three bits in that 
nibble also. An X in a nibble passes the original value through. Choose any K/D character for 
an entire byte by using the drop-down controls. Click on the K or D to toggle this setting.
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• Replace Jam with CRC - This word contains the current CRC value. CRC calculation is reset 
and started at the Dword after any SOF. Note that there should be only valid data Dwords 
between an SOF and its partner automatic CRC insertion or else the CRC value will be 
incorrect. Violations of this rule include using Primitives, Scrambled Primitive Data, or code 
violations.

• Set Bits To 0s Jam- Set defined bits to 0s and pass through the rest. Enter 0s at the 
appropriate bit locations.

• Set Bits To 1s Jam - Set defined bits to 1s and pass through the rest. Enter 1s at the 
appropriate bit locations.

• Apply Global Bit Error Jam - Apply the Global Bit Error function set on the Global tab. Enter 
1s at the appropriate bit locations (Figure 143). 

Figure 143:  Apply Global Bit Error Jam Bit Location Dialog

Replace Frame with Truncated Frame

This option truncates the target frame to a shorter length and sends SATA_WTRM on top of the 
remainder of the target frame (Figure 144).

>> Use the up and down arrow buttons or type the number of Dwords you want to truncate the 
frame to (including header and payload, not including SOF, CRC, and EOF). 

You can pass through or replace the SOF Dword with another standard Primitive, Scrambled 
Primitive Data, or any four user-defined K/D characters. In addition to these options, you can send 
an error on any byte of the Dword.

DCI options are available only in the Advanced SAS/SATA Jammer configurations. These allow 
you to replace a Dword with a DCI or to send DCI with the Global timer set in the Global tab.

The CRC must be replaced or recalculated in one of the following ways:

• Recalculating the CRC to make it correct for the modified data 

• Replacing with a user-specified data Dword or Primitive

• Relapse Dword with DCI

• Send DCI (with Global timer)

Replacing the CRC is specified the same way as the SOF. You can also send an error on any byte.

Note: If you place an SOF in Dword 2, and an automatic CRC in Dword 10, the CRC is 
calculated over Dwords 3 to 9.
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You must select a replacement Dword for the EOF. This is specified in the same way as the SOF. 
You can also send an error on any byte.

Check Inject Error for any byte(s) on which you want to send errors. Then choose Disparity Error 
or Code Violation. If you choose Disparity Error, the Jammer inverts the running disparity at that 
byte. If that byte is a neutral 10b character, you might not see the disparity error until a later byte. 
The Code Violation option replaces the byte with a predefined 10-bit illegal character.

Figure 144:  SATA/STP - Replace Frame with Truncated Frame

Replace with Scrambled Idle Dwords

This option replaces the target frame with Scrambled Idle Dwords. The following dialog is 
displayed (Figure 145).

Figure 145:  SAS - Replace Frame with Scrambled Idle Dwords.

DCI options are only available with the SAS/SATA
Jammer Advanced configuration.
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Jamming a Primitive Sequence

If the Trigger Event is a Primitive Sequence, click the Jam button on the Jammer Configuration 
window, to open the Primitive Sequence Jam Definition window (Figure 146, Figure 147, 
Figure 148). A dialog is displayed corresponding to your choice of Trigger Condition Primitive 
Sequence type.

Figure 146:  Single Primitive Sequence Jam Definition Window

Figure 147:  Continued Primitive Sequence Jam Definition Window

DCI options are only available with the SAS/SATA
Jammer Advanced configuration.

DCI option is only available with the SAS/SATA
Jammer Advanced configuration.
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Figure 148:  Repeated Primitive Sequence Jam Definition Window

Jamming a Single Primitive Sequence

For the Jam, you have three options:

• Pass through the Primitive

• Corrupt any byte(s) with an error

• Replace the Primitive with a new Dword

• Replace Dword with DCI

• Send DCI (with Global timer)

To pass through the Primitive, select the top option.

To create an error, select Create Error. Then check Inject Error for any byte(s) on which you want 
to send errors. Then choose Disparity Error or Code Violation. If you choose Disparity Error, the 
Jammer inverts the running disparity at that byte. If that byte is a neutral 10b character, you might 
not see the disparity error until a later byte. The Code Violation option replaces the byte with a 
predefined 10-bit illegal character. 

You can replace the Dword with any K/D characters, any standard Primitive, or Scrambled 
Primitive Data, by selecting the bottom option and choosing from the drop-down list.

DCI options are available only in the Advanced SAS/SATA Jammer configurations. These allow 
you to replace a Dword with a DCI or to send DCI with the Global timer set in the Global tab.

DCI options are only available with the SAS/SATA
Jammer Advanced configuration.
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Jamming a Continued or Repeated Primitive Sequence

Four options allow you to Jam the entire Primitive Sequence:

• Pass through entire sequence

• Create errors on every Dword of the sequence

• Replace every Dword of the sequence with a specific Dword

• Replace sequence with a Continued Primitive Sequence

• Send DCI (with Global timer)

Pass through and Create Errors work the same as Single Primitive Sequences.

You can replace every Dword of the sequence with another specific Dword by choosing 
Replace every Dword of sequence with this Primitive... You can replace the sequence with any 
K/D characters, any standard Primitives, or Scrambled Primitive Data by choosing from the 
drop-down menu. Choosing PMACK or PMNAK is equivalent to replacing with a Repeated 
Primitive Sequence.

You can replace the sequence with a standard Continued Primitive Sequence by choosing Replace 
sequence with this Continued Primitive Sequence... Choose from the drop-down menu.

DCI options are available only in the Advanced SAS/SATA Jammer configurations. These allow 
you to replace a Dword with a DCI or to send DCI with the Global timer set in the Global tab.
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Chapter 6
Creating Jammer Test Configurations for 10GigE

In this chapter:

• Defining Your Own Test Configurations for 10GigE

• Using the Jammer Configuration Window for 10GigE

• Configuring the Arm Condition for 10GigE

• Configuring the Trigger Condition for 10GigE

• Configuring the Jam Definition for 10GigE
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Defining Your Own Test Configurations for 10GigE

Xgig Jammer lets you define your own test configurations and save them with or without hardware 
available.

You can create a configuration from scratch, or you can open and edit an existing configuration. 
Also, you can edit a configuration in edit only mode, which is independent of any hardware, or 
you can edit a configuration that is currently loaded to a Jammer device.

To edit a configuration in edit only mode:

>> Double-click on a configuration file in the Configuration manager. 

or:

>> Right-click on the configuration file in the Configuration manager and choose Edit Jammer 
Configuration from the context menu.

The edit only mode Jammer Configuration window opens (Figure 149).

This window allows you to set up your own Test Cases, name them, organize them, and save 
them to files so that you can use them again.

Figure 149:  Edit Only Jammer Configuration Window

To start a configuration from scratch in edit only mode:

>> Select New Jammer Configuration from the context menu or the File menu (Figure 150) on 
the Xgig Maestro menu bar. Then, select 10 Gigabit Ethernet Jammer from the drop down 
menu.
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or:

>> Click the New Configuration icon at the top of the Configuration manager.

Figure 150:  Maestro File Menu

To save your configuration in edit only mode:

>> Click Save at the bottom of the Jammer Configuration window or open the File menu on the 
Jammer Configuration window and select Save Configuration or Save Configuration As.

Any changes you make have no effect on actual Jammer devices you control.

To edit a configuration that is loaded to a Jammer port:

>> Click Configuration... in the device column.

or:

>> Right-click in the Parameters Status table in the device column to open the context menu and 
select Edit configuration.

or: 

>> Click Operation in the device column to open the Operation dialog, then click Config.

The Xgig Jammer Configuration window in hardware edit mode is displayed (Figure 151). 
This window allows you to set up your own Test Cases, name them, and save them to a file so 
that you can use them again.

Click Apply or OK and Jammer accepts the changes. They are immediately reflected in the 
Parameters Status table and affect the Jammer device the next time you run it.

To save your configuration edits:

>> Open the File menu at the top of the Jammer Configuration window and select 
Save Configuration As... or Save Configuration.
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Figure 151:  Xgig Jammer Configuration Window

Using the Jammer Configuration Window for 10GigE

The Jammer Configuration window title bar indicates how many ports it is configuring, the 
protocol, and the configuration file name, if any. If you are using hardware edit mode, the chassis 
name, chassis number, slot number, and port number are also listed. The elements of the Jammer 
Configuration window are described in the following sections.

Using the Jammer Test Suite Tools for 10GigE

The Jammer Test Suite (left pane) lists the series of Xgig Jammer tests in the order in which you 
want them to execute. The suite includes one or more tests. The highlighted test appears as the 
Current Jammer Test (right pane). Each test in the suite executes in sequence with a test reset time 
of approximately 130 (200 max) milliseconds.
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Creating a Test Suite

When you create a 10GigE Jammer Test Suite, you use the toolbar in the Jammer Test Suite 
section of the Configuration window (Figure 152).

Figure 152:  10GigE Jammer Test Suite Toolbar

The following list describes the icons on the toolbar:

To duplicate a test at another point in the Test Suite:

1 Highlight the test you want to duplicate.

2 Click Copy.

3 Highlight the test in the suite that is just after the point where you want the duplicate test 
inserted.

4 Click Paste.

The duplicate test is inserted.

Refer to “Configuring the Arm Condition for 10GigE”, “Configuring the Trigger Condition 
for 10GigE” and “Configuring the Jam Definition for 10GigE” for information about 
configuring each test.

Cut current test Removes the highlighted test and holds its contents in the 
memory buffer.

Copy current text Copies the highlighted test to the memory buffer.

Paste last test cut or copied Inserts the current memory buffer contents before the currently 
highlighted test.

Add new test to bottom of stack Adds a new blank test to the bottom of the suite.

Insert new test before current test Inserts a new blank test above the currently highlighted test.

Delete current test Removes the highlighted test from the suite. If only one test is 
present, then the contents of this test are cleared.

Move current test down the stack Moves the highlighted test down one in the test order.

Move current test up the stack Moves the highlighted test up one in the test order.

Toggle view Toggles Test Suite between Card View and List View.

Run test suite once or Repeat test 
suite

When you choose Repeat test suite, the tests run according 
the settings you define in the Jammer Current Test window.
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Using the Configuration File Menu

The File menu is the only menu on the menu bar (Figure 153). 

Figure 153:  Configuration File Menu

The choices are:

The recently used 10GigE Jammer configuration files appear in the file menu and are loaded when 
selected.

Open Configuration Open an existing .tsk configuration file.

Import to Selected Test Import a Test Case from a .tst file or an entire test suite, .tsk file, to 
the currently highlighted position. A Test Case is one line in the Jammer 
Test Suite.

Export Selected Test Export and save the currently highlighted test to a .tst file.

Save Configuration Save the entire Test Suite to the .tsk file you currently have loaded.

Save Configuration As Save the entire Test Suite to a .tsk file with a name you assign to it.

Close Close the Jammer Configuration Window.

Note: The .tst files are only for storing individual Test Cases and swapping them between 
configuration files. You cannot load .tst files directly into a Jammer device on the Xgig 
Maestro window.
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Using the Current Jammer Test Window for 10GigE

The graphics in this section of the window represent the hardware configuration for the selected 
test in the Jammer Test Suite (Figure 154).

Figure 154:  Current Jammer Test Window

Mode

For 10GigE, Mode menus are available near the top of the Current Jammer Test window 
(Figure 155) and also near the top of each Test Case in the Jammer Test Suite window 
(Figure 156). 

The input to path A (on top) is always port A and the input to path B (on the bottom) is always port 
B. The external trigger input and output that are available on path A always are linked to the 
domain shown on the Xgig Maestro window as “Domain of port A.” The trigger input and output 
on the bottom on path B are in the “Domain of port B.” 
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Figure 155:  Mode Drop-down Menu in Current Jammer Test - Right Pane

Figure 156:  Mode Drop-down Menu in Test Suite - Left Pane

Reverse

You can reverse the direction of the jam by selecting the Reverse button.

Arm and Trigger

To define Arm and Trigger conditions, select a respective Type from each drop-down menu. Then 
click the Arm or Trigger button to open the corresponding definition window. 

You can use an external input as an Arm condition. Check Trigger from Domain A (or B) to enable 
this feature. You must put the corresponding Jammer port into a domain for this to work properly. 

The Trigger event can be in the next Dword after the Arm event in the traffic stream.

Jam

To define a Jam: 

1 Select a Type from the drop-down menu, if available.

2 Click the Jam button to open the Jam Definition window.

The Jam Definition specifies the modifications to be made to the traffic matching the Trigger 
Condition.
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In addition, the Jammer port can trigger out to the Domain it is in when a Jam takes place. 
Check Trigger Domain A (or B) upon Jam to enable this feature.

Figure 157:  Trigger In and Trigger Out

Note: If you use an external trigger input to define the Arm condition, then you cannot select 
the external trigger output for that path in that Test Case, and vice versa. For information 
regarding using the trigger input and output during a Test Case, refer to “Using Domains and 
External Triggering” on page 291. However, you can use an external trigger in on port A with 
an external trigger out on port B, and vice versa. Figure 157 shows an example.
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Rollback

The Rollback option defines the time or Dword count parameter between the Arm and Trigger 
events. If the Trigger does not follow the Arm event in the allotted time or Dword count, the 
Jammer begins looking for the Arm event again. Click Rollback to display the dialog shown in 
Figure 158. 

Figure 158:  Rollback Condition Dialog

Timeout

The timeout option defines the period of time to wait for a specified test to complete before 
aborting and proceeding to the next test in the suite.

To set the timeout:

1 Click Timeout to display the dialog box in Figure 159. 

2 Check Enable Timeout.

3 Enter the hours, minutes, and seconds you want to wait.

Figure 159:  Timeout Dialog

4 Click OK.

Repeat

Click Repeat to open the dialog shown in Figure 160. The Repeat Mode setting allows you to 
configure what is repeated when using an Arm condition. The first option means the Jammer will 
match the Arm condition once, then will repeat matching the Trigger condition as specified by the 
Repeat Count setting below. The second Repeat Mode option means that the Jammer must match 
the Arm condition each time before looking for a Trigger.

Note: This value is saved in terms of Dwords, not time, so keep this in mind if you save a 
Test Case using a device running at 3.0 Gbps and later open the configuration on a Jammer 
running at 1.5 Gbps.
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Figure 160:  Repeat Test Dialog

Pause

Click Pause to open the dialog shown in Figure 161. The Pause setting allows you to insert a 
pause before the beginning of a test case. 

Figure 161:  Pause Test Dialog

You can also configure options for each Test Case directly in the Test Suite, instead of clicking in 
the Current Jammer Test pane. Click on the area of the Test Case you want to modify to open the 
corresponding dialog (Figure 162).
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Figure 162:  Configuring Options Directly in the Test Suite
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Configuring the Arm Condition for 10GigE

The 10GigE Arm condition recognizes specific ordered sets, control characters, or frames. 

In 10GigE, you can select from the following:

• Frame - Allows you to specify the 10GigE header and up to 114 bytes of payload

• Ordered Set - Provides you with predefined ordered sets, or allows you to define a four byte 
ordered set

• Control Character - Allows you to choose from pre-defined control characters

You can save an arm or trigger condition as a .jmt file by clicking the Save button in the Arm or 
Trigger window. You can load a .jmt file by clicking the Load button in the Arm or Trigger 
window.

Depending on the Mode you select, the appropriate graphic diagram shows the Trigger and 
optional Arm conditions, along with the Jam event. If the Mode you select does not include an 
Arm condition, the Arm button is disabled.

To set Arm conditions: 

1 Select Frame, Ordered Set, or Control Character from the Type drop-down menu in the Arm 
section of the Current Jammer Test window.

2 Click on the Arm button to open the Arm window.

The window for the condition is displayed (Figure 163). If you are in hardware edit mode, the 
protocol, chassis name, chassis number, slot number, and port numbers are displayed in the 
title bar.

3 Set the values as required to specify the Arm condition as part of a unique Arm and Trigger 
sequence for the specific test.

The following sections describe the available values.

Setting Frame Conditions for 10GigE Arm

You can specify frame conditions in two ways. One way is to load a template from the Template 
Library tree, and the other way is to manually specify bits in the frame. 
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Figure 163:  Gigabit Ethernet Arm Window for Frames 

To use a template:

1 Select a template from the Template Library tree on the left.

2 Click the double right arrow button to set the Trigger Condition. 

The condition is indicated on the right side of the window.

To manually specify a frame: 

>> Type hexadecimal values directly into the center column of the window.

An X represents a nibble that can be any value (a “don’t care”). 

To set individual bits in any field, double-click on the hex entry to open the Binary Editor 
(Figure 164). In the hex view, partially defined hex characters appear as question marks: 
X001=?

Figure 164:  Binary Editor Dialog
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Another way to manually edit the frame condition is to make selections from the tree view in 
the right window pane.

Saving a Frame Condition

If you create a frame condition that you want to save and make easily available for future use, you 
can save it into the “User Library” folder in the Template Library tree. To do this:

>> Highlight the folder and click the double left arrow button.

Frame conditions have the option of “Use inverse of condition specified (i.e., NOT).” When you 
check this option, it means that the first frame encountered that does not match what you have 
specified creates a “condition met” event.

For each frame condition, you can specify an optional name at the top of the window. This name is 
also shown on the Jammer Configuration window under the Mode selection, and on the main Xgig 
Maestro window.

Setting Ordered Set Conditions for 10GigE Arm

You can choose from a predefined Ordered Set (LF or RF) or choose user-defined (Figure 165). 
All choices are four bytes. You can select either /Q/ or /Fsig/ for the first byte of a user-defined 
ordered set. You can enter hex values for the remaining three bytes.

To edit the values: 

>> Enter a hex value, or double-click the byte field to open the Binary Editor. 

As in frame conditions, an X indicates “don’t care” and a ? indicates a partially specified hex 
character. 

Figure 165:  10GigE Arm Window-Ordered Sets

As with frame conditions, you can specify an optional name at the top of the window. This name is 
also shown in the Jammer Configuration window under the Mode selection and on the main Xgig 
Maestro window.
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Setting Control Character Conditions for 10GigE Arm

You can choose from any standard one byte Control Character (Figure 166). The field below the 
drop-down menu shows the hex value of the Control Character selected.

Figure 166:  10GigE Arm Window Control Characters

Hex = 5C
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Configuring the Trigger Condition for 10GigE

The 10GigE Trigger condition recognizes specific ordered sets, control characters, frames, SOP, 
and SOP. 

In 10GigE, you can select a trigger from the following options:

• Frame - Allows you to specify the 10GigE header and up to 114 bytes of payload

• Ordered Set - Provides you with predefined ordered sets, or allows you to define a four byte 
ordered set

• Control Character - Allows you to choose from pre-defined control characters

• SOP - Allows you to trigger at the SOP

• EOP - Allows you to trigger at EOP

Depending on the Mode you select in the Jammer Configuration window, the appropriate 
graphic diagram shows the Trigger and optional Arm conditions, along with the Jam event. If the 
Mode you select does not include an Arm condition, the Arm button remains disabled.

To set Trigger conditions: 

1 Open the Type drop-down in the Trigger Condition window, and select Frame, Ordered Set, 
Control Character, SOP, or EOP.

2 Click the Trigger button in the Xgig Jammer Configuration window. 

The window for the condition is displayed (Figure 167). If you are in hardware edit mode, the 
protocol, chassis name, chassis number, slot number, and port numbers are displayed in the 
title bar.

3 Set the values as required to specify the Trigger condition as part of a unique Arm and Trigger 
sequence for the specific test.

The following sections describe the available values.
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Figure 167:  10GigE Trigger Window for Frames
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Setting Frame Conditions for a 10GigE Trigger

You can specify frame conditions in two ways. One way is to load a template from the Template 
Library tree, and the other way is to manually specify bits in the frame.

To use a template:

1 Select a template from the Template Library tree on the left.

2 Click the double right arrow button to set the Trigger Condition. 

The condition is indicated on the right side of the window.

To manually specify a frame: 

>> Type hexadecimal values directly into the center column of the window.

An X represents a nibble that can be any value (a “don’t care”). 

To set individual bits in any field, double-click on the hex entry to open the Binary Editor 
(Figure 168). In the hex view, partially defined hex characters appear as question marks: 
X001=?

Figure 168:  Binary Editor Dialog

Another way to manually edit the frame condition is to make selections from the tree view in 
the right window pane.

Decode Switches Menu

Some templates allow you to specify decode switches (Figure 169. When you load a template that 
has this option, the Decode Switches Menu appears in the upper left corner of the window. The 
decode switches provide detailed contextual options for decode; for example, further decode of 
response and data frames. The Decode Switches menu is context sensitive and will only show the 
decode options available for the specific template you are creating.
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Figure 169:  Decode Switches Menu

The Decode Switches menu is intended to help you create a user-defined template. When editing 
a User Library template, Decode Switches are stored inside the template so they are still ON the 
next time you open this particular template.

Decode switches allow you to further decode Response and Data frames that can't be decoded 
without knowing what the associated command frame is. Below is a description of the switches 
available for Jammer’s Trigger and Insert Frame conditions:

FCoE Interpretations

This menu is available for FCoE frames. Fibre Channel over Ethernet (FCoE) is the proposed 
mapping of Fibre Channel over selected full duplex IEEE 802.3 networks. The Auto-Detect 
FCoE setting automatically detects the version and is the default decode switch. The 
auto-detect mode works on a per-FCoE frame basis. It assumes that the FCoE frame reserved 
bits are set to zero and detects which FCoE specification is in use depending on where the 
zeroes are. If you end up with multiple errors and erroneous decoding of the FCoE frames, it is 
because the auto-detect mode assumptions do not work with your particular trace. This 
requires that select manually which FCoE specification to use. Available settings are:

• Auto-Detect FCoE
Automatically detects the specification version by looking at the frame header.

• T11 FCoE (Latest)
Selects the latest draft of the T11 standards committee specification as of this Xgig 
Analyzer release date.

• Pre-T11 FCoE Draft
Selects the pre-T11 standards committee draft, 07-303v0.pdf.\

Note: Once the Decode Switches menu appears, it remains visible. However, if you load a 
template that has no decode options, the menu is greyed out and inactive. 
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FC-SW Accept Interpretation

This menu item is available for FC-SW (Fibre Channel Switch Fabric Internal Link Service) 
Accept frames. It contains a list of the possible Switch Link Service Accept frame formats.

Figure 170:  Decode Switch Options for FC-SW Accept Interpretation

Saving a Frame Condition

If you create a frame condition that you want to save and make easily available for future use, you 
can save it into the “User Library” folder in the Template Library tree. To do this:

>> Highlight the folder and click the double left arrow button.

Frame conditions have the option of “Use inverse of condition specified (i.e., NOT).” When you 
check this option, it means that the first frame encountered that does not match what you have 
specified creates a “condition met” event.

For each frame condition, you can specify an optional name at the top of the window. This name is 
also shown on the Jammer Configuration window under the Mode selection, and on the main Xgig 
Maestro window.
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Setting Ordered Set Conditions for a 10GigE Trigger

You can choose from a predefined Ordered Set (LF or RF) or choose user-defined (Figure 171). 
All choices are four bytes. You can select either /Q/ or /Fsig/ for the first byte of a user-defined 
ordered set. You can enter hex values for the remaining three bytes.

To edit the values: 

>> Enter a hex value, or double-click the byte field to open the Binary Editor. 

As in frame conditions, an X indicates “don’t care” and a ? indicates a partially specified hex 
character. 

Figure 171:  10GigE Trigger Window-Ordered Sets

As with frame conditions, you can specify an optional name at the top of the window. This name is 
also shown in the Jammer Configuration window under the Mode selection and on the main Xgig 
Maestro window.

Setting Control Character Conditions for a 10GigE Trigger

You can choose from any standard one byte Control Character (Figure 172). The field below the 
drop-down menu shows the hex value of the Control Character selected.

Figure 172:  10GigE Trigger Window Control Characters

Hex = FE
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Setting SOP Trigger for 10GigE

The SOP Trigger has no options to set. When you set the test to trigger at the start of the packet 
(SOP), the following window appears, which states that for this type of jam test, the Jammer will 
trigger on an /S/ character, and the entire DWORD (32 bits) will be replaced with (/I/)s or “0”s 
depending on the 64 bit alignment of the /S/ character.

Figure 173:  10GigE Trigger SOP

Setting EOP Trigger for 10GigE

The EOP Trigger has no options to set. When you set the test to trigger at the end of the packet 
(EOP), the following window appears, which states that for this type of jam test, the Jammer will 
trigger on an /T/ character, and the entire DWORD (32 bits) will be replaced with (/I/)s or “0”s 
depending on the 64 bit alignment of the /T/ character.

Figure 174:  10GigE Trigger SOP

Note: When you select SOP as the trigger, the only jam type available is SOP. The jam 
window contain a message similar to the one above.

Note: When you select EOP as the trigger, the only jam type available is EOP. The jam 
window contain a message similar to the one above.
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Configuring the Jam Definition for 10GigE

The Jam Definition window defines how to modify the event specified on the Trigger Condition 
window.

The type of Jam available depends on the type of Trigger selected. In the case of SOP and EOP, the 
Jam is always the same type as the trigger.

For any Jam Definition, you can specify an optional name at the top of the window. This name is 
also displayed on the Jammer Configuration window under Mode selection and on the main Xgig 
Maestro window.

You can save a Jam definition as a .jmj file by clicking the Save button in the Jam window. You 
can load a .jmj file by clicking the Load button in the Jam window.

Jamming an Ordered Set for 10GigE

If the Trigger Event is an Ordered Set, click the Jam button on the Xgig Jammer Configuration 
window, to open the Ordered Set Jam Definition window (Figure 175).

The Ordered Set Jam Definition window allows you to modify any Ordered Set by replacing it 
with a different Ordered Set. You can choose from a predefined Ordered Set (LF or RF) or choose 
user-defined (Figure 175). All choices are four bytes. You can select either /Q/ or /Fsig/ for the 
first byte of a user-defined ordered set. Then, you can enter hex values for the remaining three 
bytes.

To edit the values: 

>> Enter a hex value, or double-click the byte field to open the Binary Editor. 

As in frame conditions, an X indicates “don’t care” and a ? indicates a partially specified hex 
character. 

Figure 175:  10GigE Ordered Set Jam Definition Window
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Jamming a Control Character for 10GigE

If the Trigger Event is a Control Character, click the Jam button on the Xgig Jammer 
Configuration window, to open the Control Character Jam Definition window (Figure 176).

The Control Character Jam Definition window allows you to modify any Control Character by 
replacing it with a different Control Character.

Figure 176:  10GigE Ordered Set Jam Definition Window
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Jamming a Frame for 10GigE

To define a Jam for a frame:

1 Select a Jam from the Jam Type drop-down menu.

2 Click the Jam button to configure the jam.

This section explains the available Jam Types.

— Replace Frame with Modified Frame

— Replace Frame with Truncated Frame

— Replace Frame with Idles

— Insert Frame

— Duplicate Frame

— Insert Dword

Replace Frame with Modified Frame

Each tab of the Modified Frame window contains options relevant to different frame 
modifications. 

— Global

— Delimiters/CRC

— Header/Payload

— Embedded Protocol(s)

Jam Behavior (All Tabs)

The Jam Behavior pane in located at the bottom of each tab in the Frame Jam Definition 
window. The Jam behavior settings control the number of user-defined header/payload Jams 
performed relative to the target trigger frame. 

Figure 177:  Jam Behavior Selection

• Jam until end of trigger frame

Jams defined in the Header/Payload tab are performed until the end of the target trigger frame 
(or until an abnormal termination of the frame). All Jams defined that would take place on the 
original CRC or later are ignored. However, if the frame that is triggered on has more Dwords 
than the Jams you specify, the remaining Dwords are passed through. The CRC and EOF of 
the original target trigger frame are always jammed according to the CRC and EOF settings on 
the SOF/CRC/EOF tab. This is the standard way to Jam a frame.
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• Execute full Jam pattern

All header and payload Jams are executed even if they overwrite beyond the end of the target 
trigger frame. 

If the target trigger frame is longer than the number of Jams defined, then the portion of the 
target trigger frame that extends after the last defined Jam is overwritten with /I/. If the target 
trigger frame is shorter, then the Jammer switches back to pass-through immediately after the 
last defined Jam. Use the control on the Header/Payload tab at the bottom of the List View 
pane to define how many payload Jams should take place.

The Execute full Jam option is supported only when any template from the FCoE library is 
loaded into the Header/Payload edit area.

The following Delimiter options are supported: 

• FCoE SOF modification

• FCoE EOF modification (always enabled)

• FCoE embedded CRC recalculate / replace

• GigE CRC recalculate/ replace

The GigE CRC is recalculated or replaced based on the user input and appended 
automatically at the end of the payload.

Note: For correct FCoE recalculation, any number of Header + payload words can be 
specified as long as the minimum embedded FCoE frame payload size is 2 Dwords.
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Non-FCoE Frames

Non-FCoE frames can also be supported by using the Replace Jam Editor to change the ether 
type byte field in the payload area, but you must specify the payload size as a multiple of 
Dword. 

Figure 178:  Replace Frame Editor

Important: Currently, when Jamming with modified frame, the delimiter modification may 
not occur consistently when jamming from a protocol-specific frame to a non-protocol frame 
and vice-versa. However, the CRC recalculation always occurs.

— For Trigger FCoE -> Jam to Non-FCoE frame, FCoE delimiter modification is applied and 
overrides the specified field in the Header Payload area. FCoE CRC modification is not 
applied.

— For Trigger Non-FCoE frame -> Jam to FCoE frame, FCoE delimiter modification is not 
applied. However, valid FCoE delimiter value can be entered on the Header/Payload tab. 
FCoE CRC modification is applied.
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Using the Global Tab

Use this tab (Figure 179) to define Jam parameters that apply globally to the frame.

Global Replace Jam Option

Use the Global Replace Jam Option word to set specific bits on an 8 bit level in a word to 1 or 
0 while passing through the remaining bits. You can apply this replace jam option to any word 
in the frame. Define one Global Replace Jam Option for each Test Case.

To edit these bits: 

>> Enter hex values, or double-click on a byte field to open the Binary Editor. 

Any bits left as Xs are passed through.

Figure 179:  10GigE Global Tab

Global 66b Jam Option

Use the Global 66b Jam Option word to set specific bits at the 64 bit level in a word to either 1 
or 0 while passing through the remaining bits. You can apply this 66b jam option to any word 
in the frame. Define one Global 66b Jam Option for each Test Case.

To edit these bits: 

>> Enter hex values, or double-click on a byte field to open the Binary Editor. 

Any bits left as Xs are passed through.
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Global Bit Errors

The Jammer software can introduce bit errors repeatedly in sequential or random fashion to 
predefined fields. These bit errors are introduced to the 32-bit form of the target words (not the 
40-bit form) so code violations are not created. The Global Bit Errors control allows you four 
options.

• Select one bit for all fields and randomly. This causes the Jammer to inject a single bit 
error in the group of all fields selected in the header or payload for a single Test Case. If 
the Jammer Test Suite is set to loop, then single bit errors are randomly injected into these 
fields, with one bit for each cycle of the Test Suite.

• Select one bit for all fields and sequentially. This also injects a single bit error in the 
group of all fields selected in the header or payload. If the Test Suite is set to loop forever, 
the bit error walks through all the selected fields.

• Select one bit in each field and randomly does the same thing as the first option; 
however, there will be one error for each word selected in the payload or header.

• Select one bit in each field and sequentially does the same thing as the second option; 
however, there will be one error for each word selected in the payload or header.

Using the Delimiters/CRC Tab for Gigabit Ethernet

Use the choices on this tab to modify the FCoE Start of Frame (SOF), FCoE Embedded CRC 
Modification, FCoE End of Frame (EOF), and GigE Carrier Modification of the original frame 
(Figure 180).

Figure 180:  10GigE Delimiters/CRC Tab
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Modifying SOF/EOF 

To modify these special characters in the target trigger frame:

1 Check the appropriate box to select replacement.

2 Open the drop-down menu and choose a standard 10GigE Ordered Set, or select User-defined.

If you choose User-defined, you can specify any value. 

To edit the value enter a hex value into the byte field or double-click to display the Binary 
Editor. 

FCoE Embedded CRC/10GigE CRC Options

The CRC options include:

• Not changing the CRC in the original target frame

• Recalculating the CRC to make it correct for the modified data

• Replacing with a user-specified data word

Using the Header/Payload Tab for 10GigE

You can modify any parameter or word on the 10GigE Header/Payload Tab (Figure 181).

Figure 181:  10GigE Header/Payload Tab
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The 10GigE window always shows Jam definitions for the header and 4096 payload words (for the 
maximum supported 16 Kilobyte jumbo frames). If the frame that is Jammed has less than 4096 
payload words, the extra Jam definitions do not take effect. The Jammer does not support 10GigE 
frames larger than 4096 payload words.

Notice the first line of the Jam Definition (Ether 0001) has only the first two bytes of the 
Destination Address header field. This is to visually orient the frame in the same manner as the 
Arm and Trigger Condition windows.

Similar to defining an Arm or Trigger Condition, there are two ways to specify your frame Jam 
Definition. One way is to load a template from the Template Library tree, and the other way is to 
manually specify bits in the frame.

To use a template:

1 Highlight a template in the Template Library tree on the left side of the window. 

Tree View is structured similar to the display on the right side of the Arm and Trigger 
Condition windows. You can make selections from the tree; this creates the appropriate 
Replace Jams.

2 Click the double right arrow to display the Jam definition on the right side of the window. 

Notice the special choice at the bottom left, “Current Trigger.” This is a copy of the frame 
condition you have specified for the Trigger. Click the double right arrow to use this.

When you use a template, the Jam definition is populated with Replace Jams of the specified data, 
while all other bits are passed through.

To manually edit the values, enter a value into the byte field. An X in a nibble passes the original 
value through. 

Selecting the Replace 8b Jam Mode radio button opens a dialog that allows you to replace an 
entire frame either by using a template or manually entering values. The Replace 8b Jam Mode 
dialog also contains a view of the frame contents, similar to those seen the Arm and Trigger 
Condition windows. These values correspond to the hex values defined in the center column. 
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Figure 182:  Replace 8b Jam Mode

Selecting the All Jam Modes radio button opens a dialog that provides the following choices for 
each word in a frame on the Header/Payload tab:

Replace 66 bit - This function allows individual bits to be set to 1, set to 0 or passed through 
unchanged according to the Global 66 Jam option defined on the Global tab.

Apply Global Replace Jam - This function allows individual bits to be set to 1, set to 0 or passed 
through unchanged according to the Global Replace Jam option defined on the Global tab.

Invert Jam - Invert defined bits and pass through the rest. Enter 1s at the appropriate bit locations.

Pass Through Jam - Pass through the current word unchanged.

Replace 8b Jam - Replace nibbles with new values. Each drop-down represents a byte so you can 
replace a byte with a standard Ordered Set. If you choose User-defined, you can specify any K/D 
character. To edit these values, enter a value into the byte field or double-click to display the 
Binary Editor. If you specify a bit as a 0 or 1, you must specify the values of the other three bits in 
that nibble also. Any nibbles with an X are passed through.

Set Bits To 0s Jam - Set defined bits to 0s and pass through the rest. Enter 0s at the appropriate bit 
locations.

Set Bits To 1s Jam - Set defined bits to 1s and pass through the rest. Enter 1s at the appropriate bit 
locations.

Apply Global Bit Error Jam - Apply the Global Bit Error function set on the Global tab.

Insert Code Violation Jam - Introduce a predefined, fixed code violation to a byte in that word. 
Which byte is corrupted depends on the alignment orientation of the frame. The Jam Definition of 
the word before a Code Violation Jam must always be a Pass Through Jam. A Code Violation Jam 
cannot be placed in the first word of a frame (Ether 0001).
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Tree View - Another way to manually edit or view your Jam Definition is to click the Switch to 
button at the lower right corner to toggle between List View and Tree View. The List View 
interface is described in the procedures in this chapter. Tree View is structured similar to the 
display on the right side of the Arm and Trigger Condition windows. You can make selections 
from the tree; this creates the appropriate Replace Jams.

Using the Embedded Protocol(s) Tab for Gigabit Ethernet

Figure 183 shows the Embedded Protocol(s) tab for Gigabit Ethernet. The available functions are 
described in this section.

Figure 183:  Gigabit Ethernet Embedded Protocol(s) Tab

Recalculate Checksum

Select the check boxes to choose recalculation of IP and TCP checksums.

Recalculate IP checksum for valid IP embedded frames

Checking this option replaces the IP checksum in the Jammed frame with a recalculated value. For 
the checksum to be inserted properly, the frame, after Jamming takes place, must have a Gigabit 
Ethernet header EtherType field value of 0x0800 and a valid IP header IHL field.
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Recalculate TCP checksum for valid TCP embedded frames

Checking this option replaces the TCP checksum in the Jammed frame with a recalculated value. 
For the checksum to be inserted properly, the frame, after Jamming takes place, must meet the 
same requirements as those listed for the IP checksum, and, in addition, have an accurate IP header 
Total Length field, an IP header IP Protocol field value of 0x06, and a valid TCP header Data 
Offset field.

Also, the Jumbo Frames setting (see “GigE Jumbo Frames” on page 25) must be correct for the 
TCP checksum insertion to work. Each setting shows the frame size limits as well as the 
corresponding latency. 

The TCP checksum recalculation is not available when using the Repeat Jam feature.

Replace Frame with Truncated Frame

This option truncates the target frame to a shorter length and sends Idles /I/ on top of the remainder 
of the target frame.

In the Truncate Frame Options window:

1 Choose the type of payload you want to truncate from the drop-down menu: 

• Gigabit Ethernet

• IP

• TCP

• FCoE

2 Enter the number of bytes you want the payload to be truncated to (this does not include the 
CRC or other delimiters).

Gigabit Ethernet Payload

For a Gigabit Ethernet payload, the Number of Payload bytes setting specifies how many bytes 
to leave after the Gigabit Ethernet header (the first 14 bytes of the frame). You can specify from 0 
to 1500 bytes. If the target frame is shorter than the specified number of bytes, then no Jamming 
occurs. You also have the option to replace the IP checksum with a recalculated value, which also 
automatically updates the IP header Total Length field.

For any successful truncation, the Gigabit Ethernet CRC is always replaced with a recalculated 
value.

IP Payload

For an IP payload, the Number of Payload bytes setting specifies how many bytes to leave after 
the IP header. You can specify from 0 to 1480 bytes. You also have the option to replace the IP 
checksum with a recalculated value, which also automatically updates the IP header Total Length 
field.
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For the truncation or the IP checksum/IP header option to work properly, there are some 
requirements of the incoming target frame. The frame must have a Gigabit Ethernet header 
EtherType field value of 0x0800, a valid IP header IHL field, and a valid IP header Total Length 
field. If the Jammed frame is shorter than the specified number of bytes, then no truncation occurs, 
but the IP checksum can be recalculated if you select it.

For any successful truncation, the Gigabit Ethernet CRC is always replaced with a recalculated 
value.

TCP Payload

For a TCP payload, the Number of Payload bytes setting specifies how many bytes to leave after 
the TCP header. You can specify from 0 to 1460 bytes. You also have the option to replace the IP 
checksum with a recalculated value, which also automatically updates the IP header Total Length 
field.

Each setting shows the frame size limits as well as the corresponding latency. In addition to these 
limits, the target frame must have an IP header IP Protocol field value of 0x06, a valid TCP header 
Data Offset field, and a valid IP header Total Length field. If the Jammed frame is shorter than the 
specified number of bytes, then no truncation occurs, but the IP checksum can be recalculated if 
you select it.

For any successful truncation, the Gigabit Ethernet CRC is automatically replaced with a 
recalculated value.

FCoE Payload

For an FCoE payload, the Payload Dwords setting specifies how many Dwords (Dword = 
4 bytes) to leave after the FCoE header. You can specify from 1 to 4096 Dwords. You also have to 
specify an EOF for the FCoE frame. 

For any successful truncation, both the FCoE and the Gigabit Ethernet CRCs are always replaced 
with a recalculated value.

Replace Frame with Idles

This option replaces the target frame with /I/ Ordered Sets in the 10GigE Jammer. There are no 
options to set for this Jam.

Figure 184:  10GigE - Replace Frame with Idles
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Insert Frame

This option allows you to insert a 10GigE frame after the triggered frame. You can define the 
header and the payload using the Template Tree on the left pane, or you can manually define the 
frame.

Figure 185:  10GigE Jam - Insert Frame Window

To use a template, click a frame template from the User Library or the Viavi Library in the left 
pane, then click the double right arrows to apply the template. The frame header and payload 
information appears on the right side of the window. 

To manually define a frame, type hexadecimal values directly into the center column of the 
window. To set individual bits in any field, double-click on the hex entry to open the Binary Editor 
(Figure 186). In the hex view, partially defined hex characters appear as question marks: X001=?
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Figure 186:  Binary Editor Dialog

The frame size is indicated at the top of the window. You can adjust the frame size within the 
limits defined by the protocol and frame content.

The software automatically recalculates the applicable CRCs, and checksums each time you 
change the frame. If the CRC or checksum is incorrect, an entry is displayed in the frame contents 
next to the incorrect CRC or checksum showing the correct value of the CRC. To apply the correct 
recalculation of the CRC and checksum, click the Recalculate CRC(s)/Checksum(s) button at 
the bottom of the Jam Definition window.

Decode Switches Menu

Some templates allow you to specify decode switches. When you load a template that has this 
option, the Decode Switches Menu appears in the upper left corner of the window. The decode 
switches provide detailed contextual options for decode; for example, further decode of response 
and data frames. The Decode Switches menu is context sensitive and will only show the decode 
options available for the specific template you are creating. 

The Decode Switches menu is intended to help you create a user-defined template. When editing 
a User Library template, Decode Switches are stored inside the template so they are still ON the 
next time you open this particular template.

Decode switches allow you to further decode Response and Data frames that can't be decoded 
without knowing what the associated command frame is. Below is a description of the switches 
available for Jammer’s Trigger and Insert Frame conditions:

FCoE Interpretations

This menu is available for FCoE frames. Fibre Channel over Ethernet (FCoE) is the proposed 
mapping of Fibre Channel over selected full duplex IEEE 802.3 networks. The Auto-Detect 
FCoE setting automatically detects the version and is the default decode switch. The 
auto-detect mode works on a per-FCoE frame basis. It assumes that the FCoE frame reserved 
bits are set to zero and detects which FCoE specification is in use depending on where the 
zeroes are. If you end up with multiple errors and erroneous decoding of the FCoE frames, it is 
because the auto-detect mode assumptions do not work with your particular trace. This 
requires that select manually which FCoE specification to use. Available settings are:

• Auto-Detect FCoE
Automatically detects the specification version by looking at the frame header.

Note: Once the Decode Switches menu appears, it remains visible. However, if you load a 
template that has no decode options, the menu is greyed out and inactive. 
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• T11 FCoE (Latest)
Selects the latest draft of the T11 standards committee specification as of this Xgig 
Analyzer release date.

• Pre-T11 FCoE Draft
Selects the pre-T11 standards committee draft, 07-303v0.pdf.

FC-ELS Accept Interpretation

This menu item is available for FC-ELS (Fibre Channel Extended Link Services) Accept 
frames. It contains a list of the possible Link Services Accept frame formats.

Saving a Frame

If you create a frame that you want to save and make easily available for future use, you can save 
it into the “User Library” folder in the Template Library tree. To do this:

1 Make sure the frame contents are displayed in the right pane.

2 Type a name for the frame, and click the double left arrow button. 

The frame appears in the User Library.

Duplicate Frame

You can duplicate the triggered frame and insert it after the frame. There are no options to set for 
this Jam.

Figure 187:  10GigE - Duplicate Frame

Insert Dword

This option allows you to insert a 32-bit word to the triggered frame at a particular offset. The 
position of offset 0 begins after the preamble of a frame. The 32-bit data to be inserted is user 
programmable. Only data characters can be inserted. The GE CRC, FCoE CRC, IP checksum are 
automatically recalculated.
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Figure 188:  10GigE Insert Dword

If the repeat jam option is used for an Insert Dword jam, the IPG between frames must be greater 
than minimum IPG. If the triggered frames are spaced by minimum IPG, the insertion process may 
be aborted before the specified number of repeat jams, and you will receive an error notice.
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Chapter 7
Creating Jammer Test Configurations for 16G FC

In this chapter:

• Defining Your Own Test Configurations for 16G FC

• Using the Jammer Configuration Window for 16G FC

• Configuring the Arm Condition for 16G FC

• Configuring the Trigger Condition for 16G FC

• Configuring the Jam Definition for 16G FC
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Defining Your Own Test Configurations for 16G FC

Xgig Jammer lets you define your own test configurations and save them with or without hardware 
available.

You can create a configuration from scratch, or you can open and edit an existing configuration. 
Also, you can edit a configuration in edit only mode, which is independent of any hardware, or 
you can edit a configuration that is currently loaded to a Jammer device.

To edit a configuration in edit only mode:

>> Double-click on a configuration file in the Configuration manager. 

or:

>> Right-click on the configuration file in the Configuration manager and choose Edit Jammer 
Configuration from the context menu.

The edit only mode Jammer Configuration window opens (Figure 189).

This window allows you to set up your own Test Cases, name them, organize them, and save 
them to files so that you can use them again.

Figure 189:  Edit Only Jammer Configuration Window

To start a configuration from scratch in edit only mode:

>> Select New Jammer Configuration from the context menu or the File menu (Figure 190) on 
the Xgig Maestro menu bar. Then, select 16 Gig FC Jammer from the drop down menu.

or:
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>> Click the New Configuration icon at the top of the Configuration manager.

Figure 190:  Maestro File Menu

To save your configuration in edit only mode:

>> Click Save at the bottom of the Jammer Configuration window or open the File menu on the 
Jammer Configuration window and select Save Configuration or Save Configuration As.

Any changes you make have no effect on actual Jammer devices you control.

To edit a configuration that is loaded to a Jammer port:

>> Click Configuration... in the device column.

or:

>> Right-click in the Parameters Status table in the device column to open the context menu and 
select Edit configuration.

or: 

>> Click Operation in the device column to open the Operation dialog, then click Config.

The Xgig Jammer Configuration window in hardware edit mode is displayed (Figure 191). 
This window allows you to set up your own Test Cases, name them, and save them to a file so 
that you can use them again.

Click Apply or OK and Jammer accepts the changes. They are immediately reflected in the 
Parameters Status table and affect the Jammer device the next time you run it.

To save your configuration edits:

>> Open the File menu at the top of the Jammer Configuration window and select 
Save Configuration As... or Save Configuration.
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Figure 191:  Xgig Jammer Configuration Window

Using the Jammer Configuration Window for 16G FC

The Jammer Configuration window title bar indicates how many ports it is configuring, the 
protocol, and the configuration file name, if any. If you are using hardware edit mode, the chassis 
name, chassis number, slot number, and port number are also listed. The elements of the Jammer 
Configuration window are described in the following sections.

Using the Jammer Test Suite Tools for 16G FC

The Jammer Test Suite (left pane) lists the series of Xgig Jammer tests in the order in which you 
want them to execute. The suite includes one or more tests. The highlighted test appears as the 
Current Jammer Test (right pane). Each test in the suite executes in sequence with a test reset time 
of approximately 130 (200 max) milliseconds.
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Creating a Test Suite

When you create a 16G FC Jammer Test Suite, you use the toolbar in the Jammer Test Suite 
section of the Configuration window (Figure 192).

Figure 192:  16G FC Jammer Test Suite Toolbar

The following list describes the icons on the toolbar:

To duplicate a test at another point in the Test Suite:

1 Highlight the test you want to duplicate.

2 Click Copy.

3 Highlight the test in the suite that is just after the point where you want the duplicate test 
inserted.

4 Click Paste.

The duplicate test is inserted.

Refer to “Configuring the Arm Condition for 16G FC”, “Configuring the Trigger Condition 
for 16G FC” and “Configuring the Jam Definition for 16G FC” for information about 
configuring each test.

Cut current test Removes the highlighted test and holds its contents in the 
memory buffer.

Copy current text Copies the highlighted test to the memory buffer.

Paste last test cut or copied Inserts the current memory buffer contents before the currently 
highlighted test.

Add new test to bottom of stack Adds a new blank test to the bottom of the suite.

Insert new test before current test Inserts a new blank test above the currently highlighted test.

Delete current test Removes the highlighted test from the suite. If only one test is 
present, then the contents of this test are cleared.

Move current test down the stack Moves the highlighted test down one in the test order.

Move current test up the stack Moves the highlighted test up one in the test order.

Toggle view Toggles Test Suite between Card View and List View.

Run test suite once or Repeat test 
suite

When you choose Repeat test suite, the tests run according 
the settings you define in the Jammer Current Test window.
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Using the Configuration File Menu

The File menu is the only menu on the menu bar (Figure 193). 

Figure 193:  Configuration File Menu

The choices are:

The recently used 16G FC Jammer configuration files appear in the file menu and are loaded when 
selected.

Open Configuration Open an existing .tsk configuration file.

Import to Selected Test Import a Test Case from a .tst file or an entire test suite, .tsk file, to 
the currently highlighted position. A Test Case is one line in the Jammer 
Test Suite.

Export Selected Test Export and save the currently highlighted test to a .tst file.

Save Configuration Save the entire Test Suite to the .tsk file you currently have loaded.

Save Configuration As Save the entire Test Suite to a .tsk file with a name you assign to it.

Close Close the Jammer Configuration Window.

Note: The .tst files are only for storing individual Test Cases and swapping them between 
configuration files. You cannot load .tst files directly into a Jammer device on the Xgig 
Maestro window.
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Using the Current Jammer Test Window for 16G FC

The graphics in this section of the window represent the hardware configuration for the selected 
test in the Jammer Test Suite (Figure 194).

Figure 194:  Current Jammer Test Window

Mode

For 16G FC, Mode menus are available near the top of the Current Jammer Test window 
(Figure 195) and also near the top of each Test Case in the Jammer Test Suite window 
(Figure 196). 

The input to path A (on top) is always port A and the input to path B (on the bottom) is always port 
B. The external trigger input and output that are available on path A always are linked to the 
domain shown on the Xgig Maestro window as “Domain of port A.” The trigger input and output 
on the bottom on path B are in the “Domain of port B.” 
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Figure 195:  Mode Drop-down Menu in Current Jammer Test - Right Pane

Figure 196:  Mode Drop-down Menu in Test Suite - Left Pane

Reverse

You can reverse the direction of the jam by selecting the Reverse button.

Arm and Trigger

To define Arm and Trigger conditions, select a respective Type from each drop-down menu. Then 
click the Arm or Trigger button to open the corresponding definition window. 

You can use an external input as an Arm condition. Check Trigger from Domain A (or B) to enable 
this feature. You must put the corresponding Jammer port into a domain for this to work properly. 

The Trigger event can be in the next Dword after the Arm event in the traffic stream.

Jam

To define a Jam: 

1 Select a Type from the drop-down menu, if available.

2 Click the Jam button to open the Jam Definition window.

The Jam Definition specifies the modifications to be made to the traffic matching the Trigger 
Condition.
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In addition, the Jammer port can trigger out to the Domain it is in when a Jam takes place. 
Check Trigger Domain A (or B) upon Jam to enable this feature.

Figure 197:  Trigger In and Trigger Out

Note: If you use an external trigger input to define the Arm condition, then you cannot select 
the external trigger output for that path in that Test Case, and vice versa. For information 
regarding using the trigger input and output during a Test Case, refer to “Using Domains and 
External Triggering” on page 291. However, you can use an external trigger in on port A with 
an external trigger out on port B, and vice versa. Figure 197 shows an example.
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Rollback

The Rollback option defines the time or Dword count parameter between the Arm and Trigger 
events. If the Trigger does not follow the Arm event in the allotted time or Dword count, the 
Jammer begins looking for the Arm event again. Click Rollback to display the dialog shown in 
Figure 198. 

Figure 198:  Rollback Condition Dialog

Timeout

The timeout option defines the period of time to wait for a specified test to complete before 
aborting and proceeding to the next test in the suite.

To set the timeout:

1 Click Timeout to display the dialog box in Figure 199. 

2 Check Enable Timeout.

3 Enter the hours, minutes, and seconds you want to wait.

Figure 199:  Timeout Dialog

4 Click OK.

Repeat

Click Repeat to open the dialog shown in Figure 200. The Repeat Mode setting allows you to 
configure what is repeated when using an Arm condition. The first option means the Jammer will 
match the Arm condition once, then will repeat matching the Trigger condition as specified by the 
Repeat Count setting below. The second Repeat Mode option means that the Jammer must match 
the Arm condition each time before looking for a Trigger.

Note: This value is saved in terms of Dwords, not time, so keep this in mind if you save a 
Test Case using a device running at 3.0 Gbps and later open the configuration on a Jammer 
running at 1.5 Gbps.
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Figure 200:  Repeat Test Dialog

Pause

Click Pause to open the dialog shown in Figure 201. The Pause setting allows you to insert a 
pause before the beginning of a test case. 

Figure 201:  Pause Test Dialog

You can also configure options for each Test Case directly in the Test Suite, instead of clicking in 
the Current Jammer Test pane. Click on the area of the Test Case you want to modify to open the 
corresponding dialog (Figure 202).
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Figure 202:  Configuring Options Directly in the Test Suite
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Configuring the Arm Condition for 16G FC

The 16G FC Arm condition recognizes specific ordered sets, control characters, or frames. 

In 16G FC, you can select from the following:

• Frame - Allows you to specify the 16G FC header and up to 114 bytes of payload

• Ordered Set - Provides you with predefined ordered sets, or allows you to define a four byte 
ordered set

• Control Character - Allows you to choose from pre-defined control characters

• SOF - Allows you to arm on the SOF

• EOF - Alows you to arm on the EOF

You can save an arm or trigger condition as a .jmt file by clicking the Save button in the Arm or 
Trigger window. You can load a .jmt file by clicking the Load button in the Arm or Trigger 
window.

Depending on the Mode you select, the appropriate graphic diagram shows the Trigger and 
optional Arm conditions, along with the Jam event. If the Mode you select does not include an 
Arm condition, the Arm button is disabled.

To set Arm conditions: 

1 Select Frame, Ordered Set, Control Character, SOF, or EOF from the Type drop-down menu 
in the Arm section of the Current Jammer Test window.

2 Click on the Arm button to open the Arm window.

The window for the condition is displayed (Figure 203). If you are in hardware edit mode, the 
protocol, chassis name, chassis number, slot number, and port numbers are displayed in the 
title bar.

3 Set the values as required to specify the Arm condition as part of a unique Arm and Trigger 
sequence for the specific test.

The following sections describe the available values.

Setting Frame Conditions for 16G FC Arm

You can specify frame conditions in two ways (Figure 203). One way is to load a template from 
the Template Library tree, and the other way is to manually specify bits in the frame. 
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Figure 203:  Gigabit Ethernet Arm Window for Frames 

To use a template:

1 Select a template from the Template Library tree on the left.

2 Click the double right arrow button to set the Trigger Condition. 

The condition is indicated on the right side of the window.

To manually specify a frame: 

>> Type hexadecimal values directly into the center column of the window.

An X represents a nibble that can be any value (a “don’t care”). 

To set individual bits in any field, double-click on the hex entry to open the Binary Editor 
(Figure 204). In the hex view, partially defined hex characters appear as question marks: 
X001=?
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Figure 204:  Binary Editor Dialog

Another way to manually edit the frame condition is to make selections from the tree view in 
the right window pane.

Saving a Frame Condition

If you create a frame condition that you want to save and make easily available for future use, you 
can save it into the “User Library” folder in the Template Library tree. To do this:

>> Highlight the folder and click the double left arrow button.

Frame conditions have the option of “Use inverse of condition specified (i.e., NOT).” When you 
check this option, it means that the first frame encountered that does not match what you have 
specified creates a “condition met” event.

For each frame condition, you can specify an optional name at the top of the window. This name is 
also shown on the Jammer Configuration window under the Mode selection, and on the main Xgig 
Maestro window.

Setting Ordered Set Conditions for 16G FC Arm

You can choose from a predefined Ordered Set (LF or RF) or choose user-defined (Figure 205). 
All choices are four bytes. You can select either /Q/ or /Fsig/ for the first byte of a user-defined 
ordered set. You can enter hex values for the remaining three bytes.

To edit the values: 

>> Enter a hex value, or double-click the byte field to open the Binary Editor. 

As in frame conditions, an X indicates “don’t care” and a ? indicates a partially specified hex 
character. 

Figure 205:  16G FC Arm Window-Ordered Sets
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As with frame conditions, you can specify an optional name at the top of the window. This name is 
also shown in the Jammer Configuration window under the Mode selection and on the main Xgig 
Maestro window.

Setting Control Character Conditions for 16G FC Arm

You can choose from any standard one byte Control Character (Figure 206). The field below the 
drop-down menu shows the hex value of the Control Character selected.

Figure 206:  16G FC Arm Window Control Characters

Setting SOF Conditions for 16G FC Arm

You can choose from a predefined Ordered Set representing the SOF or choose user-defined 
(Figure 207). All choices are four bytes. You can select either /Q/ or /Fsig/ for the first byte of a 
user-defined ordered set. You can enter hex values for the remaining three bytes.

To edit the values: 

>> Enter a hex value, or double-click the byte field to open the Binary Editor. 

As in frame conditions, an X indicates “don’t care” and a ? indicates a partially specified hex 
character. 

Figure 207:  16G FC Arm Window-SOF

As with frame conditions, you can specify an optional name at the top of the window. This name is 
also shown in the Jammer Configuration window under the Mode selection and on the main Xgig 
Maestro window.

Hex = 07
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Setting EOF Conditions for 16G FC Arm

You can choose from a predefined Ordered Set representing the EOF or choose user-defined 
(Figure 208). All choices are four bytes. You can select either /Q/ or /Fsig/ for the first byte of a 
user-defined ordered set. You can enter hex values for the remaining three bytes.

To edit the values: 

>> Enter a hex value, or double-click the byte field to open the Binary Editor. 

As in frame conditions, an X indicates “don’t care” and a ? indicates a partially specified hex 
character. 

Figure 208:  16G FC Arm Window-EOF

As with frame conditions, you can specify an optional name at the top of the window. This name is 
also shown in the Jammer Configuration window under the Mode selection and on the main Xgig 
Maestro window.
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Configuring the Trigger Condition for 16G FC

The 16G FC Trigger condition recognizes specific block type fields, ordered sets, control 
characters, frames, SOP, and SOP. 

In 16G FC, you can select a trigger from the following options:

• Frame - Allows you to specify the 16G FC header and up to 114 bytes of payload

• Ordered Set - Provides you with predefined ordered sets, or allows you to define a four byte 
ordered set

• Control Character - Allows you to choose from pre-defined control characters

• SOF - Allows you to trigger at the SOF

• EOF - Allows you to trigger at EOF

• 66-bit Block Payload for Ordered Set

Depending on the Mode you select in the Jammer Configuration window, the appropriate 
graphic diagram shows the Trigger and optional Arm conditions, along with the Jam event. If the 
Mode you select does not include an Arm condition, the Arm button remains disabled.

To set Trigger conditions: 

1 Open the Type drop-down in the Trigger Condition window, and select Frame, Ordered Set, 
Control Character, SOP, EOP, or 66-bit Block Payload for Ordered Set.

2 Click the Trigger button in the Xgig Jammer Configuration window. 

The window for the condition is displayed (Figure 209). If you are in hardware edit mode, the 
protocol, chassis name, chassis number, slot number, and port numbers are displayed in the 
title bar.

3 Set the values as required to specify the Trigger condition as part of a unique Arm and Trigger 
sequence for the specific test.

The following sections describe the available values.
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Figure 209:  16G FC Trigger Window for Frames



Creating Jammer Test Configurations for 16G FC Configuring the Trigger Condition for 16G FC

220 Xgig Jammer and Delay Emulator User Guide

  

Setting Frame Conditions for a 16G FC Trigger

You can specify frame conditions in two ways. One way is to load a template from the Template 
Library tree, and the other way is to manually specify bits in the frame.

To use a template:

1 Select a template from the Template Library tree on the left.

2 Click the double right arrow button to set the Trigger Condition. 

The condition is indicated on the right side of the window.

To manually specify a frame: 

>> Type hexadecimal values directly into the center column of the window.

An X represents a nibble that can be any value (a “don’t care”). 

To set individual bits in any field, double-click on the hex entry to open the Binary Editor 
(Figure 210). In the hex view, partially defined hex characters appear as question marks: 
X001=?

Figure 210:  Binary Editor Dialog

Another way to manually edit the frame condition is to make selections from the tree view in 
the right window pane.

Decode Switches Menu

Some templates allow you to specify decode switches (Figure 211). When you load a template that 
has this option, the Decode Switches Menu appears in the upper left corner of the window. The 
decode switches provide detailed contextual options for decode; for example, further decode of 
response and data frames. The Decode Switches menu is context sensitive and will only show the 
decode options available for the specific template you are creating.

The Decode Switches menu is intended to help you create a user-defined template. When editing 
a User Library template, Decode Switches are stored inside the template so they are still ON the 
next time you open this particular template.

Decode switches allow you to further decode Response and Data frames that can't be decoded 
without knowing what the associated command frame is. Below is a description of the switches 
available for Jammer’s Trigger and Insert Frame conditions:

Note: Once the Decode Switches menu appears, it remains visible. However, if you load a 
template that has no decode options, the menu is greyed out and inactive. 
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FC-SW Accept Interpretation

This menu item is available for FC-SW (Fibre Channel Switch Fabric Internal Link Service) 
Accept frames. It contains a list of the possible Switch Link Service Accept frame formats.

Figure 211:  Decode Switch Options for FC-SW Accept Interpretation

Saving a Frame Condition

If you create a frame condition that you want to save and make easily available for future use, you 
can save it into the “User Library” folder in the Template Library tree. To do this:

>> Highlight the folder and click the double left arrow button.

Frame conditions have the option of “Use inverse of condition specified (i.e., NOT).” When you 
check this option, it means that the first frame encountered that does not match what you have 
specified creates a “condition met” event.

For each frame condition, you can specify an optional name at the top of the window. This name is 
also shown on the Jammer Configuration window under the Mode selection, and on the main Xgig 
Maestro window.
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Setting Ordered Set Conditions for a 16G FC Trigger

You can choose from a predefined Ordered Set (LF or RF) or choose user-defined (Figure 212). 
All choices are four bytes. You can select either /Q/ or /Fsig/ for the first byte of a user-defined 
ordered set. You can enter hex values for the remaining three bytes.

To edit the values: 

>> Enter a hex value, or double-click the byte field to open the Binary Editor. 

As in frame conditions, an X indicates “don’t care” and a ? indicates a partially specified hex 
character. 

Figure 212:  16G FC Trigger Window-Ordered Sets

As with frame conditions, you can specify an optional name at the top of the window. This name is 
also shown in the Jammer Configuration window under the Mode selection and on the main Xgig 
Maestro window.

Setting Control Character Conditions for a 16G FC Trigger

You can choose from any standard one byte Control Character (Figure 213). The field below the 
drop-down menu shows the hex value of the Control Character selected.

Figure 213:  16G FC Trigger Window Control Characters

Setting SOF Conditions for 16G FC Trigger

You can choose from a predefined Ordered Set representing the SOF or choose user-defined 
(Figure 214). All choices are four bytes. You can select either /Q/ or /Fsig/ for the first byte of a 
user-defined ordered set. You can enter hex values for the remaining three bytes.

To edit the values: 

Hex = 07
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>> Enter a hex value, or double-click the byte field to open the Binary Editor. 

As in frame conditions, an X indicates “don’t care” and a ? indicates a partially specified hex 
character. 

Figure 214:  16G FC Trigger Window-SOF

As with frame conditions, you can specify an optional name at the top of the window. This name is 
also shown in the Jammer Configuration window under the Mode selection and on the main Xgig 
Maestro window.

Setting EOF Conditions for 16G FC Trigger

You can choose from a predefined Ordered Set representing the EOF or choose user-defined 
(Figure 215). All choices are four bytes. You can select either /Q/ or /Fsig/ for the first byte of a 
user-defined ordered set. You can enter hex values for the remaining three bytes.

To edit the values: 

>> Enter a hex value, or double-click the byte field to open the Binary Editor. 

As in frame conditions, an X indicates “don’t care” and a ? indicates a partially specified hex 
character. 

Figure 215:  16G FC Trigger Window-EOF

Note: When you select SOF as the trigger, the only jam type available is SOF. 
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As with frame conditions, you can specify an optional name at the top of the window. This name is 
also shown in the Jammer Configuration window under the Mode selection and on the main Xgig 
Maestro window.

Setting 66-bit Block Payload for Ordered Set Conditions for 16G FC Trigger

You can select to compare the block type field only within the block payload, to compare a ordered 
set within the block payload, or to compare both. 

If you select to Compare block type field only (See Figure 216) or Compare both (See 
Figure 217), select a block type field from the Block type field drop-down menu. If you select 
Compare an ordered set only or Compare both, choose from a predefined Ordered Set or 
User-Defined from the Ordered set drop-down menu. You can select either /Q/ or /Fsig/ for part 
of a user-defined ordered set. You can enter hex values for the remainder of the ordered set by 
typing values into the fields, or you can double-click a value to bring up the Binary Editor.

Figure 216:  66-bit Trigger: Compare Block Type Field Only

Note: When you select EOF as the trigger, the only jam type available is EOF. The jam 
window contain a message similar to the one above.
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Figure 217:  66-bit Trigger: Compare Both

If you select Compare an ordered set only (See Figure 218), you can choose to compare the 
ordered set only at the left 32-bit position within the block payload, only at the right 32-bit 
position within the block payload, or at either position within the block payload. If you selected 
Compare both above, then Compare ordered set only at right 32-bit position within block 
payload is automatically selected, and the other selections are grayed out.

Figure 218:  66-bit Trigger: Compare An Ordered Set Only

The trigger definition you create is shown in a pane at the bottom of the 16G FC 66bit Block 
Payload for Ordered Set Trigger Definition window. The trigger definition will also be shown in 
the 16G FC 66bit Block Payload Jam Definition window to assist you in defining your jam.
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If you selected Compare both above, and you selected 0x55 as your Block type field, and you 
selected Compare ordered set at either position within block payload, all the values for the 
block payload are shown as “?” (See Figure 219). The values are represented this way to indicate 
that if the selected ordered set is encountered either in the right 32-bit position, or in the left 32-bit 
position, or in both positions, then the values will be compared, as 0x55 in the only block type 
field that will have an ordered set in both the left and right positions at all times.

Figure 219:  66-bit Trigger: 0x55 Values Represented as Question Marks
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Configuring the Jam Definition for 16G FC

The Jam Definition window defines how to modify the event specified on the Trigger Condition 
window.

The type of Jam available depends on the type of Trigger selected. In the case of SOF, EOF and 
66-bit, the Jam is always the same type as the trigger.

For any Jam Definition, you can specify an optional name at the top of the window. This name is 
also displayed on the Jammer Configuration window under Mode selection and on the main Xgig 
Maestro window.

You can save a Jam definition as a .jmj file by clicking the Save button in the Jam window. You 
can load a .jmj file by clicking the Load button in the Jam window.

Jamming an Ordered Set for 16G FC

If the Trigger Event is an Ordered Set, and you want to Jam with an Ordered Set, select Replace 
with Modified Ordered Set Jam from the drop-down menu, and click the Jam button on the Xgig 
Jammer Configuration window, to open the Ordered Set Jam Definition window (Figure 220).

The Ordered Set Jam Definition window allows you to modify any Ordered Set by replacing it 
with a different Ordered Set. You can choose from a predefined Ordered Set or choose 
user-defined (Figure 205). All choices are four bytes. You can select either /Q/ or /Fsig/ for the 
first byte of a user-defined ordered set. Then, you can enter hex values for the remaining three 
bytes.

To edit the values: 

>> Enter a hex value, or double-click the byte field to open the Binary Editor. 

As in frame conditions, an X indicates “don’t care” and a ? indicates a partially specified hex 
character. 

Figure 220:  16G FC Ordered Set Jam Definition Window
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Jamming a Control Character for 16G FC

If the Trigger Event is a Control Character, click the Jam button on the Xgig Jammer 
Configuration window, to open the Control Character Jam Definition window (Figure 220).

The Control Character Jam Definition window allows you to modify any Control Character by 
replacing it with a different Control Character.

Figure 221:  16G FC Control Character Jam Definition Window

Jamming the SOF for 16G FC

If the Trigger Event is an SOF, click the Jam button on the Xgig Jammer Configuration window, 
to open the SOF Jam Definition window (Figure 220).

The SOF Jam Definition window allows you to replace the SOF with idles, with a another 
pre-defined SOF, or with an Ordered Set. You can choose from a predefined Ordered Set or choose 
user-defined (Figure 205). All choices are four bytes. The first byte is defined as “FB”. You can 
modify the last three bytes by entering hex values.

To edit the values: 

>> Enter a hex value, or double-click the byte field to open the Binary Editor. 

As in frame conditions, an X indicates “don’t care” and a ? indicates a partially specified hex 
character. 

Figure 222:  16G FC SOF Jam Definition Window
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Jamming the EOF for 16G FC

If the Trigger Event is an EOF, click the Jam button on the Xgig Jammer Configuration window, 
to open the EOF Jam Definition window (Figure 220).

The EOF Jam Definition window allows you to replace the EOF with idles, with a another 
pre-defined EOF, or with an Ordered Set. You can choose from a predefined Ordered Set or choose 
user-defined (Figure 205). All choices are four bytes. The last byte is defined as “FD”. You can 
change the first three bytes by entering hex values. 

To edit the values: 

>> Enter a hex value, or double-click the byte field to open the Binary Editor. 

As in frame conditions, an X indicates “don’t care” and a ? indicates a partially specified hex 
character. 

Figure 223:  16G FC EOF Jam Definition Window

Jamming the Periodic FEC for 16G FC

You can create a test case with Periodic FEC Jam by selecting Periodic FEC Jam on A and B 
from the Mode drop-down menu. This mode allows you to configure the number of consecutive 
bits to be corrupted or define a bit mask to configure which of the first 16 bits will be corrupted. It 
also allows you to count of the FEC block to be skipped before a FEC Jamming.

A test case with Periodic FEC Jam will not have Arm/Trigger definition. Periodic FEC Jam Type 
is the only Jam type available for the Jam type. When you click the Jam button, the 16G FC 
Periodic FEC window appears. This window contains a check box for each port, Enable Periodic 
FEC Jamming for Port A and Enable Periodic FEC Jamming for Port B. In addition, you can 
select to invert a number (1-16) of consecutive bits at the beginning of the FEC Block. You can 
also skip a number of FEC Blocks between each Jam. 

Since Periodic FEC Jamming runs forever, rollback, repeat mode, timeout, and pause settings are 
disabled for this mode.
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Figure 224:  16G FC Periodic FEC Jam Window
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Jamming a Frame for 16G FC

To define a Jam for a frame:

1 Select a Jam from the Jam Type drop-down menu.

2 Click the Jam button to configure the Jam.

This section explains the available Jam Types.

— Replace Frame with Modified Frame

— Insert Frame

— Replace Frame with Truncated Frame

— Replace Frame with Idles

— Duplicate Frame

— Insert Dword

Replace Frame with Modified Frame

Each tab of the Modified Frame window contains options relevant to different frame 
modifications. 

— Global

— Delimiters/CRC

— Header/Payload

— Embedded Protocol(s)

Jam Behavior (All Tabs)

The Jam Behavior pane in located at the bottom of each tab in the Frame Jam Definition 
window. The Jam behavior settings control the number of user-defined header/payload Jams 
performed relative to the target trigger frame. 

Figure 225:  Jam Behavior Selection

• Jam until end of trigger frame

Jams defined in the Header/Payload tab are performed until the end of the target trigger frame 
(or until an abnormal termination of the frame). All Jams defined that would take place on the 
original CRC or later are ignored. However, if the frame that is triggered on has more Dwords 
than the Jams you specify, the remaining Dwords are passed through. The CRC and EOF of 
the original target trigger frame are always jammed according to the CRC and EOF settings on 
the SOF/CRC/EOF tab. This is the standard way to Jam a frame.
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• Execute full Jam pattern

All header and payload Jams are executed even if they overwrite beyond the end of the target 
trigger frame. 

If the target trigger frame is longer than the number of Jams defined, then the portion of the 
target trigger frame that extends after the last defined Jam is overwritten with /I/. If the target 
trigger frame is shorter, then the Jammer switches back to pass-through immediately after the 
last defined Jam. Use the control on the Header/Payload tab at the bottom of the List View 
pane to define how many payload Jams should take place.

The Execute full Jam option is supported only when any template from the FCoE library is 
loaded into the Header/Payload edit area.

The following Delimiter options are supported: 

• SOF modification

• EOF modification (always enabled)

• CRC recalculate / replace / passthrough
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Using the Global Tab

Use this tab (Figure 226) to define Jam parameters that apply globally to the frame.

Global Replace Jam Option

Use the Global Replace Jam Option word to set specific bits on an 8 bit level in a word to 1 or 
0 while passing through the remaining bits. You can apply this replace jam option to any word 
in the frame. Define one Global Replace Jam Option for each Test Case.

To edit these bits: 

>> Enter hex values, or double-click on a byte field to open the Binary Editor. 

Any bits left as Xs are passed through.

Figure 226:  16G FC Global Tab

Global 66b Jam Option

Use the Global 66b Jam Option word to set specific bits at the 64 bit level in a word to either 1 
or 0 while passing through the remaining bits. You can apply this 66b jam option to any word 
in the frame. Define one Global 66b Jam Option for each Test Case.

To edit these bits: 

>> Enter hex values, or double-click on a byte field to open the Binary Editor. 

Any bits left as Xs are passed through.
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Global Bit Errors

The Jammer software can introduce bit errors repeatedly in sequential or random fashion to 
predefined fields. These bit errors are introduced to the 32-bit form of the target words (not the 
40-bit form) so code violations are not created. The Global Bit Errors control allows you four 
options.

• Select one bit for all fields and randomly. This causes the Jammer to inject a single bit 
error in the group of all fields selected in the header or payload for a single Test Case. If 
the Jammer Test Suite is set to loop, then single bit errors are randomly injected into these 
fields, with one bit for each cycle of the Test Suite.

• Select one bit for all fields and sequentially. This also injects a single bit error in the 
group of all fields selected in the header or payload. If the Test Suite is set to loop forever, 
the bit error walks through all the selected fields.

• Select one bit in each field and randomly does the same thing as the first option; 
however, there will be one error for each word selected in the payload or header.

• Select one bit in each field and sequentially does the same thing as the second option; 
however, there will be one error for each word selected in the payload or header.

Using the Delimiters/CRC Tab for Fibre Channel

Use the choices on this tab to modify the Start of Frame (SOF) Modification, CRC Modification, 
and End of Frame (EOF) Modification (Figure 227).

Figure 227:  16G FC Delimiters/CRC Tab
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Modifying SOF/EOF 

To modify these special characters in the target trigger frame:

1 Check the appropriate box to select replacement.

2 Open the drop-down menu and choose a standard 16G FC Ordered Set, or select User-defined.

If you choose User-defined, you can specify any value for the last three bytes for SOF (The 
first byte is defined as “FB”) or the first three bytes for EOF (The last byte is defined as “FD”). 

To edit the value enter a hex value into the byte field or double-click to display the Binary 
Editor. 

CRC Options

The CRC options include:

• Not changing the CRC in the original target frame

• Recalculating the CRC to make it correct for the modified data

• Replacing with a user-specified data word

Using the Header/Payload Tab for 16G FC

You can modify any parameter or word on the 16G FC Header/Payload Tab (Figure 228). The 
maximum size for a payload is 2048 payload Dwords.

Figure 228:  16G FC Header/Payload Tab
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Notice the first line of the Jam Definition (Ether 0001) has only the first two bytes of the 
Destination Address header field. This is to visually orient the frame in the same manner as the 
Arm and Trigger Condition windows.

Similar to defining an Arm or Trigger Condition, there are two ways to specify your frame Jam 
Definition. One way is to load a template from the Template Library tree, and the other way is to 
manually specify bits in the frame.

To use a template:

1 Highlight a template in the Template Library tree on the left side of the window. 

Tree View is structured similar to the display on the right side of the Arm and Trigger 
Condition windows. You can make selections from the tree; this creates the appropriate 
Replace Jams.

2 Click the double right arrow to display the Jam definition on the right side of the window. 

Notice the special choice at the bottom left, “Current Trigger.” This is a copy of the frame 
condition you have specified for the Trigger. Click the double right arrow to use this.

When you use a template, the Jam definition is populated with Replace Jams of the specified data, 
while all other bits are passed through.

To manually edit the values, enter a value into the byte field. An X in a nibble passes the original 
value through. 

Selecting the Replace 8b Jam Mode radio button opens a dialog that allows you to replace an 
entire frame either by using a template or manually entering values. The Replace 8b Jam Mode 
dialog also contains a view of the frame contents, similar to those seen the Arm and Trigger 
Condition windows. These values correspond to the hex values defined in the center column. 
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Figure 229:  Replace 8b Jam Mode

Selecting the All Jam Modes radio button opens a dialog that provides the following choices for 
each word in a frame on the Header/Payload tab:

Apply Global Replace Jam - This function allows individual bits to be set to 1, set to 0 or passed 
through unchanged according to the Global Replace Jam option defined on the Global tab.

Invert Jam - Invert defined bits and pass through the rest. Enter 1s at the appropriate bit locations.

Pass Through Jam - Pass through the current word unchanged.

Replace 8b Jam - Replace nibbles with new values. Each drop-down represents a byte so you can 
replace a byte with a standard Ordered Set. If you choose User-defined, you can specify any K/D 
character. To edit these values, enter a value into the byte field or double-click to display the 
Binary Editor. If you specify a bit as a 0 or 1, you must specify the values of the other three bits in 
that nibble also. Any nibbles with an X are passed through.

Set Bits To 0s Jam - Set defined bits to 0s and pass through the rest. Enter 0s at the appropriate bit 
locations.

Set Bits To 1s Jam - Set defined bits to 1s and pass through the rest. Enter 1s at the appropriate bit 
locations.

Apply Global Bit Error Jam - Apply the Global Bit Error function set on the Global tab.

Insert Code Violation Jam - Introduce a predefined, fixed code violation to a byte in that word. 
Which byte is corrupted depends on the alignment orientation of the frame. The Jam Definition of 
the word before a Code Violation Jam must always be a Pass Through Jam. A Code Violation Jam 
cannot be placed in the first word of a frame (Ether 0001).
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Tree View - Another way to manually edit or view your Jam Definition is to click the Switch to 
button at the lower right corner to toggle between List View and Tree View. The List View 
interface is described in the procedures in this chapter. Tree View is structured similar to the 
display on the right side of the Arm and Trigger Condition windows. You can make selections 
from the tree; this creates the appropriate Replace Jams.

Using the Embedded Protocol(s) Tab for Fibre Channel

Figure 230 shows the Embedded Protocol(s) tab for 16G FC. The available functions are described 
in this section.

Figure 230:  16G FC Embedded Protocol(s) Tab

Recalculate LRC

Select the check boxes to choose recalculation of the LRC.

Replace LRC with this...

Checking this option replaces the LRC with a user-defined DWORD.

Disable LRC

Checking this option disables the LRC and turns the FICON feature off.
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Insert Frame

This option allows you to insert a 16G FC frame after trigger. You can define the header and the 
payload using the Template Tree on the left pane, or you can manually define the frame.

Figure 231:  16G FC Jam - Insert Frame Window

To use a template, click a frame template from the User Library or the Viavi Library in the left 
pane, then click the double right arrows to apply the template. The frame header and payload 
information appears on the right side of the window. 

Notice the special choice at the bottom left, “Current Trigger.” This is a copy of the frame 
condition you have specified for the Trigger. Click the double right arrow to use this.

To manually define a frame, type hexadecimal values directly into the center column of the 
window. 

You can modify any parameter or word in the 16G FC header or payload. The maximum size for a 
header + payload is 540 Dwords. The minimum size is six Dwords.
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SOF Modification

You can choose from a predefined Ordered Set representing the SOF or choose user-defined. All 
choices are four bytes. For a user-defined ordered set, the first byte is FB. You can enter hex values 
for the remaining three bytes.

To edit the values: 

>> Enter a hex value, or double-click the byte field to open the Binary Editor. 

CRC Modification

You can choose to either recalculate the correct CRC to make it correct for the modified data or to 
replace the CRC with a user-specified DWORD.

To edit the values: 

>> Enter a hex value.

EOF Modification

You can choose from a predefined Ordered Set representing the EOF or choose user-defined. All 
choices are four bytes. For a user-defined ordered set, the last byte is FD. You can enter hex values 
for the remaining three bytes.

To edit the values: 

>> Enter a hex value, or double-click the byte field to open the Binary Editor. 

Decode Switches Menu

Some templates allow you to specify decode switches. When you load a template that has this 
option, the Decode Switches Menu appears in the upper left corner of the window. The decode 
switches provide detailed contextual options for decode; for example, further decode of response 
and data frames. The Decode Switches menu is context sensitive and will only show the decode 
options available for the specific template you are creating. 

The Decode Switches menu is intended to help you create a user-defined template. When editing 
a User Library template, Decode Switches are stored inside the template so they are still ON the 
next time you open this particular template.

Decode switches allow you to further decode Response and Data frames that can't be decoded 
without knowing what the associated command frame is. Below is a description of the switches 
available for Jammer’s Trigger and Insert Frame conditions:

Note: Once the Decode Switches menu appears, it remains visible. However, if you load a 
template that has no decode options, the menu is greyed out and inactive. 
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FCoE Interpretations

This menu is available for FCoE frames. Fibre Channel over Ethernet (FCoE) is the proposed 
mapping of Fibre Channel over selected full duplex IEEE 802.3 networks. The Auto-Detect 
FCoE setting automatically detects the version and is the default decode switch. The 
auto-detect mode works on a per-FCoE frame basis. It assumes that the FCoE frame reserved 
bits are set to zero and detects which FCoE specification is in use depending on where the 
zeroes are. If you end up with multiple errors and erroneous decoding of the FCoE frames, it is 
because the auto-detect mode assumptions do not work with your particular trace. This 
requires that select manually which FCoE specification to use. Available settings are:

• Auto-Detect FCoE
Automatically detects the specification version by looking at the frame header.

• T11 FCoE (Latest)
Selects the latest draft of the T11 standards committee specification as of this Xgig 
Analyzer release date.

• Pre-T11 FCoE Draft
Selects the pre-T11 standards committee draft, 07-303v0.pdf.

FC-ELS Accept Interpretation

This menu item is available for FC-ELS (Fibre Channel Extended Link Services) Accept 
frames. It contains a list of the possible Link Services Accept frame formats.

Saving a Frame

If you create a frame that you want to save and make easily available for future use, you can save 
it into the “User Library” folder in the Template Library tree. To do this:

1 Make sure the frame contents are displayed in the right pane.

2 Type a name for the frame, and click the double left arrow button. 

The frame appears in the User Library.

Replace Frame with Truncated Frame

This option truncates the target frame to a shorter length and sends Idles /I/ on top of the remainder 
of the target frame.

In the Truncate Frame Options window:

1 Enter the number of bytes you want the payload to be truncated to (this does not include the 
CRC or other delimiters).

2 Select an optional new EOF from the drop-down list, or choose user-defined, and define a four 
byte EOF.

3 Select LRC options. You can recalculate the LRC, replace the LRC with a user-defined FCoE 
Payload.
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Replace Frame with Idles

This option replaces the target frame with /I/ Ordered Sets in the 16G FC Jammer. There are no 
options to set for this Jam.

Figure 232:  16G FC - Replace Frame with Idles

Duplicate Frame

You can duplicate the triggered frame and insert it after the frame. There are no options to set for 
this Jam.

Figure 233:  16G FC - Duplicate Frame

Insert Dword

This option allows you to insert a 32-bit word to the triggered frame at a particular offset. The 
position of offset 0 begins after the preamble of a frame. The 32-bit data to be inserted is user 
programmable. Only data characters can be inserted. The GE CRC, FCoE CRC, IP checksum are 
automatically recalculated.

Figure 234:  16G FC Insert Dword

If the repeat jam option is used for an Insert Dword jam, the IPG between frames must be greater 
than minimum IPG. If the triggered frames are spaced by minimum IPG, the insertion process may 
be aborted before the specified number of repeat jams, and you will receive an error notice.
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Jamming a 66-bit Block Payload for 16G FC

If the trigger event is a 66-bit Block Payload for Ordered Set, click the Jam button on the Xgig 
Jammer Configuration window, to open the 66-bit Block Payload Jam Definition window (See 
Figure 235).

Figure 235:  66-bit Block Payload Jam Definition Window

The Trigger Definition pane shows the trigger you defined in the 16G FC 66-bit Block Payload 
for Ordered Set Trigger Definition window. The information in the trigger definition is what you 
are going to be replacing with the jam.

Use the Jam pane to define which bits you want to jam. 
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Sync Bits

First, choose either to Pass-through Sync Bits or Jam Sync Bits. If you choose to Jam Sync 
Bits (See Figure 236), you can define all 66 bits of the jam using the binary editor provided. As in 
frame conditions, an X indicates “don’t care”. If you select Pass-through Sync Bits (See 
Figure 237), the pane expands to include details for the block type field.

Figure 236:  66-bit Jam: Jam Sync Bits

Figure 237:  66-bit Jam: Pass Through Sync Bits



Configuring the Jam Definition for 16G FC Creating Jammer Test Configurations for 16G FC

Xgig Jammer and Delay Emulator User Guide 245

  

Block Type Field

The block type field defines what format of data you are using and which two quantities of data 
(one at the left 32-bit position and one at the right 32-bit position) are present in the 64-bit block 
payload you are jamming. The left and right quantities are represented in the panes at the bottom 
of the window. 

Pass-through the Block Type

The options you are presented with in the dialog depend on the trigger definition you have defined. 

If you select Pass-through Block Type Field, and your trigger definition includes Compare an 
Ordered Set Only, then you can define the last 56 bits of the jam using the binary editor provided. 
As in frame conditions, an X indicates “don’t care”. No panes are shown at the bottom of the 
window (See Figure 238).

Figure 238:  66-bit Jam: Compare an Ordered Set Only

If you select Pass-through Block Type Field, and your trigger definition includes Compare 
block type field only or Compare both, then the contents of the panes at the bottom of the 
window depend on the block type field you selected in the trigger. The values from the trigger 
block type field are passed through to the jam block type field. Based on this block type field, the 
corresponding left and right jams are displayed (See Figure 239).
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Figure 239:  66-bit Jam: Jam Left/Right Panes Shown

Jam Block Type Field

If you select the Jam Block Type Field, the bottom panes will change depending on which block 
type field you select from the drop-down menu. If you select User-Defined from the drop-down 
menu, a binary editor will appear allowing you to define the 64-bit block payload you want to jam 
(See Figure 240).

Figure 240:  66-bit Jam: Jam Block Type Field (User-Defined)

Below the Jam Block Type Field option, a pane shows your jam. As you choose different block 
type fields, the jam in the pane changes (See Figure 241).
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Figure 241:  66-bit Jam: Jam Values Shown in Pane

Left and Right Jam Types

The panes at the bottom of the window provide you with different ways to jam the data at the left 
32-bit position and the data at the right 32-bit position in the 64-bit block payload. The 
pass-through choices are greyed out if your jam definition does not match your trigger definition 
because the condition is automatically false and, therefore, the values cannot be passed through.

Jam Control Characters with

The following choices are available for jamming control characters:

• pass-through Control Characters

• Idle Primitive

• a user-defined value

The user defined values include four seven-bit Ordered Sets for the left or right Idle jam 
for a total of 28 bits. These Ordered Sets are labeled either C0-C3 (right) or C4-C7 (left). 
Select a pre-defined Ordered Set from each drop-down menu, or select User-Defined to 
define your own Ordered Set. You can either type hex values directly into the 0x fields, or 
double-click an 0x field to open the Binary Editor and define each bit value.

Jam Ordered Set with

The following choices are available for jamming an Ordered Set:

• pass-through Ordered Set

• this Ordered Set

Select a pre-defined Ordered Set from the drop-down menu.

• this User-defined Sequence Ordered Set (use [Q])
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Type hex values into the fields at the bottom of the pane, or double-click a value to open 
the Binary Editor and type in the bit values. The first seven bits of this Ordered Set are not 
editable.

• this User-defined Signal Ordered Set (use [Fsig])

Type hex values into the fields at the bottom of the pane, or double-click a value to open 
the Binary Editor and type in the bit values. The first seven bits of this Ordered Set are not 
editable.

• a user-defined value

Type hex values into the fields, or double-click a value to open the Binary Editor and type 
in the bit values.

Jam SOF with

• pass-through SOF

• this SOF

Select an SOF from the drop-down menu.

• a user-defined value

Type hex values into the fields, or double-click a value to open the Binary Editor and type 
in the bit values.

Jam EOF with

• pass-through EOF

• this EOF

Select an EOF from the drop-down menu.

• a user-defined value

Type hex values into the fields, or double-click a value to open the Binary Editor and type 
in the bit values.

Jam Data with

• pass-through value

• this value

Type hex values into the fields, or double-click a value to open the Binary Editor and type 
in the bit values.
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Chapter 8
Creating Jammer Test Configurations for PCIe 

In this chapter:

• Defining Your Own Test Configurations for PCIe

• Using the Jammer Configuration Window for PCIe

• Configuring the Arm Condition for PCIe

• Configuring the Trigger Condition for PCIe

• Configuring the Jam Definition for PCIe
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Defining Your Own Test Configurations for PCIe

Xgig Jammer lets you define your own test configurations and save them with or without hardware 
available for PCIe Generations 1, 2, and 3.

You can create a configuration from scratch, or you can open and edit an existing configuration. 
Also, you can edit a configuration in edit only mode, which is independent of any hardware, or 
you can edit a configuration that is currently loaded to a Jammer device.

To edit a configuration in edit only mode:

>> Double-click on a configuration file in the Configuration manager. 

or:

>> Right-click on the configuration file in the Configuration manager and choose Edit Jammer 
Configuration from the context menu.

The edit only mode Jammer Configuration window opens (Figure 242).

This window allows you to set up your own Test Cases, name them, organize them, and save 
them to files so that you can use them again.

Figure 242:  Edit Only Jammer Configuration Window  
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To start a configuration from scratch in edit only mode:

>> Select New Jammer File from the context menu or the File menu (Figure 243) on the Xgig 
Maestro menu bar. Then, select Pcie Jammer Configuration... from the drop down menu.

or:

>> Click the New Configuration icon at the top of the Configuration manager.

Figure 243:  Maestro File Menu 

To save your configuration in edit only mode:

>> Click Save at the bottom of the Jammer Configuration window or open the File menu on the 
Jammer Configuration window and select Save Configuration or Save Configuration As.

Any changes you make have no effect on actual Jammer devices you control.

To edit a configuration that is loaded to a Jammer port:

>> Click Configuration... in the device column.

or:

>> Right-click in the Parameters Status table in the device column to open the context menu and 
select Edit configuration.

or: 

>> Click Operation in the device column to open the Operation dialog, then click Config.

The Xgig Jammer Configuration window in hardware edit mode is displayed (Figure 244). 
This window allows you to set up your own Test Cases, name them, and save them to a file so 
that you can use them again.

Click Apply or OK and Jammer accepts the changes. They are immediately reflected in the 
Parameters Status table and affect the Jammer device the next time you run it.

To save your configuration edits:

>> Open the File menu at the top of the Jammer Configuration window and select 
Save Configuration As... or Save Configuration.
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Figure 244:  Xgig Jammer Configuration Window  

Using the Jammer Configuration Window for PCIe

The Jammer Configuration window title bar indicates how many ports it is configuring, the 
protocol, and the configuration file name, if any. If you are using hardware edit mode, the chassis 
name, chassis number, slot number, and port number are also listed. The elements of the Jammer 
Configuration window are described in the following sections.
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Using the Jammer Test Suite Tools for PCIe

The Jammer Test Suite (left pane) lists the series of Xgig Jammer tests in the order in which you 
want them to execute. The suite includes one or more tests. The highlighted test appears as the 
Current Jammer Test (right pane). Each test in the suite executes in sequence with a test reset time 
of approximately 130 (200 max) milliseconds.

Creating a Test Suite

When you create a PCIe Jammer Test Suite, you use the toolbar in the Jammer Test Suite section 
of the Configuration window (Figure 245).

Figure 245:  PCIe Jammer Test Suite Toolbar 

The following list describes the icons on the toolbar:

To duplicate a test at another point in the Test Suite:

1 Highlight the test you want to duplicate.

2 Click Copy.

Cut current test Removes the highlighted test and holds its contents in the 
memory buffer.

Copy current text Copies the highlighted test to the memory buffer.

Paste last test cut or copied Inserts the current memory buffer contents before the currently 
highlighted test.

Add new test to bottom of stack Adds a new blank test to the bottom of the suite.

Insert new test before current test Inserts a new blank test above the currently highlighted test.

Delete current test Removes the highlighted test from the suite. If only one test is 
present, then the contents of this test are cleared.

Move current test down the stack Moves the highlighted test down one in the test order.

Move current test up the stack Moves the highlighted test up one in the test order.

Toggle view Toggles Test Suite between Card View and List View.

Run test suite once or Repeat test 
suite

When you choose Repeat test suite, the tests run according 
the settings you define in the Jammer Current Test window.
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3 Highlight the test in the suite that is just after the point where you want the duplicate test 
inserted.

4 Click Paste.

The duplicate test is inserted.

Refer to “Configuring the Arm Condition for PCIe”, “Configuring the Trigger Condition for 
PCIe” and “Configuring the Jam Definition for PCIe” for information about configuring each 
test.

Using the Configuration File Menu

The File menu is the only menu on the menu bar (Figure 246). 

Figure 246:  Configuration File Menu 

The choices are:

Also, note that the recently used PCIe Jammer configuration files appear in the file menu and are 
loaded when selected.

Open Configuration Open an existing .tsk configuration file.

Import to Selected Test Import a Test Case from a .tst file or an entire test suite, .tsk file, to 
the currently highlighted position. A Test Case is one line in the Jammer 
Test Suite.

Export Selected Test Export and save the currently highlighted test to a .tst file.

Save Configuration Save the entire Test Suite to the .tsk file you currently have loaded.

Save Configuration As Save the entire Test Suite to a .tsk file with a name you assign to it.

Close Close the Jammer Configuration Window.

Note: The .tst files are only for storing individual Test Cases and swapping them between 
configuration files. You cannot load .tst files directly into a Jammer device on the Xgig 
Maestro window.
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Using the Current Jammer Test Window for PCIe

The graphics in this section of the window represent the hardware configuration for the selected 
test in the Jammer Test Suite (Figure 247).

Figure 247:  Current Jammer Test Window  

Mode

For PCIe, Mode menus are available near the top of the Current Jammer Test window (Figure 248) 
and also near the top of each Test Case in the Jammer Test Suite window (Figure 249). 

The input to path A (on top) is always port A and the input to path B (on the bottom) is always port 
B. The external trigger input and output that are available on path A always are linked to the 
domain shown on the Xgig Maestro window as “Domain of port A.” The trigger input and output 
on the bottom on path B are in the “Domain of port B.” 
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Figure 248:  Mode Drop-down Menu in Current Jammer Test - Right Pane 

Figure 249:  Mode Drop-down Menu in Test Suite - Left Pane 

Arm and Trigger

To define Arm and Trigger conditions, select a respective Type from each drop-down menu. Then 
click the Arm or Trigger button to open the corresponding definition window. 

You can use an external input as an Arm condition. Check Trigger from Domain A (or B) to enable 
this feature. You must put the corresponding Jammer port into a domain for this to work properly. 

The Trigger event can be in the next Dword after the Arm event in the traffic stream.

Jam

To define a Jam: 

1 Select a Type from the drop-down menu, if available.

2 Click the Jam button to open the Jam Definition window.

The Jam Definition specifies the modifications to be made to the traffic matching the Trigger 
Condition.

In addition, the Jammer port can trigger out to the Domain it is in when a Jam takes place. 
Check Trigger Domain A (or B) upon Jam to enable this feature.  

Note: If you use an external trigger input to define the Arm condition, then you cannot select 
the external trigger output for that path in that test case, and vice versa. For information 
regarding using the trigger input and output during a test case, refer to “Using Domains and 
External Triggering” on page 291. 
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Rollback 

The Rollback option  parameter defines the time or word count parameter between the 
Arm and Trigger events. If the Trigger does not follow the Arm event in the allotted time or word 
count, the Xgig Jammer begins looking for the Arm event again. Click Rollback to display the 
dialog box shown in Figure 250.  

Figure 250:  Rollback Condition Dialog  

Repeat 

Click the Repeat button to open one of the dialog boxes shown in Figure 251. The Repeat dialog 
box uses counters to provide an increased level of control over the Jam allowing you to skip over 
extraneous instances of the arm or trigger conditions and target the precise data you want to Jam. 
There are two unique Repeat dialog box for PCIe Jammer configuration modes; the “Trigger + 
Jam” or the “Arm then Trigger + Jam” modes. The Repeat Mode option means that the Jammer 
must match the specified condition each time before looking for a Trigger. 

Note: This value is saved in terms of words, not time, so keep this in mind if you save a Test 
Case using a device running at 2.5 GT/s and later open the configuration on a Jammer running 
at 5.0 GT/s. 
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Figure 251:  PCIe Repeat Dialog Boxes  

A maximum of 32,767 occurrences or the Arm condition can be waited for.

A maximum of 32,767 occurrences of the Trigger condition can be ignored.

Timeout

The timeout option defines the period of time to wait for a specified test to complete before 
aborting and proceeding to the next test in the suite.

To set the timeout:

1 Click Timeout to display the dialog box in Figure 252. 

2 Check Enable Timeout.

3 Enter the hours, minutes, and seconds you want to wait.

Figure 252:  Timeout Dialog 

4 Click OK.

Pause

Click Pause to open the dialog shown in Figure 253. The Pause setting allows you to insert a 
pause before the beginning of a test case. 
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Figure 253:  Pause Test Dialog 

You can also configure options for each Test Case directly in the Test Suite, instead of clicking in 
the Current Jammer Test pane. Click on the area of the Test Case you want to modify to open the 
corresponding dialog (Figure 254).

Figure 254:  Configuring Options Directly in the Test Suite  
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Configuring the Arm Condition for PCIe

The PCIe Arm condition recognizes specific TLPs (Transaction Layer Packets), DLLPs (Data 
Link Layer Packets), or ordered sets. You can select from the following:

• TLP - Allows you to specify a TLP to set the Arm Condition (see page 261)

• DLLP - Allows you to specify a DLLP to set the Arm Condition (see page 263)

• Ordered Set - Provides you with predefined ordered sets to set the Arm Condition (see 
page 265)

You can save an arm or trigger condition as a .jmt file by clicking the Save button in the Arm or 
Trigger window. You can load a .jmt file by clicking the Load button in the Arm or Trigger 
window.

Depending on the Mode you select, the appropriate graphic diagram shows the Trigger and 
optional Arm conditions, along with the Jam event. If the Mode you select does not include an 
Arm condition, the Arm button is disabled.

To set Arm conditions: 

1 Select TLP, DLLP, or Ordered Set from the Type drop-down menu in the Arm section of the 
Current Jammer Test window.

2 Click on the Arm button to open the Arm window.

The window for the condition is displayed (Figure 255). If you are in hardware edit mode, the 
protocol, chassis name, chassis number, slot number, and port numbers are displayed in the 
title bar.

3 Set the values as required to specify the Arm condition as part of a unique Arm and Trigger 
sequence for the specific test.

The following sections describe the available values.
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Setting TLP Conditions for PCIe Arm

You can specify TLP conditions (Figure 255) by loading a template from the Template Library 
tree. You can manually specify bits in the TLP. 

Figure 255:  PCIe Arm TLP Definition Window 

Selecting a TLP template from the Library list displays the first 32 Dwords of the TLP in the 
center portion of the window. Depending on the selected template, the first 3 or 4 Dwords of the 
displayed template are the TLP header.

To use a template:

1 Select a template from the Template Library tree on the left.

2 Click the double right arrow button to set the Arm Condition. 

The condition is indicated on the right side of the window.

To manually specify a string in the TLP: 

>> Type hexadecimal values directly into the center column of the window.

An X represents a nibble that can be any value (a “don’t care”). 

To set individual bits in any field, double-click on the hex entry to open the Binary Editor 
(Figure 256). In the hex view, partially defined hex characters appear as question marks.
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Figure 256:  Binary Editor Dialog 

A way to manually edit the TLP Header is to make selections from the tree view in the right 
window pane. Selecting all or specific portions of the TLP Header from this tree view will 
highlight that selection in the Hex code displayed in the center portion of the window.

Saving a TLP Arm Definition

If you create a TLP definition for Arm that you want to save and make easily available for future 
use, you can save it into the “User Library” folder in the Template Library tree. To do this:

>> Highlight the folder and click the double left arrow button.

TLP conditions have the option of “Use inverse of condition specified (i.e., NOT).” When you 
check this option, it means that the first TLP encountered that does not match what you have 
specified creates a “condition met” event.

For each TLP condition, you can specify an optional name at the top of the window. This name is 
also shown on the Jammer Configuration window under the Mode selection, and on the main Xgig 
Maestro window.
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Setting DLLP Conditions for PCIe Arm

You can specify DLLP conditions (Figure 257) by loading a template from the Template Library 
tree. You can manually specify bits in the DLLP. 

Figure 257:  PCIe Arm DLLP Definition Window 

Selecting a DLLP template from the Library list displays the DLLP in the center portion of the 
window. 

To use a template:

1 Select a DLLP template from the Template Library tree on the left.

2 Click the double right arrow button to set the Arm Condition. 

The condition is indicated on the right side of the window.

To manually specify a string in the DLLP: 

>> Type hexadecimal values directly into the center column of the window.

An X represents a nibble that can be any value (a “don’t care”). 

To set individual bits in any field, double-click on the hex entry to open the Binary Editor 
(Figure 258). In the hex view, partially defined hex characters appear as question marks.
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Figure 258:  Binary Editor Dialog 

A way to manually edit the DLLP is to make selections from the tree view in the right window 
pane. Selecting all or specific portions of the DLLP from this tree view will highlight that 
selection in the Hex code displayed in the center portion of the window.

Saving a DLLP Arm Definition

If you create a DLLP definition for Arm that you want to save and make easily available for future 
use, you can save it into the “User Library” folder in the Template Library tree. To do this:

>> Highlight the folder and click the double left arrow button.

DLLP conditions have the option of “Use inverse of condition specified (i.e., NOT).” When you 
check this option, it means that the first DLLP encountered that does not match what you have 
specified creates a “condition met” event.

For each DLLP condition, you can specify an optional name at the top of the window. This name is 
also shown on the Jammer Configuration window under the Mode selection, and on the main Xgig 
Maestro window.
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Setting Ordered Set Conditions for PCIe Arm

You can choose from predefined Ordered Sets for PCIe Generations 1 and 2. You can select from 
EDB, EIOS, END, FTS, IDL, SDP, SKP, or STP from the Ordered sets in the Library. All Ordered 
Set choices are four bytes long and are not editable. 

Figure 259:  PCIe Arm Ordered Set Definition Window 

The Lane selections near the top of the page allow you to monitor any or all of the lanes to identify 
the selected Ordered Set to meet the ARM condition using one or more lanes. 

Specify the PCIe generation from the tree view in the right window pane. Select either Gen 1 or 
Gen 2. 

You can specify an optional name at the top of the window. This name is also shown in the Jammer 
Configuration window under the Mode selection and on the main Xgig Maestro window.
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Configuring the Trigger Condition for PCIe

The PCIe Trigger condition recognizes specific TLPs (Transaction Layer Packets), DLLPs (Data 
Link Layer Packets), or ordered sets. You can select from the following:

• TLP - Allows you to specify a TLP to set the Trigger Condition (see page 261)

• DLLP - Allows you to specify a DLLP to set the Trigger Condition (see page 263)

• Ordered Set - Provides you with predefined ordered sets to set the Trigger Condition (see 
page 265)

Depending on the Mode you select in the Jammer Configuration window, the appropriate 
graphic diagram shows the Trigger and optional Arm conditions, along with the Jam event. If the 
Mode you select does not include an Arm condition, the Arm button remains disabled.

To set Trigger conditions: 

1 Open the Type drop-down in the Trigger Condition window, and select TLP, DLLP, or 
Ordered Set.

2 Click the Trigger button in the Xgig Jammer Configuration window. 

The window for the condition is displayed. If you are in hardware edit mode, the protocol, 
chassis name, chassis number, slot number, and port numbers are displayed in the title bar.

3 Set the values as required to specify the Trigger condition as part of a unique Arm and Trigger 
sequence for the specific test.

The following sections describe the available Trigger Type values.



Configuring the Trigger Condition for PCIe Creating Jammer Test Configurations for PCIe

Xgig Jammer and Delay Emulator User Guide 267

  

Setting TLP Conditions for a PCIe Trigger

You can specify TLP trigger conditions (Figure 260) by loading a template from the template 
Library tree. You can manually specify bits in the TLP. 

Figure 260:  PCIe Trigger TLP Definition Window 

Selecting a TLP template from the Library list displays the first 32 Dwords of the TLP in the 
center portion of the window. Depending on the selected template, the first 3 or 4 Dwords of the 
displayed template are the TLP header.

To use a template:

1 Select a template from the Template Library tree on the left.

2 Click the double right arrow button to set the Trigger Condition. 

The condition is indicated on the right side of the window.

To manually specify a string in the TLP: 

>> Type hexadecimal values directly into the center column of the window.

An X represents a nibble that can be any value (a “don’t care”). 

To set individual bits in any field, double-click on the hex entry to open the Binary Editor 
(Figure 261). In the Hex view, partially defined hex characters appear as question marks.
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Figure 261:  Binary Editor Dialog 

A way to manually edit the TLP Header is to make selections from the tree view in the right 
window pane. Selecting all or specific portions of the TLP Header from this tree view will 
highlight that selection in the Hex code displayed in the center portion of the window.

Saving a TLP Trigger Definition

If you create a TLP trigger definition that you want to save and make easily available for future 
use, you can save it into the “User Library” folder in the Template Library tree. To do this:

>> Highlight the folder and click the double left arrow button.

TLP trigger conditions have the option of “Use inverse of condition specified (i.e., NOT).” When 
you check this option, it means that the first TLP encountered that does not match what you have 
specified creates a “condition met” event.

For each TLP trigger condition, you can specify an optional name at the top of the window. This 
name is also shown on the Jammer Configuration window under the Mode selection, and on the 
main Xgig Maestro window.
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Setting DLLP Conditions for a PCIe Trigger

You can specify DLLP conditions (Figure 262) by loading a template from the Template Library 
tree. You can manually specify bits in the DLLP. 

Figure 262:  PCIe Trigger DLLP Definition Window 

Selecting a DLLP template from the Library list displays the DLLP in the center portion of the 
window. 

To use a template:

1 Select a DLLP trigger template from the Template Library tree on the left.

2 Click the double right arrow button to set the Trigger Condition. 

The condition is indicated on the right side of the window.

To manually specify a string in the DLLP: 

>> Type hexadecimal values directly into the center column of the window.

An X represents a nibble that can be any value (a “don’t care”). 

To set individual bits in any field, double-click on the hex entry to open the Binary Editor 
(Figure 258). In the hex view, partially defined hex characters appear as question marks.
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Figure 263:  Binary Editor Dialog 

A way to manually edit the DLLP is to make selections from the tree view in the right window 
pane. Selecting all or specific portions of the DLLP from this tree view will highlight that 
selection in the Hex code displayed in the center portion of the window.

Saving a DLLP Trigger Definition

If you create a DLLP definition for Trigger that you want to save and make easily available for 
future use, you can save it into the “User Library” folder in the Template Library tree. To do this:

>> Highlight the folder and click the double left arrow button.

DLLP conditions have the option of “Use inverse of condition specified (i.e., NOT).” When you 
check this option, it means that the first DLLP encountered that does not match what you have 
specified creates a “condition met” event.

For each DLLP condition, you can specify an optional name at the top of the window. This name is 
also shown on the Jammer Configuration window under the Mode selection, and on the main Xgig 
Maestro window.
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Setting Ordered Set Conditions for a PCIe Trigger

You can choose from predefined Ordered Sets for PCIe Generation 1 and Generation 2. You can 
select from EDB, EIOS, END, FTS, IDL, SDP, SKP, or STP from the Ordered sets in the Library. 
All Ordered Set choices are four bytes long and are not editable. 

Figure 264:  PCIe Arm Ordered Set Definition Window 

The Lane selections near the top of the page allow you to monitor any or all of the lanes to identify 
the selected Ordered Set to meet the Trigger condition using one or more lanes. 

Specify the PCIe generation from the tree view in the right window pane. Select either Gen 1 or 
Gen 2. 

You can specify an optional name at the top of the window. This name is also shown in the Jammer 
Configuration window under the Mode selection and on the main Xgig Maestro window.
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Configuring the Jam Definition for PCIe

The Jam Definition window defines how the specified event on the Trigger Condition window is 
modified. The type of Jam that is available depends on the type of Trigger selected. 

• Where the Trigger type is TLP, the Jam is always Replace TLP with Modified TLP.

• Where the Trigger type is DLLP, the Jam is always Replace DLLP with Modified DLLP.

• Where the Trigger type is Ordered Set, the Jam is always PCIe Ordered Set Jam Type.

For any Jam definition, you can specify an optional name at the top of the window. This name is 
also displayed on the Jammer Configuration window under Mode selection and on the main Xgig 
Maestro window.

Access the Jam definition windows using the Jam button in the Jam area 

You can save a Jam definition as a .jmj file by clicking the Save button in the Jam window. You 
can load a .jmj file by clicking the Load button in the Jam window.

Jamming a TLP for PCIe

With TLP as the Trigger Type, the Jam Type is Replace TLP with Modified TLP. When you select 
the Jam button, the following Jam Definition window is displayed (Figure 265). This window 
allows you to define the modified TLP that is used. 

There are three tabs: the Header/Payload tab defines the modified TLP; 
the Gen1/2 tab sets the SOP and LCRC modification settings for PCIe Generation 1 and 2; 
the Gen 3 tab sets the STP and LCRC modification settings for PCIe Generation 3. 

Header/Payload Tab

Any parameter in the PCIe header can be modified (Figure 265). Select either the Replace Jam or 
All Jam Modes radio button to define the Jam frame. 

The Header/Payload tab allows you to select a modified TLP packet from the Library on the left 
of the window. When the selection is made and you click the “double right arrow” button, the 
Dwords representing the full PCIe frame are displayed in the Index/Hex columns in the center of 
the window. 

The first 309 Dwords in the Frames Header and Payload are editable. The maximum value of 309 
is allowed to be entered. You can set the number of Dwords by changing the value shown below 
the Index/Hex columns. 
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Figure 265:  PCIe Jamming TLP Header/Payload Tab Definitions 

Depending on the selected TLP, the header portion is either the first 3 or 4 Dwords. At the right 
side of the window, the header portions of the TLP are shown. Selecting a specific header portion 
highlights corresponding the Hex value. 

In the Hex view, an X represents a nibble that can be any value (a “don’t care”). 
Partially defined hex characters appear as question marks.

To modify the Hex value of a highlighted string, double-click the string to display the Binary 
Editor (Figure 266). 

Figure 266:  Binary Editor Dialog 

Select the All Jam Modes radio button to open the All Jam Modes screen (see Figure 267). This 
screen provides access to set the Jam modes. Use the drop down arrow (circled in red) to open the 
list of available Jam modes.
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Figure 267:  All Jam Modes for PCIe TLP 

The header portion (index numbers 00000000 through 00000006) has six available Jam options.  

The payload portion (index numbers 00000007 and above) allows only two Jam choices: 
Pass Through Jam and Replace Jam 

• Pass Through Jam - Pass through the current word unchanged.

• Create Error Jam (Gen1/2 Only) - Check Inject Error for any byte(s) on which you want to 
send Disparity Errors. This inverts the running disparity at that byte. Selecting the 
Description column displays the following dialog box to make changes: 

Note: Once any option (other than Pass Through Jam and Create Error Jam) is selected for a 
Dword, only that Jam option plus the Pass Through Jam and Create Error Jam options are 
available for any of the other Dwords in the header portion.

Note: If any Dword in the header portion is set to Invert Jam, Set Bit to 0’s Jam, or Set Bits to 1’s 
Jam, then only the Pass Through Jam option is available in the payload portion.
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• Replace Jam - This function allows you to replace each nibble with a new value. Selecting 
the Description column displays the following dialog box to make changes: 

• Invert Jam - Invert defined bits and pass through the rest. Enter 1s at the appropriate bit 
locations. Selecting the Description column displays the following dialog box to make 
changes: 

• Set Bits To 0’s Jam- Set defined bits to 0’s and pass through the rest. Enter 0’s at the 
appropriate bit locations. Selecting the Description column displays the following dialog box 
to make changes: 

• Set Bits To 1’s Jam - Set defined bits to 1’s and pass through the rest. Enter 1’s at the 
appropriate bit locations. Selecting the Description column displays the following dialog box 
to make changes: 
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Gen 1/2 Tab

Selecting the Gen 1/2 tab allows you to define whether you want to pass through or change the 
TLP’s SOP (Start Of Packet) and LCRC (Link Cyclical Redundancy Check) values.

Figure 268:  PCIe Jamming TLP Gen1/2 Definition Window 

SOP Modification: Select either the Pass through SOP or Replace SOP with this... options. 
You can replace the SOP with User-Defined Bytes. Byte 0 is fixed and cannot be changed. You can 
modify Byte 1 and Byte 2 of the SOP. Enter values directly into the byte text boxes. 

Figure 269:  SOP Modification Bytes 

Enter values directly into the byte text boxes. The upper 4 bits of Byte 1 are Reserved bits. 

As shown in Figure 269, the 12-bit packet sequence number is the lower 4 bits of Byte 1 and the 8 
bits of Byte 2. You can also change this number by selecting the Packet Sequence Number 
button to display the Packet Sequence Number dialog box. Enter a value for the packet sequence 
number into the dialog box and select OK to modify the 12-bit value. 
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Figure 270:  Packet Sequence Number Dialog Box 

LCRC Modification: Select either the Pass through CRC unchanged or Recalculate correct 
CRC options.

Gen 3 Tab 

Selecting the Gen 3 tab allows you to define whether you want to pass through or change the 
TLP’s STP (Start Of Packet) and LCRC (Link Cyclical Redundancy Check) values.

Figure 271:  PCIe Jamming TLP Gen 3 Definition Window 

STP Modification: Select either the Pass through STP or Replace STP with this... options. You 
can replace the STP with a User-Defined Dword. Double-click the text boxes to enter bit values 
into the text boxes.
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Figure 272:  STP Modification Bytes 

LCRC Modification: Select either the Pass through CRC unchanged or Recalculate correct 
CRC options.

Jamming a DLLP for PCIe

With DLLP as the Trigger Type, the Jam Type will be Replace DLLP with Modified DLLP. 
When you select the Jam button, the following Jam Definition window is displayed (Figure 273). 
This window allows you to define the modified DLLP that is used. 

There are three tabs: the Header/Payload tab defines the DLLP, the Gen 1/2 tab sets the CRC 
modification settings, and the Gen 3 tab sets the CRC modification settings. 

Header/Payload Tab

The Header/Payload tab allows you to select a modified DLLP packet from the Library on the left 
of the window. When the selection is made and you click the “double right arrow” button, the 
DLLP’s Dword is displayed in the Index/Hex columns in the center of the window. 
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Figure 273:  PCIe Jamming DLLP Header/Payload Tab Definitions 

The header portions of the selected DLLP are shown. Selecting a specific header portion 
highlights corresponding the Hex value. 

In the Hex view, an X represents a nibble that can be any value (a “don’t care”). 
Partially defined hex characters appear as question marks.

To modify the Hex value of a highlighted string, double-click the string to display the Binary 
Editor (Figure 274). 

Figure 274:  Binary Editor Dialog 
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Select the All Jam Modes radio button to open the All Jam Modes screen (see Figure 275). This 
screen provides access to set the Jam modes using the drop down arrow (circled in red). 

Figure 275:  All Jam Modes for PCIe DLLP 

All Jam Modes for DLLP has the following available Jam options. 

• Pass Through Jam - Pass through the current word unchanged.

• Replace Jam - This function allows you to replace each nibble with a new value. Selecting 
the Description column displays the following dialog box to make changes: 

• Create Error Jam (Gen1/2 Only) - Check Inject Error for any byte(s) on which you want to 
send Disparity Errors. This inverts the running disparity at that byte. Selecting the 
Description column displays the following dialog box to make changes:  
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Gen 1/2 Tab 

Selecting the Gen1/2 tab allows you to define whether you want to pass through, recalculate, or 
replace the DLLP’s CRC value with a User-Defined Word. If you select that you want to replace 
the CRC value with a User-Defined Word, you set the word’s 2 bytes using the with the buttons at 
the right which display a drop-down list to select from. You can also inject disparity error on either 
Byte 0 or Byte 1by selecting one or both of the Inject Error check boxes.

Figure 276:  PCIe Jamming DLLP Gen 1/2 CRC Definitions  
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Gen 3 Tab 

Selecting the Gen3 tab allows you to define whether you want to pass through, recalculate, or 
replace the DLLP’s CRC value with a User-Defined Word. If you select that you want to replace 
the CRC value with a User-Defined Word, you set the word’s 2 bytes using the with the buttons at 
the right which display a drop-down list to select from.

Figure 277:  PCIe Jamming DLLP Gen 3 CRC Definitions 



Configuring the Jam Definition for PCIe Creating Jammer Test Configurations for PCIe

Xgig Jammer and Delay Emulator User Guide 283

  

Jamming an Ordered Set for PCIe

If the Trigger Event is an Ordered Set, and you want to Jam with an Ordered Set, select Replace 
with Modified Ordered Set Jam from the drop-down menu, and click the Jam button on the Xgig 
Jammer Configuration window, to open the Ordered Set Jam Definition window (Figure 278).

With Ordered Set as the Trigger Type, the Jam Type will be PCIe Ordered Set Jam Type. 
When you select the Jam button, the following Jam Definition window is displayed (Figure 278). 
This window allows you to select the modified Ordered Set that is used. 

The OS tab allows you to select a modified Ordered Set from the Library on the left of the 
window. The ordered sets that are available from the library are based on the ordered set that was 
selected in the Trigger definition. When the ordered set selection is made and you click the 
“double right arrow” button, the ordered set information (Index, Type, and Description) are 
displayed on the right side of the window. 

Figure 278:  PCIe Jamming Ordered Set Definitions 
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Chapter 9
Xgig Jammer Application Notes

In this chapter:

• Setting Up the Xgig Jammer and Xgig Analyzer to Capture a Jam

• Testing Strategies for the Xgig Jammer

• Replace Frame with Modified Traffic - Fibre Channel

• Using Domains and External Triggering

• How to Setup a Single Port Xgig Jammer
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Setting Up the Xgig Jammer and Xgig Analyzer to Capture a Jam

Typically, when setting up a Jammer test, it is customary to have a traffic source, a device under 
test (DUT), a Jammer and an Analyzer. You can set up the Analyzer to capture the traffic 
(including the Jam) and the response to the Jam. Figure 279 illustrates the setup.

Figure 279:  Xgig Jammer and Analyzer Setup

In this setup, ports 1 and 2 are part of a duplex Jammer configured in crossover. The sequence of 
events is described as follows:

1 The source traffic goes into port 1, which is Path A in the Jammer configuration.

2 An Arm-Trigger-Jam sequence creates a Jam and the traffic goes out port 2 and then into port 
3 of the Analyzer. 

3 The Analyzer captures the incoming traffic including the Jam. 

4 The traffic goes to the DUT, which responds. 

5 The response goes in port 4 of the Analyzer and is also captured. 

6 The reply goes all the way back to the traffic source by going through ports 4, 3, 2 and 1.

To see the Jam in the capture, you must stop the Analyzer when the Jam data is in the Analyzer’s 
buffer. You can accomplish this in two ways: 

• Configure the Analyzer to trigger on traffic such as the Jam itself or around the Jam. 

• Setup the Jammer to trigger the Analyzer.

Xgig blade

Duplex
Jammer Analyzer

Device 1
(traffic source)

Device 2
(DUT)

1 2 3 4

n Ports in the same domain

Un-jammed traffic
Jammed traffic
Response to Jam
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To setup the Jammer to trigger the Analyzer, the Jammer port that generates the trigger and the 
Analyzer ports that receive the trigger must be in the same Domain. To set this up:

1 Using Xgig TraceControl (Analyzer), create an Analyzer Domain using ports 3 and 4.

2 Setup port 3 to stop capturing on a trigger, but do not specify a template for the Trigger 
Condition.

3 Set the clock rate on the Analyzer.

4 Using Xgig Maestro (Jammer), go to Port > Port Selection and Domain Setup on the menu 
bar.

5 Select and Use ports 1 and 2 as a duplex Jammer.

6 Select port 1, right-click, and select Add to Domain…, then select the Domain in which the 
Analyzers are.

Now ports 1, 3 and 4 are in the same Domain and will receive each other’s triggers.

Figure 280:  Ports Selected for the Same Domain

7 Use a Jammer configuration that triggers on Path A and triggers Domain A.

8 Start the Analyzer and Jammer.

9 Each time the Jammer Jams, the Analyzer is triggered and stopped.

10 View and save the capture.

11 Restart the Analyzer for the next Jam.



Xgig Jammer Application Notes Testing Strategies for the Xgig Jammer

288 Xgig Jammer and Delay Emulator User Guide

  

Testing Strategies for the Xgig Jammer

The Xgig Jammer is designed to verify the operation of a Fibre Channel, Gigabit Ethernet, SAS, or 
SATA/STP based system by introducing errors in a controlled and repeatable way. The Fibre 
Channel, Gigabit Ethernet, SAS, or SATA/STP devices under test are assumed to be functional and 
operating properly with or without the Xgig Jammer system inserted in the link.

The goal of Xgig Jammer testing is to modify the traffic moving between the devices, creating 
errors, which should be recognized and handled correctly by the network. The range of tests that 
can be created is unlimited. A Fibre Channel test can include:

• Replace an Open (OPN) sent by a host with an Idle. Does the host recognize that the OPN was 
never received?

• Modify a frame and leave the CRC unchanged. Does the receiving device recognize a bad 
frame? 

• Modify a SCSI command within a frame and correct the CRC. Does the SCSI error checking 
software recognize a bad command?

The Xgig Jammer can be used both with black-box and white-box test strategies. For black box 
testing, the Xgig Jammer can be configured to cause a wide range of potential error conditions. 
The operating environment should trap, handle, and then report the actions the system took for 
each of these errors. If an error is not trapped or handled correctly, the Xgig Jammer can be 
configured to redo the specific test. The details of the traffic to and from the offending device are 
captured by the Xgig Analyzer for examination.

Using the Xgig Jammer for a white-box test strategy requires a two-stage process. Analyze the 
error checking software in the device and determine the expected response to specific classes of 
errors. Exercise all the error checking routines by creating the errors with the Xgig Jammer and 
then verify that the system responds correctly.
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Replace Frame with Modified Traffic - Fibre Channel

The Fibre Channel Jammer frame function “Replace w/ Modified Traffic” allows a large number 
of ways to alter a target frame. These alterations come in four basic types: 

• Simple frame modification

• Frame truncation and/or modification

• Replacement of a frame with multiple frames

• Replacement of a frame with Ordered Sets. 

Each of these types is described in this application note. All of the following cases assume you are 
using the Jam behavior option set to “Jam until end of trigger frame.”

Simple Frame Modification

The “Replace w/ Modified Traffic” feature always allows you to modify any word of the target 
frame. The “SOF/CRC/EOF” tab allows you to edit the SOF, CRC, and EOF. The “Header” tab 
allows you to define Jamming for the first 6 words of the frame. The “Payload” tab allows you to 
define Jamming for the rest of the frame, for however many words you decide, up to the maximum 
legal frame length (528 payload words). 

During operation, when the Jammer finds the target frame, it steps through each word performing 
each requested change, until it reaches the target frame's CRC. At this point, even if you have 
defined extra words in the “Payload” tab, the Jammer ignores these extra instructions and instead 
follows your instructions for the CRC word and EOF. On the other hand, if you do not specify as 
many words in the “Payload” tab as are in the target frame, then the Jammer passes through the 
remaining payload words until the CRC of the target frame.

An example of a simple modification would be leaving the structure of the target frame intact but 
changing its data. To do this you would leave the SOF as an SOF, modify the data with other data, 
keep the position of the CRC, and leave the EOF as an EOF.

Frame Truncation and/or Modification

You can also truncate and modify a frame at the same time. In order to accomplish this, define as 
many data word modifications as the desired length of the new frame, then select an “Automatic 
CRC” to be inserted after the data words, followed by an EOF. Fill the rest of the “Payload” tab 
with “Idles” or some other Ordered Sets. To be safe, define the full amount of 528 words, in case 
the target frame is very large.

Regardless of how many payload words you specify, or how long the target frame is, when the 
Jammer reaches the target frame's CRC and EOF, it looks for specific instructions regarding them 
(on the “SOF/CRC/EOF” tab). Do not forget to replace both the CRC and EOF with the desired 
Ordered Sets.

This form of truncation does not work correctly if the target frame is shorter than the new frame 
you have defined. The Jammer would modify the target frame up to the point of its CRC, and then 
jump to the CRC and EOF instructions, which are defined as other Ordered Sets. The resulting 
frame fragment would have an SOF, some data words, and then whatever Ordered Sets you 
defined for the CRC and EOF words.
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Another Frame Jamming feature “Replace Frame w/ Truncated Frame” is a simple way to access a 
subset of this functionality. The feature asks for only two simple inputs from the user: 

• The number of words the new frame should have

• A new EOF 

The Jammer passes through the original frame (without modifying) until it reaches the specified 
length, and then sends a good CRC and the user-specified EOF, followed by “Idles” to replace the 
rest of the target frame. The feature automatically deals safely with the case where the target frame 
is shorter than the new specified length. In this case, the frame is simply passed through with no 
changes, but the new EOF is used.

Replacement of Frame with Multiple Frames

Perhaps the most advanced use of the “Replace w/ Modified Traffic” feature is to replace the target 
frame with more than one frame. This is probably only wise if you know the target frame is large, 
because the replacement traffic you specify must fit in the space from the SOF to the EOF of the 
target frame.

To create multiple frames, repeat patterns of SOF, 6 or more data words, an automatic CRC and an 
EOF, throughout the Jam definition. Make sure to define some number of Ordered Sets, for 
example, “Idles” between each frame. Remember to specify what to do with the target frame’s 
SOF, CRC, and EOF (on the “SOF/CRC/EOF” tab). Either use them as part of your smaller frames 
or replace them with other Ordered Sets. As noted previously, the CRC and EOF functionality take 
precedence over payload words.

The LRC options you set on the “Global” tab take place for all frames you create or alter. The LRC 
is the eighth payload word, that is, 14 words after any SOF. Frames shorter than 14 data words are 
not affected. Any Ordered Set between an SOF and the LRC word cancels the word count, so that 
the global LRC option is ignored for that “frame” and the Jammer defers to what was specified in 
the “Payload” tab.

Replacement of Frame with Ordered Sets

Choose Ordered Sets to replace the SOF, CRC, and EOF of the target frame (“SOF/CRC/EOF” 
tab), as well as all entries in the “Header” and “Payload” tabs. Make sure to specify enough 
payload words to cover the largest possible expected target frame (defining all 528 payload words 
is the safest method).

Note that the Frame Jamming feature “Replace Frame w/ Idles” is a simple way to access a subset 
of this functionality. This feature replaces the target frame with only “Idles.” It automatically 
adjusts for any size of target frame. 
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Using Domains and External Triggering

This is a complex example of using domains and external triggering.

For this example, you want to have an Xgig duplex Jammer Arm on a TTL input, then Trigger on 
a frame and Jam it, and trigger an Xgig Analyzer in the same Sync Group. You want the Jam to 
occur on port A.

1 Set the Jammer Test Case mode to Arm B Followed by Trigger A Jams A.

2 For the Arm B, check Trigger from Domain B.

3 Set up the desired Trigger condition and Jam definition for the frame.

4 Check Trigger Domain A.

5 In the Port Selection and Domain Setup window, put port B in the same Domain as the TTL 
input connector.

6 Add port A to the domain of the Xgig Analyzer ports you are using to capture.

When the TTL input connector triggers, it will trigger the domain containing port B and will Arm 
the Jammer. When the Jammer finds its Trigger condition, it will Jam and then trigger the domain 
that contains the Analyzer ports.
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How to Setup a Single Port Xgig Jammer

When you lock two Jammer ports separately as simplex Jammers, they always have a data path 
without crossover. To use a Jammer port with an Analyzer on the same blade, the connections 
would be made as in Figure 281.

Figure 281:  Single Port Jammer Setup

The connection at port 1 requires that the transmit path and receive path go to different locations, 
so the cables must be separate. Therefore this sort of setup is probably not possible with copper 
connections.

When using a single port Jammer setup, the GUI refers only to path A and port A because the 
device has only one port. This is still true if you use port 2 as a single port Jammer.

Remember that you could use the Jammer on port 2 as part of another completely different testing 
setup (however, it must still share the same protocol and clock rate settings).

Note:  If you load a duplex Jammer configuration file (one that utilizes path B) to a single 
port simplex Jammer, you receive a warning that the configuration will be “flattened.” This 
means that any path B settings get transferred to path A. If the duplex port configuration uses 
both a trigger from domain (input) and trigger domain (output), then only the trigger domain 
(output) is used after flattening (and therefore you should review such configurations before 
use).

Xgig blade

Single Port
Jammer Analyzer

Device 1
(traffic source)

Device 2
(DUT)

1 2 3 4

n Ports in the same domain

Un-jammed traffic
Jammed traffic
Response to Jam
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Chapter 10
Introducing Xgig Delay Emulator

In this chapter:

• Xgig Delay Emulator Overview

• Features

• Cabling
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Xgig Delay Emulator Overview

The Xgig Delay Emulator includes hardware (Xgig Multi-function Blade) and software that 
performs real-time delay modification for the 10GigE protocol. You can use the Delay Emulator 
with Xgig Analyzers to capture and display the network traffic associated with the delay 
modification.

The Xgig Delay Emulator should be used as a digital retiming device. The Xgig Delay Emulator 
blade re-times the data and re-transmits it with a new clock transparent to the data link (it passes 
every bit of data.) The Xgig Delay Emulator blade functions in any 10GigE architecture. It does 
not log onto a loop, switch, or fabric; it only passes data between two devices. The Xgig Delay 
Emulator blade can pass 10GigE traffic, or it can recognize an event or event sequence and modify 
the traffic. The events must be 10GigE frames. A specific frame or series of frames can be 
modified in two ways: inserting a variety of delays or reordering a frame.

Features

Xgig Delay Emulator has the following features:

Operation

The Xgig Delay Emulator system (hardware and software), allows you to perform the following 
operations:

• Emulate network scenarios such as distance, switch processing delay, jitter, and multipath 
routing.

• Simulate network congestion.

You can use simulated congestion to help characterize effects on QoS and bandwidth throttle.

Capabilities

The Xgig Delay Emulator has the following capabilities:

• Operates with 10GigE protocol

• Supports the 10.3125 Gbps line rate.

• Supports frames from 64 bytes to 9k jumbo frames.

• Operates in digital re-timing mode at all times. 

• Contains standard editing features such as copy, cut, paste, add, insert, and delete to edit the 
test suite. An option lets you run the test suite forever in a repeating loop.

• Provides the appropriate MAC (media access control) layer when you load the application.
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Triggering Capabilities

The Xgig Delay Emulator module provides the following Triggering capabilities:

• You have two levels of triggering:

— Arm (first level)

— Trigger (second level)

• You can set an Arm condition as a specific DWord within a frame. 

• You can set an Trigger condition as a specific DWord within a frame. 

Delay Capabilities

• The Xgig Delay Emulator can perform the following types of Delays on the contents of 
frames:

• Fixed delay

• Jitter delay

• Ramp down delay

• Ramp up delay

• Random delay

• Random Jitter delay

• The minimum delay through the system is approximately 30 microseconds.

• The maximum programmable delay is approximately 1.3 seconds.

• A test supports up to eight queues.

• You can define Frame Drop mode and rate.

Reorder Capabilities

The Xgig Delay Emulator can perform the following types of frame reorder:

• Consecutive reorder

• Trigger reorder

New Features for Xgig Delay Emulator

There are no new features for the Xgig Jammer 8.1 release.
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Cabling

Test Setups containing Delay Emulator require special cabling if you want to use them to test data 
in both directions. Because Delay Emulator uses only the odd port of a port pair, data flows only 
from the Rx connector of Port one to the Tx connector of port two. The flow of data in the opposite 
direction, from the Rx connector of port two to the Tx connector of port one is not possible 
because port two is not used. Therefore, if you want to perform delay emulation on traffic flowing 
in both directions between two devices, you must use a second blade running Delay Emulator. See 
the example below.

Figure 282:  Delay Emulator Test Setup

The following diagram shows the cabling for the Delay Emulator in the example above.

Figure 283:  Delay Emulator Cabling Diagram

One cable connects the Load Tester to the Delay Emulator. The cable for the Tx Rx connection 
comes out of port 2 of the Load Tester then splits. The Rx cable plugs into the Tx connector of port 
2 of the second Delay Emulator. The Tx cable plugs into the Rx connector of port 1 of the first 
Delay Emulator. 

Another cable connects the Delay Emulator to Analyzer. The cable for the Tx Rx connection 
comes out of port 2 of the Analyzer then splits. The Rx cable plugs into the Tx connector of port 2 
of the first Delay Emulator. The Tx cable plugs into the Rx port of port 1 of the second Delay 
Emulator.

A third cable connects the Load Tester to the Analyzer through port 1 of both blades.
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Chapter 11
Using the Delay Emulator Tab

In this chapter:

• Using the Configuration Manager in Delay Emulator

• Using the Parameters Status Table in Delay Emulator

• Using the Parameters Status Context Menu in Delay Emulator

• Using the Ports Manager in Delay Emulator

• Using the Real Time Tab

• Using the Log Manager in Delay Emulator

• Customizing the Appearance of the Maestro/Delay Emulator Main Window

• Performing Configuration Tasks in Delay Emulator

• Running the Test Suite on a Delay Emulator Device
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After you have discovered and locked the Delay Emulator ports that you want to use and have set 
up your capturing and monitoring applications, such as Xgig Analyzer, you are ready to run the 
Xgig Delay Emulator application. This chapter provides an overview of the Delay Emulator tab, 
on the Xgig Maestro main window, and its functions; it also includes steps to run predefined tests 
supplied with the Xgig Delay Emulator application or tests you have defined and saved.

You should have launched Xgig Maestro and locked at least one device as described in the Xgig 
Maestro Introduction Guide. The Xgig Maestro window is displayed with the Delay Emulator tab 
on the right. This tab is where you operate the Delay Emulators you have locked.

Figure 284:  Xgig Delay Emulator Tab on Xgig Maestro Window
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Using the Configuration Manager in Delay Emulator

The Configuration manager (Figure 285) is associated with the device function tab. This window 
also displays the configuration files specific to the function tab displayed. The Sample 
Configurations folder includes configurations that are provided with the application. The User 
Configurations folder is where the configurations you create are saved. The Most Recently Used 
folder allows you easy access to those configuration files most recently used. The Configuration 
Manager also includes a list of all the drives on your system allowing you to locate any 
configuration files on your system quickly.

The Configuration manager has the following features:

• The Configuration manager provides a list of test configurations organized into folders and 
lists all the drives on your system allowing you to easily browse to locate all of your 
configuration files on your system

Figure 285:  File Location in Delay Emulator Configuration Manager
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• List of configuration files in a folder

Figure 286:  Configuration Files and Description Pane

• Description pane

— When you select a configuration file in the list, a description of the file is displayed in the 
description pane below. It also displays the name of the file, the path where the file is 
located, the size of the file, the date and time when the file was created, the date and time 
the file was modified, whether the file is read-only and the Map path where the file is 
located on your system. 

— When you click the Show/Hide button below the Description pane, you display or hide 
this pane.

• Drag and drop files

You can drag any configuration from the Configuration manager list onto a device column to 
load it.

• Tool bar that lets you create, load, copy, cut, and paste configuration files. See “Configuration 
Manager Tool Bar in Delay Emulator” on page 303 for more information on this tool bar.

• Context menu

Select a configuration file name, and right-click to display a menu where you can choose to 
create and edit configuration files, and additional operations. See “Configuration Manager 
Context Menu in Delay Emulator” on page 304 for more information about these menus.

• Browse to map folders of files stored in locations other than the default Sample and User 
Configuration folders.
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Configuration Manager Tool Bar in Delay Emulator

The Configuration manager tool bar (Figure 287) allows you to perform the following functions:

New Configuration  allows you to open the Configuration window and create a new Delay 
Emulator configuration from scratch. 

New Folder  allows you to create a new folder.

Load  allows you to load a configuration file into a port or ports. This icon is only active when 
a port has been locked and is selected in the Port Manager. See “Loading Delay Emulator 
Configuration Files” for details.

Map  allows you to select a folder that you want to be listed in the Configuration Manager for 
the selected function tab.

Unmap  allows you to unmap a folder that has been mapped.

Cut  allows you to cut a file from its current location. This is not the same as deleting a file.

Copy  allows you to copy a file.

Paste  allows you to paste a file you have cut or copied.

Delete  allows you to delete a file or folder.

Path  allows you to go up one level in the folder tree. This field next to this icon displays the 
current folder name.

Refresh  allows you to refresh the Configuration Files and Description pane.

Show/Hide  allows you to show or hide the details for the selected file. These details appear in 
the lower section of the Configuration Manager pane.

View  allows you to view the files in the Configuration Manager as a list including only the 
file name or to view the details of the files in the list.

Figure 287:  Configuration Manager Tool Bar in Delay Emulator 
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Configuration Manager Context Menu in Delay Emulator

Figure 288:  Configuration Manager Context Menu in Delay Emulator

Right-click in the list to choose the following actions from the context-sensitive menu:

• Up

Displays the contents one folder level up from the current display.

• New Delay Emulator Configuration

Allows you to open either a new Delay-Mode configuration or a Re-order Mode 
configuration.

• New Folder

Opens the Configuration manager dialog where you can enter the name of a new folder you 
want to add.

• Edit Delay Emulator Configuration

Opens the file highlighted in the list, the same as double-clicking on the file name.

• Load Delay Emulator Configuration into Selected Port(s)

Loads the file highlighted in the list into the port(s) selected in the Ports Manager. See “Using 
the Ports Manager in Delay Emulator.”

• Cut

Removes a selected file or folder from the list. 

• Copy

Copies a selected file or folder to a clipboard making it available to paste in another location.
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• Paste

Pastes a file or folder you cut or copied to the location you choose.

• Rename

Opens a dialog with the current file or folder name displayed in an entry field that you can 
modify. It also shows the protocol, path, and current file or folder name.

• Delete

Opens a dialog where you can confirm whether you want to delete the highlighted file 
(configuration) or folder from the list.

• Must Confirm Delete

Sets this choice as a preference that opens a dialog to confirm that you want to delete a file or 
folder from the list. When you select it, a check mark is displayed next to it. It is selected by 
default.

• Map Folder

Opens the Map Folder dialog box that lets you map a folder to a name of your choice. 

Figure 289:  Map Folder dialog box

Enter a name of your choice in the Mapped Folder Name field, and use the Browse button to 
select the folder on your system or network you want to map to this name.

• Edit Mapping Path

Allows you to edit the mapping path.

• Unmap Folder

Removes a highlighted mapped folder from the Configuration manager.

• Explore

Opens a Windows Explorer window showing the directory where the current configuration 
files are located.

• Open Command Prompt

Opens a Windows Command Prompt window showing the directory where the current 
configuration files are located.

• Refresh

Refreshes the Configuration Manager window.
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• View

Has two choices:

— List

Displays the list of files or folders in the path you choose.

— Details

Displays the list of files or folders with the size and modification date.
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Using the Parameters Status Table in Delay Emulator

The Parameters Status pane contains two tabs, All Ports and Delay/Reorder Frame. The All Ports 
tab shows all devices that have been locked. The Delay/Reorder Frame tab shows the devices 
locked according to their mode. Each Delay Emulator device is displayed by a column on the 
Delay Emulator tab (Figure 290). At the top of each column is the chassis name and the chassis 
number, the slot number, and port number(s) in parenthesis.

The locked ports can be divided in a sorted manner in the Delay/Reorder Frame tab or displayed 
unsorted in the All Ports tab.

To configure how to display the ports in the Parameters Status Table, click on the Views button 
and do the following:

Select or unselect Configuration to display or hide the Configurations tab and Parameters tab 
where you manage Delay Emulator configuration files and select the Parameters to display, 
respectively.

Select or unselect Port Selection to display or hide the Port Selection table.

Click Ports to display the options for displaying the ports in the Parameters Status Table.

Tile Horizontally - Select this option to display the Delay pane before the Reorder Frame 
pane. This allows you to drag and drop a port from one mode to the other. 

Tile Vertically - Select this option to display the Delay pane beside the Reorder Frame pane. 
This allows you to drag and drop a port from one mode to the other. 

Tabs - Select this option to display the Delay pane and Reorder Frame pane as tabs.
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Each Delay Emulator port is displayed by a column on the Parameters Status table (Figure 290). 
At the top of each column is the protocol, the chassis name, and in parenthesis the chassis number, 
the slot number and port number(s). 

Figure 290:  Delay Emulator Parameters Status table

The first column on the tab is the legend for each row in the device columns and contains the 
following categories for Delay and for Reorder Frame:

• State

• Link State

• Configuration

• Status

• Settings
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Parameters Category Descriptions

State

This row shows the state of the Delay Emulator: Disconnected, Connecting, Starting, Running, 
Stopping, Skipping, Pausing, Paused, Stopped

Link State

Indicating the state of the signal, whether it is present, no signal is present, or the signal has been 
lost.

Configuration

Displays the name of the configuration file, if any, loaded into the port.

Start/Stop 

Click this button to Start or Stop a test. The green arrow icon indicates you can click the button to 
Start the test. The red box indicates you can click the button to stop the test.

Pause/Resume

Click this button to pause or resume a test suite that is running.

Skip

Click this button to skip a test that is running and move to the next test in the suite.

Operation

Opens the Operation dialog box

Status Category

This category gives the status of the test suite that you have loaded into the Delay Emulator.

Time Since Test Started

Indicates the time elapsed since the current test started.

Configuration Repeat Count

Indicated how many times the test suite has been repeated.

Test Timeout Mode

Indicates whether the timeout option is set.

Test Timeout

Indicates the time value for the timeout option.
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Log

Indicates if a log from the last operation is available for viewing. 

Settings Category

This category indicates the current physical setup of the Delay Emulator device. You can change 
most of the settings in this category by using the Parameters Status context menu for each device 
you have locked.

Config Type

Indicates whether the configuration is delay-mode or reorder-mode.

Protocol

Indicates the current protocol setting for the Delay Emulator.

Clock Rate 

Indicates the Delay Emulator clock rate.

Current Test Category

This category shows the condition of the test currently loaded in the Delay Emulator device.

Index

Indicates the number of the test within the queue that is being executed. 

Name

Indicates the name of the test currently loaded in the Delay Emulator device.

Test Mode

Indicates whether the test mode is Arm, Trigger or Trigger
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Using the Parameters Status Context Menu in Delay Emulator

Right-click on the Parameters Status table to display the context menus shown in Figure 291. Each 
protocol has a unique context menu. The available operations are displayed for the column in 
which you click. This menu provides controls for configuration files, setting the data path, logging 
test activity, removing a Delay Emulator from the Parameters Status table, and the appearance of 
the status table. 

Refer to the following pages for more information about the how to use the context menu choices:

• “Using the Parameters Status Table in Delay Emulator” on page 307 for information about the 
parameter settings you make from these menus. 

• “Running the Test Suite on a Delay Emulator Device” on page 331 for information about 
running the Delay Emulator. 

• “Using the Log Manager in Delay Emulator” on page 320 for choosing log preferences. 

• “Performing Configuration Tasks in Delay Emulator” on page 329 for information about using 
the Load configuration file, Save configuration file, Reset configuration, and Edit 
configuration selections from these menus.

Figure 291:  Delay Emulator Parameters Status table Context Menus
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Log

This setting allows you to view the log, open the options menu for the log, or save the current log.

Change Port to Delay/Reorder Mode

This setting changes the configuration applied to the selected ports to the other mode. If the 
current configuration is a delay-mode configuration, this setting changes the configuration to 
reorder-mode and visa versa. The current configuration remains as a saved file. A new blank 
configuration is applied to the ports containing zero tests.

This option allows you to immediately create a blank configuration and begin editing it while it is 
loaded into to the hardware.
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Using the Ports Manager in Delay Emulator

The Ports manager displays details about the ports you have locked. It shows the protocol, chassis 
name (with chassis number, slot number, and port numbers), and other port specific information. 
You can sort the rows from first to last or last to first by clicking the column heading. For more 
information about Xgig slot positions and numbering, refer to the Xgig Family Hardware Guide 
included with the product CD.

Figure 292:  Delay Emulator Ports Manager

The following icons are displayed on the menu bar:

Note: If you are disconnected due to a network problem, you can reconnect to the ports by 
using the Port Selection and Domain Setup window.

Select All Ports
Selects all ports in the Ports Manager.

Unselect All Ports
Unselect all ports in the Ports Manager.

Load Configuration to Selected Ports
Load the selected configuration file to all selected ports in the Ports Manager.

Start Selected Ports
Start BERT operation on the selected ports in the Ports Manager.

Stop Selected Ports
Stop BERT operation on the selected ports in the Ports Manager.

Show Properties of Selected Ports
Display the Port Properties dialog box, with information on the selected function, 
protocol, and clock rate (speed). It also shows the chassis name, IP address, slot and 
port(s).

Disconnect Selected Ports
Disconnect the selected ports in the Ports Manager.

Disconnect All Ports
Disconnect all ports in the Ports Manager.
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Actions Button

The Actions button contains menus for Toggle Display. See Figure 293.

Figure 293:  Actions Button Options

Toggle Display

This option toggles between a horizontal and vertical view of the ports.

Ports Manager Columns

The Ports Manager includes the following columns:

Select

Indicates whether you want to select a port pair

Show

Indicates whether you want to show this port pair in the Ports Manager.

Operation

Operation is a button you press to display the Operation bar for the device you are using. Refer to 
“Running the Test Suite on a Delay Emulator Device” on page 331 for additional information.

State

This column displays the state of the device under test.

Address

This column displays the chassis name and the chassis number, the slot number, and port 
number(s) in parenthesis.
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Using the Ports Manager Context Menu

You can right-click in the Ports Manager to open the context menu (Figure 294).

Figure 294:  Ports Manager Context Menu

The menu contains the following choices:

Text Size

Refer to “Changing Text Size” on page 327 for information.

Columns

This choice opens a Customize table dialog (Figure 295) where you can choose which columns 
you want to display. 

Click the check box next to this item to display this item in the Ports Manager.

The grayed out items are defaults; you cannot clear these items.
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Figure 295:  Delay Emulator Ports Manager Context Menu Parameters Selection
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Using the Real Time Tab

To access the real time latency graph, click the Real Time tab at the bottom of the Delay Emulator 
main window.

Delay-Mode

The Real Time window contains a table showing parameters for each device running. The 
parameters include:

• Port ID

This includes the chassis number, the slot number, and the port number

• Current Test Index

Indicates the position of the current test within the test suite

• Test Name

Indicates the name of the current test

• Time Started

Indicates when the current test started

• Time Out

Indicates the timeout value if applicable

• Configuration Repeat Count

Indicates how many times the configuration has been repeated.

The following parameters are present for each queue when you expand the configuration table”

• Operation Status

Indicates the state of the port, started, triggered stopped, etc.

• Operation Mode

Indicates the type of delay

• Frame Drop

Indicates how many will be dropped. You can change this value by clicking the arrow at the 
right of the field and sliding the slider to the desired value.

When a test is running, the device’s ports appear in table in the upper half of the window. If 
multiple test are running, each device appears in the table. To expand the an entry in the table to 
view the queues for that test, click the plus sign on the left. This opens the delay control. 
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Delay Graph

To access the delay graph, click the button in the Delay field. This graph allows you to view the 
delay change in real time. The graph has a control at the top of the window that allows you to set 
the latency value in nanoseconds. You can either type a value in the field or click the up/down 
buttons to change the value in increments of one. Id the delay type is “Fixed Delay”, you can 
change the delay value while a test is running. If you would like to pause the graph, click the Pause 
button in the top left corner of the window. To resume, click the Play button. To undock the graph, 
click the green undock button. You can close this window and reopen it at any time while the test 
is running. 

Figure 296:  Delay Graph
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Reorder-Mode

The Real Time window contains a table showing parameters for each device running. The 
parameters include:

• Port ID

This includes the chassis number, the slot number, and the port number

• Current Test Index

Indicates the position of the current test within the test suite

• Test Name

Indicates the name of the current test

• Time Started

Indicates when the current test started

• Time Out

Indicates the timeout value if applicable

• Configuration Repeat Count

Indicates how many times the configuration has been repeated.

• Frames Reordered

Indicates the number of frames that have been reordered

• Operation Status

Indicates the state of the port, started, triggered stopped, etc.

• Operation Mode

Indicates the type of delay

When a test is running, the device’s ports for the device appear in a table in the lower half of the 
window. If multiple test are running, each device appears in the table.
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Using the Log Manager in Delay Emulator

To access the Log Manager, click the Log tab at the bottom of the Delay Emulator main window.

The purpose of logging is to automatically create a log that reports which delay or reorder tests 
have occurred and which ones might have reached the timeout limit while not finding a trigger. 
You can view a log with any text editor.

The Filter icons next to the Type and Address column labels allow you to choose how you want 
to display device types, by protocol or All, and device addresses, by single address or All devices.

If the All Devices tab at the top of the Xgig Maestro main window is selected, then the Log 
Source menu shows all log sources as active by default. You can choose 
to disable BERT logging, Delay Emulator logging, Generator logging, Target Emulator logging, or 
all four by clicking the Log Sources menu and un-checking the selections. If the BERT-Bit error 
rate testing, Jammer, Target Emulator, or Generator tabs in the main window are selected, then 
the Log Manager displays only the log entries for that tab, respectively.

The following icons are displayed on the Log Manager menu bar:

Display Entry Contents
Lets you save the selected log to a file in the device Logs folder (for example: 
C:\Program Files\Viavi\Xgig Maestro\Delay Emulator\Logs) or 
anywhere you want to save it on the network. Refer to the note on page 323 for 
information about installation on 64-bit operating systems.

Save All Entries As
Lets you save all the logs in the Log Manager to a file.

Save selected entries as
Lets you save the selected logs to a file.

Select All
Selects all the logs in the Log Manager.

Options
Opens the Log Manager Options dialog where you can enter your preferences for the 
information you want displayed in the Log Manager (Figure 297).

Clear Filtering
Removes filtering by Type and Address and displays all the devices you have locked.

Clear Selected Entries
Deletes the log entry you have highlighted.

Clear All Entries
Deletes all the log entries in the Log Manager.
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Setting Log Options

To have log files automatically named and saved to a specific location:

1 Click the Log Manager Options icon to open the drop-down menu (Figure 297), and select 
Delay Emulator logging options. 

Figure 297:  Log Manager Options Menu

Or: 

Open the Parameters context menu and select Options.

Either of these commands opens the Delay Emulator Log Options dialog (Figure 298). This 
dialog allows you to set up how you want the log files to be automatically named and the 
default location where you want them saved. You can also change the filename and folder 
when you save the log.

Figure 298:  Delay Emulator Log Options Dialog

2 Select a log filename template from the following choices:

• Delay EmulatorLog_[port]

• Delay EmulatorLog_[port]_[date]_[time]

• Delay EmulatorLog_[date]_[time]

• Delay EmulatorLog_[date]_[time]_[port]

Or, you can type in your own template. Any [port], [date], and [time] in the template is 
replaced by the corresponding value. Port is displayed as:

protocol, chassis name (chassis number in the cascade, blade 
number in the chassis, port number on the blade)

3 Enter the path to the folder where you want to save the log file.

You can browse to where you want to save the log file by clicking .

4 Click OK.
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You have set up the log filename template and default folder to save the log.

Viewing a Log

The Delay Emulator log shows the status of each Test Case during the entire length of the test run 

To display a log:

>> Click the Log Manager tab at the bottom of the Xgig Maestro main window to view the log in 
a tabulated format (Figure 299).

Or:

>> Click the Log button on the Operation bar (with the appropriate Delay Emulator device 
selected in the Parameters Status table; a green check mark indicates the device is selected).

Or you can:

>> Open the Parameters context menu and select Log > View.

These two latter commands open a window that allows you to quickly view the Xgig Delay 
Emulator log. (Figure 300). In the case of these two methods, each time you run a Delay Emulator, 
a new Delay Emulator log is created for the device, and the previous log is discarded. Click Print 
at the bottom of the Delay Emulator log to print a hard copy of the log. 

On the other hand, the Log Manager continues to list the logs and display them depending on the 
Log Manager options you have selected. See “Setting Log Options” on page 321.

You can save a log to a .txt file or an HTML file. Refer to “Saving a Log” on page 323.

Figure 299:  Log Manager

Note: These settings apply to all Delay Emulator logs. Log options are the same for all Delay 
Emulator ports.
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Figure 300:  Example of a Delay Emulator Log Display 

Saving a Log

You can save a log from the Log Manager tab or the Parameters context menu.

To save a log from the Log Manager tab as an HTML file or text file:

1 Highlight the log you want to save.

2 Click the Save Selected Entries As... button.

The Save Log Manager Contents As window is displayed that lets you name and save the log 
as an HTML file to the Saved Logs folder or to a location you prefer.

To save a log to a .txt file using the Parameters context menu:

>> Open the Parameters context menu (Figure 301) and select Log > Save As.

This command opens a File dialog where you can save the log with a file name you assign to 
it. The default location is: 
C:\Program Files\Viavi\Xgig Maestro\Delay Emulator\Logs 

Figure 301:  Log Menu

Note: This software application can be loaded on 32-bit or 64-bit Windows operating 
systems. The path used above is for a 32-bit operating system. 
If you are using a 64-bit operating system, the path would be: 
C:\Program Files(x86)\Viavi\Xgig Maestro\Delay Emulator\Logs
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Customizing the Appearance of the Maestro/Delay Emulator Main 
Window

You can move and rearrange the individual device tabs on your monitor screen as you prefer. You 
can also select the information you want to display in the Parameters Status table. In addition, you 
can select the size of displayed text.

Using the Window Menu

The Window menu allows you to arrange the window display:

Layout

Layout offers choices for rearranging the Maestro device tab windows. The Ports manager and 
Log Manager windows are not affected by this menu selection.

Internal Tabs

Allows you to restore the Maestro main window to its default format.

Internal MDI

Internal multiple document interface (MDI) lets you isolate each device tab as a separate window 
that you can activate by clicking anywhere on the window.

Show Hidden Windows

Restores any windows you have closed while using the Internal Tabs or Internal MDI display 
arrangement.

Arrange Icons

Arranges the icons for minimized windows at the bottom of the screen. If an open document 
window is at the bottom of the screen, some or all of the icons will be underneath this document 
window and will not be visible.

Cascade

Arranges all open windows in a cascade style from the top, left corner of the window.

1 All Devices

Brings the All Devices tab to the front as the active window. This window displays ports from all 
active devices (BERT, Delay Emulator, Generator, and Target Emulator).

2 BERT - Bit error rate testing

Brings the BERT device tab to the front as the active window
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3 BERT - Latency measurement

Brings the BERT Latency measurement device tab to the front as the active window

4 Jammer

Brings the Delay Emulator device tab to the front as the active window 

5 Generator

Brings the Generator device tab to the front as the active window

6 Target Emulator

Brings the Target Emulator device tab to the front as the active window

7 Delay Emulator

Brings the Delay Emulator device tab to the front as the active window.

Tile Horizontally

After selecting Layout > Internal MDI, this command opens and aligns the BERT, BERT Latency 
measurement, Delay Emulator, Generator, and Target Emulator device windows horizontally one 
over the other.

Tile Vertically 

After selecting Layout > Internal MDI, this command opens and aligns the BERT, BERT Latency 
measurement, Delay Emulator, and Generator, and Target Emulator device windows vertically one 
next to the other. You can view the individual device windows by dragging the sides out to resize 
them.

Minimize All Windows

After selecting Layout > Internal MDI, this command minimizes all the open windows. You can 
restore each window, individually, by using the standard window controls on the header or select 
Internal Tabs to restore the Maestro main window to its default format.
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Customizing the Parameters Status table in Delay Emulator

You can change the appearance of the Parameters Status table by:

• Removing columns

• Resizing columns

• Changing the text size

• Displaying and hiding status table parameters

Removing columns

If you have a number of devices locked, you can remove a column that you do not need to view 
without unlocking the port or affecting the operation. 

To remove a column:

1 Right-click on the specific column you want and open the Parameters context menu. 

2 Select Hide Delay Emulator (Figure 302).

Or:

In the Ports Manager, clear the Show check box next to the device you want to remove.

The column is removed, but the device is still locked (“in use”) and displayed in the Ports 
Manager. 

Figure 302:  Removing a Device Column

To replace the device column on the Parameters Status table:

>> Click the Show check box for the device in the Ports Manager. 
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Resizing columns

You can resize any of the columns by placing the mouse at the right edge at the top of a column, 
next to the chassis name. A resizing cursor appears. Hold down the mouse button, and drag the 
mouse to resize the column.

Changing Text Size

You can choose the text size you want the Parameters Status table or the Ports Manager to display.

To change text size:

1 Open the context menu by clicking the right mouse button while the cursor is on the 
Parameters Status table or the Ports Manager.

2 Select Text size (Figure 303).

You have five choices from which to select.

Smallest is the default size.

3 Select the text size you want.

A bullet is displayed next to the current selection.

Figure 303:  Text Size Menu

Note: You cannot change the text size in the Log Manager.

Context menu over device parameters 
status tableContext menu over Ports manager
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Displaying and Hiding Parameters in Delay Emulator

You can hide specific parameters on the Parameters Status table to simplify the status tables and 
show only the information in which you are interested.

To display or hide parameters on the Parameters Status table:

1 Click the Parameters tab at the top of the Configuration manager pane to switch to the 
Parameters manager (Figure 304).

You can expand the categories by clicking the plus signs on the left.

The default displays most of the parameters.

Figure 304:  Delay Emulator Parameters Manager

2 Click check box to set or clear the check mark next to the parameters. 

Checked parameters are displayed.
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Performing Configuration Tasks in Delay Emulator

This section describes how to handle configuration files from the Delay Emulator main window.

Loading Delay Emulator Configuration Files

You can load a configuration file on a Delay Emulator using one of the following methods:

From the Configuration Manger:

>> Drag the configuration file from the list in the Configuration Manager onto the Parameters 
Status table (column for the device) and release the mouse button. 

You can drag configuration files from anywhere, including the list of configuration files in the 
Configuration Manager on the Xgig Maestro window, the system desktop, or Windows 
Explorer.

From the Parameters Context Menu 

1 Right-click on the device column to open the Parameters context menu and select Load 
configuration file. 

An Open File dialog is displayed. 

2 Navigate to the Delay Emulator .decfg file that you want to use and click Open.

The file is loaded and its name and parameters are displayed in the device column of the 
Parameters Status table.

From the Ports Manager:

1 Check the Select check box(es) in the Ports Manager for the port(s) you want to use.

2 Click the configuration file you want to load from the Configuration Manager.

3 Click the Load Configuration to Selected Ports button . This button is located in the 
Ports Manager and in the Configuration Manager. Both have the same function.

You can use the above methods to navigate to a mapped folder and load a configuration file.

Saving a Delay Emulator Configuration File

To save a Delay Emulator configuration file you created or edited:

1 Right-click on the device column in the Parameters Status table to open the Parameters context 
menu, and select Save configuration file.

A Windows Save dialog is displayed.

2 Navigate to where you want to save the configuration file and assign a name to it.

Xgig Delay Emulator configuration files are saved with a .decfg extension.
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Resetting a Delay Emulator Configuration

To clear the configuration from a device:

1 Right-click on the device column in the Parameters Status table to open the Parameters context 
menu, and select Reset configuration.

A warning dialog may be displayed asking you to confirm the configuration reset.

Figure 305:  Reset Configuration Warning Dialog

2 Click Yes to clear the configuration from the device.

Editing a Delay Emulator Configuration

To create a configuration file for a device, you can start from a blank default configuration or edit 
the configuration after you have loaded a configuration file to the device. 

You can open the Configuration window using one of the following methods: 

1 Right-click on the device column in the Parameters Status table to open the Parameters context 
menu. 

2 Select Edit configuration.

Or:

>> Click the Configuration button on the Parameters Status table

This opens the Configuration window for the device that is currently selected. Refer to or 
“Using the Jammer Configuration Window” on page 116 for more information.



Running the Test Suite on a Delay Emulator Device Using the Delay Emulator Tab

Xgig Jammer and Delay Emulator User Guide 331

  

Running the Test Suite on a Delay Emulator Device

After you have configured a Delay Emulator device, you can start the operation. Three methods 
are available:

>> Click the Start button on the Parameters Status table.

Figure 306:  Parameters Status table Start Button

Or you can:

>> Right-click on the device column to open the Parameters context menu where the Start, 
Pause, Skip, and Stop commands are available. 

Or:

1 On the Ports manager, select the device.

2 Click the Start button .

Or:

1 On the Ports manager, in the Operation column, click the Operation button for the device.

The Operation dialog is displayed (Figure 307).

2 Click Start.

Figure 307:  Delay Emulator Tab Operation Bar

Clicking any of the Operation buttons (including Config) takes effect on the Delay Emulator 
device that is currently selected in the Parameters Status table.

Start runs the Test Suite from the beginning if you click it while the Delay Emulator is stopped. 
The Start button label becomes a Stop label while the Test Suite is running.
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Pause causes the Delay Emulator to pause and not run the next Test Case in the Test Suite when 
the current Test Case is completed. When you click Pause, the State of the Delay Emulator is 
“Pausing” while the current Test Case is still running. When the current Test Case completes (or is 
skipped), the Delay Emulator is in the “Paused” state waiting for user intervention.

Skip causes the Delay Emulator to abort the current Test Case and move on to the next one. If the 
Delay Emulator is “Paused,” you can click Skip to jump through your Test Suite without running 
any Test Cases until you get to the Test Case you want to run and resume testing. If you skip past 
the last Test Case in the Test Suite and the Test Suite is not set to loop forever, then the Delay 
Emulator goes to the Stopped state as if the Test Suite completed.

To let a test run to the end and then skip to another test:

1 Click Pause. 

Wait for the current test to finish.

2 Click Skip to step through the tests. 

3 Observe the progress field on the Parameters Status table to track tests in the queue.

4 Click Start.

Stop causes the Delay Emulator to abort running the entire Test Suite and go to the Stopped state.

Log indicates a log is available for viewing. Click Log to view the latest test log.
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Chapter 12
Creating Delay Emulator Test Configurations for Delay 
Mode

In this chapter:

• Defining Your Own Test Configurations for Delay Mode

• Using the Delay-Mode Configuration Window

• Configuring the Classify Condition in Delay-Mode

• Configuring the Arm Condition in Delay-Mode

• Configuring the Trigger Condition in Delay-Mode
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Defining Your Own Test Configurations for Delay Mode

Xgig Delay Emulator lets you define your own test configurations and save them with or without 
hardware available.

You can create a configuration from scratch, or you can open and edit an existing configuration. 
Also, you can edit a configuration in edit only mode, which is independent of any hardware, or 
you can edit a configuration that is currently loaded to a Delay Emulator device.

To edit a configuration in edit only mode:

>> Double-click a configuration file in the Configuration manager. 

or:

>> Right-click the configuration file in the Configuration manager, and choose Edit Delay 
Emulator Configuration from the context menu.

The edit only mode Delay Emulator Configuration window opens (Figure 308).

This window allows you to set up your own Test Cases, name them, organize them, and save 
them to files so that you can use them again.

Figure 308:  Edit Only Delay Emulator Configuration Window

To start a configuration from scratch in edit only mode:

>> Select New Delay Emulator Configuration from the context menu or the File menu 
(Figure 309) on the Xgig Maestro menu bar. Then, select Delay-Mode or Reorder-Mode 
Delay Emulator Configuration from the drop down menu.
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or:

>> Click the New Configuration icon at the top of the Configuration manager.

Figure 309:  Maestro File Menu

To save your configuration in edit only mode:

>> Click Save at the bottom of the Delay Emulator Configuration window, or open the File menu 
on the Delay Emulator Configuration window and select Save Delay Emulator 
Configuration or Save Delay Emulator Configuration As.

Any changes you make have no effect on actual Delay Emulator devices you control.

To edit a configuration that is loaded to a Delay Emulator port:

>> Click Configuration... in the device column.

or:

>> Right-click in the Parameters Status table in the device column to open the context menu and 
select Edit configuration.

or: 

>> Click Operation in the device column to open the Operation dialog, then click Config.

The Xgig Delay Emulator Configuration window in hardware edit mode is displayed 
(Figure 310). This window allows you to set up your own Test Cases, name them, and save 
them to a file so that you can use them again.

Click Apply or OK and Delay Emulator accepts the changes. They are immediately reflected 
in the Parameters Status table and affect the Delay Emulator device the next time you run it.

To save your configuration edits:

>> Open the File menu at the top of the Delay Emulator Configuration window and select Save 
Delay Emulator Configuration or Save Delay Emulator Configuration As.
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Figure 310:  Xgig Delay Emulator Configuration Window

Using the Delay-Mode Configuration Window

The Delay Emulator Configuration window title bar indicates how many ports it is configuring, 
the protocol, and the configuration file name, if any. If you are using hardware edit mode, the 
chassis name, chassis number, slot number, and port number are also listed. The elements of the 
Delay Emulator Configuration window are described in the following sections.

Using the Delay Emulator Test Suite Tools

The Delay Emulator Test Suite (left pane) lists the series of Xgig Delay Emulator tests in the order 
in which you want them to execute. The number of tests in a test suite has no limit. Each test can 
contain between one and eight queues. The highlighted test appears as the Current Delay Emulator 
Test (right pane). Each test in the suite executes in sequence.

Creating a Test Suite

When you create a Delay Emulator Test Suite, you use the toolbar in the Delay Emulator Test 
Suite section of the Configuration window (Figure 311).

Figure 311:  10GigE Delay Emulator Test Suite Toolbar
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The following list describes the icons on the toolbar:

To duplicate a test at another point in the Test Suite:

1 Highlight the test you want to duplicate.

2 Click Copy.

3 Highlight the test in the suite that is just after the point where you want the duplicate test 
inserted.

4 Click Paste.

The duplicate test is inserted.

Using the Configuration File Menu

The File menu is the only menu on the menu bar (Figure 312). 

Figure 312:  Configuration File Menu

Cut current test Removes the highlighted test and holds its contents in the 
memory buffer.

Copy current text Copies the highlighted test to the memory buffer.

Paste last test cut or copied Inserts the current memory buffer contents before the currently 
highlighted test.

Add new test to bottom of stack Adds a new blank test to the bottom of the suite.

Insert new test before current test Inserts a new blank test above the currently highlighted test.

Delete current test Removes the highlighted test from the suite. If only one test is 
present, then the contents of this test are cleared.

Move current test down the stack Moves the highlighted test down one in the test order.

Move current test up the stack Moves the highlighted test up one in the test order.

Run test suite once or Repeat test 
suite

When you choose Repeat test suite, the tests run according 
the settings you define in the Delay Emulator Current Test 
window. You can also type a number in this field to indicate you 
want the test suite to repeat a certain number of times.
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The choices are:

The recently used Delay Emulator configuration files appear in the file menu and are loaded when 
selected.

Using the Current Delay Emulator Test Window: Delay-Mode

The graphics in this section of the window represent the hardware configuration for the selected 
test in the Delay Emulator Test Suite (Figure 313). 

Figure 313:  Current Delay Emulator Test Window

New Configuration Creates a new delay or reorder .decfg configuration file.

Open Configuration Open an existing .decfg configuration file.

Save Configuration Save the entire Test Suite to the .decfg file you currently have loaded.

Save Configuration As Save the entire Test Suite to a .decfg file with a name you assign to it.

Recent Configuration Open a recently opened .decfg configuration file.

Close Close the Delay Emulator Configuration Window.
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Single Tab

The Single tab shows the contents for a single test within the test suite. A test is comprised of 
queues, which are delays. A test can have up to eight queues. Each queue has its own settings. To 
populate a test, you must create queues. Use the toolbar to create and control queues within a test. 
The toolbar on the Single tab contains the same functions for queues as the left pane has for tests. 

Create a Queue

To create a queue within a test, click the Add Queue  button. The queue appears below the 
toolbar. The following sections illustrate the process of defining the parameters for a queue.

Mode

The Mode menu is available near the top of the Current Delay Emulator Test window (Figure 314) 
and also near the top of each queue in the Delay Emulator Single tab (Figure 310). 

Figure 314:  Mode Drop-down Menu in Current Delay Emulator Test

Classify

The Classify menu are available in the left pane of the Current Delay Emulator Test window and 
also in each queue in the Delay Emulator Single tab. To define Classify condition, click the 
Classify button in the queue or in the left pane to open the corresponding definition window.

Arm and Trigger

The Arm and Trigger menus are available in the left pane of the Current Delay Emulator Test 
window and also in each queue in the Delay Emulator Single tab. To define Arm and Trigger 
conditions, click the Arm or Trigger Frame button in the queue. Now, click the Arm or Trigger 
button in the queue or in the left pane to open the corresponding definition window.

Delay

The Delay menu allows you to select what type of delay you want. Click the Delay button to 
access the Delay dialog. All delays are in addition to the smallest delay of 30ms and are rounded 
up or down to the nearest 6ns increment.

Select the type of delay you want from the drop-down menu.

Fixed Delay 

Emulates a fixed delay for each buffer segment

For Fixed Delay, type the delay value in nanoseconds.
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Jitter Delay

Emulates inter-packet gap variations for each buffer segment

For Jitter Delay, type the min. and max. values as well as the step size in nanoseconds.

Ramp Down Delay

Emulates delays that decrease with each buffer segment

For Ramp Down Delay, type the min. and max. values as well as the step size in nanoseconds.

Ramp Up Delay

Emulates delays that increase with each buffer segment

For Ramp Up Delay, type the min. and max. values as well as the step size in nanoseconds.

Random Delay

Emulates random inter-packet gap variations for each buffer segment

For random delay, type the min. and max. delay values in nanoseconds.

Random Jitter Delay

Emulate random inter-packet gap variations for each buffer segment

For Random Jitter Delay, type the mean value in nanoseconds and the percentage of change in 
value to define your range. For example. If your mean is 1000ns, and your percentage is 5, 
then your delay values will range from 950 to 1050ns

Drop Mode

You can define frame drop mode and rate in a delay queue. You can also choose Frame Drop 
Mode or Byte Drop Mode from the Type drop-down menu of the Drop dialog. The Drop mode 
defines whether the drop rate will be based on number of frames or number of bytes in frames. 
Byte Drop Mode is only available for the first queue. The frame drop rate defines the ration to 
drop, and it has precision to 0.01%.

Figure 315:  Drop Mode

Timeout

The timeout option defines the period of time to wait for a specified test to complete before 
aborting and proceeding to the next test in the suite.



Using the Delay-Mode Configuration Window Creating Delay Emulator Test Configurations for Delay Mode

Xgig Jammer and Delay Emulator User Guide 341

  

To set the timeout:

1 Click Timeout to display the dialog box in Figure 316. 

2 Check Enable Timeout.

3 Select either By Time or By Frame.

4 For By Time, enter the hours, minutes, and seconds you want to wait.

5 For By Frame, enter the number of frames you want to wait for.

Figure 316:  Timeout Dialog

6 Click OK.

Summary Tab

The Summary tab provides a graphical representation of all the queues in a test. The flow of 
information goes from the classify condition to the Arm and/or Trigger condition. If the Classify 
condition for a queue is not met, the Classify condition for the next queue is compared. If none of 
the Classify conditions in the test are met, the process defaults to the bypass delay. 

The bypass delay is a fixed delay set at 30 microseconds, which is the smallest delay possible.
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Figure 317:  Summary Tab

Configuring the Classify Condition in Delay-Mode

The Classify condition of a queue is compared first. If it is met, the queue process begins. The 
queue process consists of either Arm and Trigger or just Trigger. If the Classify condition is not 
met, the Classify condition of the next queue is compared. The Classify condition recognizes 
specific DWords within frames. 

Depending on the Mode you select in the Delay Emulator Configuration window, the appropriate 
graphic diagram shows the Classify condition, the Trigger and optional Arm conditions, and the 
Delay. If the Mode you select does not include an Arm condition, the Arm button remains 
disabled.

To set Classify conditions: 

1 Click the Classify button in the Xgig Delay Emulator Configuration window. 

The window for the condition is displayed (Figure 318). If you are in hardware edit mode, the 
protocol, chassis name, chassis number, slot number, and port numbers are displayed in the 
title bar.

2 Set the values as required to specify the Classify condition as part of a unique Classify, Arm 
and Trigger sequence for the specific test.

The following sections describe the available values.

Note: If none of the Classify conditions in the queue are met, the software uses the default 
bypass delay, which acts as a catch all for traffic that doesn’t go through the queues. This flow 
is represented on the Summary tab of the Delay Emulator Configuration window.
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Figure 318:  Classify Window for Delay
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Setting Frame Conditions for Classify in Delay-Mode

You can specify frame conditions in two ways. One way is to load a template from the Template 
Library tree, and the other way is to manually specify bits in the frame.

To use a template:

1 Select a template from the Template Library tree on the left.

2 Click the double right arrow button to set the Trigger Condition. 

The condition is indicated on the right side of the window.

To manually specify a frame: 

>> Type hexadecimal values directly into the center column of the window.

An X represents a nibble that can be any value (a “don’t care”). 

To set individual bits in any field, double-click on the hex entry to open the Binary Editor 
(Figure 319). In the hex view, partially defined hex characters appear as question marks: 
X001=?

Figure 319:  Binary Editor Dialog

Another way to manually edit the frame condition is to make selections from the tree view in 
the right window pane.

Decode Switches Menu

Some templates allow you to specify decode switches. When you load a template that has this 
option, the Decode Switches Menu appears in the upper left corner of the window. The decode 
switches provide detailed contextual options for decode; for example, further decode of response 
and data frames. The Decode Switches menu is context sensitive and will only show the decode 
options available for the specific template you are creating.
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Figure 320:  Decode Switches Menu

The Decode Switches menu is intended to help you create a user-defined template. When editing 
a User Library template, Decode Switches are stored inside the template so they are still ON the 
next time you open this particular template.

Decode switches allow you to further decode Response and Data frames that can't be decoded 
without knowing what the associated command frame is. Below is a description of the switches 
avaFC-SW Accept Interpretation

Note: Once the Decode Switches menu appears, it remains visible. However, if you load a 
template that has no decode options, the menu is greyed out and inactive. 
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Figure 321:  Decode Switch Options for FC-SW Accept Interpretation

Saving a Frame Condition

If you create a frame condition that you want to save and make easily available for future use, you 
can save it into the “User Library” folder in the Template Library tree. To do this:

>> Highlight the folder and click the double left arrow button.

Frame conditions have the option of “Use inverse of condition specified (i.e., NOT).” When you 
check this option, it means that the first frame encountered that does not match what you have 
specified creates a “condition met” event.

For each frame condition, you can specify an optional name at the top of the window. This name is 
also shown on the Delay Emulator Configuration window under the Mode selection, and on the 
main Xgig Maestro window.



Configuring the Arm Condition in Delay-Mode Creating Delay Emulator Test Configurations for Delay Mode

Xgig Jammer and Delay Emulator User Guide 347

  

Configuring the Arm Condition in Delay-Mode

The Arm condition recognizes specific DWords within frames. 

Depending on the Mode you select, the appropriate graphic diagram shows the Classify condition, 
the Trigger and optional Arm conditions, and the Delay. If the Mode you select does not include an 
Arm condition, the Arm button is disabled.

To set Arm conditions: 

1 Click on the Arm button to open the Arm window.

The window for the condition is displayed (Figure 322). If you are in hardware edit mode, the 
protocol, chassis name, chassis number, slot number, and port numbers are displayed in the 
title bar.

2 Set the values as required to specify the Arm condition as part of a unique Arm and Trigger 
sequence for the specific test.

The following sections describe the available values.

Setting Frame Conditions for Arm in Delay-Mode

You can specify frame conditions in two ways. One way is to load a template from the Template 
Library tree, and the other way is to manually specify bits in the frame. 
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Figure 322:  Arm Window for Delay

To use a template:

1 Select a template from the Template Library tree on the left.

2 Click the double right arrow button to set the Trigger Condition. 

The condition is indicated on the right side of the window.

To manually specify a frame: 

>> Type hexadecimal values directly into the center column of the window.

An X represents a nibble that can be any value (a “don’t care”). 

To set individual bits in any field, double-click on the hex entry to open the Binary Editor 
(Figure 323). In the hex view, partially defined hex characters appear as question marks: 
X001=?
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Figure 323:  Binary Editor Dialog

Another way to manually edit the frame condition is to make selections from the tree view in 
the right window pane.

Saving a Frame Condition

If you create a frame condition that you want to save and make easily available for future use, you 
can save it into the “User Library” folder in the Template Library tree. To do this:

>> Highlight the folder and click the double left arrow button.

Frame conditions have the option of “Use inverse of condition specified (i.e., NOT).” When you 
check this option, it means that the first frame encountered that does not match what you have 
specified creates a “condition met” event.

For each frame condition, you can specify an optional name at the top of the window. This name is 
also shown on the Delay Emulator Configuration window under the Mode selection, and on the 
main Xgig Maestro window.
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Configuring the Trigger Condition in Delay-Mode

The Trigger condition recognizes specific DWords within frames. 

Depending on the Mode you select in the Delay Emulator Configuration window, the appropriate 
graphic diagram shows the Classify condition, the Trigger and optional Arm conditions, and the 
Delay. If the Mode you select does not include an Arm condition, the Arm button remains 
disabled.

To set Trigger conditions: 

1 Click the Trigger button in the Xgig Delay Emulator Configuration window. 

The window for the condition is displayed (Figure 324). If you are in hardware edit mode, the 
protocol, chassis name, chassis number, slot number, and port numbers are displayed in the 
title bar.

2 Set the values as required to specify the Trigger condition as part of a unique Arm and Trigger 
sequence for the specific test. The default setting for the Trigger condition is to trigger on any 
frame.

The following sections describe the available values.
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Figure 324:  10GigE Trigger Window for Frames
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Setting Frame Conditions for a Trigger in Delay-Mode

You can specify frame conditions in two ways. One way is to load a template from the Template 
Library tree, and the other way is to manually specify bits in the frame.

To use a template:

1 Select a template from the Template Library tree on the left.

2 Click the double right arrow button to set the Trigger Condition. 

The condition is indicated on the right side of the window.

To manually specify a frame: 

>> Type hexadecimal values directly into the center column of the window.

An X represents a nibble that can be any value (a “don’t care”). 

To set individual bits in any field, double-click on the hex entry to open the Binary Editor 
(Figure 325). In the hex view, partially defined hex characters appear as question marks: 
X001=?

Figure 325:  Binary Editor Dialog

Another way to manually edit the frame condition is to make selections from the tree view in 
the right window pane.

Decode Switches Menu

Some templates allow you to specify decode switches. When you load a template that has this 
option, the Decode Switches Menu appears in the upper left corner of the window. The decode 
switches provide detailed contextual options for decode; for example, further decode of response 
and data frames. The Decode Switches menu is context sensitive and will only show the decode 
options available for the specific template you are creating.
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Figure 326:  Decode Switches Menu

The Decode Switches menu is intended to help you create a user-defined template. When editing 
a User Library template, Decode Switches are stored inside the template so they are still ON the 
next time you open this particular template.

Decode switches allow you to further decode Response and Data frames that can't be decoded 
without knowing what the associated command frame is. Below is a description of the switches 
avaFC-SW Accept Interpretation

Note: Once the Decode Switches menu appears, it remains visible. However, if you load a 
template that has no decode options, the menu is grayed out and inactive. 
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Figure 327:  Decode Switch Options for FC-SW Accept Interpretation

Saving a Frame Condition

If you create a frame condition that you want to save and make easily available for future use, you 
can save it into the “User Library” folder in the Template Library tree. To do this:

>> Highlight the folder and click the double left arrow button.

Frame conditions have the option of “Use inverse of condition specified (i.e., NOT).” When you 
check this option, it means that the first frame encountered that does not match what you have 
specified creates a “condition met” event.

For each frame condition, you can specify an optional name at the top of the window. This name is 
also shown on the Delay Emulator Configuration window under the Mode selection, and on the 
main Xgig Maestro window.
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Chapter 13
Creating Delay Emulator Test Configurations for 
Reorder Mode

In this chapter:

• Defining Your Own Test Configurations for Reorder Mode

• Using the Reorder-Mode Configuration Window

• Configuring the Arm Condition in Reorder-Mode

• Configuring the Trigger Condition in Reorder-Mode

• Configuring the Reorder Condition
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Defining Your Own Test Configurations for Reorder Mode

Xgig Delay Emulator lets you define your own test configurations and save them with or without 
hardware available.

You can create a configuration from scratch, or you can open and edit an existing configuration. 
Also, you can edit a configuration in edit only mode, which is independent of any hardware, or 
you can edit a configuration that is currently loaded to a Delay Emulator device.

To edit a configuration in edit only mode:

>> Double-click a configuration file in the Configuration manager. 

or:

>> Right-click the configuration file in the Configuration manager, and choose Edit Delay 
Emulator Configuration from the context menu.

The edit only mode Delay Emulator Configuration window opens (Figure 328).

This window allows you to set up your own Test Cases, name them, organize them, and save 
them to files so that you can use them again.

Figure 328:  Edit Only Delay Emulator Configuration Window
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To start a configuration from scratch in edit only mode:

>> Select New Delay Emulator Configuration from the context menu or the File menu 
(Figure 329) on the Xgig Maestro menu bar. Then, select Delay-Mode or Reorder-Mode 
Delay Emulator Configuration from the drop down menu.

or:

>> Click the New Configuration icon at the top of the Configuration manager.

Figure 329:  Maestro File Menu

To save your configuration in edit only mode:

>> Click Save at the bottom of the Delay Emulator Configuration window, or open the File menu 
on the Delay Emulator Configuration window and select Save Delay Emulator 
Configuration or Save Delay Emulator Configuration As.

Any changes you make have no effect on actual Delay Emulator devices you control.

To edit a configuration that is loaded to a Delay Emulator port:

>> Click Configuration... in the device column.

or:

>> Right-click in the Parameters Status table in the device column to open the context menu and 
select Edit configuration.

or: 

>> Click Operation in the device column to open the Operation dialog, then click Config.

The Xgig Delay Emulator Configuration window in hardware edit mode is displayed 
(Figure 330). This window allows you to set up your own Test Cases, name them, and save 
them to a file so that you can use them again.

Click Apply or OK and Delay Emulator accepts the changes. They are immediately reflected 
in the Parameters Status table and affect the Delay Emulator device the next time you run it.
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To save your configuration edits:

>> Open the File menu at the top of the Delay Emulator Configuration window and select Save 
Delay Emulator Configuration or Save Delay Emulator Configuration As.

Figure 330:  Xgig Delay Emulator Configuration Window
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Using the Reorder-Mode Configuration Window

The Delay Emulator Configuration window title bar indicates how many ports it is configuring, 
the protocol, and the configuration file name, if any. If you are using hardware edit mode, the 
chassis name, chassis number, slot number, and port number are also listed. The elements of the 
Delay Emulator Configuration window are described in the following sections.

Using the Delay Emulator Test Suite Tools in Reorder-Mode

The Delay Emulator Test Suite (left pane) lists the series of Xgig Delay Emulator tests in the order 
in which you want them to execute. The number of test in the test suite has no limit. Each test can 
contain between two and eight frames to be reordered. The highlighted test appears as the Current 
Delay Emulator Test (right pane). Each test in the suite executes in sequence.

Creating a Test Suite

When you create a Delay Emulator Test Suite, you use the toolbar in the Delay Emulator Test 
Suite section of the Configuration window (Figure 331).

Figure 331:  10GigE Delay Emulator Test Suite Toolbar

The following list describes the icons on the toolbar:

Cut current test Removes the highlighted test and holds its contents in the 
memory buffer.

Copy current text Copies the highlighted test to the memory buffer.

Paste last test cut or copied Inserts the current memory buffer contents before the currently 
highlighted test.

Add new test to bottom of stack Adds a new blank test to the bottom of the suite.

Insert new test before current test Inserts a new blank test above the currently highlighted test.

Delete current test Removes the highlighted test from the suite. If only one test is 
present, then the contents of this test are cleared.

Move current test down the stack Moves the highlighted test down one in the test order.

Move current test up the stack Moves the highlighted test up one in the test order.

Run test suite once or Repeat test 
suite

When you choose Repeat test suite, the tests run according 
the settings you define in the Delay Emulator Current Test 
window. You can also type a number in this field to indicate that 
you want the test suite to repeat a certain number of times.
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To duplicate a test at another point in the Test Suite:

1 Highlight the test you want to duplicate.

2 Click Copy.

3 Highlight the test in the suite that is just after the point where you want the duplicate test 
inserted.

4 Click Paste.

The duplicate test is inserted.

Using the Configuration File Menu

The File menu is the only menu on the menu bar (Figure 332). 

Figure 332:  Configuration File Menu

The choices are:

The recently used Delay Emulator configuration files appear in the file menu and are loaded when 
selected.

New Configuration Creates a new delay or reorder .decfg configuration file.

Open Configuration Open an existing .decfg configuration file.

Save Configuration Save the entire Test Suite to the .decfg file you currently have loaded.

Save Configuration As Save the entire Test Suite to a .decfg file with a name you assign to it.

Recent Configuration Open a recently opened .decfg configuration file.

Close Close the Delay Emulator Configuration Window.
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Using the Current Delay Emulator Test Window: Reorder-Mode

The graphics in this section of the window represent the hardware configuration for the selected 
test in the Delay Emulator Test Suite (Figure 333). 

Figure 333:  Current Delay Emulator Test Window

Mode

The Mode menu is available near the top of the Current Delay Emulator Test window 
(Figure 334). 

Figure 334:  Mode Drop-down Menu in Current Delay Emulator Test - Right Pane

Arm and Trigger

The Arm and Trigger buttons are located in the right pane of the Current Delay Emulator Test 
window. To define Arm and Trigger conditions, click the Arm or Trigger button. 
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Reorder

The Reorder button is located in the right pane of the Current Delay Emulator Test window. To 
define the Reorder condition, click the Reorder button.

Timeout

The timeout option defines the period of time to wait for a specified test to complete before 
aborting and proceeding to the next test in the suite.

To set the timeout:

1 Click Timeout to display the dialog box in Figure 335. 

2 Check Enable Timeout.

3 Enter the hours, minutes, and seconds you want to wait.

Figure 335:  Timeout Dialog

4 Click OK.
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Configuring the Arm Condition in Reorder-Mode

The Arm condition recognizes specific DWords within frames. 

Depending on the Mode you select, the appropriate graphic diagram shows the Trigger and 
optional Arm conditions. If the Mode you select does not include an Arm condition, the Arm 
button is disabled.

To set Arm conditions: 

1 Click on the Arm button to open the Arm window.

The window for the condition is displayed (Figure 336). If you are in hardware edit mode, the 
protocol, chassis name, chassis number, slot number, and port numbers are displayed in the 
title bar.

2 Set the values as required to specify the Arm condition as part of a unique Arm and Trigger 
sequence for the specific test.

The following sections describe the available values.
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Setting Frame Conditions for Arm for Reorder

You can specify frame conditions in two ways. One way is to load a template from the Template 
Library tree, and the other way is to manually specify bits in the frame. 

Figure 336:  Arm Window for Frames 
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To use a template:

1 Select a template from the Template Library tree on the left.

2 Click the double right arrow button to set the Trigger Condition. 

The condition is indicated on the right side of the window.

To manually specify a frame: 

>> Type hexadecimal values directly into the center column of the window.

An X represents a nibble that can be any value (a “don’t care”). 

To set individual bits in any field, double-click on the hex entry to open the Binary Editor 
(Figure 337). In the hex view, partially defined hex characters appear as question marks: 
X001=?

Figure 337:  Binary Editor Dialog

Another way to manually edit the frame condition is to make selections from the tree view in 
the right window pane.

Saving a Frame Condition

If you create a frame condition that you want to save and make easily available for future use, you 
can save it into the “User Library” folder in the Template Library tree. To do this:

>> Highlight the folder and click the double left arrow button.

Frame conditions have the option of “Use inverse of condition specified (i.e., NOT).” When you 
check this option, it means that the first frame encountered that does not match what you have 
specified creates a “condition met” event.

For each frame condition, you can specify an optional name at the top of the window. This name is 
also shown on the Delay Emulator Configuration window under the Mode selection, and on the 
main Xgig Maestro window.
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Configuring the Trigger Condition in Reorder-Mode

The Trigger condition recognizes DWords within frames. 

Depending on the Mode you select in the Delay Emulator Configuration window, the appropriate 
graphic diagram shows the Trigger and optional Arm conditions, along with the Delay. If the 
Mode you select does not include an Arm condition, the Arm button remains disabled.

To set Trigger conditions: 

1 Click the Trigger button in the Xgig Delay Emulator Configuration window. 

The window for the condition is displayed (Figure 338). If you are in hardware edit mode, the 
protocol, chassis name, chassis number, slot number, and port numbers are displayed in the 
title bar.

2 Set the values as required to specify the Trigger condition as part of a unique Arm and Trigger 
sequence for the specific test.

The following sections describe the available values.

Figure 338:  Trigger Window for Frames
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Setting Frame Conditions for a Trigger in Reorder-Mode

You can specify frame conditions in two ways. One way is to load a template from the Template 
Library tree, and the other way is to manually specify bits in the frame.

To use a template:

1 Select a template from the Template Library tree on the left.

2 Click the double right arrow button to set the Trigger Condition. 

The condition is indicated on the right side of the window.

To manually specify a frame: 

>> Type hexadecimal values directly into the center column of the window.

An X represents a nibble that can be any value (a “don’t care”). 

To set individual bits in any field, double-click on the hex entry to open the Binary Editor 
(Figure 339). In the hex view, partially defined hex characters appear as question marks: 
X001=?

Figure 339:  Binary Editor Dialog

Another way to manually edit the frame condition is to make selections from the tree view in 
the right window pane.
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Decode Switches Menu

Some templates allow you to specify decode switches. When you load a template that has this 
option, the Decode Switches Menu appears in the upper left corner of the window. The decode 
switches provide detailed contextual options for decode; for example, further decode of response 
and data frames. The Decode Switches menu is context sensitive and will only show the decode 
options available for the specific template you are creating.

Figure 340:  Decode Switches Menu

The Decode Switches menu is intended to help you create a user-defined template. When editing 
a User Library template, Decode Switches are stored inside the template so they are still ON the 
next time you open this particular template.

Note: Once the Decode Switches menu appears, it remains visible. However, if you load a 
template that has no decode options, the menu is greyed out and inactive. 
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Decode switches allow you to further decode Response and Data frames that can't be decoded 
without knowing what the associated command frame is. Below is a description of the switches 
avaFC-SW Accept Interpretation

Figure 341:  Decode Switch Options for FC-SW Accept Interpretation

Saving a Frame Condition

If you create a frame condition that you want to save and make easily available for future use, you 
can save it into the “User Library” folder in the Template Library tree. To do this:

>> Highlight the folder and click the double left arrow button.

Frame conditions have the option of “Use inverse of condition specified (i.e., NOT).” When you 
check this option, it means that the first frame encountered that does not match what you have 
specified creates a “condition met” event.

For each frame condition, you can specify an optional name at the top of the window. This name is 
also shown on the Delay Emulator Configuration window under the Mode selection, and on the 
main Xgig Maestro window.
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Configuring the Reorder Condition

The Reorder definition tells the software the way you want to reorder frames, how many frames to 
reorder, and in which order to place them. 

Depending on the Mode you select, the appropriate graphic diagram shows the Trigger and 
optional Arm conditions. If the Mode you select does not include an Arm condition, the Arm 
button is disabled.

To define the Reorder: 

1 Click the Reorder button to open the Reorder window.

The Reorder window is displayed (Figure 336). 

2 Select the type of reorder you want.

• Consecutive Reorder

For a consecutive reorder, every frame including the trigger frame is reordered.

• Trigger Reorder

For a trigger reorder, all frames of the type specified in the trigger are reordered beginning 
with the frame including the trigger frame.

3 Select the number of frames you want to reorder, between two and eight.

4 Drag the frames to reorder them.

5 Click OK.
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Appendix A
Fibre Channel Ordered Sets - Partial List 

Fibre Channel defines certain combinations of characters called Ordered Sets. The table in this 
appendix shows a partial list. The following abbreviations are used in the table: 

SOF Start-of-frame delimiter

EOF End-of-frame delimiter

ALPA, D, S, Type Arbitrated Loop Physical Address, Destination, Source, Mark Type. These 
are limited to 127 specific hex values. 

Name Function Beginning RD Ordered Set 8 Bit Hex

SOFc1 SOF Connect Class 1 Negative K28.5 D21.5 D23.0 D23.0 K28.5 B5 17 17

SOFi1 SOF Initiate Class 1 Negative K28.5 D21.5 D23.2 D23.2 K28.5 B5 57 57

SOFn1 SOF Normal Class 1 Negative K28.5 D21.5 D23.1 D23.1 K28.5 B5 37 37

SOFi2 SOF Initiate Class 2 Negative K28.5 D21.5 D21.2 D21.2 K28.5 B5 55 55

SOFn2 SOF Normal Class 2 Negative K28.5 D21.5 D21.1 D21.1 K28.5 B5 35 35

SOFi3 SOF Initiate Class 3 Negative K28.5 D21.5 D22.2 D22.2 K28.5 B5 56 56

SOFn3 SOF Normal Class 3 Negative K28.5 D21.5 D22.1 D22.1 K28.5 B5 36 36

SOFf SOF Fabric Negative K28.5 D21.5 D24.2 D24.2 K28.5 B5 58 58

SOFc4 SOF Activate Class 4 Negative K28.5 D21.5 D25.0 D25.0 K28.5 B5 19 19

SOFi4 SOF Initiate Class 4 Negative K28.5 D21.5 D25.2 D25.2 K28.5 B5 59 59

SOFn4 SOF Normal Class 4 Negative K28.5 D21.5 D25.1 D25.1 K28.5 B5 39 39
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EOFt EOF Terminate Negative
Positive

K28.5 D21.4 D21.3 D21.3
K28.5 D21.5 D21.3 D21.3

K28.5 95 75 75
K28.5 B5 75 75

EOFdt EOF Disconnect-Terminate Negative
Positive

K28.5 D21.4 D21.4 D21.4
K28.5 D21.5 D21.4 D21.4

K28.5 95 95 95
K28.5 B5 95 95

EOFa EOF Abort Negative
Positive

K28.5 D21.4 D21.7 D21.7
K28.5 D21.5 D21.7 D21.7

K28.5 95 F5 F5
K28.5 B5 F5 F5

EOFn EOF Normal Negative
Positive

K28.5 D21.4 D21.6 D21.6
K28.5 D21.5 D21.6 D21.6

K28.5 95 D5 D5
K28.5 B5 D5 D5

EOFdti EOF Disconnect-Terminate-Invalid Negative 
Positive

K28.5 D10.4 D21.4 D21.4
K28.5 D10.5 D21.4 D21.4

K28.5 8A 95 95
K28.5 AA 95 95

EOFni EOF Normal-Invalid Negative
Positive

K28.5 D10.4 D21.6 D21.6
K28.5 D10.5 D21.6 D21.6

K28.5 8A D5 D5
K28.5 AA D5 D5

EOFrt EOF Remove-Terminate Class 4 Negative
Positive

K28.5 D21.4 D25.4 D25.4
K28.5 D21.5 D25.4 D25.4

K28.5 95 99 99
K28.5 B5 99 99

EOFrti EOF Remove-Terminate Invalid Class 4 Negative
Positive

K28.5 D10.4 D25.4 D25.4
K28.5 D10.5 D25.4 D25.4

K28.5 8A 99 99
K28.5 AA 99 99

IDLE Idle Negative K28.5 D21.4 D21.5 D21.5 K28.5 95 B5 B5

R_RDY Receiver_Ready Negative K28.5 D21.4 D10.2 D10.2 K28.5 95 4A 4A5

VC_RDY Virtual Circuit Ready Negative K28.5 D21.7 VC.ID VC.ID K28.5 F5 xx xx

BB_SCs Buffer-to-buffer State Change (SOF) Negative K28.5 D21.4 D22.4 D22.4 K28.5 95 96 96

BB_SCr Buffer-to-buffer State Change (R_RDY) Negative K28.5 D21.4 D22.6 D22.6 K28.5 95 D6 D6

SYNx Clock Synchronization Word x Negative K28.5 D31.3 CS_x CS_x K28.5 7F xx xx

SYNy Clock Synchronization Word y Negative K28.5 D31.3 CS_y CS_y K28.5 7F xx xx

SYNz Clock Synchronization Word z Negative K28.5 D31.3 CS_z CS_z K28.5 7F xx xx

OLS Offline Negative K28.5 D21.1 D10.4 D21.2 K28.5 35 8A 55

NOS Not_Operational Negative K28.5 D21.2 D31.5 D5.2 K28.5 55 BF 45

LR Link_Reset Negative K28.5 D9.2 D31.5 D9.2 K28.5 49 BF 49

LRR Link_Reset_Response Negative K28.5 D21.1 D31.5 D9.2 K28.5 55 BF 49

OPNyx Open Loop Port Negative K28.5 D17.4 ALPD ALPS K28.5 91 xx xx

OPNfr Open Loop Port Negative K28.5 D17.4 D31.7 D31.7 K28.5 91 FF FF

CLS Close Loop Port Negative K28.5 D5.4 D21.5 D21.5 K28.5 85 B5 B5

MRK Mark Negative K28.5 D31.2 type ALPS K28.5 5F xx xx

LIP Loop Initialization, Acquire PA Negative K28.5 D21.0 D23.7 D23.7 K28.5 15 F7 F7

LIP Loop Initialization, Rcvr Fail Negative K28.5 D21.0 D24.7 D23.7 K28.5 15 F8 F7

LIP Loop Initialization, Reinitialize Negative K28.5 D21.0 D23.7 ALPS K28.5 15 F7 xx

LIP Loop Initialization, Fail at PS Negative K28.5 D21.0 D24.7 ALPS K28.5 15 F8 xx

LIP Loop Initialization, Reset PD Negative K28.5 D21.0 ALPD ALPS K28.5 15 xx xx

LPEyx Loop Port Enable, enable PD Negative K28.5 D5.0 ALPD ALPS K28.5 05 xx xx

LPEfx Loop Port Enable, enable all Negative K28.5 D5.0 D31.7 ALPS K28.5 05 FF xx

LPByx Loop Port Bypass, bypass PD Negative K28.5 D9.0 ALPD ALPS K28.5 09 xx xx

ARBx Arbitrate For Loop Negative K28.5 D20.4 ALPS ALPS K28.5 94 xx xx

ARB(F0) Arbitrate For Loop, fairness Negative K28.5 D20.4 D16.7 D16.7 K28.5 94 F0 F0

Name Function Beginning RD Ordered Set 8 Bit Hex
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Appendix B
8-Bit/10-Bit Mapping

This appendix contains tables sorted by values for 8-bit/10-bit mapping.
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The following table lists:

Legal 8-Bit/10-Bit Characters 
Sorted by 10-Bit Value

       

10B
Dec

8B 
Dec ASCII+ HEX

Previous 
Disparity

Data 
Byte 
Name

10 B
Comment

85 87 W 57 RD + D23.2 00 0101 0101
86 215 × D7 RD + D23.6 00 0101 0110
87 247 ÷ F7 RD + K23.7 00 0101 0111
89 55 7 37 RD + D23.1 00 0101 1001
90 183 · B7 RD + D23.5 00 0101 1010
91 23 ETB 17 RD + D23.0 00 0101 1011
92 119 w 77 RD + D23.3 00 0101 1100
93 151 — 97 RD + D23.4 00 0101 1101

94 247 ÷ F7 RD + D23.7 00 0101 1110
101 72 H 48 RD + D8.2 00 0110 0101
102 200 È C8 RD + D8.6 00 0110 0110
105 40 ( 28 RD + D8.1 00 0110 1001
106 168 ¨ A8 RD + D8.5 00 0110 1010
107 8 BS 08 RD + D8.0 00 0110 1011
108 104 h 68 RD + D8.3 00 0110 1100
109 136 ˆ 88 RD + D8.4 00 0110 1101
110 232 è E8 RD + D8.7 00 0110 1110
113 231 ç E7 RD + D7.7 00 0111 0001
114 135 ‡ 87 RD + D7.4 00 0111 0010

115 103 g 67 RD + D7.3 00 0111 0011
116 7 BEL 07 RD + D7.0 00 0111 0100
117 71 G 47 RD + D7.2 00 0111 0101
118 199 Ç C7 RD + D7.6 00 0111 0110
121 39 ' 27 RD + D7.1 00 0111 1001
122 167 § A7 RD + D7.5 00 0111 1010
149 91 [ 5B RD + D27.2 00 1001 0101
150 219 Û DB RD + D27.6 00 1001 0110
151 251 û FB RD + K27.7 00 1001 0111
153 59 ; 3B RD + D27.1 00 1001 1001
154 187 » BB RD + D27.5 00 1001 1010
155 27 ESC 1B RD + D27.0 00 1001 1011
156 123 { 7B RD + D27.3 00 1001 1100
157 155 › 9B RD + D27.4 00 1001 1101
158 251 û FB RD + D27.7 00 1001 1110
165 68 D 44 RD + D4.2 00 1010 0101
166 196 Ä C4 RD + D4.6 00 1010 0110
169 36 $ 24 RD + D4.1 00 1010 1001
170 164 ¤ A4 RD + D4.5 00 1010 1010
171 4 EOT 04 RD + D4.0 00 1010 1011
172 100 d 64 RD + D4.3 00 1010 1100
173 132 „ 84 RD + D4.4 00 1010 1101
174 228 ä E4 RD + D4.7 00 1010 1110
177 244 ô F4 RD + D20.7 00 1011 0001
178 148 ” 94 RD + D20.4 00 1011 0010
179 116 t 74 RD + D20.3 00 1011 0011
180 20 DC4 14 RD + D20.0 00 1011 0100
181 84 T 54 RD+/-- D20.2 00 1011 0101
182 212 Ô D4 RD+/-- D20.6 00 1011 0110
183 244 ô F4 RD-- D20.7 00 1011 0111
185 52 4 34 RD+/-- D20.1 00 1011 1001
186 180 ´ B4 RD+/-- D20.5 00 1011 1010
187 20 DC4 14 RD-- D20.0 00 1011 1011
188 116 t 74 RD-- D20.3 00 1011 1100
189 148 ” 94 RD-- D20.4 00 1011 1101
197 88 X 58 RD + D24.2 00 1100 0101
198 216 Ø D8 RD + D24.6 00 1100 0110
201 56 8 38 RD + D24.1 00 1100 1001
202 184 ¸ B8 RD + D24.5 00 1100 1010

203 24 CAN 18 RD + D24.0 00 1100 1011
204 120 x 78 RD + D24.3 00 1100 1100
205 152 ˜ 98 RD + D24.4 00 1100 1101
206 248 ø F8 RD + D24.7 00 1100 1110
209 236 ì EC RD + D12.7 00 1101 0001
210 140 Œ 8C RD + D12.4 00 1101 0010
211 108 l 6C RD + D12.3 00 1101 0011
212 12 FF 0C RD + D12.0 00 1101 0100
213 76 L 4C RD+/-- D12.2 00 1101 0101
214 204 Ì CC RD+/-- D12.6 00 1101 0110
217 44 , 2C RD+/-- D12.1 00 1101 1001
218 172 ¬ AC RD+/-- D12.5 00 1101 1010
219 12 FF 0C RD-- D12.0 00 1101 1011
220 108 l 6C RD-- D12.3 00 1101 1100
221 140 Œ 8C RD-- D12.4 00 1101 1101
222 236 ì EC RD-- D12.7 00 1101 1110
225 252 ü FC RD + D28.7 00 1110 0001
226 156 œ 9C RD + D28.4 00 1110 0010
227 124 | 7C RD + D28.3 00 1110 0011
228 28 FS 1C RD + D28.0 00 1110 0100
229 92 \ 5C RD+/-- D28.2 00 1110 0101
230 220 Ü DC RD+/-- D28.6 00 1110 0110
233 60 < 3C RD+/-- D28.1 00 1110 1001
234 188 ¼ BC RD+/-- D28.5 00 1110 1010
235 28 FS 1C RD-- D28.0 00 1110 1011
236 124 | 7C RD-- D28.3 00 1110 1100
237 156 œ 9C RD-- D28.4 00 1110 1101
238 252 ü FC RD-- D28.7 00 1110 1110
242 156 œ 9C RD -- K28.4 00 1111 0010 Reserved*
243 124 | 7C RD -- K28.3 00 1111 0011 Reserved*
244 28 FS 1C RD -- K28.0 00 1111 0100 Reserved*
245 92 \ 5C RD -- K28.2 00 1111 0101 Reserved*
246 220 Ü DC RD -- K28.6 00 1111 0110 Reserved*
248 252 ü FC RD -- K28.7 00 1111 1000 Test
249 60 < 3C RD -- K28.1 00 1111 1001 Reserved*
250 188 ¼ BC RD -- K28.5 00 1111 1010 Sync
277 93 ] 5D RD + D29.2 01 0001 0101
278 221 Ý DD RD + D29.6 01 0001 0110
279 253 ý FD RD + K29.7 01 0001 0111
281 61 = 3D RD + D29.1 01 0001 1001
282 189 ½ BD RD + D29.5 01 0001 1010
283 29 GS 1D RD + D29.0 01 0001 1011
284 125 } 7D RD + D29.3 01 0001 1100
285 157 _ 9D RD + D29.4 01 0001 1101
286 253 ý FD RD + D29.7 01 0001 1110
293 66 B 42 RD + D2.2 01 0010 0101
294 194 Â C2 RD + D2.6 01 0010 0110
297 34 " 22 RD + D2.1 01 0010 1001
298 162 ¢ A2 RD + D2.5 01 0010 1010

299 2 STX 02 RD + D2.0 01 0010 1011
300 98 b 62 RD + D2.3 01 0010 1100
301 130 ‚ 82 RD + D2.4 01 0010 1101
302 226 â E2 RD + D2.7 01 0010 1110
305 242 ò F2 RD + D18.7 01 0011 0001
306 146 ’ 92 RD + D18.4 01 0011 0010
307 114 r 72 RD + D18.3 01 0011 0011
308 18 DC2 12 RD + D18.0 01 0011 0100
309 82 R 52 RD+/-- D18.2 01 0011 0101
310 210 Ò D2 RD+/-- D18.6 01 0011 0110
311 242 ò F2 RD-- D18.7 01 0011 0111
313 50 2 32 RD+/-- D18.1 01 0011 1001
314 178 ² B2 RD+/-- D18.5 01 0011 1010
315 18 DC2 12 RD-- D18.0 01 0011 1011
316 114 r 72 RD-- D18.3 01 0011 1100
317 146 ’ 92 RD-- D18.4 01 0011 1101
325 95 _ 5F RD + D31.2 01 0100 0101
326 223 ß DF RD + D31.6 01 0100 0110
329 63 ? 3F RD + D31.1 01 0100 1001
330 191 ¿ BF RD + D31.5 01 0100 1010
331 31 US 1F RD + D31.0 01 0100 1011
332 127DELETE 7F RD + D31.3 01 0100 1100
333 159 Ÿ 9F RD + D31.4 01 0100 1101
334 255 ÿ FF RD + D31.7 01 0100 1110



8-Bit/10-Bit Mapping

Xgig Jammer and Delay Emulator User Guide 377

  

337 234 ê EA RD + D10.7 01 0101 0001
338 138 Š 8A RD + D10.4 01 0101 0010
339 106 j 6A RD + D10.3 01 0101 0011
340 10 LF 0A RD + D10.0 01 0101 0100
341 74 J 4A RD+/-- D10.2 01 0101 0101
342 202 Ê CA RD+/-- D10.6 01 0101 0110
345 42 * 2A RD+/-- D10.1 01 0101 1001
346 170 ª AA RD+/-- D10.5 01 0101 1010
347 10 LF 0A RD-- D10.0 01 0101 1011
348 106 j 6A RD-- D10.3 01 0101 1100
349 138 Š 8A RD-- D10.4 01 0101 1101
350 234 ê EA RD-- D10.7 01 0101 1110
353 250 ú FA RD + D26.7 01 0110 0001
354 154 š 9A RD + D26.4 01 0110 0010
355 122 z 7A RD + D26.3 01 0110 0011
356 26 SUB 1A RD + D26.0 01 0110 0100
357 90 Z 5A RD+/-- D26.2 01 0110 0101
358 218 Ú DA RD+/-- D26.6 01 0110 0110
361 58 : 3A RD+/-- D26.1 01 0110 1001
362 186 º BA RD+/-- D26.5 01 0110 1010
363 26 SUB 1A RD-- D26.0 01 0110 1011
364 122 z 7A RD-- D26.3 01 0110 1100
365 154 š 9A RD-- D26.4 01 0110 1101
366 250 ú FA RD-- D26.7 01 0110 1110
369 239 ï EF RD-- D15.7 01 0111 0001
370 143 _ 8F RD-- D15.4 01 0111 0010
371 111 o 6F RD-- D15.3 01 0111 0011
372 15 SI 0F RD-- D15.0 01 0111 0100
373 79 O 4F RD-- D15.2 01 0111 0101
374 207 Ï CF RD-- D15.6 01 0111 0110
377 47 / 2F RD-- D15.1 01 0111 1001
378 175 ¯ AF RD-- D15.5 01 0111 1010
389 64 @ 40 RD + D0.2 01 1000 0101
390 192 À C0 RD + D0.6 01 1000 0110
393 32SPACE 20 RD + D0.1 01 1000 1001
394 160 A0 RD + D0.5 01 1000 1010

395 0 NUL 00 RD + D0.0 01 1000 1011
396 96 ` 60 RD + D0.3 01 1000 1100
397 128 _ 80 RD + D0.4 01 1000 1101
398 224 à E0 RD + D0.7 01 1000 1110
401 230 æ E6 RD + D6.7 01 1001 0001
402 134 † 86 RD + D6.4 01 1001 0010

403 102 f 66 RD + D6.3 01 1001 0011
404 6 ACK 06 RD + D6.0 01 1001 0100
405 70 F 46 RD+/-- D6.2 01 1001 0101
406 198 Æ C6 RD+/-- D6.6 01 1001 0110
409 38 & 26 RD+/-- D6.1 01 1001 1001
410 166 ¦ A6 RD+/-- D6.5 01 1001 1010
411 6 ACK 06 RD-- D6.0 01 1001 1011
412 102 f 66 RD-- D6.3 01 1001 1100
413 134 † 86 RD-- D6.4 01 1001 1101

414 230 æ E6 RD-- D6.7 01 1001 1110
417 246 ö F6 RD + D22.7 01 1010 0001
418 150 – 96 RD + D22.4 01 1010 0010

419 118 v 76 RD + D22.3 01 1010 0011
420 22 SYN 16 RD + D22.0 01 1010 0100
421 86 V 56 RD+/-- D22.2 01 1010 0101
422 214 Ö D6 RD+/-- D22.6 01 1010 0110
425 54 6 36 RD+/-- D22.1 01 1010 1001
426 182 ¶ B6 RD+/-- D22.5 01 1010 1010
427 22 SYN 16 RD-- D22.0 01 1010 1011
428 118 v 76 RD-- D22.3 01 1010 1100
429 150 – 96 RD-- D22.4 01 1010 1101

430 246 ö F6 RD-- D22.7 01 1010 1110
433 240 ð F0 RD-- D16.7 01 1011 0001
434 144 _ 90 RD-- D16.4 01 1011 0010
435 112 p 70 RD-- D16.3 01 1011 0011
436 16 DLE 10 RD-- D16.0 01 1011 0100
437 80 P 50 RD-- D16.2 01 1011 0101
438 208 Ð D0 RD-- D16.6 01 1011 0110
441 48 0 30 RD-- D16.1 01 1011 1001

442 176 ° B0 RD-- D16.5 01 1011 1010
450 142 _ 8E RD + D14.4 01 1100 0010
451 110 n 6E RD + D14.3 01 1100 0011
452 14 SO 0E RD + D14.0 01 1100 0100
453 78 N 4E RD+/-- D14.2 01 1100 0101
454 206 Î CE RD+/-- D14.6 01 1100 0110
456 238 î EE RD + D14.7 01 1100 1000
457 46 . 2E RD+/-- D14.1 01 1100 1001
458 174 ® AE RD+/-- D14.5 01 1100 1010
459 14 SO 0E RD-- D14.0 01 1100 1011
460 110 n 6E RD-- D14.3 01 1100 1100
461 142 _ 8E RD-- D14.4 01 1100 1101
462 238 î EE RD-- D14.7 01 1100 1110
465 225 á E1 RD-- D1.7 01 1101 0001
466 129 _ 81 RD-- D1.4 01 1101 0010
467 97 a 61 RD-- D1.3 01 1101 0011
468 1 SOH 01 RD-- D1.0 01 1101 0100
469 65 A 41 RD-- D1.2 01 1101 0101
470 193 Á C1 RD-- D1.6 01 1101 0110
473 33 ! 21 RD-- D1.1 01 1101 1001
474 161 ¡ A1 RD-- D1.5 01 1101 1010
481 254 þ FE RD-- D30.7 01 1110 0001
482 158 _ 9E RD-- D30.4 01 1110 0010
483 126 ~ 7E RD-- D30.3 01 1110 0011
484 30 RS 1E RD-- D30.0 01 1110 0100
485 94 ^ 5E RD-- D30.2 01 1110 0101
486 222 Þ DE RD-- D30.6 01 1110 0110
488 254 þ FE RD -- K30.7 01 1110 1000 Reserved*
489 62 > 3E RD-- D30.1 01 1110 1001
490 190 ¾ BE RD-- D30.5 01 1110 1010
533 94 ^ 5E RD + D30.2 10 0001 0101
534 222 Þ DE RD + D30.6 10 0001 0110
535 254 þ FE RD + K30.7 10 0001 0111
537 62 > 3E RD + D30.1 10 0001 1001
538 190 ¾ BE RD + D30.5 10 0001 1010
539 30 RS 1E RD + D30.0 10 0001 1011
540 126 ~ 7E RD + D30.3 10 0001 1100
541 158 _ 9E RD + D30.4 10 0001 1101
542 254 þ FE RD + D30.7 10 0001 1110
549 65 A 41 RD + D1.2 10 0010 0101
550 193 Á C1 RD + D1.6 10 0010 0110
553 33 ! 21 RD + D1.1 10 0010 1001
554 161 ¡ A1 RD + D1.5 10 0010 1010
555 1 SOH 01 RD + D1.0 10 0010 1011
556 97 a 61 RD + D1.3 10 0010 1100
557 129 _ 81 RD + D1.4 10 0010 1101
558 225 á E1 RD + D1.7 10 0010 1110
561 241 ñ F1 RD + D17.7 10 0011 0001
562 145 ‘ 91 RD + D17.4 10 0011 0010
563 113 q 71 RD + D17.3 10 0011 0011
564 17 DC1 11 RD + D17.0 10 0011 0100
565 81 Q 51 RD+/-- D17.2 10 0011 0101
566 209 Ñ D1 RD+/-- D17.6 10 0011 0110
567 241 ñ F1 RD-- D17.7 10 0011 0111
569 49 1 31 RD+/-- D17.1 10 0011 1001
570 177 ± B1 RD+/-- D17.5 10 0011 1010
571 17 DC1 11 RD-- D17.0 10 0011 1011
572 113 q 71 RD-- D17.3 10 0011 1100
573 145 ‘ 91 RD-- D17.4 10 0011 1101
581 80 P 50 RD + D16.2 10 0100 0101
582 208 Ð D0 RD + D16.6 10 0100 0110
585 48 0 30 RD + D16.1 10 0100 1001
586 176 ° B0 RD + D16.5 10 0100 1010
587 16 DLE 10 RD + D16.0 10 0100 1011
588 112 p 70 RD + D16.3 10 0100 1100
589 144 _ 90 RD + D16.4 10 0100 1101
590 240 ð F0 RD + D16.7 10 0100 1110
593 233 é E9 RD + D9.7 10 0101 0001
594 137 ‰ 89 RD + D9.4 10 0101 0010
595 105 i 69 RD + D9.3 10 0101 0011
596 9 HT 09 RD + D9.0 10 0101 0100
597 73 I 49 RD+/-- D9.2 10 0101 0101
598 201 É C9 RD+/-- D9.6 10 0101 0110



8-Bit/10-Bit Mapping

378 Xgig Jammer and Delay Emulator User Guide

  

601 41 ) 29 RD+/-- D9.1 10 0101 1001
602 169 © A9 RD+/-- D9.5 10 0101 1010
603 9 HT 09 RD-- D9.0 10 0101 1011
604 105 i 69 RD-- D9.3 10 0101 1100
605 137 ‰ 89 RD-- D9.4 10 0101 1101
606 233 é E9 RD-- D9.7 10 0101 1110
609 249 ù F9 RD + D25.7 10 0110 0001
610 153 ™ 99 RD + D25.4 10 0110 0010
611 121 y 79 RD + D25.3 10 0110 0011
612 25 EM 19 RD + D25.0 10 0110 0100
613 89 Y 59 RD+/-- D25.2 10 0110 0101
614 217 Ù D9 RD+/-- D25.6 10 0110 0110
617 57 9 39 RD+/-- D25.1 10 0110 1001
618 185 ¹ B9 RD+/-- D25.5 10 0110 1010
619 25 EM 19 RD-- D25.0 10 0110 1011
620 121 y 79 RD-- D25.3 10 0110 1100
621 153 ™ 99 RD-- D25.4 10 0110 1101
622 249 ù F9 RD-- D25.7 10 0110 1110
625 224 à E0 RD-- D0.7 10 0111 0001
626 128 _ 80 RD-- D0.4 10 0111 0010
627 96 ` 60 RD-- D0.3 10 0111 0011
628 0 NUL 00 RD-- D0.0 10 0111 0100
629 64 @ 40 RD-- D0.2 10 0111 0101
630 192 À C0 RD-- D0.6 10 0111 0110
633 32SPACE 20 RD-- D0.1 10 0111 1001
634 160 A0 RD-- D0.5 10 0111 1010

645 79 O 4F RD + D15.2 10 1000 0101
646 207 Ï CF RD + D15.6 10 1000 0110
649 47 / 2F RD + D15.1 10 1000 1001
650 175 ¯ AF RD + D15.5 10 1000 1010
651 15 SI 0F RD + D15.0 10 1000 1011
652 111 o 6F RD + D15.3 10 1000 1100
653 143 _ 8F RD + D15.4 10 1000 1101
654 239 ï EF RD + D15.7 10 1000 1110
657 229 å E5 RD + D5.7 10 1001 0001
658 133 … 85 RD + D5.4 10 1001 0010
659 101 e 65 RD + D5.3 10 1001 0011
660 5 ENQ 05 RD + D5.0 10 1001 0100
661 69 E 45 RD+/-- D5.2 10 1001 0101
662 197 Å C5 RD+/-- D5.6 10 1001 0110
665 37 % 25 RD+/-- D5.1 10 1001 1001
666 165 ¥ A5 RD+/-- D5.5 10 1001 1010

667 5 ENQ 05 RD-- D5.0 10 1001 1011
668 101 e 65 RD-- D5.3 10 1001 1100
669 133 … 85 RD-- D5.4 10 1001 1101
670 229 å E5 RD-- D5.7 10 1001 1110
673 245 õ F5 RD + D21.7 10 1010 0001
674 149 • 95 RD + D21.4 10 1010 0010

675 117 u 75 RD + D21.3 10 1010 0011
676 21 NAK 15 RD + D21.0 10 1010 0100
677 85 U 55 RD+/-- D21.2 10 1010 0101
678 213 Õ D5 RD+/-- D21.6 10 1010 0110
681 53 5 35 RD+/-- D21.1 10 1010 1001
682 181 µ B5 RD+/-- D21.5 10 1010 1010
683 21 NAK 15 RD-- D21.0 10 1010 1011
684 117 u 75 RD-- D21.3 10 1010 1100
685 149 • 95 RD-- D21.4 10 1010 1101

686 245 õ F5 RD-- D21.7 10 1010 1110
689 255 ÿ FF RD-- D31.7 10 1011 0001
690 159 Ÿ 9F RD-- D31.4 10 1011 0010
691 127DELETE 7F RD-- D31.3 10 1011 0011
692 31 US 1F RD-- D31.0 10 1011 0100
693 95 _ 5F RD-- D31.2 10 1011 0101
694 223 ß DF RD-- D31.6 10 1011 0110
697 63 ? 3F RD-- D31.1 10 1011 1001
698 191 ¿ BF RD-- D31.5 10 1011 1010
706 141 _ 8D RD + D13.4 10 1100 0010
707 109 m 6D RD + D13.3 10 1100 0011
708 13 CR 0D RD + D13.0 10 1100 0100
709 77 M 4D RD+/-- D13.2 10 1100 0101
710 205 Í CD RD+/-- D13.6 10 1100 0110
712 237 í ED RD + D13.7 10 1100 1000

713 45 - 2D RD+/-- D13.1 10 1100 1001
714 173 - AD RD+/-- D13.5 10 1100 1010
715 13 CR 0D RD-- D13.0 10 1100 1011
716 109 m 6D RD-- D13.3 10 1100 1100
717 141 _ 8D RD-- D13.4 10 1100 1101
718 237 í ED RD-- D13.7 10 1100 1110
721 226 â E2 RD-- D2.7 10 1101 0001
722 130 ‚ 82 RD-- D2.4 10 1101 0010
723 98 b 62 RD-- D2.3 10 1101 0011
724 2 STX 02 RD-- D2.0 10 1101 0100
725 66 B 42 RD-- D2.2 10 1101 0101
726 194 Â C2 RD-- D2.6 10 1101 0110
729 34 " 22 RD-- D2.1 10 1101 1001
730 162 ¢ A2 RD-- D2.5 10 1101 1010

737 253 ý FD RD-- D29.7 10 1110 0001
738 157 _ 9D RD-- D29.4 10 1110 0010
739 125 } 7D RD-- D29.3 10 1110 0011
740 29 GS 1D RD-- D29.0 10 1110 0100
741 93 ] 5D RD-- D29.2 10 1110 0101
742 221 Ý DD RD-- D29.6 10 1110 0110
744 253 ý FD RD -- K29.7 10 1110 1000 Reserved*
745 61 = 3D RD-- D29.1 10 1110 1001
746 189 ½ BD RD-- D29.5 10 1110 1010
773 188 ¼ BC RD + K28.5 11 0000 0101 (Not Used)
774 60 < 3C RD + K28.1 11 0000 0110
775 252 ü FC RD + K28.7 11 0000 0111
777 220 Ü DC RD + K28.6 11 0000 1001
778 92 \ 5C RD + K28.2 11 0000 1010
779 28 FS 1C RD + K28.0 11 0000 1011
780 124 | 7C RD + K28.3 11 0000 1100
781 156 œ 9C RD + K28.4 11 0000 1101
785 227 ã E3 RD + D3.7 11 0001 0001
786 131 ƒ 83 RD + D3.4 11 0001 0010
787 99 c 63 RD + D3.3 11 0001 0011
788 3 ETX 03 RD + D3.0 11 0001 0100
789 67 C 43 RD+/-- D3.2 11 0001 0101
790 195 Ã C3 RD+/-- D3.6 11 0001 0110
793 35 # 23 RD+/-- D3.1 11 0001 1001
794 163 £ A3 RD+/-- D3.5 11 0001 1010

795 3 ETX 03 RD-- D3.0 11 0001 1011
796 99 c 63 RD-- D3.3 11 0001 1100
797 131 ƒ 83 RD-- D3.4 11 0001 1101
798 227 ã E3 RD-- D3.7 11 0001 1110
801 243 ó F3 RD + D19.7 11 0010 0001
802 147 “ 93 RD + D19.4 11 0010 0010
803 115 s 73 RD + D19.3 11 0010 0011
804 19 DC3 13 RD + D19.0 11 0010 0100
805 83 S 53 RD+/-- D19.2 11 0010 0101
806 211 Ó D3 RD+/-- D19.6 11 0010 0110
809 51 3 33 RD+/-- D19.1 11 0010 1001
810 179 ³ B3 RD+/-- D19.5 11 0010 1010
811 19 DC3 13 RD-- D19.0 11 0010 1011
812 115 s 73 RD-- D19.3 11 0010 1100
813 147 “ 93 RD-- D19.4 11 0010 1101
814 243 ó F3 RD-- D19.7 11 0010 1110
817 248 ø F8 RD-- D24.7 11 0011 0001
818 152 ˜ 98 RD-- D24.4 11 0011 0010
819 120 x 78 RD-- D24.3 11 0011 0011
820 24 CAN 18 RD-- D24.0 11 0011 0100
821 88 X 58 RD-- D24.2 11 0011 0101
822 216 Ø D8 RD-- D24.6 11 0011 0110
825 56 8 38 RD-- D24.1 11 0011 1001
826 184 ¸ B8 RD-- D24.5 11 0011 1010
834 139 ‹ 8B RD + D11.4 11 0100 0010
835 107 k 6B RD + D11.3 11 0100 0011
836 11 VT 0B RD + D11.0 11 0100 0100
837 75 K 4B RD+/-- D11.2 11 0100 0101
838 203 Ë CB RD+/-- D11.6 11 0100 0110
840 235 ë EB RD + D11.7 11 0100 1000
841 43 + 2B RD+/-- D11.1 11 0100 1001
842 171 « AB RD+/-- D11.5 11 0100 1010
843 11 VT 0B RD-- D11.0 11 0100 1011
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844 107 k 6B RD-- D11.3 11 0100 1100
845 139 ‹ 8B RD-- D11.4 11 0100 1101
846 235 ë EB RD-- D11.7 11 0100 1110
849 228 ä E4 RD-- D4.7 11 0101 0001
850 132 „ 84 RD-- D4.4 11 0101 0010
851 100 d 64 RD-- D4.3 11 0101 0011
852 4 EOT 04 RD-- D4.0 11 0101 0100
853 68 D 44 RD-- D4.2 11 0101 0101
854 196 Ä C4 RD-- D4.6 11 0101 0110
857 36 $ 24 RD-- D4.1 11 0101 1001
858 164 ¤ A4 RD-- D4.5 11 0101 1010
865 251 û FB RD-- D27.7 11 0110 0001
866 155 › 9B RD-- D27.4 11 0110 0010
867 123 { 7B RD-- D27.3 11 0110 0011
868 27 ESC 1B RD-- D27.0 11 0110 0100
869 91 [ 5B RD-- D27.2 11 0110 0101
870 219 Û DB RD-- D27.6 11 0110 0110
872 251 û FB RD -- K27.7 11 0110 1000 Reserved*
873 59 ; 3B RD-- D27.1 11 0110 1001
874 187 » BB RD-- D27.5 11 0110 1010
901 71 G 47 RD-- D7.2 11 1000 0101
902 199 Ç C7 RD-- D7.6 11 1000 0110
905 39 ' 27 RD-- D7.1 11 1000 1001
906 167 § A7 RD-- D7.5 11 1000 1010
907 7 BEL 07 RD-- D7.0 11 1000 1011
908 103 g 67 RD-- D7.3 11 1000 1100
909 135 ‡ 87 RD-- D7.4 11 1000 1101

910 231 ç E7 RD-- D7.7 11 1000 1110
913 232 è E8 RD-- D8.7 11 1001 0001
914 136 ˆ 88 RD-- D8.4 11 1001 0010
915 104 h 68 RD-- D8.3 11 1001 0011
916 8 BS 08 RD-- D8.0 11 1001 0100
917 72 H 48 RD-- D8.2 11 1001 0101
918 200 È C8 RD-- D8.6 11 1001 0110
921 40 ( 28 RD-- D8.1 11 1001 1001
922 168 ¨ A8 RD-- D8.5 11 1001 1010
929 247 ÷ F7 RD-- D23.7 11 1010 0001
930 151 — 97 RD-- D23.4 11 1010 0010

931 119 w 77 RD-- D23.3 11 1010 0011
932 23 ETB 17 RD-- D23.0 11 1010 0100
933 87 W 57 RD-- D23.2 11 1010 0101
934 215 × D7 RD-- D23.6 11 1010 0110
936 247 ÷ F7 RD -- K23.7 11 1010 1000 Reserved*
937 55 7 37 RD-- D23.1 11 1010 1001
938 183 · B7 RD-- D23.5 11 1010 1010
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The following table lists:

10-Bit Values with No 8-bit 
Mapping Sorted by 10-Bit 
Value

10B 
Dec 10 B COMMENT

0 00 0000 0000 ILLEGAL

1 00 0000 0001 ILLEGAL

2 00 0000 0010 ILLEGAL

3 00 0000 0011 ILLEGAL

4 00 0000 0100 ILLEGAL

5 00 0000 0101 ILLEGAL

6 00 0000 0110 ILLEGAL

7 00 0000 0111 ILLEGAL

8 00 0000 1000 ILLEGAL

9 00 0000 1001 ILLEGAL

10 00 0000 1010 ILLEGAL

11 00 0000 1011 ILLEGAL

12 00 0000 1100 ILLEGAL

13 00 0000 1101 ILLEGAL

14 00 0000 1110 ILLEGAL

15 00 0000 1111 ILLEGAL

16 00 0001 0000 ILLEGAL

17 00 0001 0001 ILLEGAL

18 00 0001 0010 ILLEGAL

19 00 0001 0011 ILLEGAL

20 00 0001 0100 ILLEGAL

21 00 0001 0101 ILLEGAL

22 00 0001 0110 ILLEGAL

23 00 0001 0111 ILLEGAL

24 00 0001 1000 ILLEGAL

25 00 0001 1001 ILLEGAL

26 00 0001 1010 ILLEGAL

27 00 0001 1011 ILLEGAL

28 00 0001 1100 ILLEGAL

29 00 0001 1101 ILLEGAL

30 00 0001 1110 ILLEGAL

31 00 0001 1111 ILLEGAL

32 00 0010 0000 ILLEGAL

33 00 0010 0001 ILLEGAL

34 00 0010 0010 ILLEGAL

35 00 0010 0011 ILLEGAL

36 00 0010 0100 ILLEGAL

37 00 0010 0101 ILLEGAL

38 00 0010 0110 ILLEGAL

39 00 0010 0111 ILLEGAL

40 00 0010 1000 ILLEGAL

41 00 0010 1001 ILLEGAL

42 00 0010 1010 ILLEGAL

43 00 0010 1011 ILLEGAL

44 00 0010 1100 ILLEGAL

45 00 0010 1101 ILLEGAL

46 00 0010 1110 ILLEGAL

47 00 0010 1111 ILLEGAL

48 00 0011 0000 ILLEGAL

49 00 0011 0001 ILLEGAL

50 00 0011 0010 ILLEGAL

51 00 0011 0011 ILLEGAL

52 00 0011 0100 ILLEGAL

53 00 0011 0101 ILLEGAL

54 00 0011 0110 ILLEGAL

55 00 0011 0111 ILLEGAL

56 00 0011 1000 ILLEGAL

57 00 0011 1001 ILLEGAL

58 00 0011 1010 ILLEGAL

59 00 0011 1011 ILLEGAL

60 00 0011 1100 ILLEGAL

61 00 0011 1101 ILLEGAL

62 00 0011 1110 ILLEGAL

63 00 0011 1111 ILLEGAL

64 00 0100 0000 ILLEGAL

65 00 0100 0001 ILLEGAL

66 00 0100 0010 ILLEGAL

67 00 0100 0011 ILLEGAL

68 00 0100 0100 ILLEGAL

69 00 0100 0101 ILLEGAL

70 00 0100 0110 ILLEGAL

71 00 0100 0111 ILLEGAL

72 00 0100 1000 ILLEGAL

73 00 0100 1001 ILLEGAL

74 00 0100 1010 ILLEGAL

75 00 0100 1011 ILLEGAL

76 00 0100 1100 ILLEGAL

77 00 0100 1101 ILLEGAL

78 00 0100 1110 ILLEGAL

79 00 0100 1111 ILLEGAL

80 00 0101 0000 ILLEGAL

81 00 0101 0001 ILLEGAL

82 00 0101 0010 ILLEGAL

83 00 0101 0011 ILLEGAL

84 00 0101 0100 ILLEGAL

88 00 0101 1000 ILLEGAL

95 00 0101 1111 ILLEGAL

96 00 0110 0000 ILLEGAL

97 00 0110 0001 ILLEGAL

98 00 0110 0010 ILLEGAL

99 00 0110 0011 ILLEGAL

100 00 0110 0100 ILLEGAL

103 00 0110 0111 ILLEGAL

104 00 0110 1000 ILLEGAL

111 00 0110 1111 ILLEGAL

112 00 0111 0000 ILLEGAL

119 00 0111 0111 ILLEGAL

120 00 0111 1000 ILLEGAL

123 00 0111 1011 ILLEGAL

124 00 0111 1100 ILLEGAL

125 00 0111 1101 ILLEGAL

126 00 0111 1110 ILLEGAL

127 00 0111 1111 ILLEGAL

128 00 1000 0000 ILLEGAL

129 00 1000 0001 ILLEGAL

130 00 1000 0010 ILLEGAL

131 00 1000 0011 ILLEGAL

132 00 1000 0100 ILLEGAL

133 00 1000 0101 ILLEGAL

134 00 1000 0110 ILLEGAL

135 00 1000 0111 ILLEGAL

136 00 1000 1000 ILLEGAL

137 00 1000 1001 ILLEGAL

138 00 1000 1010 ILLEGAL

139 00 1000 1011 ILLEGAL

140 00 1000 1100 ILLEGAL

141 00 1000 1101 ILLEGAL
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142 00 1000 1110 ILLEGAL

143 00 1000 1111 ILLEGAL

144 00 1001 0000 ILLEGAL

145 00 1001 0001 ILLEGAL

146 00 1001 0010 ILLEGAL

147 00 1001 0011 ILLEGAL

148 00 1001 0100 ILLEGAL

152 00 1001 1000 ILLEGAL

159 00 1001 1111 ILLEGAL

160 00 1010 0000 ILLEGAL

161 00 1010 0001 ILLEGAL

162 00 1010 0010 ILLEGAL

163 00 1010 0011 ILLEGAL

164 00 1010 0100 ILLEGAL

167 00 1010 0111 ILLEGAL

168 00 1010 1000 ILLEGAL

175 00 1010 1111 ILLEGAL

176 00 1011 0000 ILLEGAL

184 00 1011 1000 ILLEGAL

190 00 1011 1110 ILLEGAL

191 00 1011 1111 ILLEGAL

192 00 1100 0000 ILLEGAL

193 00 1100 0001 ILLEGAL

194 00 1100 0010 ILLEGAL

195 00 1100 0011 ILLEGAL

196 00 1100 0100 ILLEGAL

199 00 1100 0111 ILLEGAL

200 00 1100 1000 ILLEGAL

207 00 1100 1111 ILLEGAL

208 00 1101 0000 ILLEGAL

215 00 1101 0111 ILLEGAL

216 00 1101 1000 ILLEGAL

223 00 1101 1111 ILLEGAL

224 00 1110 0000 ILLEGAL

231 00 1110 0111 ILLEGAL

232 00 1110 1000 ILLEGAL

239 00 1110 1111 ILLEGAL

240 00 1111 0000 ILLEGAL

241 00 1111 0001 ILLEGAL

247 00 1111 0111 ILLEGAL

251 00 1111 1011 ILLEGAL

252 00 1111 1100 ILLEGAL

253 00 1111 1101 ILLEGAL

254 00 1111 1110 ILLEGAL

255 00 1111 1111 ILLEGAL

256 01 0000 0000 ILLEGAL

257 01 0000 0001 ILLEGAL

258 01 0000 0010 ILLEGAL

259 01 0000 0011 ILLEGAL

260 01 0000 0100 ILLEGAL

261 01 0000 0101 ILLEGAL

262 01 0000 0110 ILLEGAL

263 01 0000 0111 ILLEGAL

264 01 0000 1000 ILLEGAL

265 01 0000 1001 ILLEGAL

266 01 0000 1010 ILLEGAL

267 01 0000 1011 ILLEGAL

268 01 0000 1100 ILLEGAL

269 01 0000 1101 ILLEGAL

270 01 0000 1110 ILLEGAL

271 01 0000 1111 ILLEGAL

272 01 0001 0000 ILLEGAL

273 01 0001 0001 ILLEGAL

274 01 0001 0010 ILLEGAL

275 01 0001 0011 ILLEGAL

276 01 0001 0100 ILLEGAL

280 01 0001 1000 ILLEGAL

287 01 0001 1111 ILLEGAL

288 01 0010 0000 ILLEGAL

289 01 0010 0001 ILLEGAL

290 01 0010 0010 ILLEGAL

291 01 0010 0011 ILLEGAL

292 01 0010 0100 ILLEGAL

295 01 0010 0111 ILLEGAL

296 01 0010 1000 ILLEGAL

303 01 0010 1111 ILLEGAL

304 01 0011 0000 ILLEGAL

312 01 0011 1000 ILLEGAL

318 01 0011 1110 ILLEGAL

319 01 0011 1111 ILLEGAL

320 01 0100 0000 ILLEGAL

321 01 0100 0001 ILLEGAL

322 01 0100 0010 ILLEGAL

323 01 0100 0011 ILLEGAL

324 01 0100 0100 ILLEGAL

327 01 0100 0111 ILLEGAL

328 01 0100 1000 ILLEGAL

335 01 0100 1111 ILLEGAL

336 01 0101 0000 ILLEGAL

343 01 0101 0111 ILLEGAL

344 01 0101 1000 ILLEGAL

351 01 0101 1111 ILLEGAL

352 01 0110 0000 ILLEGAL

359 01 0110 0111 ILLEGAL

360 01 0110 1000 ILLEGAL

367 01 0110 1111 ILLEGAL

368 01 0111 0000 ILLEGAL

375 01 0111 0111 ILLEGAL

376 01 0111 1000 ILLEGAL

379 01 0111 1011 ILLEGAL

380 01 0111 1100 ILLEGAL

381 01 0111 1101 ILLEGAL

382 01 0111 1110 ILLEGAL

383 01 0111 1111 ILLEGAL

384 01 1000 0000 ILLEGAL

385 01 1000 0001 ILLEGAL

386 01 1000 0010 ILLEGAL

387 01 1000 0011 ILLEGAL

388 01 1000 0100 ILLEGAL

391 01 1000 0111 ILLEGAL

392 01 1000 1000 ILLEGAL

399 01 1000 1111 ILLEGAL

400 01 1001 0000 ILLEGAL

407 01 1001 0111 ILLEGAL

408 01 1001 1000 ILLEGAL

415 01 1001 1111 ILLEGAL

416 01 1010 0000 ILLEGAL

423 01 1010 0111 ILLEGAL

424 01 1010 1000 ILLEGAL

431 01 1010 1111 ILLEGAL

432 01 1011 0000 ILLEGAL

439 01 1011 0111 ILLEGAL

440 01 1011 1000 ILLEGAL

443 01 1011 1011 ILLEGAL

444 01 1011 1100 ILLEGAL

445 01 1011 1101 ILLEGAL

446 01 1011 1110 ILLEGAL

447 01 1011 1111 ILLEGAL

448 01 1100 0000 ILLEGAL

449 01 1100 0001 ILLEGAL
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455 01 1100 0111 ILLEGAL

463 01 1100 1111 ILLEGAL

464 01 1101 0000 ILLEGAL

471 01 1101 0111 ILLEGAL

472 01 1101 1000 ILLEGAL

475 01 1101 1011 ILLEGAL

476 01 1101 1100 ILLEGAL

477 01 1101 1101 ILLEGAL

478 01 1101 1110 ILLEGAL

479 01 1101 1111 ILLEGAL

480 01 1110 0000 ILLEGAL

487 01 1110 0111 ILLEGAL

491 01 1110 1011 ILLEGAL

492 01 1110 1100 ILLEGAL

493 01 1110 1101 ILLEGAL

494 01 1110 1110 ILLEGAL

495 01 1110 1111 ILLEGAL

496 01 1111 0000 ILLEGAL

497 01 1111 0001 ILLEGAL

498 01 1111 0010 ILLEGAL

499 01 1111 0011 ILLEGAL

500 01 1111 0100 ILLEGAL

501 01 1111 0101 ILLEGAL

502 01 1111 0110 ILLEGAL

503 01 1111 0111 ILLEGAL

504 01 1111 1000 ILLEGAL

505 01 1111 1001 ILLEGAL

506 01 1111 1010 ILLEGAL

507 01 1111 1011 ILLEGAL

508 01 1111 1100 ILLEGAL

509 01 1111 1101 ILLEGAL

510 01 1111 1110 ILLEGAL

511 01 1111 1111 ILLEGAL

512 10 0000 0000 ILLEGAL

513 10 0000 0001 ILLEGAL

514 10 0000 0010 ILLEGAL

515 10 0000 0011 ILLEGAL

516 10 0000 0100 ILLEGAL

517 10 0000 0101 ILLEGAL

518 10 0000 0110 ILLEGAL

519 10 0000 0111 ILLEGAL

520 10 0000 1000 ILLEGAL

521 10 0000 1001 ILLEGAL

522 10 0000 1010 ILLEGAL

523 10 0000 1011 ILLEGAL

524 10 0000 1100 ILLEGAL

525 10 0000 1101 ILLEGAL

526 10 0000 1110 ILLEGAL

527 10 0000 1111 ILLEGAL

528 10 0001 0000 ILLEGAL

529 10 0001 0001 ILLEGAL

530 10 0001 0010 ILLEGAL

531 10 0001 0011 ILLEGAL

532 10 0001 0100 ILLEGAL

536 10 0001 1000 ILLEGAL

543 10 0001 1111 ILLEGAL

544 10 0010 0000 ILLEGAL

545 10 0010 0001 ILLEGAL

546 10 0010 0010 ILLEGAL

547 10 0010 0011 ILLEGAL

548 10 0010 0100 ILLEGAL

551 10 0010 0111 ILLEGAL

552 10 0010 1000 ILLEGAL

559 10 0010 1111 ILLEGAL

560 10 0011 0000 ILLEGAL

568 10 0011 1000 ILLEGAL

574 10 0011 1110 ILLEGAL

575 10 0011 1111 ILLEGAL

576 10 0100 0000 ILLEGAL

577 10 0100 0001 ILLEGAL

578 10 0100 0010 ILLEGAL

579 10 0100 0011 ILLEGAL

580 10 0100 0100 ILLEGAL

583 10 0100 0111 ILLEGAL

584 10 0100 1000 ILLEGAL

591 10 0100 1111 ILLEGAL

592 10 0101 0000 ILLEGAL

599 10 0101 0111 ILLEGAL

600 10 0101 1000 ILLEGAL

607 10 0101 1111 ILLEGAL

608 10 0110 0000 ILLEGAL

615 10 0110 0111 ILLEGAL

616 10 0110 1000 ILLEGAL

623 10 0110 1111 ILLEGAL

624 10 0111 0000 ILLEGAL

631 10 0111 0111 ILLEGAL

632 10 0111 1000 ILLEGAL

635 10 0111 1011 ILLEGAL

636 10 0111 1100 ILLEGAL

637 10 0111 1101 ILLEGAL

638 10 0111 1110 ILLEGAL

639 10 0111 1111 ILLEGAL

640 10 1000 0000 ILLEGAL

641 10 1000 0001 ILLEGAL

642 10 1000 0010 ILLEGAL

643 10 1000 0011 ILLEGAL

644 10 1000 0100 ILLEGAL

647 10 1000 0111 ILLEGAL

648 10 1000 1000 ILLEGAL

655 10 1000 1111 ILLEGAL

656 10 1001 0000 ILLEGAL

663 10 1001 0111 ILLEGAL

664 10 1001 1000 ILLEGAL

671 10 1001 1111 ILLEGAL

672 10 1010 0000 ILLEGAL

679 10 1010 0111 ILLEGAL

680 10 1010 1000 ILLEGAL

687 10 1010 1111 ILLEGAL

688 10 1011 0000 ILLEGAL

695 10 1011 0111 ILLEGAL

696 10 1011 1000 ILLEGAL

699 10 1011 1011 ILLEGAL

700 10 1011 1100 ILLEGAL

701 10 1011 1101 ILLEGAL

702 10 1011 1110 ILLEGAL

703 10 1011 1111 ILLEGAL

704 10 1100 0000 ILLEGAL

705 10 1100 0001 ILLEGAL

711 10 1100 0111 ILLEGAL

719 10 1100 1111 ILLEGAL

720 10 1101 0000 ILLEGAL

727 10 1101 0111 ILLEGAL

728 10 1101 1000 ILLEGAL

731 10 1101 1011 ILLEGAL

732 10 1101 1100 ILLEGAL

733 10 1101 1101 ILLEGAL

734 10 1101 1110 ILLEGAL

735 10 1101 1111 ILLEGAL

736 10 1110 0000 ILLEGAL

743 10 1110 0111 ILLEGAL
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747 10 1110 1011 ILLEGAL

748 10 1110 1100 ILLEGAL

749 10 1110 1101 ILLEGAL

750 10 1110 1110 ILLEGAL

751 10 1110 1111 ILLEGAL

752 10 1111 0000 ILLEGAL

753 10 1111 0001 ILLEGAL

754 10 1111 0010 ILLEGAL

755 10 1111 0011 ILLEGAL

756 10 1111 0100 ILLEGAL

757 10 1111 0101 ILLEGAL

758 10 1111 0110 ILLEGAL

759 10 1111 0111 ILLEGAL

760 10 1111 1000 ILLEGAL

761 10 1111 1001 ILLEGAL

762 10 1111 1010 ILLEGAL

763 10 1111 1011 ILLEGAL

764 10 1111 1100 ILLEGAL

765 10 1111 1101 ILLEGAL

766 10 1111 1110 ILLEGAL

767 10 1111 1111 ILLEGAL

768 11 0000 0000 ILLEGAL

769 11 0000 0001 ILLEGAL

770 11 0000 0010 ILLEGAL

771 11 0000 0011 ILLEGAL

772 11 0000 0100 ILLEGAL

776 11 0000 1000 ILLEGAL

782 11 0000 1110 ILLEGAL

783 11 0000 1111 ILLEGAL

784 11 0001 0000 ILLEGAL

791 11 0001 0111 ILLEGAL

792 11 0001 1000 ILLEGAL

799 11 0001 1111 ILLEGAL

800 11 0010 0000 ILLEGAL

807 11 0010 0111 ILLEGAL

808 11 0010 1000 ILLEGAL

815 11 0010 1111 ILLEGAL

816 11 0011 0000 ILLEGAL

823 11 0011 0111 ILLEGAL

824 11 0011 1000 ILLEGAL

827 11 0011 1011 ILLEGAL

828 11 0011 1100 ILLEGAL

829 11 0011 1101 ILLEGAL

830 11 0011 1110 ILLEGAL

831 11 0011 1111 ILLEGAL

832 11 0100 0000 ILLEGAL

833 11 0100 0001 ILLEGAL

839 11 0100 0111 ILLEGAL

847 11 0100 1111 ILLEGAL

848 11 0101 0000 ILLEGAL

855 11 0101 0111 ILLEGAL

856 11 0101 1000 ILLEGAL

859 11 0101 1011 ILLEGAL

860 11 0101 1100 ILLEGAL

861 11 0101 1101 ILLEGAL

862 11 0101 1110 ILLEGAL

863 11 0101 1111 ILLEGAL

864 11 0110 0000 ILLEGAL

871 11 0110 0111 ILLEGAL

875 11 0110 1011 ILLEGAL

876 11 0110 1100 ILLEGAL

877 11 0110 1101 ILLEGAL

878 11 0110 1110 ILLEGAL

879 11 0110 1111 ILLEGAL

880 11 0111 0000 ILLEGAL

881 11 0111 0001 ILLEGAL

882 11 0111 0010 ILLEGAL

883 11 0111 0011 ILLEGAL

884 11 0111 0100 ILLEGAL

885 11 0111 0101 ILLEGAL

886 11 0111 0110 ILLEGAL

887 11 0111 0111 ILLEGAL

888 11 0111 1000 ILLEGAL

889 11 0111 1001 ILLEGAL

890 11 0111 1010 ILLEGAL

891 11 0111 1011 ILLEGAL

892 11 0111 1100 ILLEGAL

893 11 0111 1101 ILLEGAL

894 11 0111 1110 ILLEGAL

895 11 0111 1111 ILLEGAL

896 11 1000 0000 ILLEGAL

897 11 1000 0001 ILLEGAL

898 11 1000 0010 ILLEGAL

899 11 1000 0011 ILLEGAL

900 11 1000 0100 ILLEGAL

903 11 1000 0111 ILLEGAL

904 11 1000 1000 ILLEGAL

911 11 1000 1111 ILLEGAL

912 11 1001 0000 ILLEGAL

919 11 1001 0111 ILLEGAL

920 11 1001 1000 ILLEGAL

923 11 1001 1011 ILLEGAL

924 11 1001 1100 ILLEGAL

925 11 1001 1101 ILLEGAL

926 11 1001 1110 ILLEGAL

927 11 1001 1111 ILLEGAL

928 11 1010 0000 ILLEGAL

935 11 1010 0111 ILLEGAL

939 11 1010 1011 ILLEGAL

940 11 1010 1100 ILLEGAL

941 11 1010 1101 ILLEGAL

942 11 1010 1110 ILLEGAL

943 11 1010 1111 ILLEGAL

944 11 1011 0000 ILLEGAL

945 11 1011 0001 ILLEGAL

946 11 1011 0010 ILLEGAL

947 11 1011 0011 ILLEGAL

948 11 1011 0100 ILLEGAL

949 11 1011 0101 ILLEGAL

950 11 1011 0110 ILLEGAL

951 11 1011 0111 ILLEGAL

952 11 1011 1000 ILLEGAL

953 11 1011 1001 ILLEGAL

954 11 1011 1010 ILLEGAL

955 11 1011 1011 ILLEGAL

956 11 1011 1100 ILLEGAL

957 11 1011 1101 ILLEGAL

958 11 1011 1110 ILLEGAL

959 11 1011 1111 ILLEGAL

960 11 1100 0000 ILLEGAL

961 11 1100 0001 ILLEGAL

962 11 1100 0010 ILLEGAL

963 11 1100 0011 ILLEGAL

964 11 1100 0100 ILLEGAL

965 11 1100 0101 ILLEGAL

966 11 1100 0110 ILLEGAL

967 11 1100 0111 ILLEGAL

968 11 1100 1000 ILLEGAL

969 11 1100 1001 ILLEGAL

970 11 1100 1010 ILLEGAL
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971 11 1100 1011 ILLEGAL

972 11 1100 1100 ILLEGAL

973 11 1100 1101 ILLEGAL

974 11 1100 1110 ILLEGAL

975 11 1100 1111 ILLEGAL

976 11 1101 0000 ILLEGAL

977 11 1101 0001 ILLEGAL

978 11 1101 0010 ILLEGAL

979 11 1101 0011 ILLEGAL

980 11 1101 0100 ILLEGAL

981 11 1101 0101 ILLEGAL

982 11 1101 0110 ILLEGAL

983 11 1101 0111 ILLEGAL

984 11 1101 1000 ILLEGAL

985 11 1101 1001 ILLEGAL

986 11 1101 1010 ILLEGAL

987 11 1101 1011 ILLEGAL

988 11 1101 1100 ILLEGAL

989 11 1101 1101 ILLEGAL

990 11 1101 1110 ILLEGAL

991 11 1101 1111 ILLEGAL

992 11 1110 0000 ILLEGAL

993 11 1110 0001 ILLEGAL

994 11 1110 0010 ILLEGAL

995 11 1110 0011 ILLEGAL

996 11 1110 0100 ILLEGAL

997 11 1110 0101 ILLEGAL

998 11 1110 0110 ILLEGAL

999 11 1110 0111 ILLEGAL

1000 11 1110 1000 ILLEGAL

1001 11 1110 1001 ILLEGAL

1002 11 1110 1010 ILLEGAL

1003 11 1110 1011 ILLEGAL

1004 11 1110 1100 ILLEGAL

1005 11 1110 1101 ILLEGAL

1006 11 1110 1110 ILLEGAL

1007 11 1110 1111 ILLEGAL

1008 11 1111 0000 ILLEGAL

1009 11 1111 0001 ILLEGAL

1010 11 1111 0010 ILLEGAL

1011 11 1111 0011 ILLEGAL

1012 11 1111 0100 ILLEGAL

1013 11 1111 0101 ILLEGAL

1014 11 1111 0110 ILLEGAL

1015 11 1111 0111 ILLEGAL

1016 11 1111 1000 ILLEGAL

1017 11 1111 1001 ILLEGAL

1018 11 1111 1010 ILLEGAL

1019 11 1111 1011 ILLEGAL

1020 11 1111 1100 ILLEGAL

1021 11 1111 1101 ILLEGAL

1022 11 1111 1110 ILLEGAL

1023 11 1111 1111 ILLEGAL
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The following table lists:

Legal 10-Bit Values Sorted by 
8-Bit Hex Code

10B 
Dec

8B 
Dec ASCII+ HEX

Previous 
Disparity

Data 
Byte FC 
Name

10 B COMMENT

3950 NUL 00 RD + D0.0 01 1000 1011
628 0 NUL 00 RD-- D0.0 10 0111 0100
468 1 SOH 01 RD-- D1.0 01 1101 0100
555 1 SOH 01 RD + D1.0 10 0010 1011
299 2 STX 02 RD + D2.0 01 0010 1011
724 2 STX 02 RD-- D2.0 10 1101 0100
788 3 ETX 03 RD + D3.0 11 0001 0100
795 3 ETX 03 RD-- D3.0 11 0001 1011
171 4 EOT 04 RD + D4.0 00 1010 1011
852 4 EOT 04 RD-- D4.0 11 0101 0100
660 5 ENQ 05 RD + D5.0 10 1001 

0100
667 5 ENQ 05 RD-- D5.0 10 1001 1011
404 6 ACK 06 RD + D6.0 01 1001 

0100
411 6 ACK 06 RD-- D6.0 01 1001 1011
116 7 BEL 07 RD + D7.0 00 0111 0100
907 7 BEL 07 RD-- D7.0 11 1000 1011
107 8 BS 08 RD + D8.0 00 0110 1011
916 8 BS 08 RD-- D8.0 11 1001 0100
596 9 HT 09 RD + D9.0 10 0101 

0100
603 9 HT 09 RD-- D9.0 10 0101 1011
436 16 DLE 10 RD-- D16.0 01 1011 0100
587 16 DLE 10 RD + D16.0 10 0100 1011
564 17 DC1 11 RD + D17.0 10 0011 0100
571 17 DC1 11 RD-- D17.0 10 0011 1011
308 18 DC2 12 RD + D18.0 01 0011 0100
315 18 DC2 12 RD-- D18.0 01 0011 1011
804 19 DC3 13 RD + D19.0 11 0010 0100
811 19 DC3 13 RD-- D19.0 11 0010 1011
180 20 DC4 14 RD + D20.0 00 1011 0100
187 20 DC4 14 RD-- D20.0 00 1011 1011
676 21 NAK 15 RD + D21.0 10 1010 

0100
683 21 NAK 15 RD-- D21.0 10 1010 1011
420 22 SYN 16 RD + D22.0 01 1010 

0100
427 22 SYN 16 RD-- D22.0 01 1010 1011
91 23 ETB 17 RD + D23.0 00 0101 1011
932 23 ETB 17 RD-- D23.0 11 1010 0100
203 24 CAN 18 RD + D24.0 00 1100 1011
820 24 CAN 18 RD-- D24.0 11 0011 0100
612 25 EM 19 RD + D25.0 10 0110 0100
619 25 EM 19 RD-- D25.0 10 0110 1011
393 32 SPACE 20 RD + D0.1 01 1000 

1001
633 32 SPACE 20 RD-- D0.1 10 0111 1001
473 33 ! 21 RD-- D1.1 01 1101 1001
553 33 ! 21 RD + D1.1 10 0010 

1001
297 34 " 22 RD + D2.1 01 0010 

1001
729 34 " 22 RD-- D2.1 10 1101 1001
793 35 # 23 RD+/-- D3.1 11 0001 1001
169 36 $ 24 RD + D4.1 00 1010 

1001
857 36 $ 24 RD-- D4.1 11 0101 1001
665 37 % 25 RD+/-- D5.1 10 1001 

1001

409 38 & 26 RD+/-- D6.1 01 1001 
1001

121 39 ' 27 RD + D7.1 00 0111 1001
905 39 ' 27 RD-- D7.1 11 1000 1001
105 40 ( 28 RD + D8.1 00 0110 1001
921 40 ( 28 RD-- D8.1 11 1001 1001
601 41 ) 29 RD+/-- D9.1 10 0101 

1001
441 48 0 30 RD-- D16.1 01 1011 1001
585 48 0 30 RD + D16.1 10 0100 

1001
569 49 1 31 RD+/-- D17.1 10 0011 1001
313 50 2 32 RD+/-- D18.1 01 0011 1001
809 51 3 33 RD+/-- D19.1 11 0010 1001
185 52 4 34 RD+/-- D20.1 00 1011 1001
681 53 5 35 RD+/-- D21.1 10 1010 

1001
425 54 6 36 RD+/-- D22.1 01 1010 

1001
89 55 7 37 RD + D23.1 00 0101 

1001
937 55 7 37 RD-- D23.1 11 1010 1001
201 56 8 38 RD + D24.1 00 1100 1001
825 56 8 38 RD-- D24.1 11 0011 1001
617 57 9 39 RD+/-- D25.1 10 0110 1001
389 64 @ 40 RD + D0.2 01 1000 

0101
629 64 @ 40 RD-- D0.2 10 0111 0101
469 65 A 41 RD-- D1.2 01 1101 0101
549 65 A 41 RD + D1.2 10 0010 

0101
293 66 B 42 RD + D2.2 01 0010 

0101
725 66 B 42 RD-- D2.2 10 1101 0101
789 67 C 43 RD+/-- D3.2 11 0001 0101
165 68 D 44 RD + D4.2 00 1010 

0101
853 68 D 44 RD-- D4.2 11 0101 0101
661 69 E 45 RD+/-- D5.2 10 1001 

0101
405 70 F 46 RD+/-- D6.2 01 1001 

0101
117 71 G 47 RD + D7.2 00 0111 0101
901 71 G 47 RD-- D7.2 11 1000 0101
101 72 H 48 RD + D8.2 00 0110 0101
917 72 H 48 RD-- D8.2 11 1001 0101
597 73 I 49 RD+/-- D9.2 10 0101 

0101
437 80 P 50 RD-- D16.2 01 1011 0101
581 80 P 50 RD + D16.2 10 0100 

0101
565 81 Q 51 RD+/-- D17.2 10 0011 0101
309 82 R 52 RD+/-- D18.2 01 0011 0101
805 83 S 53 RD+/-- D19.2 11 0010 0101
181 84 T 54 RD+/-- D20.2 00 1011 0101
677 85 U 55 RD+/-- D21.2 10 1010 

0101
421 86 V 56 RD+/-- D22.2 01 1010 

0101
85 87 W 57 RD + D23.2 00 0101 

0101
933 87 W 57 RD-- D23.2 11 1010 0101
197 88 X 58 RD + D24.2 00 1100 0101
821 88 X 58 RD-- D24.2 11 0011 0101
613 89 Y 59 RD+/-- D25.2 10 0110 0101
396 96 ` 60 RD + D0.3 01 1000 1100
627 96 ` 60 RD-- D0.3 10 0111 0011
467 97 a 61 RD-- D1.3 01 1101 0011
556 97 a 61 RD + D1.3 10 0010 1100
300 98 b 62 RD + D2.3 01 0010 1100
723 98 b 62 RD-- D2.3 10 1101 0011
787 99 c 63 RD + D3.3 11 0001 0011
796 99 c 63 RD-- D3.3 11 0001 1100
172 100 d 64 RD + D4.3 00 1010 1100
851 100 d 64 RD-- D4.3 11 0101 0011
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659 101 e 65 RD + D5.3 10 1001 0011
668 101 e 65 RD-- D5.3 10 1001 1100
403 102 f 66 RD + D6.3 01 1001 0011
412 102 f 66 RD-- D6.3 01 1001 1100
115 103 g 67 RD + D7.3 00 0111 0011
908 103 g 67 RD-- D7.3 11 1000 1100
108 104 h 68 RD + D8.3 00 0110 1100
915 104 h 68 RD-- D8.3 11 1001 0011
595 105 i 69 RD + D9.3 10 0101 0011
604 105 i 69 RD-- D9.3 10 0101 1100
435 112 p 70 RD-- D16.3 01 1011 0011
588 112 p 70 RD + D16.3 10 0100 1100
563 113 q 71 RD + D17.3 10 0011 0011
572 113 q 71 RD-- D17.3 10 0011 1100
307 114 r 72 RD + D18.3 01 0011 0011
316 114 r 72 RD-- D18.3 01 0011 1100
803 115 s 73 RD + D19.3 11 0010 0011
812 115 s 73 RD-- D19.3 11 0010 1100
179 116 t 74 RD + D20.3 00 1011 0011
188 116 t 74 RD-- D20.3 00 1011 1100
675 117 u 75 RD + D21.3 10 1010 0011
684 117 u 75 RD-- D21.3 10 1010 1100
419 118 v 76 RD + D22.3 01 1010 0011
428 118 v 76 RD-- D22.3 01 1010 1100
92 119 w 77 RD + D23.3 00 0101 1100
931 119 w 77 RD-- D23.3 11 1010 0011
204 120 x 78 RD + D24.3 00 1100 1100
819 120 x 78 RD-- D24.3 11 0011 0011
611 121 y 79 RD + D25.3 10 0110 0011
620 121 y 79 RD-- D25.3 10 0110 1100
397 128 _ 80 RD + D0.4 01 1000 1101
626 128 _ 80 RD-- D0.4 10 0111 0010
466 129 _ 81 RD-- D1.4 01 1101 0010
557 129 _ 81 RD + D1.4 10 0010 1101
301 130 ‚ 82 RD + D2.4 01 0010 1101
722 130 ‚ 82 RD-- D2.4 10 1101 0010
786 131 ƒ 83 RD + D3.4 11 0001 0010
797 131 ƒ 83 RD-- D3.4 11 0001 1101
173 132 „ 84 RD + D4.4 00 1010 1101
850 132 „ 84 RD-- D4.4 11 0101 0010
658 133 … 85 RD + D5.4 10 1001 

0010
669 133 … 85 RD-- D5.4 10 1001 1101
402 134 † 86 RD + D6.4 01 1001 

0010
413 134 † 86 RD-- D6.4 01 1001 1101
114 135 ‡ 87 RD + D7.4 00 0111 0010
909 135 ‡ 87 RD-- D7.4 11 1000 1101
109 136 ˆ 88 RD + D8.4 00 0110 1101
914 136 ˆ 88 RD-- D8.4 11 1001 0010
594 137 ‰ 89 RD + D9.4 10 0101 

0010
605 137 ‰ 89 RD-- D9.4 10 0101 1101
434 144 _ 90 RD-- D16.4 01 1011 0010
589 144 _ 90 RD + D16.4 10 0100 1101
562 145 ‘ 91 RD + D17.4 10 0011 0010
573 145 ‘ 91 RD-- D17.4 10 0011 1101
306 146 ’ 92 RD + D18.4 01 0011 0010
317 146 ’ 92 RD-- D18.4 01 0011 1101
802 147 “ 93 RD + D19.4 11 0010 0010
813 147 “ 93 RD-- D19.4 11 0010 1101
178 148 ” 94 RD + D20.4 00 1011 0010
189 148 ” 94 RD-- D20.4 00 1011 1101
674 149 • 95 RD + D21.4 10 1010 

0010
685 149 • 95 RD-- D21.4 10 1010 1101
418 150 – 96 RD + D22.4 01 1010 

0010
429 150 – 96 RD-- D22.4 01 1010 1101
93 151 — 97 RD + D23.4 00 0101 1101
930 151 — 97 RD-- D23.4 11 1010 0010
205 152 ˜ 98 RD + D24.4 00 1100 1101
818 152 ˜ 98 RD-- D24.4 11 0011 0010

610 153 ™ 99 RD + D25.4 10 0110 0010
621 153 ™ 99 RD-- D25.4 10 0110 1101
340 10 LF 0A RD + D10.0 01 0101 

0100
347 10 LF 0A RD-- D10.0 01 0101 1011
836 11 VT 0B RD + D11.0 11 0100 0100
843 11 VT 0B RD-- D11.0 11 0100 1011
212 12 FF 0C RD + D12.0 00 1101 0100
219 12 FF 0C RD-- D12.0 00 1101 1011
708 13 CR 0D RD + D13.0 10 1100 0100
715 13 CR 0D RD-- D13.0 10 1100 1011
452 14 SO 0E RD + D14.0 01 1100 0100
459 14 SO 0E RD-- D14.0 01 1100 1011
372 15 SI 0F RD-- D15.0 01 0111 0100
651 15 SI 0F RD + D15.0 10 1000 1011
356 26 SUB 1A RD + D26.0 01 0110 0100
363 26 SUB 1A RD-- D26.0 01 0110 1011
155 27 ESC 1B RD + D27.0 00 1001 1011
868 27 ESC 1B RD-- D27.0 11 0110 0100
228 28 FS 1C RD + D28.0 00 1110 0100
235 28 FS 1C RD-- D28.0 00 1110 1011
244 28 FS 1C RD -- K28.0 00 1111 0100Reserved*
779 28 FS 1C RD + K28.0 11 0000 1011
283 29 GS 1D RD + D29.0 01 0001 1011
740 29 GS 1D RD-- D29.0 10 1110 0100
484 30 RS 1E RD-- D30.0 01 1110 0100
539 30 RS 1E RD + D30.0 10 0001 1011
331 31 US 1F RD + D31.0 01 0100 1011
692 31 US 1F RD-- D31.0 10 1011 0100
345 42 * 2A RD+/-- D10.1 01 0101 

1001
841 43 + 2B RD+/-- D11.1 11 0100 1001
217 44 , 2C RD+/-- D12.1 00 1101 1001
713 45 - 2D RD+/-- D13.1 10 1100 1001
457 46 . 2E RD+/-- D14.1 01 1100 1001
377 47 / 2F RD-- D15.1 01 0111 1001
649 47 / 2F RD + D15.1 10 1000 

1001
361 58 : 3A RD+/-- D26.1 01 0110 1001
153 59 ; 3B RD + D27.1 00 1001 

1001
873 59 ; 3B RD-- D27.1 11 0110 1001
233 60 < 3C RD+/-- D28.1 00 1110 1001
249 60 < 3C RD -- K28.1 00 1111 1001Reserved*
774 60 < 3C RD + K28.1 11 0000 0110
281 61 = 3D RD + D29.1 01 0001 

1001
745 61 = 3D RD-- D29.1 10 1110 1001
489 62 > 3E RD-- D30.1 01 1110 1001
537 62 > 3E RD + D30.1 10 0001 

1001
329 63 ? 3F RD + D31.1 01 0100 

1001
697 63 ? 3F RD-- D31.1 10 1011 1001
341 74 J 4A RD+/-- D10.2 01 0101 

0101
837 75 K 4B RD+/-- D11.2 11 0100 0101
213 76 L 4C RD+/-- D12.2 00 1101 0101
709 77 M 4D RD+/-- D13.2 10 1100 0101
453 78 N 4E RD+/-- D14.2 01 1100 0101
373 79 O 4F RD-- D15.2 01 0111 0101
645 79 O 4F RD + D15.2 10 1000 

0101
357 90 Z 5A RD+/-- D26.2 01 0110 0101
149 91 [ 5B RD + D27.2 00 1001 

0101
869 91 [ 5B RD-- D27.2 11 0110 0101
229 92 \ 5C RD+/-- D28.2 00 1110 0101
245 92 \ 5C RD -- K28.2 00 1111 0101Reserved*
778 92 \ 5C RD + K28.2 11 0000 1010
277 93 ] 5D RD + D29.2 01 0001 

0101
741 93 ] 5D RD-- D29.2 10 1110 0101
485 94 ^ 5E RD-- D30.2 01 1110 0101
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533 94 ^ 5E RD + D30.2 10 0001 
0101

325 95 _ 5F RD + D31.2 01 0100 
0101

693 95 _ 5F RD-- D31.2 10 1011 0101
339 106 j 6A RD + D10.3 01 0101 0011
348 106 j 6A RD-- D10.3 01 0101 1100
835 107 k 6B RD + D11.3 11 0100 0011
844 107 k 6B RD-- D11.3 11 0100 1100
211 108 l 6C RD + D12.3 00 1101 0011
220 108 l 6C RD-- D12.3 00 1101 1100
707 109 m 6D RD + D13.3 10 1100 0011
716 109 m 6D RD-- D13.3 10 1100 1100
451 110 n 6E RD + D14.3 01 1100 0011
460 110 n 6E RD-- D14.3 01 1100 1100
371 111 o 6F RD-- D15.3 01 0111 0011
652 111 o 6F RD + D15.3 10 1000 1100
355 122 z 7A RD + D26.3 01 0110 0011
364 122 z 7A RD-- D26.3 01 0110 1100
156 123 { 7B RD + D27.3 00 1001 1100
867 123 { 7B RD-- D27.3 11 0110 0011
227 124 | 7C RD + D28.3 00 1110 0011
236 124 | 7C RD-- D28.3 00 1110 1100
243 124 | 7C RD -- K28.3 00 1111 0011Reserved*
780 124 | 7C RD + K28.3 11 0000 1100
284 125 } 7D RD + D29.3 01 0001 1100
739 125 } 7D RD-- D29.3 10 1110 0011
483 126 ~ 7E RD-- D30.3 01 1110 0011
540 126 ~ 7E RD + D30.3 10 0001 1100
332 127 DELETE 7F RD + D31.3 01 0100 1100
691 127 DELETE 7F RD-- D31.3 10 1011 0011
338 138 Š 8A RD + D10.4 01 0101 

0010
349 138 Š 8A RD-- D10.4 01 0101 1101
834 139 ‹ 8B RD + D11.4 11 0100 0010
845 139 ‹ 8B RD-- D11.4 11 0100 1101
210 140 Œ 8C RD + D12.4 00 1101 0010
221 140 Œ 8C RD-- D12.4 00 1101 1101
706 141 _ 8D RD + D13.4 10 1100 0010
717 141 _ 8D RD-- D13.4 10 1100 1101
450 142 _ 8E RD + D14.4 01 1100 0010
461 142 _ 8E RD-- D14.4 01 1100 1101
370 143 _ 8F RD-- D15.4 01 0111 0010
653 143 _ 8F RD + D15.4 10 1000 1101
354 154 š 9A RD + D26.4 01 0110 0010
365 154 š 9A RD-- D26.4 01 0110 1101
157 155 › 9B RD + D27.4 00 1001 1101
866 155 › 9B RD-- D27.4 11 0110 0010
226 156 œ 9C RD + D28.4 00 1110 0010
237 156 œ 9C RD-- D28.4 00 1110 1101
242 156 œ 9C RD -- K28.4 00 1111 0010Reserved*
781 156 œ 9C RD + K28.4 11 0000 1101
285 157 _ 9D RD + D29.4 01 0001 1101
738 157 _ 9D RD-- D29.4 10 1110 0010
482 158 _ 9E RD-- D30.4 01 1110 0010
541 158 _ 9E RD + D30.4 10 0001 1101
333 159 Ÿ 9F RD + D31.4 01 0100 1101
690 159 Ÿ 9F RD-- D31.4 10 1011 0010
394 160 A0 RD + D0.5 01 1000 

1010
634 160 A0 RD-- D0.5 10 0111 1010
474 161 ¡ A1 RD-- D1.5 01 1101 1010
554 161 ¡ A1 RD + D1.5 10 0010 

1010
298 162 ¢ A2 RD + D2.5 01 0010 

1010
730 162 ¢ A2 RD-- D2.5 10 1101 1010
794 163 £ A3 RD+/-- D3.5 11 0001 1010
170 164 ¤ A4 RD + D4.5 00 1010 

1010
858 164 ¤ A4 RD-- D4.5 11 0101 1010
666 165 ¥ A5 RD+/-- D5.5 10 1001 

1010

410 166 ¦ A6 RD+/-- D6.5 01 1001 
1010

122 167 § A7 RD + D7.5 00 0111 1010
906 167 § A7 RD-- D7.5 11 1000 1010
106 168 ¨ A8 RD + D8.5 00 0110 1010
922 168 ¨ A8 RD-- D8.5 11 1001 1010
602 169 © A9 RD+/-- D9.5 10 0101 

1010
346 170 ª AA RD+/-- D10.5 01 0101 

1010
842 171 « AB RD+/-- D11.5 11 0100 1010
218 172 ¬ AC RD+/-- D12.5 00 1101 1010
714 173 - AD RD+/-- D13.5 10 1100 1010
458 174 ® AE RD+/-- D14.5 01 1100 1010
378 175 ¯ AF RD-- D15.5 01 0111 1010
650 175 ¯ AF RD + D15.5 10 1000 

1010
442 176 ° B0 RD-- D16.5 01 1011 1010
586 176 ° B0 RD + D16.5 10 0100 

1010
570 177 ± B1 RD+/-- D17.5 10 0011 1010
314 178 ² B2 RD+/-- D18.5 01 0011 1010
810 179 ³ B3 RD+/-- D19.5 11 0010 1010
186 180 ´ B4 RD+/-- D20.5 00 1011 1010
682 181 µ B5 RD+/-- D21.5 10 1010 

1010
426 182 ¶ B6 RD+/-- D22.5 01 1010 

1010
90 183 · B7 RD + D23.5 00 0101 

1010
938 183 · B7 RD-- D23.5 11 1010 1010
202 184 ¸ B8 RD + D24.5 00 1100 1010
826 184 ¸ B8 RD-- D24.5 11 0011 1010
618 185 ¹ B9 RD+/-- D25.5 10 0110 1010
362 186 º BA RD+/-- D26.5 01 0110 1010
154 187 » BB RD + D27.5 00 1001 

1010
874 187 » BB RD-- D27.5 11 0110 1010
234 188 ¼ BC RD+/-- D28.5 00 1110 1010
250 188 ¼ BC RD -- K28.5 00 1111 1010Sync
773 188 ¼ BC RD + K28.5 11 0000 0101(Not Used)
282 189 ½ BD RD + D29.5 01 0001 

1010
746 189 ½ BD RD-- D29.5 10 1110 1010
490 190 ¾ BE RD-- D30.5 01 1110 1010
538 190 ¾ BE RD + D30.5 10 0001 

1010
330 191 ¿ BF RD + D31.5 01 0100 

1010
698 191 ¿ BF RD-- D31.5 10 1011 1010
390 192 À C0 RD + D0.6 01 1000 0110
630 192 À C0 RD-- D0.6 10 0111 0110
470 193 Á C1 RD-- D1.6 01 1101 0110
550 193 Á C1 RD + D1.6 10 0010 0110
294 194 Â C2 RD + D2.6 01 0010 0110
726 194 Â C2 RD-- D2.6 10 1101 0110
790 195 Ã C3 RD+/-- D3.6 11 0001 0110
166 196 Ä C4 RD + D4.6 00 1010 0110
854 196 Ä C4 RD-- D4.6 11 0101 0110
662 197 Å C5 RD+/-- D5.6 10 1001 0110
406 198 Æ C6 RD+/-- D6.6 01 1001 0110
118 199 Ç C7 RD + D7.6 00 0111 0110
902 199 Ç C7 RD-- D7.6 11 1000 0110
102 200 È C8 RD + D8.6 00 0110 0110
918 200 È C8 RD-- D8.6 11 1001 0110
598 201 É C9 RD+/-- D9.6 10 0101 0110
342 202 Ê CA RD+/-- D10.6 01 0101 0110
838 203 Ë CB RD+/-- D11.6 11 0100 0110
214 204 Ì CC RD+/-- D12.6 00 1101 0110
710 205 Í CD RD+/-- D13.6 10 1100 0110
454 206 Î CE RD+/-- D14.6 01 1100 0110
374 207 Ï CF RD-- D15.6 01 0111 0110
646 207 Ï CF RD + D15.6 10 1000 0110
438 208 Ð D0 RD-- D16.6 01 1011 0110
582 208 Ð D0 RD + D16.6 10 0100 0110
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566 209 Ñ D1 RD+/-- D17.6 10 0011 0110
310 210 Ò D2 RD+/-- D18.6 01 0011 0110
806 211 Ó D3 RD+/-- D19.6 11 0010 0110
182 212 Ô D4 RD+/-- D20.6 00 1011 0110
678 213 Õ D5 RD+/-- D21.6 10 1010 0110
422 214 Ö D6 RD+/-- D22.6 01 1010 0110
86 215 × D7 RD + D23.6 00 0101 0110
934 215 × D7 RD-- D23.6 11 1010 0110
198 216 Ø D8 RD + D24.6 00 1100 0110
822 216 Ø D8 RD-- D24.6 11 0011 0110
614 217 Ù D9 RD+/-- D25.6 10 0110 0110
358 218 Ú DA RD+/-- D26.6 01 0110 0110
150 219 Û DB RD + D27.6 00 1001 0110
870 219 Û DB RD-- D27.6 11 0110 0110
230 220 Ü DC RD+/-- D28.6 00 1110 0110
246 220 Ü DC RD -- K28.6 00 1111 0110Reserved*
777 220 Ü DC RD + K28.6 11 0000 1001
278 221 Ý DD RD + D29.6 01 0001 0110
742 221 Ý DD RD-- D29.6 10 1110 0110
486 222 Þ DE RD-- D30.6 01 1110 0110
534 222 Þ DE RD + D30.6 10 0001 0110
326 223 ß DF RD + D31.6 01 0100 0110
694 223 ß DF RD-- D31.6 10 1011 0110
398 224 à E0 RD + D0.7 01 1000 1110
625 224 à E0 RD-- D0.7 10 0111 0001
465 225 á E1 RD-- D1.7 01 1101 0001
558 225 á E1 RD + D1.7 10 0010 1110
302 226 â E2 RD + D2.7 01 0010 1110
721 226 â E2 RD-- D2.7 10 1101 0001
785 227 ã E3 RD + D3.7 11 0001 0001
798 227 ã E3 RD-- D3.7 11 0001 1110
174 228 ä E4 RD + D4.7 00 1010 1110
849 228 ä E4 RD-- D4.7 11 0101 0001
657 229 å E5 RD + D5.7 10 1001 

0001
670 229 å E5 RD-- D5.7 10 1001 1110
401 230 æ E6 RD + D6.7 01 1001 

0001
414 230 æ E6 RD-- D6.7 01 1001 1110
113 231 ç E7 RD + D7.7 00 0111 0001
910 231 ç E7 RD-- D7.7 11 1000 1110
110 232 è E8 RD + D8.7 00 0110 1110
913 232 è E8 RD-- D8.7 11 1001 0001
593 233 é E9 RD + D9.7 10 0101 

0001
606 233 é E9 RD-- D9.7 10 0101 1110
337 234 ê EA RD + D10.7 01 0101 

0001
350 234 ê EA RD-- D10.7 01 0101 1110
840 235 ë EB RD + D11.7 11 0100 1000
846 235 ë EB RD-- D11.7 11 0100 1110
209 236 ì EC RD + D12.7 00 1101 0001
222 236 ì EC RD-- D12.7 00 1101 1110
712 237 í ED RD + D13.7 10 1100 1000
718 237 í ED RD-- D13.7 10 1100 1110
456 238 î EE RD + D14.7 01 1100 1000
462 238 î EE RD-- D14.7 01 1100 1110
369 239 ï EF RD-- D15.7 01 0111 0001
654 239 ï EF RD + D15.7 10 1000 1110
433 240 ð F0 RD-- D16.7 01 1011 0001
590 240 ð F0 RD + D16.7 10 0100 1110
561 241 ñ F1 RD + D17.7 10 0011 0001
567 241 ñ F1 RD-- D17.7 10 0011 0111
305 242 ò F2 RD + D18.7 01 0011 0001
311 242 ò F2 RD-- D18.7 01 0011 0111
801 243 ó F3 RD + D19.7 11 0010 0001
814 243 ó F3 RD-- D19.7 11 0010 1110
177 244 ô F4 RD + D20.7 00 1011 0001
183 244 ô F4 RD-- D20.7 00 1011 0111
673 245 õ F5 RD + D21.7 10 1010 

0001
686 245 õ F5 RD-- D21.7 10 1010 1110
417 246 ö F6 RD + D22.7 01 1010 

0001

430 246 ö F6 RD-- D22.7 01 1010 1110
87 247 ÷ F7 RD + K23.7 00 0101 0111
94 247 ÷ F7 RD + D23.7 00 0101 1110
929 247 ÷ F7 RD-- D23.7 11 1010 0001
936 247 ÷ F7 RD -- K23.7 11 1010 1000Reserved*
206 248 ø F8 RD + D24.7 00 1100 1110
817 248 ø F8 RD-- D24.7 11 0011 0001
609 249 ù F9 RD + D25.7 10 0110 0001
622 249 ù F9 RD-- D25.7 10 0110 1110
353 250 ú FA RD + D26.7 01 0110 0001
366 250 ú FA RD-- D26.7 01 0110 1110
151 251 û FB RD + K27.7 00 1001 0111
158 251 û FB RD + D27.7 00 1001 1110
865 251 û FB RD-- D27.7 11 0110 0001
872 251 û FB RD -- K27.7 11 0110 1000Reserved*
225 252 ü FC RD + D28.7 00 1110 0001
238 252 ü FC RD-- D28.7 00 1110 1110
248 252 ü FC RD -- K28.7 00 1111 1000Test
775 252 ü FC RD + K28.7 11 0000 0111
279 253 ý FD RD + K29.7 01 0001 0111
286 253 ý FD RD + D29.7 01 0001 1110
737 253 ý FD RD-- D29.7 10 1110 0001
744 253 ý FD RD -- K29.7 10 1110 1000Reserved*
481 254 þ FE RD-- D30.7 01 1110 0001
488 254 þ FE RD -- K30.7 01 1110 1000Reserved*
535 254 þ FE RD + K30.7 10 0001 0111
542 254 þ FE RD + D30.7 10 0001 1110
334 255 ÿ FF RD + D31.7 01 0100 1110
689 255 ÿ FF RD-- D31.7 10 1011 0001
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The following table lists:

Legal 10-bit Values Sorted by 
K/D Code

10B 
Dec

8B 
Dec ASCII+ HEX

Previous 
Disparity

Data 
Byte 
FC 
Name

10 B COMMENT

395 0 NUL 00 RD + D0.0 01 1000 1011

628 0 NUL 00 RD-- D0.0 10 0111 0100

393 32 SPACE 20 RD + D0.1 01 1000 1001

633 32 SPACE 20 RD-- D0.1 10 0111 1001

389 64 @ 40 RD + D0.2 01 1000 0101

629 64 @ 40 RD-- D0.2 10 0111 0101

396 96 ` 60 RD + D0.3 01 1000 1100

627 96 ` 60 RD-- D0.3 10 0111 0011

397 128 _ 80 RD + D0.4 01 1000 1101

626 128 _ 80 RD-- D0.4 10 0111 0010

394 160 A0 RD + D0.5 01 1000 1010

634 160 A0 RD-- D0.5 10 0111 1010

390 192 À C0 RD + D0.6 01 1000 0110

630 192 À C0 RD-- D0.6 10 0111 0110

398 224 à E0 RD + D0.7 01 1000 1110

625 224 à E0 RD-- D0.7 10 0111 0001

468 1 SOH 01 RD-- D1.0 01 1101 0100

555 1 SOH 01 RD + D1.0 10 0010 1011

473 33 ! 21 RD-- D1.1 01 1101 1001

553 33 ! 21 RD + D1.1 10 0010 1001

469 65 A 41 RD-- D1.2 01 1101 0101

549 65 A 41 RD + D1.2 10 0010 0101

467 97 a 61 RD-- D1.3 01 1101 0011

556 97 a 61 RD + D1.3 10 0010 1100

466 129 _ 81 RD-- D1.4 01 1101 0010

557 129 _ 81 RD + D1.4 10 0010 1101

474 161 ¡ A1 RD-- D1.5 01 1101 1010

554 161 ¡ A1 RD + D1.5 10 0010 1010

470 193 Á C1 RD-- D1.6 01 1101 0110

550 193 Á C1 RD + D1.6 10 0010 0110

465 225 á E1 RD-- D1.7 01 1101 0001

558 225 á E1 RD + D1.7 10 0010 1110

340 10 LF 0A RD + D10.0 01 0101 0100

347 10 LF 0A RD-- D10.0 01 0101 1011

345 42 * 2A RD+/-- D10.1 01 0101 1001

341 74 J 4A RD+/-- D10.2 01 0101 0101

339 106 j 6A RD + D10.3 01 0101 0011

348 106 j 6A RD-- D10.3 01 0101 1100

338 138 Š 8A RD + D10.4 01 0101 0010

349 138 Š 8A RD-- D10.4 01 0101 1101

346 170 ª AA RD+/-- D10.5 01 0101 1010

342 202 Ê CA RD+/-- D10.6 01 0101 0110

337 234 ê EA RD + D10.7 01 0101 0001

350 234 ê EA RD-- D10.7 01 0101 1110

836 11 VT 0B RD + D11.0 11 0100 0100

843 11 VT 0B RD-- D11.0 11 0100 1011

841 43 + 2B RD+/-- D11.1 11 0100 1001

837 75 K 4B RD+/-- D11.2 11 0100 0101

835 107 k 6B RD + D11.3 11 0100 0011

844 107 k 6B RD-- D11.3 11 0100 1100

834 139 ‹ 8B RD + D11.4 11 0100 0010

845 139 ‹ 8B RD-- D11.4 11 0100 1101

842 171 « AB RD+/-- D11.5 11 0100 1010

838 203 Ë CB RD+/-- D11.6 11 0100 0110

840 235 ë EB RD + D11.7 11 0100 1000

846 235 ë EB RD-- D11.7 11 0100 1110

212 12 FF 0C RD + D12.0 00 1101 0100

219 12 FF 0C RD-- D12.0 00 1101 1011

217 44 , 2C RD+/-- D12.1 00 1101 1001

213 76 L 4C RD+/-- D12.2 00 1101 0101

211 108 l 6C RD + D12.3 00 1101 0011

220 108 l 6C RD-- D12.3 00 1101 1100

210 140 Œ 8C RD + D12.4 00 1101 0010

221 140 Œ 8C RD-- D12.4 00 1101 1101

218 172 ¬ AC RD+/-- D12.5 00 1101 1010

214 204 Ì CC RD+/-- D12.6 00 1101 0110

209 236 ì EC RD + D12.7 00 1101 0001

222 236 ì EC RD-- D12.7 00 1101 1110

708 13 CR 0D RD + D13.0 10 1100 0100

715 13 CR 0D RD-- D13.0 10 1100 1011

713 45 - 2D RD+/-- D13.1 10 1100 1001

709 77 M 4D RD+/-- D13.2 10 1100 0101

707 109 m 6D RD + D13.3 10 1100 0011

716 109 m 6D RD-- D13.3 10 1100 1100

706 141 _ 8D RD + D13.4 10 1100 0010

717 141 _ 8D RD-- D13.4 10 1100 1101

714 173 - AD RD+/-- D13.5 10 1100 1010

710 205 Í CD RD+/-- D13.6 10 1100 0110

712 237 í ED RD + D13.7 10 1100 1000

718 237 í ED RD-- D13.7 10 1100 1110

452 14 SO 0E RD + D14.0 01 1100 0100

459 14 SO 0E RD-- D14.0 01 1100 1011

457 46 . 2E RD+/-- D14.1 01 1100 1001

453 78 N 4E RD+/-- D14.2 01 1100 0101

451 110 n 6E RD + D14.3 01 1100 0011

460 110 n 6E RD-- D14.3 01 1100 1100

450 142 _ 8E RD + D14.4 01 1100 0010

461 142 _ 8E RD-- D14.4 01 1100 1101

458 174 ® AE RD+/-- D14.5 01 1100 1010

454 206 Î CE RD+/-- D14.6 01 1100 0110

456 238 î EE RD + D14.7 01 1100 1000

462 238 î EE RD-- D14.7 01 1100 1110

372 15 SI 0F RD-- D15.0 01 0111 0100

651 15 SI 0F RD + D15.0 10 1000 1011

377 47 / 2F RD-- D15.1 01 0111 1001

649 47 / 2F RD + D15.1 10 1000 1001

373 79 O 4F RD-- D15.2 01 0111 0101

645 79 O 4F RD + D15.2 10 1000 0101

371 111 o 6F RD-- D15.3 01 0111 0011

652 111 o 6F RD + D15.3 10 1000 1100

370 143 _ 8F RD-- D15.4 01 0111 0010

653 143 _ 8F RD + D15.4 10 1000 1101

378 175 ¯ AF RD-- D15.5 01 0111 1010

650 175 ¯ AF RD + D15.5 10 1000 1010

374 207 Ï CF RD-- D15.6 01 0111 0110

646 207 Ï CF RD + D15.6 10 1000 0110

369 239 ï EF RD-- D15.7 01 0111 0001

654 239 ï EF RD + D15.7 10 1000 1110

436 16 DLE 10 RD-- D16.0 01 1011 0100

587 16 DLE 10 RD + D16.0 10 0100 1011

441 48 0 30 RD-- D16.1 01 1011 1001

585 48 0 30 RD + D16.1 10 0100 1001

437 80 P 50 RD-- D16.2 01 1011 0101

581 80 P 50 RD + D16.2 10 0100 0101

435 112 p 70 RD-- D16.3 01 1011 0011

588 112 p 70 RD + D16.3 10 0100 1100

434 144 _ 90 RD-- D16.4 01 1011 0010

589 144 _ 90 RD + D16.4 10 0100 1101

442 176 ° B0 RD-- D16.5 01 1011 1010

586 176 ° B0 RD + D16.5 10 0100 1010

438 208 Ð D0 RD-- D16.6 01 1011 0110

582 208 Ð D0 RD + D16.6 10 0100 0110

433 240 ð F0 RD-- D16.7 01 1011 0001

590 240 ð F0 RD + D16.7 10 0100 1110

564 17 DC1 11 RD + D17.0 10 0011 0100

571 17 DC1 11 RD-- D17.0 10 0011 1011

569 49 1 31 RD+/-- D17.1 10 0011 1001

565 81 Q 51 RD+/-- D17.2 10 0011 0101

563 113 q 71 RD + D17.3 10 0011 0011

572 113 q 71 RD-- D17.3 10 0011 1100

562 145 ‘ 91 RD + D17.4 10 0011 0010
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573 145 ‘ 91 RD-- D17.4 10 0011 1101

570 177 ± B1 RD+/-- D17.5 10 0011 1010

566 209 Ñ D1 RD+/-- D17.6 10 0011 0110

561 241 ñ F1 RD + D17.7 10 0011 0001

567 241 ñ F1 RD-- D17.7 10 0011 0111

308 18 DC2 12 RD + D18.0 01 0011 0100

315 18 DC2 12 RD-- D18.0 01 0011 1011

313 50 2 32 RD+/-- D18.1 01 0011 1001

309 82 R 52 RD+/-- D18.2 01 0011 0101

307 114 r 72 RD + D18.3 01 0011 0011

316 114 r 72 RD-- D18.3 01 0011 1100

306 146 ’ 92 RD + D18.4 01 0011 0010

317 146 ’ 92 RD-- D18.4 01 0011 1101

314 178 ² B2 RD+/-- D18.5 01 0011 1010

310 210 Ò D2 RD+/-- D18.6 01 0011 0110

305 242 ò F2 RD + D18.7 01 0011 0001

311 242 ò F2 RD-- D18.7 01 0011 0111

804 19 DC3 13 RD + D19.0 11 0010 0100

811 19 DC3 13 RD-- D19.0 11 0010 1011

809 51 3 33 RD+/-- D19.1 11 0010 1001

805 83 S 53 RD+/-- D19.2 11 0010 0101

803 115 s 73 RD + D19.3 11 0010 0011

812 115 s 73 RD-- D19.3 11 0010 1100

802 147 “ 93 RD + D19.4 11 0010 0010

813 147 “ 93 RD-- D19.4 11 0010 1101

810 179 ³ B3 RD+/-- D19.5 11 0010 1010

806 211 Ó D3 RD+/-- D19.6 11 0010 0110

801 243 ó F3 RD + D19.7 11 0010 0001

814 243 ó F3 RD-- D19.7 11 0010 1110

299 2 STX 02 RD + D2.0 01 0010 1011

724 2 STX 02 RD-- D2.0 10 1101 0100

297 34 " 22 RD + D2.1 01 0010 1001

729 34 " 22 RD-- D2.1 10 1101 1001

293 66 B 42 RD + D2.2 01 0010 0101

725 66 B 42 RD-- D2.2 10 1101 0101

300 98 b 62 RD + D2.3 01 0010 1100

723 98 b 62 RD-- D2.3 10 1101 0011

301 130 ‚ 82 RD + D2.4 01 0010 1101

722 130 ‚ 82 RD-- D2.4 10 1101 0010

298 162 ¢ A2 RD + D2.5 01 0010 1010

730 162 ¢ A2 RD-- D2.5 10 1101 1010

294 194 Â C2 RD + D2.6 01 0010 0110

726 194 Â C2 RD-- D2.6 10 1101 0110

302 226 â E2 RD + D2.7 01 0010 1110

721 226 â E2 RD-- D2.7 10 1101 0001

180 20 DC4 14 RD + D20.0 00 1011 0100

187 20 DC4 14 RD-- D20.0 00 1011 1011

185 52 4 34 RD+/-- D20.1 00 1011 1001

181 84 T 54 RD+/-- D20.2 00 1011 0101

179 116 t 74 RD + D20.3 00 1011 0011

188 116 t 74 RD-- D20.3 00 1011 1100

178 148 ” 94 RD + D20.4 00 1011 0010

189 148 ” 94 RD-- D20.4 00 1011 1101

186 180 ´ B4 RD+/-- D20.5 00 1011 1010

182 212 Ô D4 RD+/-- D20.6 00 1011 0110

177 244 ô F4 RD + D20.7 00 1011 0001

183 244 ô F4 RD-- D20.7 00 1011 0111

676 21 NAK 15 RD + D21.0 10 1010 0100

683 21 NAK 15 RD-- D21.0 10 1010 1011

681 53 5 35 RD+/-- D21.1 10 1010 1001

677 85 U 55 RD+/-- D21.2 10 1010 0101

675 117 u 75 RD + D21.3 10 1010 0011

684 117 u 75 RD-- D21.3 10 1010 1100

674 149 • 95 RD + D21.4 10 1010 0010

685 149 • 95 RD-- D21.4 10 1010 1101

682 181 µ B5 RD+/-- D21.5 10 1010 1010

678 213 Õ D5 RD+/-- D21.6 10 1010 0110

673 245 õ F5 RD + D21.7 10 1010 0001

686 245 õ F5 RD-- D21.7 10 1010 1110

420 22 SYN 16 RD + D22.0 01 1010 0100

427 22 SYN 16 RD-- D22.0 01 1010 1011

425 54 6 36 RD+/-- D22.1 01 1010 1001

421 86 V 56 RD+/-- D22.2 01 1010 0101

419 118 v 76 RD + D22.3 01 1010 0011

428 118 v 76 RD-- D22.3 01 1010 1100

418 150 – 96 RD + D22.4 01 1010 0010

429 150 – 96 RD-- D22.4 01 1010 1101

426 182 ¶ B6 RD+/-- D22.5 01 1010 1010

422 214 Ö D6 RD+/-- D22.6 01 1010 0110

417 246 ö F6 RD + D22.7 01 1010 0001

430 246 ö F6 RD-- D22.7 01 1010 1110

91 23 ETB 17 RD + D23.0 00 0101 1011

932 23 ETB 17 RD-- D23.0 11 1010 0100

89 55 7 37 RD + D23.1 00 0101 1001

937 55 7 37 RD-- D23.1 11 1010 1001

85 87 W 57 RD + D23.2 00 0101 0101

933 87 W 57 RD-- D23.2 11 1010 0101

92 119 w 77 RD + D23.3 00 0101 1100

931 119 w 77 RD-- D23.3 11 1010 0011

93 151 — 97 RD + D23.4 00 0101 1101

930 151 — 97 RD-- D23.4 11 1010 0010

90 183 · B7 RD + D23.5 00 0101 1010

938 183 · B7 RD-- D23.5 11 1010 1010

86 215 × D7 RD + D23.6 00 0101 0110

934 215 × D7 RD-- D23.6 11 1010 0110

94 247 ÷ F7 RD + D23.7 00 0101 1110

929 247 ÷ F7 RD-- D23.7 11 1010 0001

203 24 CAN 18 RD + D24.0 00 1100 1011

820 24 CAN 18 RD-- D24.0 11 0011 0100

201 56 8 38 RD + D24.1 00 1100 1001

825 56 8 38 RD-- D24.1 11 0011 1001

197 88 X 58 RD + D24.2 00 1100 0101

821 88 X 58 RD-- D24.2 11 0011 0101

204 120 x 78 RD + D24.3 00 1100 1100

819 120 x 78 RD-- D24.3 11 0011 0011

205 152 ˜ 98 RD + D24.4 00 1100 1101

818 152 ˜ 98 RD-- D24.4 11 0011 0010

202 184 ¸ B8 RD + D24.5 00 1100 1010

826 184 ¸ B8 RD-- D24.5 11 0011 1010

198 216 Ø D8 RD + D24.6 00 1100 0110

822 216 Ø D8 RD-- D24.6 11 0011 0110

206 248 ø F8 RD + D24.7 00 1100 1110

817 248 ø F8 RD-- D24.7 11 0011 0001

612 25 EM 19 RD + D25.0 10 0110 0100

619 25 EM 19 RD-- D25.0 10 0110 1011

617 57 9 39 RD+/-- D25.1 10 0110 1001

613 89 Y 59 RD+/-- D25.2 10 0110 0101

611 121 y 79 RD + D25.3 10 0110 0011

620 121 y 79 RD-- D25.3 10 0110 1100

610 153 ™ 99 RD + D25.4 10 0110 0010

621 153 ™ 99 RD-- D25.4 10 0110 1101

618 185 ¹ B9 RD+/-- D25.5 10 0110 1010

614 217 Ù D9 RD+/-- D25.6 10 0110 0110

609 249 ù F9 RD + D25.7 10 0110 0001

622 249 ù F9 RD-- D25.7 10 0110 1110

356 26 SUB 1A RD + D26.0 01 0110 0100

363 26 SUB 1A RD-- D26.0 01 0110 1011

361 58 : 3A RD+/-- D26.1 01 0110 1001

357 90 Z 5A RD+/-- D26.2 01 0110 0101

355 122 z 7A RD + D26.3 01 0110 0011

364 122 z 7A RD-- D26.3 01 0110 1100

354 154 š 9A RD + D26.4 01 0110 0010

365 154 š 9A RD-- D26.4 01 0110 1101

362 186 º BA RD+/-- D26.5 01 0110 1010

358 218 Ú DA RD+/-- D26.6 01 0110 0110

353 250 ú FA RD + D26.7 01 0110 0001

366 250 ú FA RD-- D26.7 01 0110 1110

155 27 ESC 1B RD + D27.0 00 1001 1011

868 27 ESC 1B RD-- D27.0 11 0110 0100

153 59 ; 3B RD + D27.1 00 1001 1001

873 59 ; 3B RD-- D27.1 11 0110 1001

149 91 [ 5B RD + D27.2 00 1001 0101

869 91 [ 5B RD-- D27.2 11 0110 0101

156 123 { 7B RD + D27.3 00 1001 1100

867 123 { 7B RD-- D27.3 11 0110 0011

157 155 › 9B RD + D27.4 00 1001 1101
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866 155 › 9B RD-- D27.4 11 0110 0010

154 187 » BB RD + D27.5 00 1001 1010

874 187 » BB RD-- D27.5 11 0110 1010

150 219 Û DB RD + D27.6 00 1001 0110

870 219 Û DB RD-- D27.6 11 0110 0110

158 251 û FB RD + D27.7 00 1001 1110

865 251 û FB RD-- D27.7 11 0110 0001

228 28 FS 1C RD + D28.0 00 1110 0100

235 28 FS 1C RD-- D28.0 00 1110 1011

233 60 < 3C RD+/-- D28.1 00 1110 1001

229 92 \ 5C RD+/-- D28.2 00 1110 0101

227 124 | 7C RD + D28.3 00 1110 0011

236 124 | 7C RD-- D28.3 00 1110 1100

226 156 œ 9C RD + D28.4 00 1110 0010

237 156 œ 9C RD-- D28.4 00 1110 1101

234 188 ¼ BC RD+/-- D28.5 00 1110 1010

230 220 Ü DC RD+/-- D28.6 00 1110 0110

225 252 ü FC RD + D28.7 00 1110 0001

238 252 ü FC RD-- D28.7 00 1110 1110

283 29 GS 1D RD + D29.0 01 0001 1011

740 29 GS 1D RD-- D29.0 10 1110 0100

281 61 = 3D RD + D29.1 01 0001 1001

745 61 = 3D RD-- D29.1 10 1110 1001

277 93 ] 5D RD + D29.2 01 0001 0101

741 93 ] 5D RD-- D29.2 10 1110 0101

284 125 } 7D RD + D29.3 01 0001 1100

739 125 } 7D RD-- D29.3 10 1110 0011

285 157 _ 9D RD + D29.4 01 0001 1101

738 157 _ 9D RD-- D29.4 10 1110 0010

282 189 ½ BD RD + D29.5 01 0001 1010

746 189 ½ BD RD-- D29.5 10 1110 1010

278 221 Ý DD RD + D29.6 01 0001 0110

742 221 Ý DD RD-- D29.6 10 1110 0110

286 253 ý FD RD + D29.7 01 0001 1110

737 253 ý FD RD-- D29.7 10 1110 0001

788 3 ETX 03 RD + D3.0 11 0001 0100

795 3 ETX 03 RD-- D3.0 11 0001 1011

793 35 # 23 RD+/-- D3.1 11 0001 1001

789 67 C 43 RD+/-- D3.2 11 0001 0101

787 99 c 63 RD + D3.3 11 0001 0011

796 99 c 63 RD-- D3.3 11 0001 1100

786 131 ƒ 83 RD + D3.4 11 0001 0010

797 131 ƒ 83 RD-- D3.4 11 0001 1101

794 163 £ A3 RD+/-- D3.5 11 0001 1010

790 195 Ã C3 RD+/-- D3.6 11 0001 0110

785 227 ã E3 RD + D3.7 11 0001 0001

798 227 ã E3 RD-- D3.7 11 0001 1110

484 30 RS 1E RD-- D30.0 01 1110 0100

539 30 RS 1E RD + D30.0 10 0001 1011

489 62 > 3E RD-- D30.1 01 1110 1001

537 62 > 3E RD + D30.1 10 0001 1001

485 94 ^ 5E RD-- D30.2 01 1110 0101

533 94 ^ 5E RD + D30.2 10 0001 0101

483 126 ~ 7E RD-- D30.3 01 1110 0011

540 126 ~ 7E RD + D30.3 10 0001 1100

482 158 _ 9E RD-- D30.4 01 1110 0010

541 158 _ 9E RD + D30.4 10 0001 1101

490 190 ¾ BE RD-- D30.5 01 1110 1010

538 190 ¾ BE RD + D30.5 10 0001 1010

486 222 Þ DE RD-- D30.6 01 1110 0110

534 222 Þ DE RD + D30.6 10 0001 0110

481 254 þ FE RD-- D30.7 01 1110 0001

542 254 þ FE RD + D30.7 10 0001 1110

331 31 US 1F RD + D31.0 01 0100 1011

692 31 US 1F RD-- D31.0 10 1011 0100

329 63 ? 3F RD + D31.1 01 0100 1001

697 63 ? 3F RD-- D31.1 10 1011 1001

325 95 _ 5F RD + D31.2 01 0100 0101

693 95 _ 5F RD-- D31.2 10 1011 0101

332 127 DELETE 7F RD + D31.3 01 0100 1100

691 127 DELETE 7F RD-- D31.3 10 1011 0011

333 159 Ÿ 9F RD + D31.4 01 0100 1101

690 159 Ÿ 9F RD-- D31.4 10 1011 0010

330 191 ¿ BF RD + D31.5 01 0100 1010

698 191 ¿ BF RD-- D31.5 10 1011 1010

326 223 ß DF RD + D31.6 01 0100 0110

694 223 ß DF RD-- D31.6 10 1011 0110

334 255 ÿ FF RD + D31.7 01 0100 1110

689 255 ÿ FF RD-- D31.7 10 1011 0001

171 4 EOT 04 RD + D4.0 00 1010 1011

852 4 EOT 04 RD-- D4.0 11 0101 0100

169 36 $ 24 RD + D4.1 00 1010 1001

857 36 $ 24 RD-- D4.1 11 0101 1001

165 68 D 44 RD + D4.2 00 1010 0101

853 68 D 44 RD-- D4.2 11 0101 0101

172 100 d 64 RD + D4.3 00 1010 1100

851 100 d 64 RD-- D4.3 11 0101 0011

173 132 „ 84 RD + D4.4 00 1010 1101

850 132 „ 84 RD-- D4.4 11 0101 0010

170 164 ¤ A4 RD + D4.5 00 1010 1010

858 164 ¤ A4 RD-- D4.5 11 0101 1010

166 196 Ä C4 RD + D4.6 00 1010 0110

854 196 Ä C4 RD-- D4.6 11 0101 0110

174 228 ä E4 RD + D4.7 00 1010 1110

849 228 ä E4 RD-- D4.7 11 0101 0001

660 5 ENQ 05 RD + D5.0 10 1001 0100

667 5 ENQ 05 RD-- D5.0 10 1001 1011

665 37 % 25 RD+/-- D5.1 10 1001 1001

661 69 E 45 RD+/-- D5.2 10 1001 0101

659 101 e 65 RD + D5.3 10 1001 0011

668 101 e 65 RD-- D5.3 10 1001 1100

658 133 … 85 RD + D5.4 10 1001 0010

669 133 … 85 RD-- D5.4 10 1001 1101

666 165 ¥ A5 RD+/-- D5.5 10 1001 1010

662 197 Å C5 RD+/-- D5.6 10 1001 0110

657 229 å E5 RD + D5.7 10 1001 0001

670 229 å E5 RD-- D5.7 10 1001 1110

404 6 ACK 06 RD + D6.0 01 1001 0100

411 6 ACK 06 RD-- D6.0 01 1001 1011

409 38 & 26 RD+/-- D6.1 01 1001 1001

405 70 F 46 RD+/-- D6.2 01 1001 0101

403 102 f 66 RD + D6.3 01 1001 0011

412 102 f 66 RD-- D6.3 01 1001 1100

402 134 † 86 RD + D6.4 01 1001 0010

413 134 † 86 RD-- D6.4 01 1001 1101

410 166 ¦ A6 RD+/-- D6.5 01 1001 1010

406 198 Æ C6 RD+/-- D6.6 01 1001 0110

401 230 æ E6 RD + D6.7 01 1001 0001

414 230 æ E6 RD-- D6.7 01 1001 1110

116 7 BEL 07 RD + D7.0 00 0111 0100

907 7 BEL 07 RD-- D7.0 11 1000 1011

121 39 ' 27 RD + D7.1 00 0111 1001

905 39 ' 27 RD-- D7.1 11 1000 1001

117 71 G 47 RD + D7.2 00 0111 0101

901 71 G 47 RD-- D7.2 11 1000 0101

115 103 g 67 RD + D7.3 00 0111 0011

908 103 g 67 RD-- D7.3 11 1000 1100

114 135 ‡ 87 RD + D7.4 00 0111 0010

909 135 ‡ 87 RD-- D7.4 11 1000 1101

122 167 § A7 RD + D7.5 00 0111 1010

906 167 § A7 RD-- D7.5 11 1000 1010

118 199 Ç C7 RD + D7.6 00 0111 0110

902 199 Ç C7 RD-- D7.6 11 1000 0110

113 231 ç E7 RD + D7.7 00 0111 0001

910 231 ç E7 RD-- D7.7 11 1000 1110

107 8 BS 08 RD + D8.0 00 0110 1011

916 8 BS 08 RD-- D8.0 11 1001 0100

105 40 ( 28 RD + D8.1 00 0110 1001

921 40 ( 28 RD-- D8.1 11 1001 1001

101 72 H 48 RD + D8.2 00 0110 0101

917 72 H 48 RD-- D8.2 11 1001 0101

108 104 h 68 RD + D8.3 00 0110 1100

915 104 h 68 RD-- D8.3 11 1001 0011

109 136 ˆ 88 RD + D8.4 00 0110 1101

914 136 ˆ 88 RD-- D8.4 11 1001 0010

106 168 ¨ A8 RD + D8.5 00 0110 1010
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922 168 ¨ A8 RD-- D8.5 11 1001 1010

102 200 È C8 RD + D8.6 00 0110 0110

918 200 È C8 RD-- D8.6 11 1001 0110

110 232 è E8 RD + D8.7 00 0110 1110

913 232 è E8 RD-- D8.7 11 1001 0001

596 9 HT 09 RD + D9.0 10 0101 0100

603 9 HT 09 RD-- D9.0 10 0101 1011

601 41 ) 29 RD+/-- D9.1 10 0101 1001

597 73 I 49 RD+/-- D9.2 10 0101 0101

595 105 i 69 RD + D9.3 10 0101 0011

604 105 i 69 RD-- D9.3 10 0101 1100

594 137 ‰ 89 RD + D9.4 10 0101 0010

605 137 ‰ 89 RD-- D9.4 10 0101 1101

602 169 © A9 RD+/-- D9.5 10 0101 1010

598 201 É C9 RD+/-- D9.6 10 0101 0110

593 233 é E9 RD + D9.7 10 0101 0001

606 233 é E9 RD-- D9.7 10 0101 1110

87 247 ÷ F7 RD + K23.7 00 0101 0111

936 247 ÷ F7 RD -- K23.7 11 1010 1000Reserved*
151 251 û FB RD + K27.7 00 1001 0111

872 251 û FB RD -- K27.7 11 0110 1000Reserved*
244 28 FS 1C RD -- K28.0 00 1111 0100 Reserved*
779 28 FS 1C RD + K28.0 11 0000 1011

249 60 < 3C RD -- K28.1 00 1111 1001 Reserved*
774 60 < 3C RD + K28.1 11 0000 0110

245 92 \ 5C RD -- K28.2 00 1111 0101 Reserved*
778 92 \ 5C RD + K28.2 11 0000 1010

243 124 | 7C RD -- K28.3 00 1111 0011 Reserved*
780 124 | 7C RD + K28.3 11 0000 1100

242 156 œ 9C RD -- K28.4 00 1111 0010 Reserved*
781 156 œ 9C RD + K28.4 11 0000 1101

250 188 ¼ BC RD -- K28.5 00 1111 1010 Sync
773 188 ¼ BC RD + K28.5 11 0000 0101(Not Used)
246 220 Ü DC RD -- K28.6 00 1111 0110 Reserved*
777 220 Ü DC RD + K28.6 11 0000 1001

248 252 ü FC RD -- K28.7 00 1111 1000 Test
775 252 ü FC RD + K28.7 11 0000 0111

279 253 ý FD RD + K29.7 01 0001 0111

744 253 ý FD RD -- K29.7 10 1110 1000Reserved*
488 254 þ FE RD -- K30.7 01 1110 1000Reserved*
535 254 þ FE RD + K30.7 10 0001 0111
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Appendix C
Fibre Channel Legal Arbitrated Loop Physical 
Addresses

This appendix contains legal (neutral disparity) arbitrated loop physical addresses (APLAs) sorted 
from highest (at the top) to the lowest (at the bottom) priority.
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Loop 
ID

ALPAA
HEX Name

 

RD -- Code RD-/+ Code Previous
Running 
Disparity
RD+ Code

7E 00 D0.0 10  0111  0100 01  1000  1011
7D 01 D1.0 01  1101  0100 10  0010  1011
7C 02 D2.0 10  1101  0100 01  0010  1011
7B 04 D4.0 11  0101  0100 00  1010  1011
7A 08 D8.0 11  1001  0100 00  0110  1011
79 0F D15.0 01  0111  0100 10  1000  1011
78 10 D16.0 01  1011  0100 10  0100  1011
77 17 D23.0 11  1010  0100 00  0101  1011
76 18 D24.0 11  0011  0100 00  1100  1011
75 1B D27.0 11  0110  0100 00  1001  1011
74 1D D29.0 10  1110  0100 01  0001  1011
73 1E D30.0 01  1110  0100 10  0001  1011
72 1F D31.0 10  1011  0100 01  0100  1011
71 23 D3.1 11  0001  1001
70 25 D5.1 10  1001  1001
6F 26 D6.1 01  1001  1001
6E 27 D7.1 11  1000  1001 00  0111  1001
6D 29 D9.1 10  0101  1001
6C 2A D10.1 01  0101  1001
6B 2B D11.1 11  0100  1001
6A 2C D12.1 00  1101  1001
69 2D D13.1 10  1100  1001
68 2E D14.1 01  1100  1001
67 31 D17.1 10  0011  1001
66 32 D18.1 01  0011  1001
65 33 D19.1 11  0010  1001
64 34 D20.1 00  1011  1001
63 35 D21.1 10  1010  1001
62 36 D22.1 01  1010  1001
61 39 D25.1 10  0110  1001
60 3A D26.1 01  0110  1001
5F 3C D28.1 00  1110  1001
5E 43 D3.2 11  0001  0101
5D 45 D5.2 10  1001  0101
5C 46 D6.2 01  1001  0101
5B 47 D7.2 11  1000  0101 00  0111  0101
5A 49 D9.2 10  0101  0101
59 4A D10.2 01  0101  0101
58 4B D11.2 11  0100  0101
57 4C D12.2 00  1101  0101
56 4D D13.2 10  1100  0101
55 4E D14.2 01  1100  0101
54 51 D17.2 10  0011  0101
53 52 D18.2 01  0011  0101
52 53 D19.2 11  0010  0101
51 54 D20.2 00  1011  0101
50 55 D21.2 10  1010  0101
4F 56 D22.2 01  1010  0101
4E 59 D25.2 10  0110  0101
4D 5A D26.2 01  0110  0101
4C 5C D28.2 00  1110  0101
4B 63 D3.3 11  0001  1100 11  0001  0011
4A 65 D5.3 10  1001  1100 10  1001  0011
49 66 D6.3 01  1001  1100 01  1001  0011
48 67 D7.3 11  1000  1100 00  0111  0011
47 69 D9.3 10  0101  1100 10  0101  0011
46 6A D10.3 01  0101  1100 01  0101  0011
45 6B D11.3 11  0100  1100 11  0100  0011
44 6C D12.3 00  1101  1100 00  1101  0011
43 6D D13.3 10  1100  1100 10  1100  0011
42 6E D14.3 01  1100  1100 01  1100  0011
41 71 D17.3 10  0011  1100 10  0011  0011
40 72 D18.3 01  0011  1100 01  0011  0011
3F 73 D19.3 11  0010  1100 11  0010  0011
3E 74 D20.3 00  1011  1100 00  1011  0011
3D 75 D21.3 10  1010  1100 10  1010  0011
3C 76 D22.3 01  1010  1100 01  1010  0011

3B 79 D25.3 10  0110  1100 10  0110  0011
3A 7A D26.3 01  0110  1100 01  0110  0011
39 7C D28.3 00  1110  1100 00  1110  0011
38 80 D0.4 10  0111  0010 01  1000  1101
37 81 D1.4 01  1101  0010 10  0010  1101
36 82 D2.4 10  1101  0010 01  0010  1101
35 84 D4.4 11  0101  0010 00  1010  1101
34 88 D8.4 11  1001  0010 00  0110  1101
33 8F D15.4 01  0111  0010 10  1000  1101
32 90 D16.4 01  1011  0010 10  0100  1101
31 97 D23.4 11  1010  0010 00  0101  1101
30 98 D24.4 11  0011  0010 00  1100  1101
2F 9B D27.4 11  0110  0010 00  1001  1101
2E 9D D29.4 10  1110  0010 01  0001  1101
2D 9E D30.4 01  1110  0010 10  0001  1101
2C 9F D31.4 10  1011  0010 01  0100  1101
2B A3 D3.5 11  0001  1010
2A A5 D5.5 10  1001  1010
29 A6 D6.5 01  1001  1010
28 A7 D7.5 11  1000  1010 00  0111  1010
27 A9 D9.5 10  0101  1010
26 AA D10.5 01  0101  1010
25 AB D11.5 11  0100  1010
24 AC D12.5 00  1101  1010
23 AD D13.5 10  1100  1010
22 AE D14.5 01  1100  1010
21 B1 D17.5 10  0011  1010
20 B2 D18.5 01  0011  1010
1F B3 D19.5 11  0010  1010
1E B4 D20.5 00  1011  1010
1D B5 D21.5 10  1010  1010
1C B6 D22.5 01  1010  1010
1B B9 D25.5 10  0110  1010
1A BA D26.5 01  0110  1010
19 BC D28.5 00  1110  1010
18 C3 D3.6 11  0001  0110
17 C5 D5.6 10  1001  0110
16 C6 D6.6 01  1001  0110
15 C7 D7.6 11  1000  0110 00  0111  0110
14 C9 D9.6 10  0101  0110
13 CA D10.6 01  0101  0110
12 CB D11.6 11  0100  0110
11 CC D12.6 00  1101  0110
10 CD D13.6 10  1100  0110
0F CE D14.6 01  1100  0110
0E D1 D17.6 10  0011  0110
0D D2 D18.6 01  0011  0110
0C D3 D19.6 11  0010  0110
0B D4 D20.6 00  1011  0110
0A D5 D21.6 10  1010  0110
09 D6 D22.6 01  1010  0110
08 D9 D25.6 10  0110  0110
07 DA D26.6 01  0110  0110
06 DC D28.6 00  1110  0110
05 E0 D0.7 10  0111  0001 01  1000  1110
04 E1 D1.7 01  1101  0001 10  0010  1110
03 E2 D2.7 10  1101  0001 01  0010  1110
02 E4 D4.7 11  0101  0001 00  1010  1110
01 E8 D8.7 11  1001  0001 00  0110  1110
00 EF D15.7 01  0111  0001 10  1000  1110
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Appendix D
Gigabit Ethernet Ordered Sets - Partial List 

Gigabit Ethernet defines certain combinations of characters called Ordered Sets. The table in this 
appendix shows a partial list.

Name Function Beginning RD Ordered Set 8 Bit Hex

C1 Configuration - flip disparity Positive K28.5 D21.5 config_reg[7:0] 
config_reg[15:8]

C2 Configuration - sustain 
disparity

Negative K28.5 D2.2 config_reg

I1 Idle - correct disparity Positive K28.5 D5.6 0xBC 0xC5

I2 Idle - preserve disparity Negative K28.5 D16.2 0xBC 0x50

R Carrier extend Negative
Positive

K23.7 0xF7

S Start of packet Negative K27.7 0xFB

T End of packet Negative
Positive

K29.7 0xFD

V Error propagation Negative
Positive

K30.7 0xFE
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Appendix E
Primitive Encoding

The table in this appendix (Table 2) describes a set of the K28.5-based Primitive encoding whose 
40-bit values (after 8b10b encoding with either starting running disparity) have a Hamming 
distance (that is, the number of bits different in two patterns) of at least 8. Unassigned encodings 
might be used by future versions of this standard (Reprinted from American National Standard 
T10/1562-D). 

Table 2:  Primitives with Hamming Distance of 8 

1st  2nd 3rd  4th  Assignment

K28.5 D01.3 D01.3 D01.3 ALIGN (2)

K28.5 D01.4 D01.4 D01.4 ACK

K28.5 D01.4 D02.0 D31.4 RRDY (RESERVED 0)

K28.5 D01.4 D04.7 D24.0 NAK (RESERVED 1)

K28.5 D01.4 D07.3 D30.0 CREDIT_BLOCKED

K28.5 D01.4 D16.7 D07.3 NAK (RESERVED 2)

K28.5 D01.4 D24.0 D16.7 RRDY (NORMAL)

K28.5 D01.4 D27.4 D04.7 NAK (CRC ERROR)

K28.5 D01.4 D30.0 D02.0 RRDY (RESERVED 1)

K28.5 D01.4 D31.4 D29.7 NAK (RESERVED 0)
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K28.5 D02.0 D01.4 D29.7 ERROR

K28.5 D02.0 D02.0 D02.0 HARD_RESET

K28.5 D02.0 D04.7 D01.4 CLOSE (RESERVED 1)

K28.5 D02.0 D07.3 D04.7 CLOSE (CLEAR AFFILIATION)

K28.5 D02.0 D16.7 D31.4

K28.5 D02.0 D24.0 D07.3 BREAK

K28.5 D02.0 D29.7 D16.7

K28.5 D02.0 D30.0 D27.4 CLOSE (NORMAL)

K28.5 D02.0 D31.4 D30.0 CLOSE (RESERVED 0)

K28.5 D04.7 D01.4 D24.0 BROADCAST (RESERVED 1)

K28.5 D04.7 D02.0 D01.4 BROADCAST (CHANGE)

K28.5 D04.7 D04.7 D04.7 BROADCAST (RESERVED 2)

K28.5 D04.7 D07.3 D29.7 BROADCAST (RESERVED 0)

K28.5 D04.7 D16.7 D02.0 BROADCAST (RESERVED 3)

K28.5 D04.7 D24.0 D31.4 BROADCAST (RESERVED CHANGE 0)

K28.5 D04.7 D27.4 D07.3 BROADCAST (RESERVED CHANGE 1)

K28.5 D04.7 D29.7 D30.0 BROADCAST (RESERVED 4)

K28.5 D04.7 D31.4 D27.4

K28.5 D07.0 D07.0 D07.0 ALIGN (1)

K28.5 D07.3 D01.4 D31.4

K28.5 D07.3 D02.0 D04.7

K28.5 D07.3 D04.7 D30.0

K28.5 D07.3 D07.3 D07.3

K28.5 D07.3 D24.0 D29.7

K28.5 D07.3 D27.4 D16.7

K28.5 D07.3 D29.7 D27.4

K28.5 D07.3 D30.0 D24.0

K28.5 D07.3 D31.4 D02.0

K28.5 D10.2 D10.2 D27.3 ALIGN (0)

K28.5 D16.7 D01.4 D02.0

K28.5 D16.7 D02.0 D07.3

K28.5 D16.7 D04.7 D31.4

Table 2:  Primitives with Hamming Distance of 8 

1st  2nd 3rd  4th  Assignment
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K28.5 D16.7 D16.7 D16.7 OPEN_ACCEPT

K28.5 D16.7 D24.0 D27.4

K28.5 D16.7 D27.4 D30.0

K28.5 D16.7 D29.7 D24.0

K28.5 D16.7 D30.0 D04.7

K28.5 D16.7 D31.4 D01.4

K28.5 D24.0 D01.4 D16.7

K28.5 D24.0 D02.0 D29.7

K28.5 D24.0 D04.7 D07.3 SOF

K28.5 D24.0 D07.3 D31.4 EOAF

K28.5 D24.0 D16.7 D27.4 EOF

K28.5 D24.0 D24.0 D24.0

K28.5 D24.0 D27.4 D02.0

K28.5 D24.0 D29.7  D04.7

K28.5 D24.0 D30.0 D01.4 SOAF

K28.5 D27.3 D27.3 D27.3 ALIGN (3)

K28.5 D27.4 D01.4 D07.3 AIP (RESERVED WAITING ON PARTIAL)

K28.5 D27.4 D04.7 D02.0

K28.5 D27.4 D07.3 D24.0 AIP (WAITING ON CONNECTION)

K28.5 D27.4 D16.7 D30.0 AIP (RESERVED 1)

K28.5 D27.4 D24.0 D04.7 AIP (WAITING ON PARTIAL)

K28.5 D27.4 D27.4 D27.4 AIP (NORMAL)

K28.5 D27.4 D29.7 D01.4 AIP (RESERVED 2)

K28.5 D27.4 D30.0 D29.7 AIP (WAITING ON DEVICE)

K28.5 D27.4 D31.4 D16.7 AIP (RESERVED 0)

K28.5 D29.7 D02.0 D30.0 OPEN_REJECT (RESERVED CONTINUE 0)

K28.5 D29.7 D04.7 D27.4 OPEN_REJECT (RESERVED STOP 1)

K28.5 D29.7 D07.3 D16.7 OPEN_REJECT (RESERVED INITIALIZE 1)

K28.5 D29.7 D16.7 D04.7 OPEN_REJECT (PATHWAY BLOCKED)

K28.5 D29.7 D24.0 D01.4 OPEN_REJECT (RESERVED CONTINUE 1)

K28.5 D29.7 D27.4 D24.0 OPEN_REJECT (RETRY)

K28.5 D29.7 D29.7 D29.7 OPEN_REJECT (NO DESTINATION)

Table 2:  Primitives with Hamming Distance of 8 

1st  2nd 3rd  4th  Assignment
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K28.5 D29.7 D30.0 D31.4 OPEN_REJECT (RESERVED INITIALIZE 0)

K28.5 D29.7 D31.4 D07.3 OPEN_REJECT (RESERVED STOP 0)

K28.5 D30.0 D01.4 D04.7 DONE (ACK/NAK TIMEOUT)

K28.5 D30.0 D02.0 D16.7

K28.5 D30.0 D07.3 D27.4 DONE (CREDIT TIMEOUT)

K28.5 D30.0 D16.7 D01.4 DONE (RESERVED 0)

K28.5 D30.0 D24.0 D02.0

K28.5 D30.0 D27.4 D29.7 DONE (RESERVED TIMEOUT 0)

K28.5 D30.0 D29.7 D31.4 DONE (RESERVED 1)

K28.5 D30.0 D30.0 D30.0 DONE (NORMAL)

K28.5 D30.0 D31.4 D24.0 DONE (RESERVED TIMEOUT 1)

K28.5 D31.3 D01.3 D07.0 NOTIFY (RESERVED 1)

K28.5 D31.3 D07.0 D01.3 NOTIFY (RESERVED 0)

K28.5 D31.3 D10.2 D10.2 NOTIFY (RESERVED 2)

K28.5 D31.3 D31.3 D31.3 NOTIFY (ENABLE SPINUP)

K28.5 D31.4 D01.4 D30.0 OPEN_REJECT (RESERVED ABANDON 3)

K28.5 D31.4 D02.0 D27.4 OPEN_REJECT (RESERVED ABANDON 0)

K28.5 D31.4 D04.7 D29.7 OPEN_REJECT (CONNECTION RATE NOT SUPPORTED)

K28.5 D31.4 D07.3 D02.0 OPEN_REJECT (RESERVED ABANDON 2)

K28.5 D31.4 D16.7 D24.0 OPEN_REJECT (WRONG DESTINATION)

K28.5 D31.4 D27.4 D01.4 OPEN_REJECT (STP RESOURCES BUSY)

K28.5 D31.4 D29.7 D07.3 OPEN_REJECT (PROTOCOL NOT SUPPORTED)

K28.5 D31.4 D30.0 D16.7 OPEN_REJECT (RESERVED ABANDON 1)

K28.5 D31.4 D31.4 D31.4 OPEN_REJECT (BAD DESTINATION)

Table 2:  Primitives with Hamming Distance of 8 

1st  2nd 3rd  4th  Assignment
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Numbers

10GigE
creating Jammer configurations, 162
decode switches menu, 179, 344, 352, 368
Jam definition, 184
Jammer configuration window, 164
pause, 171
repeat mode, 170
rollback option, 170
test suite toolbar, 165
timeout option, 170, 340, 362
trigger button, 168

16G FC
configuration window, 203
creating Jammer configurations, 202
decode switches menu, 220
FEC, 24
Jam definition, 227
Jammer configuration window, 204
pause, 211
repeat mode, 210
rollback option, 210
test suite toolbar, 205
timeout option, 210
trigger button, 208

8-bit/10-bit mapping, 375

A
All Jam Modes, 280

APLAs, 393

Apply Global Bit Error Jam, 84, 109, 139, 156, 193, 237

Apply Global Match Mask Jam, 83, 108, 193, 237

Apply Global Replace Jam, 138, 154

arbitrated loop physical addresses, 393

arm button, 71, 94, 120, 168, 208, 256
Delay Emulator, 339, 361

arm condition, 173, 213, 347, 363

arm condition, PCIe, 260

arm conditions, 73, 99, 125, 143

arm name, 26

arm status, 26

arm-trigger timeout, 26

B
Binary Editor, 74, 100, 129, 146, 174, 179, 197, 214, 220, 

261, 263, 267, 269, 273, 279, 344, 348, 352, 365, 367

bit errors, 80, 105, 133, 150, 190, 234

C

Carrier Extend(s), 106, 191, 235

Classify button
Delay Emulator, 339

clock rate
Delay Emulator, 310
Jammer, 10, 23, 25

Code Violation, 138, 155

Condition button, 71

config type (Delay Emulator), 310

configuration
10GigE Jammer, 164
16G FC Jammer, 204
Delay Emulator, 336
FC Jammer, 66
Gigabit Ethernet Jammer, 88
Jammer, 68, 91
PCIe Jammer, 252
reorder, 359
SAS/SATA Jammer, 114

configuration file menu, PCIe, 254

configuration manager
Jammer, 15, 301

configuration window
Jammer, 68, 91
SAS Jammer, 116

configuring tests, 67, 90, 115, 163, 203, 251, 335
reorder, 357

control character conditions, 176, 182, 216, 222

control character, jamming, 185, 228

CRC
recalculate checksum, 198

CRC definitions, 281

CRC options, 81, 106, 135, 139, 152, 156, 191, 235

Create Error Jam, 138, 155, 274, 280

creating 10GigE Jammer configurations, 162

creating 16G FC Jammer configurations, 202

creating Delay Emulator configurations, 334, 356

creating FC Jammer configurations, 66

creating Gigabit Ethernet Jammer configurations, 88

creating PCIe Jammer configurations, 250

creating SAS/SATA Jammer configurations, 114

D

decode switches
FCoE interpretations, 180
FC-SW accept interpretation, 181, 221, 345, 353, 369

Delay capabilities, 297
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Delay Configuration window, 335, 336

Delay Emulator
cabling, 298
capabilities, 296
configuration files, 329
configuration window, 336, 359
creating configurations, 334, 356
delay graph, 318
parameters, 309
parameters status table, 307
ports manager, 313
real time tab, 317
running test suite, 331
Test Suite toolbar, 336
triggering capabilities, 297

Delimiters/CRC Tab, 105, 190, 234

digital retiming device, 296

Disable LRC, 238

Disparity Error, 138, 155, 274, 280, 281

Domains and External Triggering, 291

E

edit Delay Emulator configuration, 334, 356

edit Jammer configuration
10GigE, 162
16G FC, 202
FC, 66
Gigabit Ethernet, 88
PCIe, 250
SAS/SATA, 114

editing the tests stack, 69

Embedded Protocol(s) tab, 109, 194, 238

F

FC, GE Configuration window, 67, 90, 163

FCoE interpretations, 180, 198, 241

FCoE payload, 195

FC-SW accept interpretation, 181, 221, 345, 353, 369

Fibre Channel
edit Jammer configuration, 66
pause, 73

Fibre Channel arbitrated loop physical address, 393

Fibre Channel Ordered Sets, 373

file menu, PCIe, 254

frame condition, save, 75, 101, 129, 175, 181, 215, 221, 
346, 349, 354, 365, 369

frame conditions, 74, 100, 128, 173, 179, 213, 220, 344, 
347, 352, 364, 367
SATA, 146

frame jamming, 11

frame modification, 289

frame truncation, 289

full frame Jam support, 272

G

Gen 1/2 tab, PCIe, 276, 281

Gen 3 tab, PCIe, 277, 282

Gigabit Etherner
edit Jammer configuration, 88

Gigabit Ethernet
Ordered Sets, 395
pause, 97
payload, 195
Repeat Mode, 96
Rollback option, 96
Test Suite toolbar, 92
timeout option, 96
Trigger button, 94

global bit errors, 80, 105, 133, 150, 190, 234

Global Match/Mask Option, 79, 104, 189, 233

Global Option, 132, 149

Global Tab, 79, 104, 132, 149, 189, 233

H
hashed address, 118

Header/Payload tab, 82, 107, 135, 152, 191, 235, 272

I
Inject Error, 274, 280

Inject Errors, 281

Insert Code Violation Jam, 83

Invert Jam, 83, 108, 138, 155, 193, 237, 275

IP, 110, 195

IP checksum, 110, 195

IP header IHL field, 111, 196

IP header IP Protocol field value, 110, 195

IP header Total Length field, 110, 195

IP payload, 195

J

Jam Behavior, 131, 186, 231

Jam button, 77, 103, 140, 158, 184, 185, 227, 228, 229, 
243, 283

Jam Definition, 130
FC, 77
Gigabit Ethernet, 103
SATA, 148
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Jam definition
10GigE, 184
16G FC, 227
PCIe, 272

Jam name, 26

Jam Status, 23

Jammer
capabilities, 10
displaying and hiding parameters, 59, 328
using the log manager, 50, 320
using the Window menu, 55, 324

Jammer blade LEDs, 24

Jammer capture, 286

Jammer Configuration window, 68, 91, 164, 204, 252

Jammer Tests Stack, 68, 91, 116, 164, 204, 253, 336, 359

Jamming a control character, 185, 228

Jamming a Primitive Sequence, 140, 158

Jamming an Ordered Set, 77, 103, 184, 227, 243, 283

Jamming capabilities, 11, 12

L

LCRC modification, 277

LCRC modification, PCIe, 277, 278

LEDs
Jammer blade, 24

line rates, 10

Link State (Delay Emulator), 309

logging
Jammer, 50, 320

loop, 69

M

MAC layer, 11, 296

match/mask, global option, 79, 104, 189, 233

mode, 70, 93, 119, 167, 207, 255
Delay Emulator, 339, 361

Modified Frame, Replace Frame with, 79, 104, 132, 149, 
186, 231

N
New Payload Size, 195

number of Dwords, 272

O

Ordered Set
jamming, 77, 103, 184, 227, 243, 283

Ordered Set conditions, 75, 102, 175, 182, 184, 215, 216, 
217, 222, 223, 227, 240, 265, 271

Ordered Sets
Fibre Channel, 373
Gigabit Ethernet, 395

Ordered Sets, jamming, 12

output voltage, 47

P

parameters status context menu
Jammer, 27, 311

parameters status table
Jammer, 21, 307

pass through, 8, 11

Pass Through Jam, 83, 108, 138, 155, 193, 237, 274, 280

pause, 73, 97, 123, 171, 211

pause, PCIe, 258

Payload Size, 136, 153

Payload Words Tab, 135, 152

PCI trigger condition, 266
DLLP, 269
ordered set, 271
TLP, 267

PCIe
creating Jammer configurations, 250
Jammer configuration window, 252
pause, 258
rollback option, 257
test suite toolbar, 253
timeout option, 258
trigger button, 256

PCIe arm condition, 260
DLLP, 263
ordered set, 265
TLP, 261

PCIe configuration window, 251

PCIe Jam definition, 272
DLLP, 278
ordered set, 283
TLP, 272

PCIe link speed, 24

PCIe link width, 24

PCIe timeout button, 258

ports manager
Jammer, 45

Primitive Sequence
jamming, 140, 158
Redundant, 126, 143
Triple, 126, 143

primitive sequence
continued, 160
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repeated, 160
single, 159

protocol indicator
Jammer, 23

R

Recalculate Checksum, 109, 194

recalculate CRC checksum, 198

Recalculate IP checksum for valid IP embedded frames, 
109, 194

Recalculate LRC, 238

Recalculate TCP checksum for valid TCP embedded 
frames, 110, 195

reorder
Delay Emulator configuration window, 359
Test Suite toolbar, 359

Reorder capabilities, 297

reorder configuration window, 357

reorder definition, 370

Repeat button, 257

Repeat Mode, 96, 123

repeat mode, 170, 210

Replace 10b Jam, 138, 155

Replace 66 bit Jam, 193

Replace 8b Jam, 83, 109, 137, 154, 193, 237

Replace Frame with ARB(ff), 86

Replace Frame with Idles, 86, 112, 140, 157, 196, 242

Replace Frame with Modified Frame, 79, 104, 132, 149, 
186, 231

Replace Frame with Modified Traffic - Fibre Channel, 289

Replace Frame with Truncated Frame, 86, 110, 139, 156, 
195, 241

Replace Jam, 155, 275, 280

Replace Jam with CRC, 83, 138, 156

Replace LRC, 238

Replace w/ Modified Traffic, 289

replacing a frame with multiple frames, 290

replacing a frame with Ordered Sets, 290

reverse jam, 71, 94, 120, 168, 208

Rollback option, 96, 122

rollback option, 170, 210

rollback, PCIe, 257

S

SAS, 125
Binary Editor, 129

frame condition, save, 129
frame conditions, 128
Hashed Address, 118
Jam Definition, 130
Template Library, 128
trigger conditions, 125
User Library, 129, 147

SAS Jammer Configuration window, 116

SAS Trigger condition, 130

SAS/SATA
pause, 123
Repeat Mode, 123
Rollback option, 122
Test Suite toolbar, 117
Test Suite Tools, 116
timeout option, 122
Trigger button, 120

SAS/SATA Configuration window, 115

SAS/SATA edit Jammer configuration, 114

SATA, 143
frame condition, save, 147
frame conditions, 146
Jam Definition, 148
primitive sequence, Jamming, 158
Template Library, 146
trigger conditions, 143

Set Bits To 0’s Jam, 275

Set Bits To 0s Jam, 84, 109, 139, 156, 193, 237

Set Bits To 1’s Jam, 275

Set Bits To 1s Jam, 84, 109, 139, 156, 193, 237

Setting Up the Xgig Jammer and Xgig Analyzer to 
Capture a Jam, 286

Settings category
Jammer, 25, 310

Signal LED A
Jammer, 24

Signal LED B
Jammer, 24

SOF/CRC/EOF Tab, 80, 134, 151

SOP modification, PCIe, 276

SOP/SFP/EOP, 106, 191, 235

State category
Jammer, 23

State category (Delay Emulator), 309

Switch to button, 194, 238

T

TCP, 110, 195

TCP header Data Offset field, 111, 196
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TCP payload, 195

Template Library, 74, 100, 128, 146, 174, 179, 214, 220, 
261, 263, 267, 269, 344, 348, 352, 365, 367

Test Repeat Count
Delay Emulator, 309

Test Suite Tools, SAS/SATA, 116

Test Timeout, 26
Delay Emulator, 309

Test Timeout Mode
Delay Emulator, 309

testing strategies, 288

Testing Strategies for the Xgig Jammer, 288

tests stack, 68, 91, 164, 204, 253, 336, 359

tests stack, SAS/SATA, 116

Time Since Test Started
Delay Emulator, 309

timeout, 96, 122, 170, 210, 340, 362

Timeout button, 72, 96, 122, 170, 210, 341, 362

timeout, PCIe, 258

TLP full frame Jam support, 272

toolbar
Delay Emulator, 336

toolbar, 10GigE, 165

toolbar, 16G FC, 205

toolbar, Gigabit Ethernet, 92

toolbar, PCIe, 253

toolbar, reorder, 359

toolbar, SAS/SATA, 117

traffic patterns, 10

Trigger button, 71, 94, 120

trigger button, 168, 208, 256
Delay Emulator, 339, 361

trigger condition, 266

Trigger conditions, 177, 218, 342, 350, 366

trigger conditions, 73, 99, 125, 143

Trigger Definition, 77, 103, 130, 184, 227, 272

Trigger Domain A/B, 73

Trigger from Domain A/B, 73

Trigger name, 26

Trigger occurred, 26

Trigger timed out, 26

Triggering capabilities, 11

Tuning and Equalization, 39

U

User Library, 75, 101, 129, 147, 175, 181, 199, 215, 221, 
241, 262, 264, 268, 270, 346, 349, 354, 365, 369
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